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Notificare
Nicio parte a acestei publicații nu poate fi reprodusă sau transmisă sub nicio formă și prin niciun fel de
mijloace, electronice sau mecanice, incluzând foto-copierea, înregistrarea sau orice sistem de stocare sau
recuperare de informații, fără permisiunea scrisă a Bio-Rad Laboratories, Inc.

Bio-Rad își rezervă dreptul de a modifica produsele și serviciile sale în orice moment. Acest ghid poate
suferi modificări fără înștiințare prealabilă. Deși a fost întocmit astfel încât să asigure acuratețea, Bio-Rad
nu își asumă nicio răspundere pentru erori sau omisiuni sau pentru orice daune care apar din aplicarea
sau utilizarea acestor informații.

BIO-RAD este marcă comercială a Bio-Rad Laboratories, Inc.

SYBR este o marcă comercială a Thermo Fisher Scientific Inc.

EvaGreen este o marcă comercială a Biotium, Inc.
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Domeniu de utilizare

Domeniu de utilizare
Sistemul PCR în timp real CFX Opus 96 Dx sau sistemul PCR în timp real CFX Opus 384 Dx cu
Software-ul CFX Maestro Dx SE este destinat efectuării PCR pe bază de fluorescență pentru a detecta
și cuantifica secvențele de acizi nucleici. Sistemele și software-ul sunt concepute pentru utilizarea în
scop de diagnosticare in vitro de către tehnicieni de laborator instruiți. Sistemele sunt concepute
pentru a fi utilizate cu teste de diagnostic pentru acizi nucleici furnizate de alți producători care au fost
produse și etichetate in scopuri de diagnostic.

Lexicon de simboluri

Producător Numărul lotului

Utilizare de către
Pentru utilizare de diagnosticare in
vitro

Limita de temperatură Număr de catalog

Consultați instrucțiunile de utilizare Numărul de teste

Pentru utilizare cu Număr de serie
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Numai cu utilizare pe bază de
prescripție Conține latex

Traduceri
Documentele de produs pot fi furnizate în limbi suplimentare pe suport electronic.
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Siguranța și conformitatea cu reglementările
Sistemele PCR în timp real CFX Opus 96 Dx și CFX Opus 384 Dx (cunoscute în acest ghid sub
denumirea Sistemul CFX Opus Dx) se încălzesc și se răcesc foarte repede în timpul funcționării.
Pentru operarea în siguranță a sistemului PCR în timp real, Bio-Rad vă recomandă în mod imperios
să respectați specificațiile de siguranță enumerate în această secțiune și în acest manual.

Etichete cu avertizări de siguranță
Etichetele de atenționare aplicate pe Sistemul CFX Opus Dx și prezentate în acest manual vă
avertizează despre sursele de rănire sau vătămare. Tabelul 1 definește fiecare etichetă cu avertizări
de siguranță.

Pictogramă Semnificație

Operarea cu Sistemul CFX Opus Dx înainte de a citi acest manual poate constitui
un risc de vătămare personală. Utilizarea acestui instrument într-un mod care nu
este specificat în acest manual sau de către Bio-Rad poate duce la deteriorarea
sau dezactivarea caracteristicilor de protecție ale instrumentului.

Nu există pericole biologice sau pericole radioactive asociate cu Sistemul CFX
Opus Dx în sine. Aceste pericole devin îngrijorătoare numai atunci când sunt
introduse în sistem prin probele în curs de testare. Când manevrați probe
biopericuloase sau radioactive, respectați măsurile de precauție recomandate și
liniile directoare specifice laboratorului și locației dvs. Aceste linii directoare
trebuie să includă metode de curățare, monitorizare și eliminare a materialelor
periculoase pe care le utilizați.

În plus, așa cum s-a identificat mai sus, există un risc mic de explozie sau de
expulzare a lichidelor sau a vaporilor din recipientul (recipientele) probei. Atunci
când lucrați cu materiale periculoase, riscul de rănire cauzat de materialul
expulzat se agravează cu riscul ca materialul periculos să fie dispersat în
interiorul și în jurul instrumentului. Utilizatorii trebuie să ia măsurile de precauție
adecvate pentru o astfel de situație.

Tabelul 1. Avertismente generale de siguranță
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Siguranța și conformitatea cu reglementările

Pictogramă Semnificație

Sistemul CFX Opus Dx funcționează la temperaturi suficient de ridicate pentru a
provoca arsuri grave. Lăsați întotdeauna blocul de reacție să revină la
temperatura camerei înainte de a deschide capacul și de a scoate probele. Chiar
și după ce blocul de reacție s-a răcit, zonele înconjurătoare, precum și placa de
încălzire pot rămâne fierbinți destul de mult timp. În situațiile în care nu există
suficient timp pentru a permite instrumentului să se răcească, se recomandă
utilizarea echipamentului de protecție, cum ar fi mănuși termice sau „mănuși de
cuptor”.

Siguranța și performanța oricărui sistem care încorporează un Sistemul CFX
Opus Dx sunt exclusiv responsabilitatea persoanei care asamblează sistemul.

Sistemul CFX Sistemul CFX Opus Dx poate deveni suficient de fierbinte în timpul
funcționării normale pentru a provoca fierberea sau evaporarea lichidelor din
probe, presurizând recipientele pentru probe. Există posibilitatea ca recipientul
(recipientele) de probe să se defecteze; conducând la scurgeri, pulverizarea cu
lichide sau ruptură explozivă și expulzarea vaporilor sau a lichidelor în instrument
și în jurul acestuia.

Utilizatorii trebuie să acționeze întotdeauna instrumentul cu capacul închis sau să
poarte ochelari de protecție, mănuși termice și alte echipamente de protecție
personală în timpul funcționării pentru a evita vătămarea corporală. Deschiderea
instrumentului în timp ce probele sunt încă fierbinți, cum ar fi după întreruperea
unei rulări, poate permite recipientelor sub presiune să se scurgă, să pulverizeze
sau să stropească cu lichid. Lăsați întotdeauna probele să se răcească înainte de
a deschide capacul.

Utilizatorii nu trebuie să efectueze niciodată o reacție cu un capac sau sigiliu
deschis, slăbit, perforat sau deteriorat în alt mod, deoarece va crește
probabilitatea unei rupturi sau explozii periculoase.

Utilizatorii nu trebuie să efectueze niciodată o reacție cu reactivi volatili care ar
putea crește probabilitatea unei rupturi sau explozii periculoase.

Tabelul 1. Avertismente generale de siguranță, continuare
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Siguranța și conformitatea cu reglementările
Sistemul CFX Opus Dx este proiectat pentru a funcționa sigur și eficient când este utilizat în modul
recomandat de producător. Sistemul CFX Opus Dx a fost conceput pentru a putea fi operat în condiții
de siguranță în condițiile de mediu enumerate în Tabelul 2.

Aspect de utilizare Condiții de utilizare sigură

Putere de intrare nominală 100-240 VAC ± 10%, 50/60 Hz, 850 W max.

Categorie de supratensiune II

Siguranțe 10 A, 250 V, 5 x 20 mm, fuzibile cu acțiune rapidă (cant. 2)

Mediu Numai pentru utilizare în spații interioare

Temperatura de operare 15–31 °C (funcționarea în intervalul 5 °C–40 °C este sigură, dar
este posibil ca instrumentul să nu îndeplinească specificațiile
privind performanța)

Umiditate relativă Până la 80% (fără condens)

Altitudine Până la 2.000 de metri deasupra nivelului mării

Grad de poluare 2

Tabelul 2. Condiții pentru utilizarea sigură

Conformitate cu siguranța
Sistemul de detectare PCR în timp real pentru Sistemul CFX Opus Dx a fost testat și s-a dovedit că
respectă toate cerințele aplicabile ale următoarelor standarde de siguranță și electromagnetice:

n IEC 61010-1:2010 cerințe de siguranță pentru echipamente electrice de măsurare, control și
utilizare în laborator, Partea 1: cerințe generale

n IEC 61010-2-010:2019 Cerințe de siguranță pentru echipamente electrice de măsurare, control și
utilizare în laborator — Partea 2 010: Cerințe speciale pentru echipamente de laborator pentru
încălzirea materialelor

n IEC 61010-2-081:2019 Cerințe de siguranță pentru echipamente electrice de măsurare, control și
utilizare în laborator — Partea 2 081: Cerințe speciale pentru echipamente de laborator automate
și semiautomate pentru analiză și alte scopuri
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n IEC 61010-2-101:2018 Cerințe de siguranță pentru echipamente electrice de măsurare, control și
utilizare în laborator — Partea 2 101: Cerințe speciale pentru echipamente medicale pentru
diagnostic in vitro (IVD)

n CAN/CSA-C22.2 NR. 61010-1-12:2018 Cerințe de siguranță pentru echipamente electrice de
măsurare, control și utilizare în laborator, Partea 1: Cerințe generale

n CAN/CSA-C22.2 NR. 61010-2-010:19 Cerințe de siguranță pentru echipamente electrice de
măsurare, control și utilizare în laborator, Partea 2-010: Cerințe speciale pentru echipamente de
laborator pentru încălzirea materialelor

n CAN/CSA-C22.2 NR. 61010-2-081:19 Cerințe de siguranță pentru echipamente electrice de
măsurare, control și utilizare în laborator, Partea 2-081: Cerințe speciale pentru echipamente de
laborator automate și semiautomate pentru analiză și alte scopuri

n CSA-C22.2 NR. 61010-2-101:19 Cerințe de siguranță pentru echipamente electrice de măsurare,
control și utilizare în laborator — Partea 2-101: Cerințe speciale pentru echipamente medicale
pentru diagnostic in vitro (IVD)

n EN 61010-1:2010 Cerințe de siguranță pentru echipamente electrice de măsurare, control și
utilizare în laborator, Partea 1: Cerințe generale

n EN 61010-2-010:2014 Cerințe de siguranță pentru echipamente electrice de măsurare, control și
utilizare în laborator — Partea 2-010: Cerințe speciale pentru echipamente de laborator pentru
încălzirea materialelor

n EN 61010-2-081:2015 Cerințe de siguranță pentru echipamente electrice de măsurare, control și
utilizare în laborator — Partea 2-081: Cerințe speciale pentru echipamente de laborator automate
și semiautomate pentru analiză și alte scopuri

n EN 61010-2-101:2017 Cerințe de siguranță pentru echipamente electrice de măsurare, control și
utilizare în laborator — Partea 2-101: Cerințe speciale pentru echipamente medicale pentru
diagnostic in vitro (IVD)

n UL 61010-1:2012 Cerințe de siguranță pentru echipamente electrice de măsurare, control și
utilizare în laborator — Partea 1: Cerințe generale

n UL 61010-2-010:2019 Cerințe de siguranță pentru echipamente electrice de măsurare, control și
utilizare în laborator — Partea 2-010: Cerințe speciale pentru echipamente de laborator pentru
încălzirea materialelor
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n UL 61010-2-081:2019 Cerințe de siguranță pentru echipamente electrice de măsurare, control și
utilizare în laborator — Partea 2-081: Cerințe speciale pentru echipamente de laborator automate
și semiautomate pentru analiză și alte scopuri

n UL 61010-2-101:19 Cerințe de siguranță pentru echipamente electrice de măsurare, control și
utilizare în laborator — Partea 2-101: Cerințe speciale pentru echipamente medicale pentru
diagnostic in vitro (IVD)

Compatibilitate electromagnetică (EMC)
Sistemul CFX Opus Dx a fost testat și s-a dovedit că este în conformitate cu toate cerințele aplicabile
ale următoarelor standarde de compatibilitate electromagnetică:

n IEC 61326-1:2012 Echipamente electrice de măsurare, control și utilizare în laborator — Cerințe
EMC — Partea 1: Cerințe generale. Testat ca dispozitiv de clasă A

n IEC 61326-2-6:2012 Echipamente electrice de măsurare, control și utilizare în laborator —
Cerințe EMC — Partea 2–6: Cerințe speciale – Echipamente medicale pentru diagnostic in vitro
(IVD)

n EN 61326-1:2013 Echipamente electrice de măsurare, control și utilizare în laborator — Cerințe
EMC — Partea 1: Cerințe generale. Testat ca dispozitiv de clasă A

n EN 61326-2:-6:2013 Echipamente electrice de măsurare, control și utilizare în laborator —
Cerințe EMC — Partea 2–6: Cerințe speciale – Echipamente medicale pentru diagnostic in vitro
(IVD)

n FCC Partea 15, Subpartea B, Secțiunile 15.107 și 15.109. Testat ca dispozitiv digital de clasă A

n CAN ICES-003v6: 2019 Standard pentru echipamentele care cauzează interferențe,
echipamente pentru tehnologia informației (inclusiv aparate digitale) — Limite și metode de
măsurare. Testat la limitele clasei A

Avertismente și observații EMC
n Avertisment: Schimbările sau modificările acestei unități care nu au fost aprobate în mod expres

de Bio-Rad ar putea anula autoritatea utilizatorului de a opera echipamentul.

n Notă: Acest echipament a fost testat și s-a constatat că respectă limitele unui dispozitiv digital de
clasa A, în conformitate cu Partea 15 din Reglementările FCC. Aceste limite sunt stabilite astfel
încât să ofere o protecție rezonabilă împotriva interferențelor prejudiciabile atunci când
echipamentul este operat într-un mediu comercial. Acest echipament generează, utilizează și
poate emite energie de radiofrecvență, iar dacă nu este instalat și utilizat conform manualului de
instrucțiuni, poate provoca interferențe perturbatoare pentru comunicațiile radio. Operarea
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acestui echipament într-o zonă rezidențială poate provoca interferențe prejudiciabile, caz în care
utilizatorul va trebui să corecteze interferențele pe propria cheltuială.

n Notă privind conformitatea FCC: Cu toate că acest instrument a fost testat și s-a constatat că
respectă limitele unui dispozitiv digital de clasa A, în conformitate cu Partea 15, Subpartea B din
Reglementările FCC, rețineți faptul că această conformitate este voluntară, deoarece instrumentul
se califică drept „dispozitiv scutit” conform 47 CFR 15.103(c), în ceea ce privește reglementările
FCC citate în vigoare în momentul fabricării.

n Notă privind cablurile: Acest instrument a fost testat pentru conformitatea EMC utilizând cabluri
USB special concepute, care sunt furnizate împreună cu instrumentul. Aceste cabluri sau înlocuiri
autorizate de Bio-Rad trebuie utilizate împreună cu acest instrument pentru a asigura
conformitatea continuă cu limitele de emisii EMC.
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Pericole
Sistemul CFX Opus Dx este proiectat pentru a funcționa sigur și eficient când este utilizat în modul
recomandat de producător. Dacă sistemul sau oricare dintre componentele sale asociate este utilizat
într-o manieră nespecificată de producător, protecția inerentă furnizată de instrument poate fi afectată.
Bio-Rad nu poartă răspunderea pentru vătămări sau daune cauzate de utilizarea acestui echipament
într-o manieră nespecificată sau de modificări ale instrumentului care nu sunt efectuate de Bio-Rad
sau de un agent autorizat. Operația de service pentru Sistemul CFX Opus Dx trebuie să fie efectuată
numai de către personal Bio-Rad instruit.

Pericole biologice
Sistemul CFX Opus Dx este un produs de laborator. Dacă există totuși materiale periculoase din
punct de vedere biologic, respectați următoarele instrucțiuni și conformați-vă tuturor recomandărilor
locale specifice pentru laboratorul dumneavoastră și locul în care vă aflați.

Notă: Nicio substanță periculoasă din punct de vedere biologic nu este eliminată în timpul
operațiunilor normale ale acestui instrument.

Măsuri de precauție generale

n Purtați întotdeauna mănuși și îmbrăcăminte de laborator, precum și ochelari de protecție sau
ochelari de siguranță cu apărători laterale.

n Țineți mâinile la distanță de gură, nas și ochi.

n Protejați în mod complet orice tăietură sau urmă de frecare de pe piele înainte de a lucra cu
materiale potențial infecțioase.

n Spălați-vă pe mâini foarte bine, cu apă și săpun, după ce ați lucrat cu orice materiale potențial
infecțioase, înainte de a părăsi laboratorul.

n Scoateți ceasurile de mână și bijuteriile înainte de a lucra în laborator.

n Depozitați toate materialele infecțioase sau potențial infecțioase în recipiente incasabile și
impermeabile.

n Înainte de a părăsi laboratorul, scoateți îmbrăcămintea de protecție.

n Nu folosiți mănuși pentru a scrie, a răspunde la telefon, a aprinde lumina sau pentru a atinge
lucruri pe care alte persoane le pot atinge fără mănuși.

n Schimbați mănușile frecvent. Scoateți mănușile imediat ce au fost contaminate în mod vizibil.

n Nu expuneți materialele care nu pot fi decontaminate în mod corespunzător la materiale potențial
infecțioase.
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n După terminarea unei operațiuni care implică materiale periculoase din punct de vedere biologic,
decontaminați zona de lucru cu un dezinfectant corespunzător (de exemplu, înălbitor de uz
casnic, diluat în proporție de 1:10).

Decontaminarea suprafețelor

AVERTISMENT! Pentru a preveni electrocutarea, opriți și deconectați de la priză
instrumentul de fiecare dată înainte de a efectua procedurile de decontaminare.

Următoarele zone pot fi curățate cu orice dezinfectant bactericid, virucid sau fungicid de uz spitalicesc:

n Capacul exterior și șasiul

n Suprafața interioară a blocului de reacție și godeurile blocului de reacție

n Panoul de control și afișajul

Pentru a pregăti și aplica dezinfectantul, consultați instrucțiunile furnizate de fabricantul produsului.
Clătiți întotdeauna blocul de reacție și godeurile blocului de reacție de mai multe ori cu apă după
aplicarea unui dezinfectant. Uscați complet blocul de reacție și alveolele blocului de reacție după ce
clătiți cu apă.

Important: Nu utilizați detergenți abrazivi sau corozivi sau soluții alcaline puternice. Acești agenți
pot zgâria suprafețele și deteriora blocul de reacție, rezultând în pierderea controlului termic
precis.

Eliminarea materialelor periculoase din punct de vedere biologic

Eliminați următoarele materiale posibil contaminate în conformitate cu regulamentele locale,
regionale și naționale privind laboratoarele:

n Probe clinice

n Reactivi

n Recipientele de reacție sau alte consumabile folosite care ar putea fi contaminate

Pericole chimice
Sistemul CFX Opus Dx nu conține materiale care pot prezenta pericol chimic.

Pericole de explozie sau aprindere
Sistemul CFX Opus Dx nu prezintă pericole deosebite de aprindere sau explozie când este utilizat
corect, conform specificațiilor Bio-Rad Laboratories.
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Pericole electrice
Sistemul CFX Opus Dx nu prezintă pericole electrice neobișnuite pentru operatori, dacă este instalat
și utilizat corect, fără modificări fizice, și dacă este conectat la o sursă de alimentare cu specificații
adecvate.

Transport
Înainte de mutarea sau expedierea sistemului CFX , trebuie realizate proceduri de decontaminare.
Mutați sau expediați întotdeauna sistemul într-un recipient/în recipiente separat(e) în materialul de
ambalare furnizat de Bio-Rad, care va proteja sistemul împotriva deteriorării.

Pentru informații despre transportul sistemului și pentru a solicita materialul de ambalare adecvat,
contactați biroul local Bio-Rad.

Bateria
În funcție de model, Sistemul CFX Opus Dx utilizează una sau două baterii cu celule de litiu-metal de
3 V de tip nasture pentru a menține setările de timp în caz de pierdere a alimentării c.a. Dacă ora nu
rămâne setată după oprirea unității, acest lucru poate fi un semnal că bateriile încep să se consume.

AVERTISMENT! Nu încercați să schimbați bateriile, acestea nu pot fi reparate de
către utilizator. În schimb, contactați serviciul de asistență tehnică Bio-Rad.

Eliminare
Sistemul CFX Opus Dx conține materiale electrice; acestea nu trebuie eliminate ca deșeuri
nediferențiate și trebuie să fie colectate separat, în conformitate cu Directiva Uniunii Europene
2012/19/UE privind deșeurile de echipamente electrice și electronice — Directiva DEEE. Înainte de
eliminare, contactați reprezentantul local Bio-Rad pentru instrucțiuni specifice țării dvs.

Garanția
Sistemul CFX Opus Dx și accesoriile sale asociate sunt acoperite de o garanție Bio-Rad standard.
Pentru detalii privind garanția, contactați biroul local Bio-Rad.
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Capitolul 1 Introducere
Sistemele de amplificare PCR de înaltă performanță ale Bio-Rad sunt caracterizate de cele mai noi
progrese tehnologice, oferind o mai mare precizie și reproductibilitate în amplificarea acidului nucleic
pentru experimentele genomice.

Software-ul CFX Maestro Dx SE al Bio-Rad este compatibil cu următoarele instrumente și este
caracterizat de fișiere pentru rularea optimizată pentru primerul PrimePCR al Bio-Rad și testele pentru
probe.

n CFX Sistem PCR în timp real Opus 96 Dx (cunoscut în acest ghid ca CFX Opus 96 Dx)

n CFX Sistem PCR în timp real Opus 384 Dx (cunoscut în acest ghid ca CFX Opus 384 Dx)

Utilizând Software-ul CFX Maestro Dx SE (cunoscut în acest ghid sub denumirea de CFX Maestro Dx
SE), puteți interpreta date complexe și crea studii eficiente pentru analiza genetică. Prin doar câteva
clicuri, puteți configura studii și înțelege studiul expresiei genice cu ajutorul unor instrumente precum
testul t, ANOVA unidirecțională, analiza de control PrimePCR și instrumentul de selectare a genei de
referință. Apoi vă puteți pregăti rezultatele pentru publicări și postere, cu ajutorul instrumentelor
CFX Maestro Dx SE de vizualizare a datelor și de adnotare, care pot fi particularizate în extrem de
multe aspecte.
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Caracteristici principale pentru Software-ul CFX Maestro Dx
SE

Utilizând CFX Maestro Dx SE, puteți face următoarele:

n Analiza datele folosind sau corelograme pentru a interpreta și înțelege rapid rezultatele
dumneavoastră.

n Personaliza reprezentările datelor și exporta grafice de înaltă rezoluție, pentru publicare și
generare de rapoarte.

n Determina calitatea ARN-ului și depana experimente cu controale de analiză PrimePCR.

n Selecta gena de referință adecvată și analiza stabilitatea acesteia, cu ajutorul instrumentului de
selectare a genei de referință.

n Efectua analize statistice, inclusiv ANOVA unidirecțională, în analiza expresiei genice.

Acest ghid de utilizare explică aceste funcții și cum pot fi folosite ele.

Aflați mai multe
După instalarea pentru Sistemul CFX Opus Dx și CFX Maestro Dx SE pe Bio-Rad, puteți accesa acest
ghid, precum și subiectele detaliate de ajutor ale CFX Maestro Dx SE din meniul Help (Ajutor) în orice
fereastră.

Sfat: Faceți clic pe logoul Bio-Rad din colțul din dreapta sus al oricărei ferestre CFX Maestro Dx
SE pentru a accesa site-ul web al Bio-Rad. Acest site include linkuri către note tehnice, manuale,
videoclipuri, informații despre produse și suport tehnic. De asemenea, acest site pune la
dispoziție numeroase resurse tehnice despre o mare varietate de metode și aplicații legate de
PCR, PCR în timp real și expresia genică.
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Capitolul 2 Instalarea pentru Software-ul
CFX Maestro Dx SE

Acest capitol explică modul de instalare pentru Software-ul CFX Maestro Dx SE. Pentru informații
privind configurarea instrumentelor PCR în timp real acceptate de Bio-Rad, consultați ghidul
corespunzător.

CFX Maestro Dx SE este necesar pentru a analiza datele PCR în timp real din sistemele PCR în timp
real CFX Opus 96 Dx și CFX Opus 384 Dx. De asemenea, puteți utiliza acest software pentru a
controla aceste sisteme în modul controlat prin software.

Sistemele PCR în timp real CFX Opus 96 Dx și CFX Opus 384 Dx sunt livrate cu un cablu USB în
punga de accesorii. Utilizați cablul USB pentru a conecta computerul care rulează CFX Maestro Dx
SE la Sistemul CFX Opus Dx .

Îndepărtați materialele de ambalare și depozitați-le pentru utilizarea viitoare. Dacă un element
lipsește sau este deteriorat, contactați reprezentantul Bio-Rad local.
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System Requirements
Tabelul 3 lists the minimum and recommended system requirements for the computer running the
CFX Maestro Dx SE.

System Minimum Recommended

Operating
system

Microsoft Windows 10 (64-bit
only) with the latest security
updates

Microsoft Windows 10 (64-bit only) with the
latest security updates

Important: Secure Boot must be disabled on computers running CFX Maestro Dx SE. Computers
running CFX Maestro Dx SE should be configured such that they do not automatically restart after a
system or security update if a run is in progress. See your system administrator for assistance.

Ports 2 USB 2.0 High-speed ports 2 USB 2.0 High-speed ports

Hard disk space 128 GB 128 GB

Processor speed 2.4 GHz, Dual Core 2.4 GHz, Quad Core

RAM 4 GB RAM 8 GB RAM

Screen
resolution

1024 x 768 with true-color mode 1280 x 1024 with true-color mode

PDF reader Adobe PDF Reader or Windows PDF Reader
from one of the supported Microsoft Office
Suites:

n 2016

n 2019

Localization Supported Microsoft Windows
64-bit OS in English, Chinese,
and Russian

Supported Microsoft Windows 64-bit OS in
English, Chinese, and Russian

Tabelul 3. Computer requirements for CFX Maestro Dx SE

Notă: If you plan to run CFX Automation Control software on the same computer as CFX Maestro
Dx SE, set the screen resolution to 1280 x 1024 with true-color mode.
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Instalarea pentru Software-ul CFX Maestro Dx SE
Important: Trebuie să deconectați orice instrumente conectate de la computerul CFX Maestro Dx
SE înainte de a instala software-ul sau de a efectua un upgrade al acestuia. Nu trebuie să opriți
instrumentul în timpul instalării software-ului. Asigurați-vă că ați salvat toate rulările și că nu este
în desfășurare niciun experiment.

Notă: Verificați dacă Secure Boot (Boot securizat) este dezactivat înainte de a începe procedura
de instalare. Asigurați-vă că computerul este configurat astfel încât să nu repornească automat
după o actualizare de sistem sau de securitate dacă aceasta este în desfășurare. Consultați
administratorul de sistem pentru asistență.

Pentru a instala software-ul CFX Maestro Dx SE

1. Dacă este necesar, deconectați orice instrumente conectate de la computer.

Localizați și deconectați cablul USB al instrumentului de la computerul CFX Maestro Dx SE.
Capătul introdus în Sistemul CFX Opus Dx poate rămâne în poziție.

2. Autentificați-vă pe computerul CFX Maestro Dx SE cu drepturi de administrator.

3. Introduceți unitatea USB cu software-ul CFX Maestro Dx SE în portul USB al computerului.

4. În Windows Explorer, navigați la și deschideți unitatea USB cu software-ul CFX Maestro Dx SE.

Unitatea USB conține Release Notes (Note privind versiunea) și următoarele foldere:

n CFX

n Drivers (Drivere)

n Firmware

n Quick Start (Pornire rapidă)

Împreună cu alte fișiere, folderul CFX conține fișierul de instalare a software-ului
CFX Maestro Dx SE (CFXMaestroDxSetup.exe) .

5. Deschideți folder-ul CFX și faceți dublu clic pe CFXMaestroDxSetup.exe pentru a porni programul
de instalare.

6. Urmați instrucțiunile de instalare de pe ecran.

La finalizare, ecranul de pornire pentru Software-ul CFX Maestro Dx SE Bio-Rad apare pe
ecranul computerului, iar pictograma cu Software-ul CFX Maestro Dx SE Bio-Rad apare pe
desktop.

7. După ce se finalizează instalarea, puteți scoate în siguranță unitatea USB cu software-ul.
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Detecting Connected Instruments
During installation, the CFX Maestro Dx SE installer automatically installs the instrument drivers onto
the CFX Maestro Dx SE computer. CFX Maestro Dx SE detects connected instruments when you start
the software.

To detect connected instruments

1. If you have not yet done so, insert the square (male) end of the supplied USB Type B cable into
the USB Type B port located on the back of the instrument’s base.

2. Insert the other (port) end into a USB port on the CFX Maestro Dx SE computer.

3. If the instrument is not already running, press the power switch on the instrument to turn it on.

4. Start CFX Maestro Dx SE.

The software automatically detects the connected instrument and displays its name in the Detected
Instruments pane on the Home window.

Notă: If the instrument does not appear in the Detected Instruments pane, verify that the USB
cable is properly installed. To reinstall drivers, on the Home window in CFX Maestro Dx SE select
Tools > Reinstall Instrument Drivers.
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Fișierele software-ului
Tabelul 4 listează tipurile de fișiere pentru CFX Maestro Dx SE.

Tipul de fișier Extensie Detalii

Protocol .prcl Conține detaliile configurării protocolului pentru efectuarea
unei rulări PCR.

Placă .pltd Conține detaliile configurării plăcii pentru efectuarea unei
rulări PCR.

Data (Date) .pcrd Conține rezultatele unei rulări de experiment și unei analize
PCR.

Rulare PrimePCR .csv Conține structura protocolului și plăcii pentru plăcile
PrimePCR.

Studiu genic .mgxd Conține rezultatele mai multor rulări PCR și analizele
expresiei genice.

Fișier pre-date de sine
stătător

.zpcr Conține citiri ale fluorescenței din operarea de sine
stătătoare, care sunt convertite într-un fișier de date.

LIMS .plrn Conține informații de configurare a plăcii și informații
despre protocol necesare pentru efectuarea unei rulări
compatibile LIMS.

JSON .json Fișier disponibil doar în modul citire generat numai de
sistemele CFX Opus Dx, acest fișier conține datele despre
fișierul de rulare care apar în panoul de detalii din File
Browser (Browser fișiere) atunci când este selectat un
fișier de rulare. Acest fișier este generat după finalizarea
unei rulări. Acesta este exportat împreună cu fișierul .zpcr
și salvat împreună cu fișierele de date când Save Location
(Locație salvare) este fie o unitate USB, fie un folder de
rețea partajată.

Tabelul 4. Tipurile de fișiere pentru CFX Maestro Dx SE
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Capitolul 3 Gestionarea conturilor de utilizator
pentru Software-ul CFX Maestro Dx SE

În Software-ul CFX Maestro Dx SE, utilizatorii se autentifică cu numele de utilizator și parola Windows.
Persoanei care a instalat CFX Maestro Dx SE i se atribuie automat rolul de Administrator și poate crea
și gestiona conturi și roluri de utilizator. Tuturor celorlalți utilizatori trebuie să i se atribuie un cont de
utilizator pentru a se autentifica și a utiliza software-ul.

Important: Fiecare utilizator trebuie să aibă un cont Windows și o parolă pe computerul
CFX Maestro Dx SE înainte de a i se putea atribui un cont de utilizator și un rol. Utilizatorii pot fi
membri ai grupului Windows Users sau al grupului Windows Administrators. Membrii grupului
Windows Users pot accesa doar propriile lor fișiere și foldere CFX Maestro Dx SE. Membrii
grupului Windows Administrators pot accesa fișierele și folderele tuturor utilizatorilor de pe
computer.

Această capitolului explică modul de creare a utilizatorilor Microsoft Windows pentru a adăuga acei
utilizatori la CFX Maestro Dx SE. Această secțiune explică, de asemenea, cum să adăugați utilizatorii
CFX Maestro Dx SE și modul de gestionare a rolurilor și permisiunilor utilizatorilor.
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Pornirea pentru Software-ul CFX Maestro Dx SE
Notă: Fiecare utilizator trebuie să se conecteze cu numele de utilizator și parola Windows.

Pentru a porni CFX Maestro Dx SE

1. Pe computerul CFX Maestro Dx SE, faceți dublu clic pe pictograma de comandă rapidă
CFX Maestro Dx SE pentru a porni aplicația.

2. În caseta de dialog Login (Autentificare), tastați parola Windows și faceți clic pe OK.

CFX Maestro Dx SE se deschide la fereastra Acasă. Bara de titlu afișează numele de utilizator
Windows al utilizatorului conectat, iar bara de meniu afișează o etichetă albastră care indică
faptul că software-ul este compatibil cu 21 CFR Partea 11, de exemplu:
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Adăugarea utilizatorilor Microsoft Windows la calculatorul
pentru Software-ul CFX Maestro Dx SE

Toți utilizatorii trebuie să se conecteze la calculatorul CFX Maestro Dx SE cu numele de utilizator și
parola de autentificare în Windows. Pentru urmărirea corectă a auditului, conturile de utilizator
Windows nu pot fi adăugate prin intermediul casetei de dialog Start> Settings (Setări)> Accounts
(Conturi). Conturile de utilizator Windows trebuie adăugate prin intermediul consolei Computer
Management.

Important: Modificări aduse proprietăților utilizatorului Windows (inclusiv numele de utilizator și
numele complet) după ce ați creat utilizatorul asociat CFX Maestro Dx SE invalidează utilizatorul
CFX Maestro Dx SE. Asigurați-vă că informațiile sunt corecte înainte de a salva utilizatorul
Windows și de a crea utilizatorul asociat CFX Maestro Dx SE.

Sfat: Înainte de a crea conturi Windows, consultați documentația de administrare Microsoft
Windows și consultați administratorul de sistem Windows pentru mai multe informații.

Pentru a adăuga conturi de utilizator Windows la calculatorul pentru CFX Maestro Dx SE

1. Autentificați-vă pe calculatorul pentru CFX Maestro Dx SE ca membru al grupului Administrator
Windows.

2. Pe desktop, faceți clic dreapta pe My Computer și selectați Manage (Gestionare) pentru a
deschide consola Computer Management.
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3. În consola Computer Management, deschideți pagina Local Users and Groups (Utilizatori și
grupuri locale).

4. Faceți clic dreapta pe folderul Users (Utilizatori) și selectați New User (Utilizator nou) pentru a
deschide caseta de dialog New User (Utilizator nou).

5. În caseta de dialog New User (Utilizator nou), trebuie să completați următoarele câmpuri:

n User name (Nume de utilizator)

n Full name (Numele complet)

n Password (Parola)

n Confirm password (Confirmă parola)

6. Faceți clic pe Create (Creare).
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Adăugarea și ștergerea utilizatorilor din Software-ulCFX Maestro DxSE

Adăugarea și ștergerea utilizatorilor din Software-ul
CFX Maestro Dx SE

Sfat: Doar utilizatorii cu CFX Maestro Dx SE rolul de Administrator pot crea și elimina
CFX Maestro Dx SE conturi de utilizator. Persoana care a instalat CFX Maestro Dx SE primește
automat rolul de Administrator. Această persoană poate atribui rolul de Administrator altor
utilizatori.

Notă: În CFX Maestro Dx SE, cel puțin unui utilizator trebuie să i se atribuie rolul de Administrator.

Pentru a adăuga conturi de utilizator CFX Maestro Dx SE

1. Verificați dacă fiecare utilizator dorit este membru fie al grupului de utilizatori Windows, fie al
grupului Administratori Windows și are o parolă Windows pe calculatorul CFX Maestro Dx SE.

2. Porniți CFX Maestro Dx SE și autentificați-vă ca Administrator.

3. Din fereastra Home (Pagină de pornire), selectați User > User Administration (Utilizator >
Administrare utilizatori).

Va apărea caseta de dialog User Administration (Administrare utilizatori).
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4. În secțiunea Manage Users (Gestionare utilizatori), furnizați următoarele informații pentru fiecare
utilizator:

n User name (Nume utilizator) - în CFX Maestro Dx SE, acesta trebuie să fie numele de
utilizator de autentificare pentru Windows.

n Full name (Nume complet) - numele complet al utilizatorului.

Acest nume apare în câmpul Utilizator complet din traseul de audit. Acest nume trebuie să fie
același nume introdus în câmpul Full Name) Nume complet în momentul creării utilizatorului
Windows.

n Role (Rol) - rolul de atribuit utilizatorului.

Notă: Puteți selecta un singur rol din lista verticală. Pentru mai multe informații,
consultați Gestionarea rolurilor utilizatorilor pentru Software-ul CFX Maestro Dx SE.

n Domain (Domeniu) - domeniul Windows din care utilizatorul accesează software-ul.

Consultați administratorul de sistem Windows pentru mai multe informații.

5. Faceți clic pe OK, apoi pe Yes (Da) pentru a salva modificările și a închide caseta de dialog User
Administration (Administrare utilizator).

Pentru a elimina un cont de utilizator CFX Maestro Dx SE

1. Porniți CFX Maestro Dx SE și autentificați-vă ca Administrator.

2. În fereastra Home (Pagină de pornire), selectați User > User Administration (Utilizator>
Administrare utilizator) pentru a deschide caseta de dialog User Administration (Administrare
utilizator).

3. În panoul Manage Users (Gestionare utilizatori), selectați Remove (Ștergere) pentru fiecare
utilizator pe care doriți să-l ștergeți.

4. Faceți clic pe OK, apoi pe Yes (Da) pentru a salva modificările și a închide caseta de dialog User
Administration (Administrare utilizator).

Gestionarea rolurilor utilizatorilor pentru Software-ul
CFX Maestro Dx SE

Important: CFX Maestro Dx SE necesită ca cel puțin unui utilizator să i se atribuie rolul de
Administrator. Puteți atribui acest rol mai multor utilizatori.

CFX Maestro Dx SE are patru roluri de utilizator. Fiecărui utilizator trebuie să i se atribuie un rol pentru
a accesa software-ul. Deși utilizatorilor li se poate atribui un singur rol, puteți schimba oricând rolul
unui utilizator.
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Cu excepția rolului de Administrator, puteți modifica permisiunile atribuite fiecărui rol. Toți utilizatorii
cărora li s-a atribuit un rol moștenesc doar permisiunile acelui rol.

În mod implicit, permisiunile pentru fiecare rol sunt următoarele:

n Administrator — acest rol are toate permisiunile; nu puteți modifica aceste permisiuni.

n Principal — acest rol are toate permisiunile, cu excepția configurării e-mailului.

n Operator — acest rol are toate permisiunile, cu excepția omiterii ciclurilor și configurarea e-
mailului.

n Invitat - acest rol poate doar să citească fișiere.

Când atribuiți roluri în CFX Maestro Dx SE, determinați cu atenție cerințele pentru fiecare utilizator. De
exemplu, fără permisiunea de a salva, utilizatorii atribuiți rolul de Invitat nu vor putea semna un fișier.
Fără permisiunea de a configura un cont de e-mail, niciunul dintre roluri nu va primi un e-mail la
finalizarea unei rulări.

Pentru a modifica permisiunile pentru un rol

1. Porniți CFX Maestro Dx SE și autentificați-vă ca Administrator.

2. În fereastra Home (Pagină de pornire), selectați User > User Administration (Utilizator>
Administrare utilizator) pentru a deschide caseta de dialog User Administration (Administrare
utilizator).

3. În secțiunea Manage Rights (Gestionare drepturi), pentru fiecare rol debifați sau bifați caseta de
selectare a permisiunilor specifice, după caz.

4. Faceți clic pe OK, apoi pe Yes (Da) pentru a salva modificările și a închide caseta de dialog User
Administration (Administrare utilizator).

Vizualizarea rolului și permisiunilor dumneavoastră
Sfat: Utilizatorilor cărora li s-au atribuit roluri de utilizator Principal, Operator sau Guest (Invitat) își
pot vizualiza doar setările, permisiunile și rolurile lor de utilizator. Utilizatorii cărora li se atribuie
rolul de Administrator pot vizualiza toate permisiunile și rolurile utilizatorilor.

Pentru a vă vizualiza rolul de utilizator și permisiunile curente

u Din fereastra Home (Pagină de pornire), selectați User > User Administration (Utilizator >
Administrare utilizatori).

Contactați-vă administratorul CFX Maestro Dx SE pentru a modifica setările, drepturile și rolurile de
utilizator listate în fereastra User Administration (Administrare utilizatori).
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Capitolul 4 Utilizarea pentru Software-ul
CFX Maestro Dx SE

Important: Software-ul CFX Maestro Dx SE folosește autentificarea utilizatorului Microsoft
Windows pentru a verifica accesul la fișierele de date CFX securizate. Contactați administratorul
Windows pentru a crea un mediu care respectă cerințele 21 CFR Partea 11.

Folosind CFX Maestro Dx SE, utilizatorii pot

n Semna fișiere de date și studii genice.

n Proteja prin parolă fișierele de date

n Vizualiza și imprima trasee de audit.

Această secțiune explică în detaliu aceste funcții.

Fișiere securizate
În mod implicit, CFX Maestro Dx SE salvează fișierele securizate în folderul personal al utilizatorului
conectat, care se află la adresa

C:\Users\[username]\Documents\Bio-Rad\CFX_MDX\My qPCR

CFX Maestro Dx SE configurează acest folder doar pentru citire. Cu toate acestea, puteți partaja acest
folder și conținutul acestuia cu alte persoane din echipa dumneavoastră.

Sfat: Alternativ, administratorul de sistem Windows poate crea un folder partajat iar
administratorul CFX Maestro Dx SE poate programa software-ul pentru a salva toate fișierele în
acel folder.

În CFX Maestro Dx SE fișierele pentru placă, protocol, date și studiu genice sunt marcate ca fiind
sigure atunci când sunt salvate. Puteți crea aceste fișiere în software-ul CFX Maestro sau în
CFX Maestro Dx SE. După salvarea lor în CFX Maestro Dx SE, puteți deschide aceste fișiere numai în
CFX Maestro Dx SE.

CFX Maestro Dx SE creează un traseu de audit pentru toate fișierele securizate de date și studii
genice (fișierele .pcrd și respectiv .mgxd). Software-ul înregistrează toată activitatea verificabilă în
traseul de audit al fișierului. Pentru mai multe informații, consultați Trasee de audit de la pagina 299.
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Semnarea fișierelor securizate

După salvarea unui fișier în CFX Maestro Dx SE, utilizatorii pot adăuga o semnătură electronică.
Pentru a semna un fișier, rolul utilizatorului trebuie să aibă permisiunea de a salva un fișier. De
exemplu, în mod implicit rolul Guest (Invitat) nu are permisiunea de a salva un fișier și, prin urmare,
utilizatorii care au atribuit acest rol nu pot semna un fișier.

În CFX Maestro Dx SE, fișierele semnate nu sunt setate doar pentru citire. Ele pot fi revizuite,
modificate și semnate de mai multe ori. Toate modificările și semnăturile sunt înregistrate în traseul de
audit al fișierului. Puteți semna următoarele tipuri de fișiere:

n Fișiere de date (.pcrd)

n Fișiere de studiu genic (.mgxd)

Notă: Fișierele trebuie salvate înainte de a putea fi semnate. Dacă ați efectuat recent o rulare în
CFX Maestro Dx SE, salvați mai întâi fișierul de date rezultat.

Pentru a semna un fișier

1. Autentificați-vă la CFX Maestro Dx SE cu datele de conectare Windows.

2. Deschideți fișierul securizat de date sau fișierul de studiu genic pentru a semna.

3. Selectați File (Fișier)> Sign (Semnare). Apare caseta de dialog Electronic Signature (Semnătură
electronică).
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4. Introduceți numele dumneavoastră de utilizator și parola Windows și motivul semnării fișierului.

Numele de utilizator și motivul semnării sunt înregistrate în traseul de audit (pentru mai multe
informații, consultați Trasee de audit de la pagina 299 ).

5. Faceți clic pe OK pentru a transmite semnătura și a închide caseta de dialog.

Modificarea fișierelor securizate

În CFX Maestro Dx SE, utilizatorii pot modifica fișierele securizate, inclusiv fișierele de date semnate și
nesemnate și studiile genice. Software-ul vă solicită să furnizați un motiv pentru modificare atunci
când salvați un fișier de date securizate sau un fișier de studiu genic modificat. Modificările sunt
urmărite în traseul de audit al fișierului.

Sfat: Deoarece software-ul nu creează trasee de audit pentru fișierele pentru plăci sau protocol,
nu vi se solicită să furnizați un motiv atunci când salvați modificările acestor fișiere.

Pentru a salva un fișier de date sau studiu genic modificat

1. Autentificați-vă la CFX Maestro Dx SE cu datele de conectare Windows.

2. Deschideți și modificați un fișier de date securizat sau un fișier de studiu genic.
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Sfat: Pentru o listă de activități verificabile, consultați Evenimente verificabile de la pagina
301.

3. Selectați File (Fișier)> Save (Salvare). Pe ecran este afișată caseta de dialog Audit Trail Change
Motive (Motiv pentru modificarea traseului auditului).

Această casetă de dialog afișează următoarele informații, care sunt memorate în antetul traseului
auditului fișierului pentru fiecare eveniment de modificare:

n Date (Data) - data la care s-a produs modificarea.

n User (Utilizator) - domeniul Windows și numele de utilizator al utilizatorului conectat.

n Comment (Comentariu) - ultimul comentariu salvat.

n Signature (Semnătură) - semnătura electronică a ultimei persoane care a semnat fișierul.

n Signature reason (Motivul semnăturii) - motivul semnăturii.

n Application (Aplicație) -CFX Maestro Dx SE (apare ca BioRadCFXManager.exe, ceea ce
este corect).

n Application version (Versiunea aplicației) - versiunea curentă a CFX Maestro Dx SE.

n Full user (Utilizator complet) - numele complet al utilizatorului conectat.
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Notă: Acest nume apare în traseul auditului.

n Machine (Mașină) - computerul pe care este instalat.

Tabelul de modificări afișează modificările care pot fi verificate ca urmare a modificării. S-ar putea
să apară și o scurtă descriere a motivului modificării.

Sfat: Puteți adăuga sau edita descrieri în coloana Reason for Change (Motivul modificării).

4. Examinați lista modificărilor. Furnizați motive detaliate, dacă este necesar.

5. Urmați una dintre procedurile următoare:

n Faceți clic pe Save Changes (Salvați modificările) pentru a salva modificările la fișier, precum
și orice modificări pe care le-ați făcut în tabel și pentru a închide caseta de dialog.

Modificările aduse fișierului și motivele modificărilor apar în traseul auditului fișierului.

n Faceți clic pe Cancel Changes (Anulare modificări) pentru a readuce fișierul la starea sa
anterioară și a închide caseta de dialog.

Modificările nu sunt salvate în fișier și traseul auditului nu este actualizat.
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Protejarea prin parolă a fișierelor

Ca un nivel suplimentar de securitate, CFX Maestro Dx SE permite utilizatorilor să configureze parole
pentru toate fișierele securizate. Când configurați o parolă pentru un fișier securizat, luați în
considerare următoarele condiții:

Condiție Acțiune

Nu este necesară nicio parolă. Toți utilizatorii pot deschide, modifica și salva fișierul
securizat.

Fișierul necesită parolă de
salvare.

Toți utilizatorii pot deschide fișierul securizat, iar
utilizatorii care cunosc parola de salvare pot modifica și
salva fișierul securizat.

Fișierul necesită parola de
deschidere.

Numai utilizatorii care cunosc parola de deschidere pot
deschide, modifica și salva fișierul securizat.

Fișierul necesită atât parolele de
deschidere, cât și de salvare.

Unii utilizatori pot deschide fișierul securizat, iar un
subgrup din acei utilizatori poate modifica și salva
fișierul.

În funcție de rolul utilizatorului, orice utilizator poate efectua acțiunea Save as (Salvare ca) pentru a
crea un nou fișier securizat cu alt nume sau să salveze un fișier cu același nume într-o altă locație,
atâta timp cât una dintre următoarele este adevărată:

n Fișierul securizat nu este protejat prin parolă.

n Utilizatorul are parola pentru a deschide fișierul.

Sfat: Noul fișier este salvat fără protecție prin parolă. Fișierul original își păstrează parolele.

În funcție de rol, un utilizator poate modifica și salva fișierul original, atâta timp cât una dintre
următoarele este adevărată:

n Fișierul nu este protejat prin parolă.

n Utilizatorul are parola pentru a deschide și parola pentru a salva fișierul.

Notă: Rolul utilizatorului trebuie să includă dreptul de a salva fișiere pentru a configura parole.
De exemplu, utilizatorii cu rolul Guest (Invitat) nu pot salva fișiere și, prin urmare, nu pot configura
parole pentru un fișier.

Important: Numai Administratorii CFX Maestro Dx SE pot reseta sau elimina parolele.
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Pentru a proteja un fișier cu parolă

1. Autentificați-vă la CFX Maestro Dx SE cu datele de conectare Windows.

2. Deschideți fișierul securizat.

3. Selectați File (Fișier)> File passwords (Parole fișier). Pe ecran este afișată caseta de dialog File
passwords (Parole fișier).

4. Introduceți parolele în casetele Save Password (Parolă salvare) și Open Password (Parolă
deschidere).

Sfat: În mod implicit, în timpul introducerii parolelor, acestea apar scrise cu caractere
asterisc. Selectați Show Password (Afișare parolă) pentru a afișa parola pe măsură ce o
introduceți.

Important: Parolele sunt sensibile la litere mari și mici. CFX Maestro Dx SE nu prevede
limitări pentru parole. Pentru cele mai bune practici, consultați administratorul de sistem
pentru cerințele de parolă din unitatea dumneavoastră.

5. Faceți clic pe Set Passwords (Setare parole) pentru a seta parolele și pentru a închide caseta de
dialog.

6. Alegeți File (Fișier)> Save (Salvare) pentru a salva modificările la fișier.
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Pentru a elimina parolele

Important: Pentru a elimina parolele, trebuie să fiți administrator CFX Maestro Dx SE.

1. În caseta de dialog Password Required (Parolă necesară), faceți clic pe Remove Passwords
(Eliminare parole).

Apare caseta de dialog Login (Autentificare) CFX Maestro Dx SE.

2. Furnizați numele de utilizator și parola Windows pentru administratorul CFX Maestro Dx SE și
faceți clic pe OK.

Apare fișierul de date original.

Important: Trebuie să salvați fișierul pentru a elimina parolele.

3. Alegeți File (Fișier)> Save (Salvare) pentru a salva modificările la fișier.

Pentru a schimba parolele

Important: Numai administratorii CFX Maestro Dx SE pot schimba parolele.
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1. Deschideți fișierul securizat.

2. Selectați File (Fișier)> File passwords (Parole fișier). Pe ecran este afișată caseta de dialog File
passwords (Parole fișier).

Sfat: Save Password (Parolă salvare), Open Password (Parolă deschidere) și Show
Password (Parolă afișare) sunt dezactivate.

3. Faceți clic pe Reset Passwords (Resetare parole).

Apare caseta de dialog Login (Autentificare) CFX Maestro Dx SE.
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4. Furnizați numele de utilizator și parola Windows pentru administratorul CFX Maestro Dx SE și
faceți clic pe OK.

Pe ecran este afișată caseta de dialog File passwords (Parole fișier).

5. Urmați una dintre procedurile următoare:

n Pentru a reseta protejarea prin parolă, tastați o parolă nouă în caseta de parolă
corespunzătoare.

n Pentru a elimina protejarea prin parolă, debifați casetele pentru parole.

6. Faceți clic pe Set Passwords (Setare parole) pentru a salva modificările parolei și a ieși din
caseta de dialog.
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Capitolul 5 Spațiul de lucru
Software-ul CFX Maestro Dx SE oferă o interfață pentru configurația plăcilor, dezvoltarea
protocoalelor PCR, rularea acestora în instrumentele CFX Opus Dx și analizarea datelor din rulările
PCR.

CFX Maestro Dx SE prezintă cinci spații de lucru principale:

n Fereastra Home (Pagină de pornire)

n Startup Wizard (Expert pornire)

n Fereastra Protocol Editor (Editor Protocol)

n Fereastra Plate Editor (Editor placă)

n Fereastra Data Analysis (Analiză date)

Fiecare spațiu de lucru este prezentat și descris pe scurt în acest capitol.
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Fereastra Home (Pagină de pornire)
CFX Maestro Dx SE deschide fereastra Home (Pagină de pornire) și afișează Startup Wizard (Expert
pornire), din care puteți configura un experiment, realiza sau repeta o rulare sau analiza o rulare
existentă. Din fereastra Home (Pagină de pornire) puteți, de asemenea, vizualiza jurnalele aplicației
și instrumentului, crea și gestiona utilizatori și accesa multiple instrumente utile. Pentru mai multe
informații, consultați Capitolul 6, Fereastra Home (Pagină de pornire).
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StartupWizard (Expert pornire)

Startup Wizard (Expert pornire)
Folosiți Startup Wizard (Expert pornire) pentru a configura și rula rapid experimente definite de
utilizator sau pentru a selecta și rula rapid un experiment PrimePCR. Puteți folosi acest expert și
pentru a repeta o rulare sau analiza datele rulării.
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Fereastra Protocol Editor (Editor Protocol)
În Protocol Editor (Editor Protocol) puteți crea, deschide, revizui și edita un protocol. De asemenea,
puteți modifica temperatura capacului pentru protocolul deschis. Funcționalitatea Editorului de
protocol este detaliată în Capitolul 7, Crearea de protocoale.
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Fereastra Plate Editor (Editor placă)

Fereastra Plate Editor (Editor placă)
În Plate Editor (Editor placă) puteți crea, deschide, revizui și edita o placă. Funcționalitatea Editorului
de plăci este detaliată în Capitolul 8, Pregătirea plăcilor.
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Fereastra Data Analysis (Analiză date)
În fereastra Data Analysis (Analiză date) puteți vizualiza și compara date de rulare, efectua analize
statistice, exporta date și crea rapoarte pregătite pentru publicare. Funcționalitatea Data Analysis
(Analiză date) este detaliată în Capitolul 10, Prezentare generală a ferestrei Data Analysis (Analiză
date) și în Capitolul 11, Detalii despre fereastra Data Analysis (Analiză date).
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Capitolul 6 Fereastra Home (Pagină de pornire)
Software-ul CFX Maestro Dx SE oferă o interfață pentru dezvoltarea protocoalelor PCR, rularea
acestora pe sistemelor CFX Dx și analizarea datelor de rulare PCR.

Acest capitol prezintă CFX Maestro Dx SE și explică funcțiile accesibile din fereastra Home (Pagină
de pornire).
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Fereastra Home (Pagină de pornire)
CFX Maestro Dx SE deschide fereastra Home (Pagină de pornire) și afișează Startup Wizard (Expert
pornire), din care puteți configura o rulare, efectua sau repeta o rulare sau analiza o rulare existentă.
Din fereastra Home (Pagină de pornire) puteți, de asemenea, vizualiza jurnalele aplicației și
instrumentului, crea și gestiona utilizatori și accesa multiple instrumente utile.

1. Bara de titlu a software-ului afișează numele software-ului și utilizatorul conectat.

2. Bara de meniu oferă acces rapid la comenzile meniurilor File (Fișier), View (Vizualizare), Users
(Utilizatori), Run (Rulare), Tools (Instrumente), Window (Fereastră) și Help (Ajutor).

3. Comenzile barei de instrumente oferă acces rapid la opțiunile meniului.

4. Panoul din stânga afișează instrumentele conectate la computerul CFX Maestro Dx SE și
furnizează butoanele prin care puteți opera capacul și vizualiza starea instrumentelor.

5. Panoul principal afișează fereastra de lucru. Fereastra de lucru implicită de pe ecranul Home
(Pagină de pornire) este Startup Wizard (Expert pornire).

LEGENDĂ
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6. Bara de stare afișează numele instrumentelor conectate și utilizatorul conectat.

Comenzile meniului File (Fișier)
New (Nou) – deschide o casetă de dialog pe care o puteți folosi pentru a crea un protocol nou, o placă
nouă sau un studiu genic nou.

Open (Deschidere) – deschide o casetă de dialog din care puteți alege să navigați la și să deschideți
un protocol, o placă, un fișier de date, un studiu genic, un fișier LIMS existente, să rulați dintr-un
instrument de sine stătător (rulare de sine stătătoare) sau un fișier de rulare PrimePCR.

Recent Data Files (Fișiere de date recente) – afișează o listă a fișierelor PCR deschise recent.

Repeat a Run (Repetare rulare) – deschide Windows Explorer în locul în care sunt salvate fișierele
PCR, unde puteți localiza o rulare de repetat.

Exit (Ieșire) – închide CFX Maestro Dx SE.

Comenzile meniului View (Vizualizare)
Application Log (Jurnalul aplicației) – afișează un jurnal de utilizare a software-ului de la instalarea
inițială și până în ziua actuală.

Run Reports (Rapoarte rulare) – afișează o listă de rapoarte de rulare.

StartupWizard (Expert pornire) – afișează Startup Wizard (Expert pornire) în panoul principal.

Run Setup (Configurare rulare) – afișează fereastra Run Setup (Configurare rulare) în panoul
principal.

Instrument Summary (Rezumat instrument) – afișează fereastra Instrument Summary (Rezumat
instrument) în panoul principal.

Detected Instruments (Instrumente detectate) – comută între afișarea și neafișarea instrumentelor
conectate în panoul stâng. Implicit, software-ul afișează instrumentele conectate în panoul din stânga.

Toolbar (Bară de instrumente) – comută între afișarea și neafișarea barei de instrumente în partea
de sus a ecranului. Implicit, software-ul afișează bara de instrumente.

Status Bar (Bară de stare) – comută între afișarea și neafișarea barei de stare în partea de jos a
ecranului. Implicit, software-ul afișează bara de stare.

Show (Afișare) – deschide o casetă de dialog din care puteți

n Vizualiza sau bloca jurnalul Status (Stare).

n Deschide și vizualiza folderul de date CFX Maestro Dx SE.
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n Deschide și vizualiza folderul de date al utilizatorului.

n Deschide și vizualiza folderul de fișiere LIMS.

n Deschide și vizualiza folderul PrimePCR.

n Vizualiza istoricul rulărilor.

n Vizualiza proprietățile tuturor instrumentelor conectate.

Comenzile meniului User (Utilizator)
Select User (Selectare utilizator) – deschide ecranul Login (Autentificare) în care puteți selecta un
utilizator din lista verticală User Name (Nume utilizator) și vă puteți autentifica în aplicație.

Change Password (Schimbare parolă) – deschide caseta de dialog Change Password (Schimbare
parolă), în care utilizatorii își pot schimba parola pentru .

Notă: Această opțiune este dezactivată pentru CFX Maestro Dx SE . Utilizatorii trebuie să-și
schimbe parola Windows pentru a le schimba parola CFX Maestro Dx SE.

User Preferences (Preferințe utilizator) – deschide caseta de dialog User Preferences (Preferințe
utilizator), în care utilizatorii pot schimba setările implicite pentru

n Trimiterea și primirea notificării prin e-mail la finalizarea rulării

n Salvarea fișierelor de date

n Crearea de protocoale prin Protocol Editor (Editor protocol) sau Protocol AutoWriter (Utilitar
de scriere automată protocol)

n Crearea de plăci

n Analizarea datelor

n Realizarea analizei expresiei genice

n Determinarea calității datelor

n Exportarea datelor instrumentului CFX

User Administration (Administrare utilizatori) – deschide caseta de dialog User Administration
(Administrare utilizatori), în care administratorii pot crea utilizatori, modifica permisiunile rolurilor și
atribui roluri utilizatorilor.

Bio-Rad Service Login (Autentificare serviciu) – pentru utilizarea exclusivă de către personalul de
asistență tehnică Bio-Rad. Nu selectați această comandă.
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Comenzile meniului Run (Rulare)
User-defined Run (Rulare definită de utilizator) – deschide fereastra Run Setup (Configurare rulare),
în care puteți configura un protocol și o placă definite de utilizator, apoi puteți rula un experiment PCR
pe instrumentele selectate.

PrimePCR Run (Rulare PrimePCR) – deschide fila Start Run (Începere rulare) în fereastra Run
Setup (Configurare rulare) cu protocolul PrimePCR și structura de placă implicite încărcate în funcție
de instrumentul selectat.

End-Point Only Run (Rulare numai punct final) – deschide fila Start Run (Începere rulare) în
fereastra Run Setup (Configurare rulare) cu protocolul de punct final și structura de placă implicite
încărcate în funcție de instrumentul selectat.

Qualification Run (Rulare de calificare) – deschide fila Start Run (Începere rulare) în fereastra Run
Setup (Configurare rulare) cu protocolul de calificare Bio-Rad și structura de placă implicite încărcate
pentru instrumentul selectat.

Comenzile meniului Tools (Instrumente)
Master Mix Calculator (Calculator Amestec principal) – deschide Master Mix Calculator (Calculator
Amestec principal), în care puteți crea un amestec de reacție și imprima calculele.

Protocol AutoWriter (Utilitar de scriere automată protocol) – deschide caseta de dialog Protocol
AutoWriter (Utilitar de scriere automată protocol), în care puteți crea cu ușurință un protocol nou.

Ta Calculator (Calculator Ta) – deschide calculatorul Ta, în care puteți calcula cu ușurință temperatura
de atașare a primerilor.

Dye Calibration Wizard (Expert calibrare coloranți) – deschide expertul Dye Calibration (Calibrare
coloranți), în care puteți calibra un instrument pentru un nou fluorofor.

Reinstall Instrument Drivers (Reinstalare drivere instrument) – reinstalează driverele care
controlează comunicarea cu sistemele PCR în timp real ale Bio-Rad.

Zip Data and Log Files (Fișiere ZIP jurnal și de date) – deschide o casetă de dialog în care puteți
selecta fișiere pentru a le condensa și salva într-un fișier ZIP comprimat pentru stocare sau trimitere
prin e-mail.

Batch Analysis (Analiza loturilor) – deschide caseta de dialog Batch Analysis (Analiza loturilor), în
care puteți seta parametrii pentru analizarea mai multor fișiere de date în același timp.

Options (Opțiuni) – deschide o casetă de dialog în care puteți

n Configura setările serverului dumneavoastră de e-mail

n Configura setările de exportare pentru fișierele LIMS, Seegene și alte fișiere de date.
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Sfat: De asemenea, puteți selecta opțiunea de a porni automat Seegene Viewer după
export dacă alegeți să exportați datele în format Seegene.

Comenzile meniului Help (Ajutor)
Sfat: Meniul Help (Ajutor) este disponibil în bara de meniu a tuturor ferestrelor CFX Maestro Dx
SE.

Contents (Cuprins)– afișează fila Contents (Cuprins) în secțiunea Help (Ajutor) a sistemului
CFX Maestro Dx SE.

Index - afișează fila Index secțiunea Help (Ajutor) a sistemului CFX Maestro Dx SE.

Search (Căutare) – afișează fila Search (Căutare) în secțiunea Help (Ajutor) a sistemului
CFX Maestro Dx SE.

Open User Guide (Deschide ghidul utilizatorului) - deschide o versiune PDF a acestui ghid.

Additional Documentation (Documentație suplimentară) - oferă acces la manualul de utilizare a
sistemelor PCR în timp real, CFX Opus Dx.

Release Notes (Note privind versiunea) – deschide documentul Release Notes (Note privind
versiunea) pentru versiunea instalată a CFX Maestro Dx SE.

Video Resources (Resurse Video) – deschide un site web care conține resurse video Bio-Rad
precum materiale video de instruire.

qPCR Applications and Technologies Web Site (Site-ul web al aplicațiilor și tehnologiilor qPCR) –
deschide site-ul web al aplicațiilor și tehnologiilor qPCR ale Bio-Rad, unde puteți afla mai multe
despre PCR (qPCR) în timp real.

PCR Reagents Web Site (Site-ul web al reactivilor PCR) – deschide site-ul web al Bio-Rad care
conține reactivii PCR și qPCR, de unde puteți comanda reactivi, amestecuri de reacție, coloranți și
kituri PCR.

PCR Plastic Consumables Web Site (Site web consumabile PCR din plastic) – deschide site-ul
web Bio-Rad cu articole din plastic și consumabile PCR, de unde puteți comanda plăci, folii de
sigilare placă, eprubete și capace și alte accesorii PCR din plastic.

Software Web Site (Site-ul web al software-ului) – deschide site-ul web al software-ului de analiză
PCR al Bio-Rad, de unde puteți comanda versiuni actualizate ale software-ului Bio-Rad CFX Maestro
Dx SE.

About (Despre) – afișează informații despre copyright și versiune pentru CFX Maestro Dx SE.
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Comenzi bară de instrumente

– deschide Windows Explorer, în care puteți naviga la și deschide un fișier de date sau un fișier
de studiu genic.

– deschide Master Mix Calculator (Calculator Amestec principal).

– deschide fereastra Run Setup (Configurare rulare).

– deschide fereastra Run Setup (Configurare rulare) cu protocolul PrimePCR și structura de
placă implicite încărcate în funcție de instrumentul selectat.

– deschide Startup Wizard (Expert pornire).
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Startup Wizard (Expert pornire)
Când se inițializează CFX Maestro Dx SE, panoul de lucru afișează Startup Wizard (Expert pornire).
Din Startup Wizard (Expert pornire) puteți

n Selecta un instrument dintre instrumentele detectate și configura o rulare definită de utilizator sau
PrimePCR.

n Deschide și repeta o rulare

n Deschide un fișier de date pentru a analiza rezultatele dintr-o singură rulare sau dintr-un fișier de
studiu genic pentru rezultate din mai multe rulări de expresie genică

Aceste activități sunt explicate în mod detaliat în capitolele care urmează.

Bara de stare
Partea stângă a barei de stare din partea de jos a ferestrei principale a software-ului afișează starea
actuală a instrumentelor detectate. Partea dreaptă a barei de stare afișează numele utilizatorului
actual și data și ora.
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Panoul Detected Instruments (Instrumente detectate)
Panoul Detected Instruments (Instrumente detectate) afișează fiecare instrument care este conectat la
computerul CFX Maestro Dx SE. Implicit, fiecare instrument apare sub formă de pictogramă, iar numărul
său de serie apare ca denumirea sa.

Pe instrumentele care necesită o actualizare de sistem va apărea o alertă roșie. Până când sistemul
nu este actualizat, nu puteți utiliza instrumentul. Pentru mai multe informații despre actualizările de
sistem, consultați Verificarea versiunii instalate în prezent de la pagina 72.

Sfat: Acest instrument necesită o actualizare. Până când sistemul nu este actualizat,
utilizatorii nu pot folosi acest instrument.

Din acest panou puteți

n Vizualiza proprietățile și coloranții calibrați pentru instrumentul selectat.

Pentru informații referitoare la proprietățile instrumentului, consultați Vizualizarea proprietăților
unui instrument de la pagina 70.

n Vizualiza starea unui instrument conectat

n Deschide capacul motorizat al instrumentului selectat

n Închide capacul motorizat al instrumentului selectat

n Vizualiza starea tuturor instrumentelor conectate

Pentru a vizualiza starea unui instrument conectat

u În panoul Detected Instruments (Instrumente detectate), selectați instrumentul țintă și faceți una
dintre următoarele:

n Faceți clic pe View Status (Vizualizare stare) în secțiunea Selected Instrument (Instrument
selectat).

n Faceți clic dreapta și selectați View Status (Vizualizare stare) în meniul care apare.

Va apărea caseta de dialog Run Details (Detalii rulare), care afișează fila Run Status (Stare
rulare). Starea instrumentului selectat apare sub panoul de stare a rulării, de exemplu:
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Pentru a deschide sau închide capacul unui instrument

u În panoul Detected Instruments (Instrumente detectate), selectați instrumentul țintă și faceți una
dintre următoarele:

n Faceți clic pe Open Lid (Deschidere capac) sau Close Lid (Închidere capac) în secțiunea
Selected Instrument (Instrument selectat).

n Faceți clic dreapta și selectați acțiunea corespunzătoare în meniul care apare.

n Deschideți caseta de dialog Run Details (Detalii rulare), selectați fila Run Status (Stare
rulare) și faceți clic pe Open Lid (Deschidere capac) sau Close Lid (Închidere capac).

Pentru a vizualiza starea tuturor instrumentelor detectate

u Urmați una dintre procedurile următoare:

n În secțiunea All Instruments (Toate instrumentele) din panoul Detected Instruments
(Instrumente detectate), faceți clic pe View Summary (Vizualizare rezumat).

n În bara de meniu, selectați View > Instrument Summary (Vizualizare > Rezumat instrument).

Va apărea caseta de dialog Instrument Summary (Rezumat instrument).

Sfat: Dacă sistemul detectează doar un singur instrument conectat, secțiunea All Instruments
(Toate instrumentele) nu apare în panoul Detected Instruments (Instrumente detectate).
Pentru a vizualiza rezumatul instrumentului pentru un singur instrument, selectați View >
Instrument Summary (Vizualizare > Rezumat instrument).
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Comenzile barei de instrumente Instrument Summary (Rezumat instrument)

Tabelul 5 prezintă comenzile și funcțiile de pe bara de instrumente Instrument Summary (Rezumat
instrument).

Buton Nume buton Funcție

Creați o nouă rulare Creează o rulare pe blocul selectat
deschizând fereastra Run Setup (Configurare
rulare).

Oprire Oprește rularea curentă pe blocurile
selectate.

Pauză Realizează o pauză în rularea curentă pe
blocurile selectate.

Reluare Reia rularea pe blocurile selectate.

Indicator lumină intermitentă
bloc

Face să lumineze intermitent indicatorul LED
de pe capacul blocurilor selectate.

Deschidere capac Deschide capacul motorizat al blocului
selectat.

Închidere capac Închide capacul motorizat al blocului
selectat.

Ascundere blocuri selectate Ascunde blocurile selectate din lista
Instrument Summary (Rezumat instrument)

Afișare toate blocurile Afișează blocurile selectate din lista
Instrument Summary (Rezumat instrument)

Show (Afișare) Selectați ce blocuri vor fi afișate în listă.
Selectați una dintre opțiuni pentru a afișa
toate blocurile detectate, toate blocurile
inactive, toate blocurile care rulează cu
utilizatorul curent sau toate blocurile care
rulează

Tabelul 5. Comenzile barei de instrumente Instrument Summary (Rezumat instrument)
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Vizualizarea proprietăților unui instrument
Din panoul Detected Instruments (Instrumente detectate) puteți vedea detalii despre un instrument
selectat, inclusiv proprietățile acestuia, starea șurubului de expediere aferent și o listă a coloranților
săi calibrați (fluorofori).

Pentru vizualizarea proprietăților instrumentului

u În panoul Detected Instruments (Instrumente detectate), faceți clic dreapta pe instrumentul țintă și
selectați Properties (Proprietăți) în meniul care apare.

Fila Properties (Proprietăți)

Fila Properties (Proprietăți) prezintă detaliile tehnice privind instrumentul selectat, inclusiv modelul,
seriile componentelor și versiunile de firmware. Denumirea implicită a instrumentului (seria acestuia)
apare în multe locuri, inclusiv în panoul Detected Instruments (Instrumente detectate) și pe bara de
antet a casetei de dialog Instrument Properties (Proprietăți instrument). Puteți redenumi instrumentul
pentru a-l identifica mai simplu.

Pentru a redenumi un instrument

u În fila Instrument Properties (Proprietăți instrument), introduceți un nume în caseta Rename
(Redenumire) în partea de sus a filei Properties (Proprietăți) și faceți clic pe Rename
(Redenumire).

Denumirea nouă apare pe rândul Nickname (Alias) în fila Properties (Proprietăți), precum și pe
bara de antet Instrument Properties (Proprietăți instrument) și în panoul Detected Instruments
(Instrumente detectate).

Fila Shipping Screw (Șurub de expediere)

Fila Shipping Screw (Șurub de expediere) afișează starea actuală a șurubului de expediere pentru
instrumentul selectat (Removed (Înlăturat) sau (Installed) (Instalat)). Fila include de asemenea
instrucțiuni pentru instalarea sau înlăturarea șurubului roșu de transport.

Sfat: Dacă software-ul detectează că șurubul de expediere este introdus în orice alt instrument
decât în sistemul CFX Opus Dx, caseta de dialog Instrument Properties (Proprietăți instrument)
afișează automat fila Shipping Screw (Șurub de expediere). Urmați instrucțiunile pentru a înlătura
șurubul.

(Doar pentru sistemele CFX Opus Dx ) Dacă software-ul detectează faptul că șurubul de transport
este introdus într-un sistem CFX Opus Dx, software-ul afișează un mesaj când este lansat pentru
prima dată, prin care vă avertizează că șurubul de transport este introdus și vă informează să urmați
instrucțiunile de pe ecranul tactil al sistemului.
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Notă: Trebuie să înlăturați șurubul de expediere înainte de a putea utiliza instrumentul. Pentru
mai multe informații, consultați manualul de utilizare a sistemului PCR în timp real CFX Opus Dx.

Fila Calibrated Dyes (Coloranți calibrați)

Fila Calibrated Dyes (Coloranți calibrați) afișează fluoroforii și plăcile calibrate pentru instrumentul
selectat.

Pentru a vedea informații detaliate despre o calibrare, faceți clic pe butonul Info (Informații) din
coloana Detail (Detalii).
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Înainte de a începe
Această secțiune explică sarcinile pe care poate fi necesar să le efectuați înainte de utilizarea pentru
CFX Maestro Dx SE. Aceasta include

n Actualizarea software-ului și a firmware-ului pentru Sistemul CFX Opus Dx

n Crearea unui amestec principal de reacție

n Calibrarea de noi coloranți

Actualizarea software-ului și a firmware-ului pe sistemele PCR în timp real CFX
Opus Dx

Important: Numai utilizatorul Administrator poate efectua upgrade-ul software-ului și al firmware-
ului de pe Sistemul CFX Opus Dx.

Când sunteți conectat la internet, CFX Maestro Dx SE vă avertizează cu privire la actualizările de
software și firmware disponibile pentru Sistemul CFX Opus Dx. Accesați actualizările de pe site-ul
web cu actualizări de actualizări de firmware și software al Bio-Rad. Programul de instalare pentru
Sistemul CFX Opus Dx poate include atât actualizări de software, cât și firmware. Actualizările de
firmware pentru Sistemul CFX Opus Dx nu sunt distribuite într-un pachet separat.

Înainte de a actualiza sistemul, Bio-Rad vă recomandă să verificați versiunea curentă instalată pe
sistemul CFX Opus. În această secțiune este explicat modul în care să verificați versiunea instalată și
modul în care să actualizați sistemul.

Notă: În funcție de tipul de upgrade, finalizarea acestui proces poate dura câteva minute.

Verificarea versiunii instalate în prezent
Pentru a verifica versiunea curentă a software-ului pentru Sistemul CFX Opus Dx

1. Pe ecranul de pornire pentru Sistemul CFX Opus Dx, atingeți Tools (Instrumente) pentru a
vizualiza ecranul Tools (Instrumente).

2. Dacă sunteți conectat ca Administrator, atingeți pictograma User (Utilizator) din partea de jos a
ecranului pentru a vizualiza instrumentele disponibile pentru toți utilizatorii.

3. Atingeți About (Despre) și localizați Opus Version (Versiune Opus) pe ecranul About (Despre).

4. Rețineți versiunea instalată în prezent.

Asigurați-vă că versiunea la care faceți upgrade este mai nouă decât versiunea instalată în
prezent.
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5. Atingeți Back (Înapoi) și apoi atingeți Home (Fereastră de pornire) pentru a reveni la ecranul de
pornire.

Efectuarea upgrade-ului pentru software-ul și firmware-ul
sistemului
Notă: În funcție de tipul de upgrade, finalizarea acestui proces poate dura câteva minute.

Pentru a actualiza software-ul și firmware-ul pentru Sistemul CFX Opus Dx

1. De pe computerul cu software-ul CFX Maestro Dx SE, conectați-vă la bio-rad.com și accesați
pagina Firmware and Software Updates (Actualizări firmware și software) pentru a descărca
programul de instalare pe o unitate USB atașată.

2. Introduceți unitatea USB într-un port USB de pe Sistemul CFX Opus Dx.

3. Pe ecranul de pornire, conectați-vă ca utilizator Administrator.

4. Pe ecranul de pornire, atingeți Tools (Instrumente) pentru a deschide ecranul Admin tools
(Instrumente de administrare).

5. Pe ecranul Admin tools (Instrumente de administrare), atingeți System Update (Actualizare
sistem) pentru a deschide ecranul Software and Instrument Updates (Actualizări software și
instrument).

Apare ecranul Software and Instrument Updates (Actualizări software și instrument).

Important: Când actualizarea este în curs de desfășurare, nu opriți sistemul și nu scoateți
unitatea USB.

6. (Opțional) Pentru a obține detalii despre actualizare, atingeți Details (Detalii).
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7. Urmați una dintre procedurile următoare:

n Pentru a anula actualizarea, atingeți Cancel (Anulare).

n Pentru a efectua upgrade-ul sistemului, atingeți Update (Actualizare) și urmați instrucțiunile.

Notă: La finalizarea actualizării, sistemul repornește automat.

Crearea unui amestec principal de reacție
Folosind Master Mix Calculator (Calculator Amestec principal) al CFX Maestro Dx SE, puteți calcula
cu ușurință volumul necesar al fiecărei componente a amestecului principal. Puteți imprima tabelul de
calcul al amestecului principal la imprimanta dumneavoastră implicită și puteți salva calculele pentru
fiecare țintă în vederea utilizării ulterioare.

Pentru a crea un amestec principal de reacție cu ajutorul Master Mix Calculator
(Calculator Amestec principal)

1. Pentru a deschide Master Mix Calculator (Calculator Amestec principal), urmați una dintre
procedurile următoare:

n Selectați Tools > Master Mix Calculator (Instrumente > Calculator Amestec principal).

n Faceți clic pe Master Mix Calculator (Calculator Amestec principal) de pe bara de
instrumente.

Va apărea Master Mix Calculator (Calculator Amestec principal).
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2. În secțiunea Reaction (Reacție), selectați o metodă de detecție:

n SYBR® Green/EvaGreen®

n Probes (Sonde)

3. Pentru a crea o țintă nouă, în secțiunea Target (Țintă) faceți clic pe Create New (Creare nou). În
lista verticală de ținte va apărea o nouă denumire de țintă.

4. (Opțional) Pentru a schimba denumirea țintei implicite:

a. Evidențiați denumirea țintei în lista verticală a țintei.

b. Tastați o nouă denumire a țintei în caseta Target (Țintă).

c. Apăsați tasta Enter.

5. Ajustați concentrațiile inițiale și finale pentru primerii de redirecționare și inversare și orice sonde.

6. În secțiunea Master Mix Setup (Configurare Amestec principal), ajustați valorile pentru

n Numărul de reacții de rulat
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n Volumul reacției per godeu

n Volumul matriței per godeu

n Concentrație amestec de reacție per godeu

n Volumul reacției în exces per godeu

7. (Opțional) Urmați pașii 2–6 pentru câte ținte este necesar.

8. În secțiunea Choose Target to Calculate (Alegere țintă de calculat), selectați ținta de calculat.

Sfat: Puteți calcula doar una sau mai multe sau toate țintele în același timp.

Volumele calculate ale componentelor necesare pentru fiecare țintă selectată apar în tabelul
amestecului principal.

9. Faceți clic pe Set as Default (Stabilire ca implicit) pentru a seta cantitățile în secțiunile Target
(Țintă) și Master Mix Setup (Configurare Amestec principal) drept noi valori implicite.

10. Faceți clic pe OK pentru a salva conținutul casetei de dialog Master Mix Calculator (Calculator
Amestec principal).

Pentru a imprima tabelul de calcul al amestecului principal

u Pentru a imprima tabelul de calcul al amestecului principal, faceți clic pe Print (Imprimare).

Tabelul de calcul se imprimă la imprimanta dumneavoastră implicită.

Pentru a salva tabelul de calcul al amestecului principal ca fișier PDF

u Schimbați imprimanta implicită cu un driver PDF și faceți clic pe Print (Imprimare) în Master Mix
Calculator (Calculator Amestec principal).

Pentru a șterge țintele

u Selectați ținta utilizând lista verticală de ținte și făcând clic pe Remove (Eliminare).

Important: Ștergerea unei ținte din lista de ținte o șterge și din toate calculele amestecului
principal în care este folosită. Procedați cu atenție când ștergeți o țintă.

Calibrarea de noi coloranți
Sistemele CFX Opus 96 Dx sunt calibrate din fabrică pentru fluoroforii utilizați în mod obișnuit cu plăcile
cu godeuri albe și transparente. Sistemele CFX Opus 384 Dx sunt calibrate din fabrică pentru fluoroforii
utilizați în mod obișnuit doar cu plăcile cu godeuri albe. Tabelul 6 afișează fluoroforii și canalul pentru
care este calibrat fiecare instrument.

76 | Software-ulCFXMaestro DxSE



Înainte de a începe

Notă: Sistemele CFX Opus 96 Dx și CFX Opus 384 Dx includ și un canal dedicat compușilor
FRET. Acest canal nu necesită calibrare pentru coloranți specifici.

Important: Dacă efectuați o calibrare definită de utilizator a unui colorant care a fost calibrat din
fabrică, instrumentul utilizează calibrarea definită de utilizator în locul calibrării din fabrică.

Fluorofori Canal
Excitație,

nm
Detecție,

nm Instrument

FAM, SYBR® Green I 1 450-490 515-530 Sistemele CFX Opus 96 Dx și
CFX Opus 384 Dx

VIC, HEX, CAL Fluor Gold 540,
Cal Fluor Orange 560

2 515-535 560-580 Sistemele CFX Opus 96 Dx și
CFX Opus 384 Dx

ROX, Texas Red, CAL Fluor
Red 610, TEX 615

3 560-590 610-650 Sistemele CFX Opus 96 Dx și
CFX Opus 384 Dx

CY5, Quasar 670 4 620-650 675-690 Sistemele CFX Opus 96 Dx și
CFX Opus 384 Dx

Quasar 705, Cy5.5 5 672-684 705-730 Doar sistemele CFX Opus 96
Dx

Tabelul 6. Fluorofori calibrați din fabrică, canale, și instrumente
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Pentru a calibra coloranți noi pentru sistemele CFX

1. În fereastra Home (Pagină de pornire), selectați un instrument țintă în panoul Detected
Instruments (Instrumente detectate).

2. Selectați Tools > Calibration Wizard (Instrumente > Expert calibrare) pentru a deschide expertul
Dye Calibration (Calibrare coloranți).

Fluoroforii calibrați deja pentru instrumentul țintă apar în tabelul Calibrated Fluorophores
(Fluorofori calibrați).

3. În secțiunea Calibrate New or Existing Fluorophores (Calibrare fluorofori noi sau existenți),
selectați fluoroforul de calibrat din lista verticală.

Dacă denumirea fluoroforului nu este inclusă în listă, introduceți denumirea în caseta de text
pentru a o adăuga în listă.

Important: Aveți grijă când denumiți fluoroforii calibrați personalizați. Dacă creați o calibrare
personalizată a colorantului pentru un fluorofor cu același nume ca pentru un fluorofor
calibrat din fabrică, fluoroforul personalizat (nu fluoroforul calibrat din fabrică) va fi cel folosit
de instrument în timpul rulărilor.

4. Selectați tipul de placă pentru fluorofor.
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Dacă tipul de placă nu este inclus în listă, introduceți denumirea în caseta de text pentru a o
adăuga în listă.

5. Selectați un canal pentru fluorofor.

6. Selectați o coloană de placă pentru fluorofor.

7. (Opțional) Scrieți o culoare care doriți să fie asociată cu fluoroforul.

8. Faceți clic pe Add to Plate (Adăugare la placă) pentru a adăuga fluoroforul.

9. (Opțional) Repetați pașii 38 pentru a adăuga fiecare fluorofor pe care doriți să îl calibrați pentru
placă.

10. Când finalizați adăugarea fluoroforilor, faceți clic pe View Plate (Vizualizare placă) pentru a
deschide fereastra Pure Dye Plate Display (Afișare placă coloranți puri).

Utilizați această fereastră ca ghid pentru încărcarea coloranților pe placă.

11. Pregătiți o placă cu 96 sau 384 godeuri pentru calibrarea coloranților:

a. Pipetați soluție de colorant în fiecare godeu, respectând tiparul din Pure Dye Plate Display
(Afișare placă coloranți puri).

b. Pentru fiecare fluorofor, umpleți patru godeuri cu 50 µl (placă cu 96 de godeuri) sau cu 30 µl
(placă cu 384 de godeuri) de soluție de colorant
300 nM. Veți observa că cel puțin jumătate din placă conține godeuri goale.

c. Sigilați placa folosind metoda de sigilare pe care o veți utiliza în cadrul experimentului.

12. Poziționați placa de calibrare în bloc și închideți capacul.

13. În expertul Dye Calibration (Calibrare coloranți), faceți clic pe Calibrate (Calibrare) și apoi pe OK
pentru a confirma că placa se află în bloc.

14. Când Software-ul CFX Maestro Dx SE finalizează rularea de calibrare, apare o casetă de dialog.
Faceți clic pe Yes (Da) pentru a finaliza calibrarea și a deschide Dye Calibration Viewer
(Instrumentul de vizualizare pentru calibrarea coloranților).

15. Faceți clic pe OK pentru a închide fereastra.

Setarea preferințelor utilizatorului
Sfat: Nu este obligatoriu să realizați aceste acțiuni pentru a utiliza CFX Maestro Dx SE. Puteți
omite fără probleme această secțiune sau puteți realiza aceste acțiuni în orice moment.

În CFX Maestro Dx SE , fiecare utilizator își poate personaliza mediul de lucru.

De exemplu, în meniul Users > User Preferences (Utilizatori > Preferințe utilizator), puteți face
următoarele:
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n Configura notificarea prin e-mail pentru finalizarea rulării.

Notă: Această funcție este disponibilă numai pentru utilizatorii cărora le-a fost atribuit acest
drept. Consultați Gestionarea rolurilor utilizatorilor pentru Software-ul CFX Maestro Dx SE de
la pagina 40 pentru mai multe informații.

n Modifica setările implicite pentru

o Locul în care se salvează fișierele

o Fișierele de configurare a rulării

o Prefixul de denumire a fișierelor

n Seta parametrii impliciți pe care să-i utilizați când creați un nou protocol și o placă nouă.

n Seta parametrii impliciți pentru analiza datelor și expresia genică.

n Personaliza parametrii impliciți de control al calității.

n Personaliza parametrii de exportare a datelor

În meniul Tools (Instrumente), puteți face următoarele lucruri:

n Crea un amestec principal de reacție.

n Calibra coloranți pentru un anumit instrument.

Notă: Amestecul de reacție PCR și calibrarea coloranților sunt disponibile oricărui utilizator care
se autentifică în CFX Maestro Dx SE.

Această secțiune vă explică cum să realizați aceste acțiuni.

Configurarea notificării prin e-mail

Puteți conecta CFX Maestro Dx SE la serverul dumneavoastră de e-mail de ieșire pentru a trimite o
notificare prin e-mail privind finalizarea unei rulări unei liste de utilizatori. Puteți, de asemenea, alege
să atașați un fișier de date și un raport de analiză listei de utilizatori. Pentru a configura conexiunea
între CFX Maestro Dx SE și serverul dumneavoastră SMTP, consultați Conectarea pentru Software-ul
CFX Maestro Dx SE la un server SMTP de la pagina 82.

Notă: Capacitatea unui utilizator de a accesa funcțiile de configurare a e-mailului depinde de
rolul utilizatorului și permisiunile atribuite de administrator. Pentru detalii referitoare la
gestionarea utilizatorilor și a rolurilor acestora, consultați Gestionarea rolurilor utilizatorilor pentru
Software-ul CFX Maestro Dx SE de la pagina 40.
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Pentru a configura notificările prin e-mail

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

Va apărea caseta de dialog User Preferences (Preferințe utilizator), afișând fila Email (E-mail).

Notă: Veți fi informat dacă sistemul detectează că nu ați configurat un server SMTP valid
pentru CFX Maestro Dx SE. Faceți clic pe Configure Outgoing Email (Configurare e-mail de
ieșire) pentru a deschide caseta de dialog Options (Opțiuni) și a configura serverul SMTP de
e-mail. Pentru mai multe informații, consultați Conectarea pentru Software-ul CFX Maestro
Dx SE la un server SMTP de la pagina 82.

2. În caseta de text To (Destinatar), tastați adresa de e-mail a fiecărei persoane pe care intenționați
să o informați despre finalizarea rulării. Toți destinatarii vor primi un e-mail după finalizarea
rulării.

Notă: Trebuie să introduceți fiecare adresă de e-mail pe un rând separat. Apăsați Enter sau
Return după fiecare adresă.

3. (Opțional) În caseta de text cc, tastați adresa de e-mail a fiecărui destinatar căruia intenționați să-i
trimiteți o copie a fiecărei notificări prin e-mail.

4. (Opțional) Implicit, toți destinatarii primesc o copie a fișierului de date sub formă de atașare.
Debifați această casetă de selectare dacă nu doriți să atașați o copie a fișierului de date.

5. (Opțional) Selectați Attach Analysis Report (Atașare raport analiză) pentru a atașa un PDF al
raportului de analiză la e-mail.

6. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog User Preferences
(Preferințe utilizator).

Pentru a edita adresa de e-mail a unui destinatar

u Modificați adresa de e-mail după cum este necesar și faceți clic pe OK.

Ghid de utilizare | 81



Capitolul 6 Fereastra Home (Pagină de pornire)

Pentru a șterge un destinatar de e-mail

1. Selectați destinatarul e-mailului și apăsați tasta Delete (Ștergere).

2. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Important: Făcând clic pe Restore Defaults (Restabilire valori implicite) în caseta de dialog User
Preferences (Preferințe utilizator), resetați toate preferințele din toate filele la setările de fabrică
inițiale. Procedați cu atenție când faceți clic pe acest buton.

Conectarea pentru Software-ul CFX Maestro Dx SE la un server SMTP

Important: Unii furnizori comerciali de servicii de webmail (cum ar fi Yahoo! și Gmail) au sporit
securitatea e-mailurilor. Dacă utilizați aceste conturi, trebuie să activați setarea Allow less
secure apps (Permiteți aplicațiile mai puțin sigure) în setările contului respectiv, pentru a
permite CFX Maestro Dx SE să trimită e-mailuri. Consultați informațiile de securitate ale
furnizorului dumneavoastră de servicii e-mail pentru informații suplimentare.

Trebuie să stabiliți o conexiune de la CFX Maestro Dx SE la serverul dumneavoastră de e-mail înainte
ca software-ul să poată trimite notificări prin e-mail.

Pentru a conecta CFX Maestro Dx SE la un server de e-mail

1. Urmați una dintre procedurile următoare:

n Selectați User > User Preferences (Utilizator > Preferințe utilizator) și faceți clic pe Configure
Outgoing Email (Configurare e-mail de ieșire) în fila Email (E-mail).

n Selectați Tools > Options (Instrumente > Opțiuni).

Apare caseta de dialog Options (Opțiuni), care afișează fila Email (E-mail).
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2. Introduceți următoarele informații pentru compania dumneavoastră:

n SMTP Server Name (Denumire server SMTP) – numele serverului pentru e-mailuri de
ieșire al companiei dumneavoastră.

n Port – numărul portului aferent serverului dumneavoastră SMTP. De obicei, acesta este 25.

n Utilizare opțiunea SSL – Secure Sockets Layer (SSL). Unele servere SMTP necesită
această setare. Dacă nu este necesară în cadrul companiei dumneavoastră, debifați
respectiva casetă de selectare.

n Use Default “From” Address (Utilizare adresă „De la” implicită) – numele serverului de e-
mail al companiei dumneavoastră. Unele servere SMTP impun ca toate e-mailurile trimise să
aibă o adresă „de la” dintr-un anumit domeniu, de exemplu,
nume@CompaniaDumneavoastrăcom. În acest caz, debifați această casetă de selectare și
introduceți o adresă de e-mail validă.

n Authentication Required (Autentificare necesară) – dacă instituția dumneavoastră impune
autentificarea cu un cont, asigurați-vă că această casetă de selectare este bifată.

n User Name (Nume utilizator) – numele contului autentificat. Este necesar numai dacă se
selectează Authentication Required (Autentificare necesară).

n Password (Parolă) – parola pentru contul autentificat. Este necesar numai dacă se
selectează Authentication Required (Autentificare necesară).

3. Pentru a vă asigura că setările serverului SMTP sunt corecte, introduceți o adresă de e-mail
validă în caseta text Test Email Address (Adresă de e-mail de test) și faceți clic pe Test Email
(Testare e-mail).

Notă: Unele servere SMTP nu permit utilizarea de atașări, iar altele permit numai utilizarea
de atașări până la o dimensiune maximă specifică. Dacă intenționați să trimiteți prin e-mail
fișiere de date și/sau rapoarte utilizând CFX Maestro Dx SE, selectați Test Attachment
(Atașament de test) și setați Attachment Size in MB (Dimensiune atașament în MB) la
minimum 5 megabyte (MB).

4. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Schimbarea setărilor implicite ale fișierelor

În fila Files (Fișiere) din caseta de dialog User Preferences (Preferințe utilizator), puteți modifica

n Locația implicită în care se salvează fișierele CFX Maestro Dx SE

n Fișierele implicite pentru configurarea rulării

n Parametrii impliciți de denumire a fișierelor
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Pentru a schimba setările implicite ale fișierelor

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

2. În caseta de dialog User Preferences (Preferințe utilizator), selectați fila Files (Fișiere).

3. În secțiunea Default Folder for File Creation (Folder implicit pentru crearea fișierelor), navigați la
și selectați un folder implicit în care doriți să salvați noile fișiere. Puteți selecta un loc diferit pentru
fiecare tip de fișier:

n Protocol

n Placă

n Fișier de date

n Studiu genic

4. În secțiunea File Selection for Run Setup (Selectare fișier pentru configurarea rulării), navigați la
și selectați protocolul țintă și fișierele de placă ce vor apărea când deschideți fereastra
Experiment Setup (Configurare experiment).

5. În secțiunea Data File (Fișier de date), definiți prefixul și/sau sufixul pentru fișierele de date.
Pentru orice parte, selectați o nouă valoare din lista sa verticală. Puteți, de asemenea, furniza
valori personalizate pentru prefix și sufix în casetele de text Prefix și Suffix.
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CFX Maestro Dx SE afișează o previzualizare a numelui fișierului sub casetele de selectare.

6. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Important: Făcând clic pe Restore Defaults (Restabilire valori implicite) în caseta de dialog User
Preferences (Preferințe utilizator), resetați toate preferințele din toate filele la setările de fabrică
inițiale. Procedați cu atenție când faceți clic pe acest buton.

Setarea parametrilor de protocol impliciți

Pentru a seta parametri de protocol impliciți pentru Protocol Editor (Editor Protocol) și
Protocol AutoWriter (Utilitar de scriere automată protocol)

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

2. În caseta de dialog User Preferences (Preferințe utilizator), selectați fila Protocol.

3. În secțiunea Protocol Editor (Editor Protocol), specificați valori pentru următoarele setări care apar
în Protocol Editor (Editor Protocol):

n Sample volume (Volumul probei) – volumul fiecărei probe din godeuri (în µl).

n Lid Shutoff temperature (Temperatură oprire capac) – temperatura în ºC la care
încălzitorul capacului se oprește în timpul unei rulări.

4. În secțiunea Protocol AutoWriter (Utilitar de scriere automată protocol), specificați valori pentru
următoarele setări care apar în Protocol AutoWriter (Utilitar de scriere automată protocol):

n Annealing temperature (Temperatură de atașare) – temperatura în ºC pentru experimente
care utilizează polimerază ADN iProof, polimerază ADN iTaq sau alte polimeraze.

n Amplicon length (Lungime amplicon) – lungimea ampliconului în bp.
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5. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Important: Făcând clic pe Restore Defaults (Restabilire valori implicite) în caseta de dialog User
Preferences (Preferințe utilizator), resetați toate preferințele din toate filele la setările de fabrică
inițiale. Procedați cu atenție când faceți clic pe acest buton.

Setarea parametrilor de placă impliciți

Schimbările pe care le faceți în fila Plate (Placă) sunt disponibile tuturor utilizatorilor software-ului.
Schimbările pe care le faceți în timpul configurării plăcii sunt disponibile utilizatorilor după ce salvați și
închideți fișierul de placă.

În caseta de dialog User Preferences (Preferințe utilizator) puteți efectua următoarele:

n Setați parametrii de placă impliciți.

n Adăugați noi denumiri pentru țintă, mostră și grup biologic la bibliotecile lor respective.

n Ștergeți denumiri pentru țintă, mostră și grup biologic din bibliotecile lor respective.

Pentru a seta parametrii de placă impliciți

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

2. În caseta de dialog User Preferences (Preferințe utilizator), selectați fila Plate (Placă).
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3. Specificați valori pentru următoarele setări pentru un fișier nou de placă. Aceste valori apare în
fereastra Plate Editor (Editor placă):

n Tip de placă

n Dimensiune placă

n Units (Unități) – concentrația matriței de pornire pentru godeurile care conțin standarde.

CFX Maestro Dx SE utilizează aceste unități pentru a crea o curbă standard în fila Data
Analysis Quantification (Cuantificare analiză date).

n Scientific notation (Notație științifică) – când este selectată, CFX Maestro Dx SE afișează
unitățile de concentrație în notația științifică.

n Scan mode (Mod scanare) – numărul sau tipul de canale de scanat în timpul unei rulări.

n Fluorophores (Fluorofori) – fluoroforii impliciți care apar în soluțiile de control Plate Editor
(Editor placă) pentru încărcarea godeului.

n Libraries (Biblioteci) – denumirile pentru țintă, mostră și grup biologic pe care le utilizați de
obicei în experimentele dumneavoastră:

o Target Names (Denumiri ținte) – denumirile genelor și secvențelor țintă.

o Sample Names (Denumiri probe) – denumirile pentru probele experimentului sau o
caracteristică identificatoare pentru mostre (de exemplu, Mouse1, Mouse2, Mouse3 –
Șoarece1, Șoarece2, Șoarece3).

o Biological group names (Denumiri grupuri biologice) – denumirile pentru grupuri de
probe similare care au aceeași stare de tratament sau aceleași condiții (de exemplu, 0
ore, 1 oră, 2 ore).

4. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Pentru a adăuga un nume nou pentru țintă, mostră sau grup biologic

u În caseta corespunzătoare bibliotecii, introduceți numele pentru țintă, mostră sau grup biologic și
faceți clic pe OK.

Pentru a șterge un nume țintă, mostră sau grup biologic

u În caseta de bibliotecă corespunzătoare, selectați numele și apăsați tasta Delete (Ștergere), apoi
faceți clic pe OK.

Important: Numele pe care le înlăturați din bibliotecă sunt eliminate automat din software și nu
mai sunt disponibile utilizatorilor. Pentru a restaura denumirile implicite CFX Maestro Dx SE,
faceți clic pe Restore Defaults (Restabilire valori implicite). Făcând clic pe Restore Defaults
(Restabilire valori implicite) în caseta de dialog User Preferences (Preferințe utilizator), resetați
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toate preferințele din toate filele la setările de fabrică inițiale. Procedați cu atenție la ștergerea
denumirilor CFX Maestro Dx SE implicite și când faceți clic pe acest buton.
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Setarea parametrilor impliciți pentru analiza de date

Pentru a configura parametrii impliciți ai analizei datelor

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

2. În caseta de dialog User Preferences (Preferințe utilizator), selectați fila Data Analysis (Analiză
date).

3. În secțiunea Analysis Mode (Mod Analiză), selectați modul în care să analizați datele (fie
Fluorophore (Fluorofor), fie Target (Țintă)).

4. În secțiunea PCR Quantitation (Cuantificare PCR), configurați parametrii impliciți pentru
următoarele opțiuni:

n Baseline Setting (Setarea Nivel inițial) – metoda de referință pentru modul de analiză.

n Cq Determination Mode (Mod Determinare Cq) – modul în care sunt calculate valorile Cq
pentru fiecare urmă de fluorescență (fiecare regresie sau prag unic).

n Threshold Calc. (Calculare Prag) Mode (Mod calc. prag) – cantitatea țintei la momentul
final.

Opțiunea implicită este Auto. Adică software-ul calculează automat ținta la momentul final.
Pentru a configura un anumit prag, debifați caseta de selectare Auto și introduceți valoarea
de la momentul final, calculată în unități de fluorescență relativă (sau RFU). Valoarea
maximă este de 65.000,00 RFU. Fișierele de date pentru rulările ulterioare vor folosi această
setare de prag.

n Baseline Calc. Mode (Mod calc. nivel inițial) – nivelul inițial pentru toate urmele.

Opțiunea implicită este Auto. Adică software-ul calculează automat nivelul inițial pentru toate
urmele. Pentru a configura un anumit nivel inițial, debifați caseta de dialog Auto și introduceți
valorile minime și maxime pentru intervalul de cicluri (de la 1 la 9999). Fișierele de date
pentru rulările ulterioare vor folosi acest interval de cicluri.

n Log View (Vizualizare log) – determină modul în care software-ul afișează datele de
amplificare:

o On (Activat) – datele amplificării sunt afișate într-un grafic semi-logaritmic.

o Off (Dezactivat) – (implicit) datele amplificării sunt afișate într-un grafic liniar.

5. În secțiunea End Point (Momentul final), selectați numărul de cicluri finale pentru care veți calcula
media atunci când faceți calculele pentru momentul final.
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n PCR – numărul de cicluri finale pentru care veți calcula media datelor de cuantificare
(valoarea implicită este 5).

n End Point Only run (Rulare doar la momentul final) – numărul de cicluri finale pentru care
veți calcula media datelor de la momentul final (valoarea implicită este 2).

6. În secțiunea Melt Curve (Curbă de topire), selectați tipul vârfului de detectat (pozitiv sau negativ).

7. În secțiunea Well Selector (Selector godeuri), selectați modul de afișare a etichetelor godeurilor
(după tipul probei, denumirea țintei sau denumirea probei).

8. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Important: Făcând clic pe Restore Defaults (Restabilire valori implicite) în caseta de dialog User
Preferences (Preferințe utilizator), resetați toate preferințele din toate filele la setările de fabrică
inițiale. Procedați cu atenție când faceți clic pe acest buton.

Setarea parametrilor impliciți pentru fișierul de date de expresie genică

Pentru a seta parametrii impliciți pentru un nou fișier de date de expresie genică

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

2. În caseta de dialog User Preferences (Preferințe utilizator), selectați fila Gene Expression
(Expresie genică).

3. Specificați valorile pentru următoarele setări:

n Relative to (Relativ la) – generează un grafic pentru datele expresiei genice relativ la o
proba control (începând de la 1) sau relativ la zero:

o Zero – software-ul ignoră proba control. Aceasta este valoarea implicită atunci când nu
este alocată nicio probă de control în fereastra Experiment Settings (Setări experiment).

o Control – software-ul calculează datele relativ la proba de control alocată în fereastra
Experiment Setup (Configurare experiment).

n X-axis (Axa x) – reprezintă grafic proba sau ținta pe axa x.

n Y-axis (Axa y) – reprezintă grafic scara liniară, log2 sau log10 pe axa y.
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n Scaling (Scalare) – opțiunea de scalare pentru grafic (opțiunea implicită este Unscaled
(Nescalat)):

o Highest (Cel mai ridicat) – software-ul scalează graficul la punctul de date cel mai
ridicat.

o Lowest (Cel mai scăzut) – software-ul scalează graficul către punctul de date cel mai
scăzut.

o Unscaled (Nescalat) – software-ul prezintă datele nescalate (fără scalare) în grafic.

n Mode (Mod) – modul de analiză, fie cantitate relativă (∆Cq) fie expresie normalizată (∆∆Cq).

n Error Bar (Bară de eroare) – variabilitatea datelor s-a prezentat fie ca deviația standard
(Std. Dev.), fie ca eroarea standard a mediei (Std. Error Mean).

n Error Bar Multiplier (Multiplicator bară de eroare) – multiplicatorul deviației standard utilizat
pentru a desena barele de eroare (valoarea implicită este 1).

Puteți mări multiplicatorul la 2 sau 3.

n Sample Types to Exclude (Tipuri de probe de exclus) – aceleași tipuri de probe de exclus
din analiză.

Puteți selecta una sau mai multe probe pentru excludere din analiză. Pentru a exclude toate
tipurile de probe, debifați casetele de selectare pentru orice tipuri de probe selectate.

4. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Important: Făcând clic pe Restore Defaults (Restabilire valori implicite) în caseta de dialog User
Preferences (Preferințe utilizator), resetați toate preferințele din toate filele la setările de fabrică
inițiale. Procedați cu atenție când faceți clic pe acest buton.

Personalizarea regulilor de control al calității

În CFX Maestro Dx SE, puteți seta reguli pentru controlul calității, care sunt aplicate datelor din
fereastra Data Analysis (Analiză date). Software-ul validează datele față de regulile setate de
dumneavoastră

Notă: Implicit, toate regulile de control al calității sunt activate.

Sfat: Puteți exclude cu ușurință godeurile care nu îndeplinesc un parametru CC în modulul CC al
ferestrei Data Analysis (Analiză date).

Pentru a personaliza regulile de control al calității

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

2. În caseta de dialog User Preferences (Preferințe utilizator), selectați fila QC (CC).
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Unde:

n NTC— control fără țintă de amplificare

n NRT – control fără transcriptaza inversă

n Efficiency (Eficiență) – eficiența reacțiilor

n Std Curve R^2 (R^2 curbă standard) – valoarea R pătrat pentru curba standard

n Replicate group Cq Std Dev (Deviație standard Cq pentru grup de replicate) – deviația
standard calculată pentru fiecare grup de replicate

3. Pentru fiecare regulă QC (CC), urmați una dintre procedurile următoare:

n Pentru a utiliza valoarea implicită, nu faceți nimic.

n Pentru a modifica valoarea, faceți clic pe caseta de text Value (Valoare) aferentă, introduceți
o nouă valoare și apăsați tasta Enter.

n Pentru a dezactiva regula, debifați caseta de selectare Use (Utilizare) aferentă.

4. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.
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Important: Făcând clic pe Restore Defaults (Restabilire valori implicite) în caseta de dialog User
Preferences (Preferințe utilizator), resetați toate preferințele din toate filele la setările de fabrică
inițiale. Procedați cu atenție când faceți clic pe acest buton.

Personalizarea parametrilor de exportare a datelor

Puteți exporta datele CFX Maestro Dx SE în următoarele formate:

n Text (.txt)

n CSV (.csv)

n Excel (.xls, .xlsx)

n XML (.xml)

n HTML (.html)

Puteți specifica tipul de date de exportat și personaliza ieșirea datelor exportate.

Pentru a personaliza parametrii de exportare a datelor

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

2. În caseta de dialog User Preferences (Preferințe utilizator), selectați fila Custom Export (Exportare
particularizată).
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3. În lista verticală Export Format (Format de exportare), selectați un format în care să exportați
datele.

4. În secțiunea Data to Export (Date de exportat), bifați sau debifați casetele de selectare pentru tipul
de date de exportat. Elementele selectate apar în caseta listă Exported Columns (Coloane
exportate).

Notă: Implicit, informațiile rulării sunt incluse în antet. Debifați această casetă de selectare
dacă nu doriți să fie incluse informațiile de rulare.

5. Puteți modifica ordinea de pe afișajul de ieșire a elementelor selectate.

În caseta listă Exported Columns (Coloane exportate), evidențiați elementul, apoi faceți clic pe
butoanele săgeată din stânga listei pentru a-l deplasa în sus sau în jos.

6. Opțional, puteți modifica numele coloanelor de ieșire ale elementelor selectate:

a. Faceți clic pe Customize Column Names (Personalizare nume coloană).

Va apărea caseta de dialog Column Name Customizer (Instrument de particularizare nume
coloană).

b. Pentru fiecare nume implicit de coloană pe care doriți să-l schimbați, tastați un nume nou în
câmpul Custom Name (Nume personalizat) corespunzător.

c. Urmați una dintre procedurile următoare:

n Faceți clic pe OK pentru a salva modificările și a reveni la fila Custom Export (Exportare
particularizată). Noul nume apare în paranteze, lângă coloana implicită din caseta listă
Exported Columns (Coloane exportate).

n Faceți clic pe Cancel (Anulare) pentru a anula modificările și a reveni la fila Custom
Export (Exportare particularizată).

7. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Important: Făcând clic pe Restore Defaults (Restabilire valori implicite) în caseta de dialog User
Preferences (Preferințe utilizator), resetați toate preferințele din toate filele la setările de fabrică
inițiale. Procedați cu atenție când faceți clic pe acest buton.
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Un protocol este un set de pași care sunt executați într-o secvență specifică. În Software-ul
CFX Maestro Dx SE, toți pașii sunt asociați cu opțiunile instrumentului. De exemplu, pașii dau
instrucțiuni instrumentului să controleze temperatura blocului și a capacului, să aplice o diferență de
temperatură pe bloc, să efectueze o citire de placă sau să efectueze o analiză pentru curba de topire.
Fiecare opțiune este specificată pentru diferite tipuri de placă și rulare.

CFX Maestro Dx SE oferă două opțiuni pentru crearea protocoalelor: Protocol Editor (Editor protocol)
și Protocol AutoWriter (Utilitar de scriere automată protocol).

Funcția Protocol Editor (Editor Protocol) include următoarele:

n Soluții de control standard pentru protocol, pentru a crea rapid protocoale

n Capacitatea de a calcula rapid un gradient pentru numărul selectat de rânduri

n Capacitatea de a calcula rapid timpul de rulare pentru tipul de placă selectat

n Capacitatea de a edita pași de protocol

n Capacitatea de a salva protocoale pentru reutilizare

n Capacitatea de a imprima protocolul la o imprimantă implicită

Protocol AutoWriter (Utilitar de scriere automată protocol) generează automat un protocol PCR
personalizat cu pași pentru start fierbinte, denaturare inițială, atașare și extensie, folosind parametrii
pe care îi furnizați dumneavoastră. Puteți apoi să vizualizați o reprezentare grafică a protocolului
sugerat și să editați, rulați sau salvați protocolul.
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Fereastra Protocol Editor (Editor Protocol)
Folosiți fereastra Protocol Editor (Editor Protocol) pentru a crea, deschide, verifica și edita un protocol.
Implicit, Protocol Editor (Editor Protocol) afișează un protocol generic în 2 pași în timp real pentru o
placă de 96 de godeuri.

1. Bara de meniu oferă acces rapid la comenzile de meniu File (Fișier), Settings (Setări) și Tools
(Instrumente).

2. Bara de instrumente oferă acces rapid pentru salvarea și imprimarea protocolului, stabilirea
punctului de inserare a unui pas, setarea volumului probei și vizualizarea timpului de rulare
estimat al protocolului.

3. Panoul principal afișează o reprezentare grafică a protocolului.

4. Panoul de jos afișează schița protocolului.

5. Panoul din stânga afișează comenzile protocolului pe care le puteți adăuga pentru a personaliza
protocolul.

LEGENDĂ
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Comenzile meniului File (Fișier)
Save (Salvare) – salvează protocolul curent.

Save As (Salvare ca) – salvează protocolul curent cu o denumire nouă sau într-un loc nou.

File Passwords (Parole fișier) - permite utilizatorilor să-și seteze parolele de salvare și deschidere a
fișierelor.

Sfat: Pentru mai multe informații, consultați Protejarea prin parolă a fișierelor de la pagina 48.

Close (Închidere) – închide Protocol Editor (Editor Protocol).

Comandă meniu Settings (Setări)
Lid Settings (Setări capac) – deschide caseta de dialog Lid Setting (Setări capac) în care puteți
schimba sau seta temperatura capacului.

Comenzile meniului Tools (Instrumente)
Gradient Calculator (Calculator Gradient) – deschide o casetă de dialog din care puteți selecta tipul
de bloc pentru un pas de gradient. Opțiunea implicită este 96 de godeuri.

Run time Calculator (Calculator timp rulare) – deschide o casetă de dialog din care puteți selecta
tipul de placă și modul de scanare pentru a calcula timpul de rulare estimat în fereastra Run Setup
(Configurare rulare). Opțiunea implicită este 96 de godeuri, toate canalele.

Comenzi bară de instrumente

– salvează fișierul de protocol actual.

– imprimă fereastra selectată.

– utilizați această comandă pentru a selecta unde să introduceți pași relativ la
pasul selectat în prezent.

– utilizați această comandă pentru a introduce un volum de probă în µl.
Volumele probelor diferă în funcție de tipul de bloc:

n Pentru un bloc de 96 de godeuri intervalul este de 0-50 µl.
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n Pentru un bloc de 384 de godeuri intervalul este de 0-30 µl.

– afișează timpul de rulare estimat bazat pe pașii de protocol, viteza de
creștere și tipul de bloc selectat.

– afișează informații de Ajutor despre protocoale.

Soluții de control pentru editarea protocolului
Panoul stâng din fereastra Protocol Editor (Editor Protocol) include soluții de control pe care le puteți
utiliza pentru a crea protocoale.

Fiecare soluție de control constă într-un set de parametri care reprezintă un pas din protocol. Puteți
modifica fiecare parametru și puteți adăuga sau elimina parametri pentru a vă personaliza protocolul.
Această secțiune descrie opțiunile din fiecare soluție de control.

n Insert Step (Inserare pas) – inserează un pas înainte sau după pasul
selectat. Puteți edita valorile pentru temperatură și timpul de menținere
în afișajul grafic al protocolului sau în schița protocolului.

n Insert Gradient (Inserare gradient) – inserează un pas de gradient
bazat pe tipul de bloc cu godeuri selectat în calculatorul de gradient.
Puteți edita intervalul de gradient în panoul Gradient care apare atunci
când un pas de gradient este inserat.

n Insert GOTO (Inserare SaltLa) – inserează un pas de ciclu (buclă),
care informează software-ul să repete pași specifici în secvență pentru
un număr specificat de cicluri. Repetițiile încep după ce primul ciclu
este finalizat. De exemplu, puteți informa software-ul să efectueze 39

de repetiții pentru pașii 2-4. După repetiția finală, software-ul va fi efectuat pașii 2-4 de 40 de ori
în total. Puteți edita pasul de return-to (revenire-la) (GOTO (SaltLa)) și numărul de cicluri fie din
afișajul grafic, fie din schița de protocol.

n Insert Melt Curve (Inserare curbă de topire) – inserează un pas de citire de curbă de topire.

n Insert Plate Read to Step (Inserare citire placă la pas) – adăugați o comandă de citire placă la
pasul selectat. O citire de placă măsoară cantitatea de fluorescență de la sfârșitul unui ciclu.
Pasul pentru citire placă este în general ultimul pas dintr-o buclă GOTO (SaltLa).

Sfat: După ce adăugați o comandă de citire placă unui pas, butonul se schimbă în Remove
Plate Read (Eliminare citire placă) atunci când selectați pasul.
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n Remove Plate Read (Eliminare citire placă) – elimină o comandă de citire placă din pasul
selectat.

Sfat: După ce eliminați o comandă de citire placă dintr-un pas, butonul de schimbă în Add
Plate Read to Step (Adăugare citire placă la pas) atunci când selectați pasul.

n Step Options (Opțiuni pas) – deschide caseta de dialog Step Options (Opțiuni pas) și afișează
opțiunile disponibile pentru pasul selectat. Consultați Opțiuni pas de la pagina 99 pentru
informații detaliate despre opțiunile pasului.

Sfat: De asemenea, puteți accesa Step Options (Opțiuni pas) făcând clic dreapta pe pas în
afișajul grafic.

n Delete Step (Ștergere pas) – șterge pasul selectat din protocol.

Opțiuni pas

Deschideți caseta de dialog Step Options (Opțiuni pas) pentru a vizualiza opțiunile pe care le puteți
adăuga, schimba sau elimina dintr-un pas.

n Plate Read (Citire placă) – când este selectată, adaugă o citire de placă la pas.

n Temperature (Temperatură) – setează temperatura țintă pentru pasul selectat.

n Gradient – setează intervalul de gradient pentru pas; intervalul este 1-24°C.

Notă: Un gradient rulează cu cea mai joasă temperatură în partea din fata a blocului (în
această imagine, rândul H) și cea mai ridicată temperatură în partea din spatele blocului (în
această imagine, rândul A).
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n Increment – suma cu care să crească (sau scadă) temperatura pasului selectat; această valoare
este adăugată la temperatura țintă cu fiecare ciclu. Intervalul este de ±0,1-10°C.

Notă: Pentru a reduce temperatura, introduceți un semn de minus (–) înainte de valoarea
numerică (de exemplu, –5°C).

n Ramp Rate (Viteză de creștere) – viteza de creștere pentru pasul selectat; intervalul depinde de
dimensiunea blocului.

n Time (Timp) – timpul de menținere pentru pasul selectat.

n Extend (Prelungire) – timpul (în sec.) pentru prelungirea sau scurtarea pasului selectat; această
opțiune este adăugată la timpul de menținere din fiecare ciclu; intervalul este de 1-60 sec.

n Beep - când este selectat, se aude un beep în timpul pasului.

Sfat: Când introduceți un număr care este în afara intervalului de opțiuni, software-ul
schimbă numărul la cea mai apropiată intrare din interval.
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Crearea unui protocol în Protocol Editor (Editor Protocol)
Utilizând Protocol Editor (Editor Protocol), puteți crea fișiere protocol personalizate. Puteți, de
asemenea, edita și salva fișiere protocol salvate anterior sau exemple de fișiere protocol livrate
împreună cu CFX Maestro Dx SE.

Pentru a crea un nou fișier protocol, procedați în felul următor:

n Deschideți un fișier protocol în Protocol Editor (Editor Protocol).

Sfat: Puteți deschide un protocol nou sau existent în Protocol Editor (Editor Protocol).

n Configurați noul protocol.

n Adăugați pași la protocol din panoul de control al protocolului.

n Editați proprietățile pașilor.

n Salvați protocolul.

Sfat: Pentru a crea un protocol nou dintr-un fișier de protocol salvat anterior sau exemplu,
consultați Deschiderea unui protocol existent în Protocol Editor (Editor Protocol) de la pagina
103.

Deschiderea unui nou fișier de protocol în Protocol Editor
(Editor Protocol)
CFX Maestro Dx SE oferă mai multe opțiuni de deschidere a unui nou fișier de protocol:

n Din meniul File (Fișiere) din fereastra Home (Pagină de pornire)

n Din caseta de dialog Run Setup (Configurare rulare) din fereastra Home (Pagină de pornire)

n Din fereastra de dialog Startup Wizard (Expert pornire) din fereastra Home (Pagină de pornire)

Pentru a deschide un nou fișier de protocol din meniul File (Fișier)

u În fereastra Home (Pagină de pornire), selectați File > Open > Protocol (Fișier > Deschidere >
Protocol).

Se va deschide fereastra Protocol Editor (Editor Protocol), care afișează fișierul de protocol
implicit.

Sfat: Pentru informații despre setarea protocolului implicit, consultați Schimbarea setărilor
implicite ale fișierelor de la pagina 83.
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Pentru a deschide un nou protocol din caseta de dialog Run Setup (Configurare rulare)

1. În fereastra Home (Pagină de pornire), urmați una dintre procedurile următoare pentru a
deschide caseta de dialog Run Setup (Configurare rulare):

n Selectați Run > User-defined Run (Rulare > Rulare definită de utilizator).

n Faceți clic pe User-defined Run Setup (Configurare rulare definită de utilizator) de pe bara
de instrumente.

Se va deschide caseta de dialog Run Setup (Configurare rulare) în fila Protocol, care vă va afișa
fișierul de protocol implicit.

2. Faceți clic pe Create New (Creare nou).

Se va deschide fereastra Protocol Editor (Editor Protocol), care afișează protocolul implicit în timp
real.

Pentru a deschide un nou fișier de protocol din Startup Wizard (Expert pornire)

1. În fereastra Home (Pagină de pornire), urmați una dintre procedurile următoare pentru a
deschide Startup Wizard (Expert pornire) dacă nu apare în vizualizare:

n Selectați View > Startup Wizard (Vizualizare > Expert pornire).

n Faceți clic pe Startup Wizard (Expert pornire) de pe bara de instrumente.

Implicit, Startup Wizard (Expert pornire) afișează fila Run Setup (Configurare rulare) cu tipul de
instrument CFX96 selectat.

2. Dacă este necesar, selectați tipul de instrument din lista verticală.

3. Faceți clic pe User-defined (Definit de utilizator) ca tip de rulare.

Se va deschide caseta de dialog Run Setup (Configurare rulare) în fila Protocol, care va afișa
fișierul de protocol implicit.

4. Faceți clic pe Create New (Creare nou).

Se va deschide fereastra Protocol Editor (Editor Protocol), care afișează protocolul implicit în timp
real.

Pentru a deschide un nou protocol din meniul Run (Rulare)

1. În fereastra Home (Pagină de pornire), urmați una dintre procedurile următoare pentru a
deschide caseta de dialog Run Setup (Configurare rulare):

n Selectați Run > User-defined Run (Rulare > Rulare definită de utilizator).
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n Faceți clic pe User-defined Run Setup (Configurare rulare definită de utilizator) de pe bara
de instrumente.

Se va deschide caseta de dialog Run Setup (Configurare rulare) în fila Protocol, care vă va afișa
fișierul de protocol implicit.

2. Faceți clic pe Create New (Creare nou).

Se va deschide fereastra Protocol Editor (Editor Protocol), care afișează protocolul implicit în timp
real.

Deschiderea unui protocol existent în Protocol Editor (Editor
Protocol)
CFX Maestro Dx SE furnizează exemple de fișiere de protocol pe care le puteți edita și salva ca
protocoale noi personalizate. De asemenea puteți crea un protocol nou dintr-un protocol personalizat
existent.

Pentru a deschide un exemplu de fișier de protocol

1. În fereastra Home (Pagină de pornire), selectați File > Open > Protocol (Fișier > Deschidere >
Protocol).

Implicit, Windows Explorer se deschide la locația folderului CFX Maestro Dx SE Sample files
(Fișiere probă).

2. Deschideți folderul Sample files (Fișiere probă). Vedeți următoarele foldere:

n ConventionalProtocols (ProtocoaleConvenționale) – conține fișiere de protocol exemplu
pentru analiză PCR tradițională.

n DataFiles (FișiereDate) – conține fișiere de date exemplu pe care le puteți utiliza pentru a
explora funcțiile CFX Maestro Dx SE.

n MeltCalibration (CalibrareTopire) – conține fișiere de protocol exemplu pentru utilizare cu
software-ul Precision Melt Analysis al Bio-Rad.

n Plates (Plăci) – conține exemple de fișiere de placă.

n RealTimeProtocols (ProtocoaleTimpReal) – conține exemple de fișiere de protocol pentru
analiză PCR în timp real.

3. Deschideți folderul de protocol pentru tipul de rulare pe care doriți să îl efectuați, fie
ConventionalProtocols (ProtocoaleConvenționale) fie RealTimeProtocols (ProtocoaleTimpReal).

4. Selectați protocolul pe care îl doriți și faceți clic pe Open (Deschidere).

Exemplul de protocolul se deschide în fereastra Protocol Editor (Editor Protocol).
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5. Selectați File > Save As (Fișier > Salvare ca) și salvați protocolul cu o denumire nouă sau într-un
folder nou.

Pentru a deschide un protocol existent

1. În fereastra Home (Pagină de pornire), efectuați una dintre următoarele:

n Selectați File > Open > Protocol (Fișier > Deschidere > Protocol), navigați la și selectați
protocolul țintă și faceți clic pe Open (Deschidere).

n Deschideți Startup Wizard (Expert pornire) și efectuați una dintre următoarele:

o Pentru a edita protocolul afișat, faceți clic pe Edit Selected (Editare selectate).

o Pentru a edita un alt protocol existent, faceți clic pe Select Existing (Selectare existent) și
navigați la fișierul țintă.

Protocolul se deschide în fereastra Protocol Editor (Editor Protocol).

2. Selectați File > Save As (Fișier > Salvare ca) și salvați protocolul cu o denumire nouă sau într-un
folder nou.

Configurarea unui nou protocol
Sfat: Dacă fișierul dumneavoastră de protocol include parametrii necesari (de exemplu, dacă
editați un fișier placă existent), puteți omite această secțiune. Continuați cu Adăugarea de pași la
un protocol de la pagina 106.

Noile fișiere de protocol necesită următorii parametri:

n Tipul blocului

n Modul de scanare pentru tipul de bloc selectat

n Temperatura capacului

n Volumul probei

Setarea tipului de bloc

CFX Maestro Dx SE calculează automat creșterile de temperatură pentru pașii de gradient pe baza
tipului de bloc.

Notă: Tipul de placă setat în Protocol Editor (Editor protocol) trebuie să fie același cu cel pentru
placa din modulul de reacție.
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Pentru a seta tipul de bloc

u În fereastra Protocol Editor (Editor protocol), selectați Tools > Gradient Calculator (Instrumente >
Calculator gradient) și alegeți tipul de placă adecvat din lista verticală care apare.

Selectarea modului de scanare pentru tipul de bloc selectat

Pentru a stabili timpul de rulare a protocolului, selectați tipul blocului țintă și modul de scanare.

Pentru a selecta tipul blocului și modul de scanare

u În fereastra Protocol Editor (Editor Protocol), selectați Tools > Run time Calculator (Instrumente >
Calculator timp de rulare) și alegeți tipul de placă și modul de scanare adecvate din lista verticală
care apare.

Ajustarea temperaturii capacului

CFX Maestro Dx SE setează temperaturile implicite ale capacului după cum urmează:

n Instrumente cu 96 de godeuri – 105,0°C

n Instrumente cu 384 de godeuri – 95,0°C

Puteți modifica setările implicite sau opri încălzitorul capacului în funcție de cerințele protocolului.

Pentru a ajusta temperatura capacului

1. În fereastra Plate Editor (Editor placă), selectați Settings > Lid Settings (Setări > Setări capac).

Apare caseta de dialog Lid Settings (Setări capac).

2. Urmați una dintre procedurile următoare:

n Selectați User Defined (Definite de utilizator) și introduceți o valoare de temperatură în
caseta de text.

n Selectați Turn Off Lid Heater (Oprire încălzitor capac).

3. Faceți clic pe OK pentru a accepta modificările și a închide caseta de dialog.

Setarea volumului probei

Implicit, CFX Maestro Dx SE setează volumul probei pentru fiecare godeu la 25 µl. Volumele probelor
diferă în funcție de tipul de bloc, de exemplu:

n 0-50 µl pentru un bloc de 96 de godeuri

n 0-30 µl pentru un bloc de 384 de godeuri
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Instrumentul utilizează unul din două moduri de control al temperaturii pentru a determina când
ajunge proba la temperatura țintă într-un protocol:

n Calculated mode (Mod calculat) – atunci când volumul probei este setat la un volum diferit de
zero corespunzător pentru bloc, instrumentul calculează temperatura probei pe baza volumului
probei. Acesta este modul standard.

n Block mode (Mod bloc) – atunci când volumul probei este setat la zero (0) µl, instrumentul
înregistrează temperatura probei ca fiind aceeași cu temperatura măsurată a blocului.

Pentru a seta volumul probei pentru un bloc specific

u În fereastra Plate Editor (Editor placă), introduceți valoarea corectă în caseta de text Sample
Volume (Volum probă) de pe bara de instrumente.

Sfat: Puteți modifica volumul probei implicit în caseta de dialog User Preferences (Preferințe
utilizator). Consultați Schimbarea setărilor implicite ale fișierelor de la pagina 83.

Adăugarea de pași la un protocol
Pentru a adăuga un pas la un protocol

1. Deschideți protocolul în fereastra Protocol Editor (Editor Protocol).

2. Stabiliți unde doriți să inserați noul pas. Pe bara de instrumente, selectați Before (Înainte) sau
After (După) din lista verticală Step (Pas).

3. În grafic, selectați pasul înainte sau după care intenționați să inserați noul pas.

4. În panoul din stânga, faceți clic pe Insert Step (Inserare pas).

5. Pentru a modifica temperatura sau timpul de așteptare, faceți clic pe valoarea implicită din grafic
sau schița protocolului și tastați o valoare nouă.

6. (Opțional) În panoul din stânga, faceți clic pe Step Options (Opțiuni pași) pentru a deschide
caseta de dialog Step Options (Opțiuni pași) și pentru a modifica opțiunile disponibile pentru
pasul selectat.

Sfat: Puteți accesa caseta de dialog Step Options (Opțiuni pași) din meniul clic dreapta al
panoului graficului sau al panoului schiței protocolului.

7. Faceți clic pe OK și apoi pe Yes (Da) pentru a salva modificările protocolului.

Va apărea caseta de dialog Save As (Salvare ca).

8. În caseta de dialog Save As (Salvare ca), tastați denumirea noului fișier de protocol și faceți clic
pe Save (Salvare).
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Inserarea unui pas de gradient
Pentru a insera un pas de gradient

1. Verificați că dimensiunea plăcii pentru gradient este aceeași cu tipul de bloc al instrumentului, cu
96 de godeuri sau cu 384 de godeuri.

2. Dacă încă nu ați procedat astfel, selectați dimensiunea plăcii pentru gradient:

Selectați Tools > Gradient Calculator (Instrumente > Calculator gradient) și selectați tipul de
godeu corespunzător din lista verticală.

3. Pe bara de instrumente, selectați Before (Înainte) sau After (După) din lista verticală Insert Step
(Inserare pas).

4. În grafic sau în panoul de schiță, selectați pasul înainte sau după care intenționați să inserați
pasul de gradient.

5. În panoul din stânga, faceți clic pe Insert gradient (Inserare gradient). Noul pas de gradient este
evidențiat în grafic și în panoul de schiță, de exemplu:

Temperatura fiecărui rând din gradient apare în tabelul Gradient în panoul din dreapta.
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6. Pentru a edita intervalul de temperatură pentru gradient, efectuați una dintre următoarele:

n Faceți clic pe temperatura implicită în grafic sau panoul de schiță și introduceți o temperatură
nouă.

n Faceți clic pe Step Options (Opțiuni Pas) pentru a introduce intervalul de gradient în fereastra
Step Options (Opțiuni Pas).

n Schimbați valoarea pentru Range (Interval) în tabelul Gradient.

7. Pentru a edita timpul de menținere, faceți clic pe timpul implicit din vizualizarea grafică sau text și
introduceți un timp nou.

8. Faceți clic pe OK și apoi pe Yes (Da) pentru a salva modificările.

Inserarea unui pas GOTO (SaltLa)
Notă: Nu puteți insera un pas GOTO (SaltLa) într-un set GOTO (SaltLa); nu puteți crea bucle
GOTO (SaltLa) imbricate.

Pentru a insera un pas GOTO (SaltLa)

1. Pe bara de instrumente, selectați Before (Înainte) sau After (După) din lista verticală Insert Step
(Inserare pas).

2. În grafic, selectați pasul înainte sau după care intenționați să inserați pasul GOTO (SaltLa).

3. În panoul din stânga, faceți clic pe Insert GOTO (Inserare SaltLa).

4. Pentru a edita numărul pasului GOTO (SaltLa) sau numărul de repetări GOTO (SaltLa), selectați
numărul implicit din grafic sau din panoul de schiță și introduceți o valoare nouă.

5. Faceți clic pe OK și apoi pe Yes (Da) pentru a salva modificările.

Inserarea unui pas de curbă de topire
Sfat: Nu puteți insera un pas de curbă de topire într-o buclă GOTO (SaltLa).

Notă: Pasul de curbă de topire include o menținere de 30 de secunde la începutul pasului, care
nu este afișată în protocol.

Pentru a insera un pas de curbă de topire

1. Pe bara de instrumente, selectați Before (Înainte) sau After (După) din lista verticală Insert Step
(Inserare pas).

2. În grafic, selectați pasul înainte sau după care intenționați să inserați pasul de curbă de topire.
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3. În panoul din stânga, faceți clic pe Insert Melt Curve (Inserare curbă de topire). Noul pas de curbă
de topire este evidențiat în grafic și în panoul de schiță, de exemplu:

4. Pentru a edita intervalul de temperatură de topire sau timpul de increment, selectați numărul
implicit în grafic sau în panoul de schiță și introduceți o valoare nouă.

5. Faceți clic pe OK și apoi pe Yes (Da) pentru a salva modificările.
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Adăugarea sau eliminarea unui pas de citire placă
Sfat: După ce adăugați o comandă de citire placă unui pas, butonul se schimbă în Remove Plate
Read (Eliminare citire placă) atunci când selectați pasul.

Pentru a adăuga o citire de placă la un pas

1. Pe bara de instrumente, selectați Before (Înainte) sau After (După) din lista verticală Insert Step
(Inserare pas).

2. În grafic, selectați pasul înainte sau după care intenționați să inserați pasul de citire placă.

3. În panoul din stânga, faceți clic pe Add Plate Read to Step (Adăugare citire placă la pas) pentru a
adăuga o citire de placă la pasul selectat.

4. Faceți clic pe OK și apoi pe Yes (Da) pentru a salva modificările.

Pentru a elimina o citire de placă dintr-un pas

u În grafic, selectați pasul care conține citirea de placă și faceți clic pe Remove Plate Read
(Eliminare citire placă) în panoul din stânga.

Modificarea opțiunilor pașilor
Pentru a modifica opțiunile pașilor pentru un pas selectat

1. Selectați pasul țintă în grafic sau în panoul de schiță.

2. În panoul din stânga, faceți clic pe Step Options (Opțiuni pași) pentru a deschide caseta de dialog
Step Options (Opțiuni pași).

Ca alternativă, faceți clic dreapta pe pasul țintă în oricare panou și selectați Step Options (Opțiuni
pași) în meniul care apare.

3. Pentru a adăuga, modifica sau elimina opțiuni:

n Introduceți o valoare în caseta de text corespunzătoare.

n Editați o valoare în caseta de text specifică.

n Bifați sau debifați o casetă de selectare.

4. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog Step Options (Opțiuni
pași).

5. Faceți clic pe OK și apoi pe Yes (Da) pentru a salva protocolul.
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Ștergerea unui pas
Important: Această funcție nu poate fi anulată. Procedați cu atenție când ștergeți pași.

Pentru a șterge un pas din protocol

1. Selectați pasul în grafic sau în panoul de schiță.

2. În panoul din stânga, faceți clic pe Delete Step (Ștergere pas) pentru a șterge pasul selectat.

3. Faceți clic pe OK și apoi pe Yes (Da) pentru a salva protocolul.

Copierea, exportarea sau imprimarea unui protocol
Pentru a copia un protocol

u Faceți clic dreapta pe schița protocolului și selectați Copy Protocol (Copiere protocol).

Puteți lipi schița într-un fișier .txt, .xls, .doc sau .ppt.

Pentru a exporta un protocol

1. Faceți clic dreapta pe schița protocolului și selectați Export Protocol (Exportare protocol).

Va apărea caseta de dialog Save As (Salvare ca).

2. (Opțional) În Windows Explorer, navigați la un folder în care doriți să salvați fișierul protocolului.

3. În File name (Denumire fișier), introduceți o denumire pentru fișierul de protocol exportat.

4. Faceți clic pe Save (Salvare).

Pentru a imprima un protocol

u Faceți clic dreapta pe schița protocolului și selectați Print (Imprimare).

Puteți imprima schița protocolului utilizând imprimanta dvs. implicită.
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Crearea unui protocol cu Protocol AutoWriter (Utilitar de
scriere automată protocol)

Important: Bio-Rad nu garantează că rularea unui protocol creat cu Protocol AutoWriter (Utilitar
de scriere automată protocol) va determina întotdeauna un produs PCR.

Utilitarul Protocol AutoWriter (Utilitar de scriere automată protocol) al CFX Maestro Dx SE generează
automat protocoale de ciclu bazate pe următorii parametri de intrare:

n Amplicon length (Lungime amplicon) – lungimea așteptată a produsului PCR

n Annealing temperature (Temperatură de atașare) – Ta de reacție pentru primerii utilizați

Dacă Ta este necunoscută, puteți utiliza calculatorul Ta pentru a o calcula automat pe baza
secvențelor de primer.

Notă: Ta este ajustată pe baza informațiilor privind temperatura de topire a primerului (Tm),
care se bazează pe enzima selectată și pe viteza protocolului.

n Enzyme type (Tip de enzimă) – enzima DNA (ADN) polimerază (iTaq, iProof DNA (ADN)
polimerază sau Other (Alta))

Dacă utilizați o altă enzimă decât iTaq sau iProof DNA (ADN) polimerază, puteți introduce
informații suplimentare, inclusiv intervalul de gradient, timpul de activare la pornirea la cald (în
sec) și timpul de extensie finală (în sec).

n Run speed (Viteza de rulare) – viteza de reacție (standard, rapid sau ultrarapid)

Utilitarul Protocol AutoWriter (Utilitar de scriere automată protocol) optimizează protocolul în
funcție de setarea selectată pentru viteză. Timpul de rulare total este determinat de numărul de
pași și de cicluri, de timpul de incubare la fiecare pas și de timpul necesar pentru atingerea
uniformității la temperatura țintă.

Utilizând parametrii introduși de dumneavoastră și ghidul standard pentru PCR, Protocol AutoWriter
(Utilitar de scriere automată protocol) generează automat un protocol PCR personalizat cu pași
pentru start fierbinte, denaturare inițială, atașare și extensie. Puteți apoi să vizualizați o reprezentare
grafică a protocolului sugerat și să editați, rulați sau salvați protocolul.
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Pentru a crea un nou protocol utilizând utilitarul Protocol AutoWriter (Utilitar de scriere
automată protocol) al CFX Maestro Dx SE

1. În fereastra Home (Pagină de pornire), selectați Tools > Protocol AutoWriter (Instrumente > Utilitar
de scriere automată protocol).

Apare caseta de dialog Protocol AutoWriter (Utilitar de scriere automată protocol).

2. În secțiunea Enter Target Values/Enzyme (Introducere valori țintă/enzimă), procedați după cum
urmează:

n Introduceți temperatura de atașare (Ta) pentru primeri, dacă este cunoscută.

Sfat: Consultați Utilizarea Ta Calculator (Calculator Ta) de la pagina 114 pentru mai
multe informații.

Notă: Pentru informații despre calculele utilizate în Ta Calculator (Calculator Ta),
consultați Breslauer et al. 1986.

n Introduceți lungimea ampliconului în perechi de baze (pb).

n Selectați un tip de enzimă din lista de opțiuni (iTaq DNA (ADN) polimerază, iProof DNA
(ADN) polimerază sau Other (Alta)).

Sfat: Dacă selectați Other (Alta) ca tip de enzimă, parametrii din secțiunea Additional
Parameters (Optional) (Parametri suplimentari (Opțional)) devin activi.
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3. Dacă ați selectat Other (Alta) ca tip de enzimă, puteți adăuga oricare dintre sau toți parametrii
următori la protocol:

n Gradient range (Interval de gradient)

n Hot start activation temperature (Temperatură de activare pentru pornirea la cald)

n Final extension time (Timp de extensie finală)

4. În secțiunea Type (Tip), deplasați cursorul pentru a selecta o viteză de protocol (Standard, Fast
(Rapid) sau Ultrafast (Ultrarapid)). CFX Maestro Dx SE reglează timpul total.

5. Selectați tipul de PCR de efectuat (Real-time PCR (PCR în timp real) este opțiunea implicită).

În cazul PCR în timp real, CFX Maestro Dx SE adaugă un pas de citire placă pentru colectarea de
date de fluorescență.

6. În secțiunea Preview (Previzualizare), revizuiți protocolul. Puteți efectua modificări în funcție de
necesități.

7. Urmați una dintre procedurile următoare:

n Faceți clic pe OK pentru a salva noul protocol. După ce a fost salvat, protocolul se deschide
în Startup Wizard (Expert pornire). Faceți clic pe Edit Selected (Editare selectate) pentru a
aduce orice modificări protocolului. De exemplu, ați putea avea nevoie să schimbați
temperatura capacului și volumul probei.

n Faceți clic pe Cancel (Anulare) pentru a închide fereastra fără a salva protocolul.

Utilizarea Ta Calculator (Calculator Ta)
Atunci când nu cunoașteți temperatura de atașare pentru primer, puteți folosi Ta Calculator (Calculator
Ta) pentru a calcula valoarea. Puteți folosi valoarea din Protocol AutoWriter (Utilitar de scriere
automată protocol) sau din Protocol Editor (Editor protocol) pentru a vă crea protocolul.

Despre Ta Calculator (Calculator Ta)
Ta Calculator (Calculator Ta) calculează valoarea Tm pentru fiecare primer, precum și valoarea Ta
pentru protocol la viteză standard.

Valoarea Ta pentru protocol este bazată pe valorile medii Tmale primerului, aplicându-se următoarele
reguli:

n Dacă diferența dintre valorile Tm ale primerului este > 4°C, Ta = (valoarea cea mai mică dintre
cele două valori Tm ale primerului + 2) – 4 °C

n Dacă diferența dintre valorilem este ≤4 °C, Ta = (media valorilor Tm ale primerului) – 4 °C
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Metoda numărării perechilor de baze

Pentru fiecare primer, Ta Calculator (Calculator Ta) utilizează metoda numărării perechilor de baze
pentru secvențe de maximum 14 perechi de baze (pb).

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

unde w, x, y și z sunt numerele bazelor A, T, G, respectiv C din secvență.

Metoda Cel mai apropiat vecin

Pentru secvențe mai lungi de 14 bp, se utilizează metoda cu cel mai apropiat vecin. În metoda cu cel
mai apropiat vecin, calculele pentru temperatura de topire sunt bazate pe relația termodinamică dintre
entropie (ordine sau o măsură a caracterului aleatoriu al oligonucleotidei), entalpie (căldură eliberată
sau absorbită de oligonucleotidă), energie liberă și temperatură.

∆H = ∆G + T* ∆S

unde:

n ∆H = Valoare entalpie, Cal/Mol*K

n T = temperatură, Kelvin

n ∆S = Valoare entropie, Cal/Mol*K

n ∆G = Energie liberă Gibbs în Cal/Mol*K

Schimbarea entropiei și entalpiei este calculată direct însumând valorile pentru perechile de
nucleotide afișate în Tabelul 7 (Breslauer et al. 1986).

Relația dintre energia liberă și concentrația de reactanți și produse la echilibru este dată de:

∆G = R*T*ln ((ADN * Primer)/(ADN + Primer))

unde R este constanta gazoasă (1,986 Cal/Mol*K).

Prin substituirea G în cele două ecuații și rezolvarea pentru T rezultă

T = ∆H/(∆S + R*Ln((ADN * Primer)/(ADN + Primer)))

presupunând că concentrațiile pentru ADN și complexul ADN-primer sunt egale.

S-a determinat în mod empiric faptul că există o schimbare de energie liberă de 5 kcal (3,4 kcal)
(Sugimoto et al. 1996) în timpul tranziției de la ADN cu catenă unică la ADN de formă B. Aceasta se
presupune a fi energie de inițializare a helixului. La final, adăugarea unei ajustări pentru sare dă
ecuația pe care o utilizează Ta Calculator (Calculatorul Ta):

T = (∆H – 5(KCal/K*Mol))/(∆S + (R * ln(1/(primer)))) + 16,6 log10 (MolaritateSare)
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Nicio constantă de ajustare pentru concentrația de sare nu este necesară, deoarece diverșii parametri
au fost determinați la 1 M NaCl, iar log10 de 1 este zero.

Calculele termodinamice presupun că procesul de atașare are loc la pH 7,0. Calculele pentru Tm
presupun că secvențele nu sunt simetrice și conțin cel puțin un G sau C.

Secvența de oligonucleotidă trebuie să fie la o lungime de cel puțin 14 baze pentru a oferi valori Tm
rezonabile. Mai puțin de 14 baze utilizează aceeași metodă de numărare a perechilor de baze
(consultați Tabelul 7 care urmează).

Interacțiune ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

Tabelul 7. Constante de interacțiune Breslauer
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Utilizarea Ta Calculator (Calculator Ta)

Pentru a utiliza Ta Calculator (Calculator Ta)

1. Pentru a deschide Ta Calculator (Calculator Ta), urmați una dintre procedurile următoare:

n Dacă momentan vă aflați în Protocol AutoWriter (Utilitar de scriere automată protocol), faceți
clic pe Ta Calculator (Calculator Ta).

n În fereastra Home (Pagină de pornire), selectați Tools > Ta Calculator (Instrumente >
Calculator Ta).

Va apărea caseta de dialog Ta Calculator (Calculator Ta).

2. În caseta de dialog Forward Primer (înaintare primer), tastați sau lipiți secvența de înaintare a
primerului.

Sfat: Puteți, de asemenea, folosi butoanele A, T, G, C din partea stângă a casetei de dialog
pentru a introduce secvența.

3. Tastați sau lipiți secvența de retur a primerului în caseta de text Reverse Primer (retur primer).

4. Faceți clic pe Calculate (Calculare).
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Ta Calculator (Calculator Ta) calculează și afișează Tm pentru fiecare primer și media Tm și
valorile Ta, de exemplu:

Dacă valorile Tm ale primerului diferă între ele cu mai mult de 4°C, Protocol AutoWriter (Utilitar de
scriere automată protocol) folosește valoarea Tm mai mică a primerului + 2 °C ca bază de calcul
pentru valoarea Ta, pe care o puteți modifica ulterior prin modificarea enzimei și a vitezei de
reacție.

Ta Calculator (Calculator Ta) generează o temperatură de atașare pentru viteza standard cu
polimeraza ADN iTaq. Dacă se folosește o altă enzimă, setările de viteză se ajustează automat
Ta.

5. Urmați una dintre procedurile următoare:

n Dacă ați deschis Ta Calculator (Calculator Ta) din Protocol AutoWriter (Utilitar de scriere
automată protocol), faceți clic pe OK. Reveniți la Protocol AutoWriter (Utilitar de scriere
automată protocol). Temperatura de atașare este modificată automat.

n Dacă ați deschis Ta Calculator (Calculator Ta) din meniul Tools (Instrumente), înregistrați
calculele și faceți clic pe Cancel (Anulare) pentru a închide calculatorul.
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Un fișier placă conține informații despre parametrii rulării, precum modul de scanare, fluoroforii și
conținutul godeului. După rulare, Software-ul CFX Maestro Dx SE asociază conținutul godeurilor cu
datele de fluorescență colectate în timpul protocolului și aplică analiza corespunzătoare în fereastra
Data Analysis (Analiză date). De exemplu, godeurile încărcate cu probă de tip standard sunt utilizate
pentru a genera o curbă standard.

CFX Maestro Dx SE oferă două opțiuni pentru crearea plăcilor: Plate Editor (Editorul de plăci) pentru
rulările PCR în timp real și Setup Wizard (Expertul de configurație) pentru analiza normalizată a
expresiei genice.

Plate Editor (Editor placă) include următoarele funcții:

n Fluorofori standard și tipuri de probe ce vor fi atribuite godeurilor plăcii

n Capacitatea de a configura țintă de referință și probă de control pentru analiza expresiei genice

n Capacitatea de a edita configurația plăcii înainte, în timpul sau după finalizarea unei rulări

n Capacitatea de a salva fișierele placă pentru reutilizare

n Capacitatea de a imprima fișierul placă la o imprimantă implicită

Setup Wizard (Expert configurație) vă asistă la crearea unei structuri de placă pentru analiza expresiei
genice normalizate. Puteți folosi Setup Wizard (Expert configurație) înainte, în timpul sau după
finalizarea unei rulări.
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Fereastra Plate Editor (Editor placă)
Utilizați Plate Editor (Editor placă) pentru a crea plăci personalizate sau modifica plăcile existente.

1. Bara de meniu furnizează acces rapid la comenzile de meniu File (Fișier) și Settings (Setări),
precum și la opțiunile de instrumente de editare pentru placă.

2. Bara de instrumente oferă acces rapid la funcții de încărcare de placă importante.

3. Panoul principal afișează schița plăcii și opțiunile de placă atunci când le aplicați.

4. Panoul din dreapta afișează opțiuni pe care le utilizați pentru a vă personaliza placa.

5. Panoul de jos afișează tipul de placă și oferă acces rapid la opțiunile de vizualizare.

LEGENDĂ

Comenzile meniului File (Fișier)
Save (Salvare) – salvează fișierul de date de placă în locația specificată în fila File (Fișier) din caseta
de dialog User Preferences (Preferințe utilizator). Consultați Schimbarea setărilor implicite ale
fișierelor de la pagina 83 pentru mai multe informații. Acest element de meniu este disponibil numai la
crearea unui fișier de placă nou.

Save As (Salvare ca) – salvează fișierul de date de placă deschis cu un nume nou pe care îl furnizați
dumneavoastră Acest element de meniu este disponibil numai la crearea unui fișier de placă nou.
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File Passwords (Parole fișier) - permite utilizatorilor să-și seteze parolele de salvare și deschidere a
fișierelor.

Extract Plate (Extragere placă) – deschide o casetă de dialog în care puteți extrage/salva fișierul de
placă (.pltd). Acest element de meniu este disponibil numai la vizualizarea sau editarea unui fișier de
placă existent.

Print (Imprimare) – imprimă fișierul de date de placă deschis.

Close (Închidere) – închide Plate Editor (Editor placă)

Comenzile meniului Edit (Editare)
Undo (Anulare) – anulează o modificare dintr-un fișier placă înainte ca fișierul placă să fie salvat.

Redo (Refacere) – anulează cea mai recentă acțiune de anulare dacă fișierul placă nu a fost salvat.

Comenzile meniului Settings (Setări)
Plate Size (Dimensiune placă) – deschide o casetă de dialog din care puteți selecta o dimensiune a
plăcii pentru rulare.

Notă: Dimensiunea plăcii trebuie să fie aceeași cu dimensiunea blocului de pe instrumentul
pe care se realizează rularea. Alegeți 384-well (384 de godeuri) pentru sistemul CFX Opus
384 Dx sau 96-well (96 de godeuri) pentru
sistemul CFX Opus 96 Dx.

Plate Type (Tipul plăcii) – vă permite să alegeți tipul godeurilor din placa cu probele dumneavoastră,
fie BR White (BR Alb), fie BR Clear (BR Transparent). Pentru o analiză de date precisă, tipul de placă
selectat trebuie să corespundă cu tipul de placă utilizat în rulare.

Notă: Trebuie să calibrați noile tipuri de placă. Consultați Calibrarea de noi coloranți de la
pagina 76 pentru mai multe informații.

Number Convention (Convenție numerică) – vă permite să bifați sau să debifați opțiunea de afișare
a unităților în notație științifică. Opțiunea implicită este afișarea unităților în notație științifică.

Units (Unități) – vă permite să alegeți unitățile de afișat în foile de calcul atunci când efectuați
cuantificarea unei curbe necunoscute vs. una standard.

Comenzile meniului Editing Tools (Instrumente de editare)
SetupWizard (Expert configurație) – deschide Setup Wizard (Expert configurație), în care puteți
defini parametrii de structură și analiză pentru placa actuală. Puteți folosi Setup Wizard (Expert
configurație) înainte de, în timpul sau după finalizarea unei rulări.
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Spreadsheet View/Importer (Vizualizare/importare foaie de calcul) – deschide caseta de dialog
View (Vizualizare), care afișează structura de placă drept matriță în format de foaie de calcul. Puteți
utiliza această casetă de dialog pentru a exporta sau importa datele de matriță de placă în format .csv.

Flip Plate (Întoarcere placă) – întoarce conținutul plăcii la 180o.

Comenzi bară de instrumente

Revine asupra schimbării unei plăci.CFX Maestro Dx SE acceptă până la
zece acțiuni de anulare

Inversează cea mai recentă acțiune Undo (Anulare). CFX Maestro Dx SE
acceptă până la zece acțiuni de refacere.

Salvează fișierul de placă actual.

Afișează o listă verticală din care puteți crește sau reduce mărirea
vizualizării plăcii.

Afișează o listă verticală din care puteți selecta un mod de scanare, care
dă instrucțiuni instrumentului din ce canale să colecteze date de
fluorescență în timpul unei rulări.

Deschide fereastra Well Groups Manager (Manager grupuri de godeuri),
pe care o puteți utiliza pentru a crea grupuri de godeuri pentru placa
actuală.

Afișează o casetă de dialog în care puteți alege culorile și simbolurile
pentru urmele de amplificare.

Deschide caseta de dialog View (Vizualizare), care afișează structura de
placă drept matriță într-un format de foaie de calcul. Puteți utiliza această
casetă de dialog pentru a exporta sau importa datele de matriță de placă
în format .csv.

Deschide Setup Wizard (Expert configurație), unde puteți defini
parametrii de structură și analiză pentru placa actuală. Puteți folosi Setup
Wizard (Expert configurație) înainte, în timpul sau după finalizarea unei
rulări.

Deschide fila Plate (Placă) în caseta de dialog User Preferences
(Preferințe utilizator), în care puteți defini parametrii pentru structura
dumneavoastră de placă și puteți crea sau șterge denumiri de țintă, probă
și grup biologic. Schimbările pe care le efectuați în fila Plate (Placă) sunt
disponibile data viitoare când deschideți Plate Editor (Editor placă).

Afișează pașii necesari pentru configurația unei plăci și încărcarea
godeurilor.
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Crearea unui fișier placă utilizând Plate Editor (Editor placă)
Utilizând Plate Editor (Editor placă), puteți crea fișiere placă particularizate. Puteți, de asemenea,
edita și salva fișiere placă salvate anterior sau fișiere placă de probă livrate împreună cu Sistemul
CFX Opus Dx.

Pentru a crea un nou fișier placă, procedați în felul următor:

n Deschideți un fișier placă în Plate Editor (Editor placă).

n Selectați tipul plăcii.

Notă: Tipul plăcii pentru fișierul placă trebuie să fie același cu tipul de placă din modulul de
reacție.

n Selectați modul de scanare care va fi utiliza în protocol.

n Selectați fluoroforii care vor fi utilizați în placă.

n Selectați tipul probei, țintele și probele.

n Selectați replicatele tehnice, dacă este cazul.

n Salvați structura plăcii.

Sfat: Pentru a crea o placă nouă din fișiere placă salvate anterior sau probă, consultați
Deschiderea unui fișier placă existent în Plate Editor (Editor placă) de la pagina 125.

Deschiderea unui fișier placă nou în Plate Editor (Editor placă)
CFX Maestro Dx SE oferă mai multe opțiuni de deschidere a unui nou fișier de placă:

n Din fereastra Home (Pagină de pornire)

n Din caseta de dialog Startup Wizard (Expert pornire)

n Din caseta de dialog Run Setup (Configurare rulare)

Pentru a deschide un nou fișier de placă din fereastra Home (Pagină de pornire)

u Selectați File > New Plate (Fișier > Placă nouă).

Fereastra Plate Editor (Editor placă) se deschide afișând fișierul de placă implicit pentru
instrumentul selectat.

Sfat: Pentru informații despre setarea fișierului dumneavoastră implicit de placă, consultați
Schimbarea setărilor implicite ale fișierelor de la pagina 83.
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Pentru a deschide un nou fișier de placă din Startup Wizard (Expert pornire)

1. În fereastra Home (Pagină de pornire), urmați una dintre procedurile următoare pentru a
deschide Startup Wizard (Expert pornire) dacă nu apare în vizualizare:

n Selectați View > Startup Wizard (Vizualizare > Expert pornire).

n Faceți clic pe Startup Wizard (Expert pornire) de pe bara de instrumente.

Implicit, Startup Wizard (Expert pornire) afișează fila Run Setup (Configurare rulare) cu
instrumentul CFX96 selectat.

2. Dacă este necesar, selectați tipul de instrument din lista verticală.

3. Pentru a crea o placă nouă, faceți clic pe User-defined (Definit de utilizator) ca tip de rulare.

Se va deschide caseta de dialog Run Setup (Configurare rulare) care afișează fila Protocol.

4. Faceți clic pe fila Plate (Placă) și faceți clic pe Create New (Creare nou).

Fereastra Plate Editor (Editor placă) se deschide afișând structura de placă implicită pentru
instrumentul selectat.

Pentru a deschide un nou fișier de placă din caseta de dialog Run Setup (Configurare
rulare)

1. În fereastra Home (Pagină de pornire), urmați una dintre procedurile următoare pentru a
deschide caseta de dialog Run Setup (Configurare rulare):

n Selectați Run > User-defined Run (Rulare > Rulare definită de utilizator).

n Faceți clic pe User-defined Run Setup (Configurare rulare definită de utilizator) de pe bara
de instrumente.

Se va deschide caseta de dialog Run Setup (Configurare rulare) în fila Protocol.

2. Pentru a crea o placă nouă, faceți clic pe fila Plate (Placă) și faceți clic pe Create New (Creare
nou).

Fereastra Plate Editor (Editor placă) se deschide afișând structura de placă implicită pentru
instrumentul selectat.
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Deschiderea unui fișier placă existent în Plate Editor (Editor
placă)
CFX Maestro Dx SE furnizează fișiere de placă probă pe care le puteți edita și salva ca o placă nouă.
De asemenea, puteți crea un fișier de placă nou dintr-un fișier de placă salvat.

Pentru a deschide un fișier de placă probă

1. În fereastra Home (Pagină de pornire), selectați File > Open > Plate (Fișier > Deschidere > Placă).

Windows Explorer (funcția Căutare) deschide locația folderului Sistemul CFX Opus Dx Sample
files (Fișiere probă).

2. Deschideți folderul Sample files (Fișiere probă), apoi deschideți folderul Plates (Plăci).

3. Selectați un fișier placă și faceți clic pe Open (Deschidere).

Fișierul de placă probă se deschide în fereastra Plate Editor (Editor placă).

4. Selectați File > Save As (Fișier > Salvare ca) și salvați fișierul de placă cu o denumire nouă sau
într-un folder nou.

Pentru a deschide un fișier de placă salvat anterior

1. În fereastra Home (Pagină de pornire), efectuați una dintre următoarele:

n Selectați File > Open > Plate (Fișier > Deschidere > Placă), navigați la și selectați placa țintă
și faceți clic pe Open (Deschidere).

n Deschideți Startup Wizard (Expert pornire) și efectuați una dintre următoarele:

o Pentru a edita un fișier de placă existent, faceți clic pe Select Existing (Selectare
existent) și navigați la fișierul țintă.

o Pentru a edita fișierul de placă afișat, faceți clic pe Edit Selected (Editare selectate).

Fișierul de placă țintă se deschide în fereastra Plate Editor (Editor placă).

2. Selectați File > Save As (Fișier > Salvare ca) și salvați fișierul de placă cu o denumire nouă sau
într-un folder nou.
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Configurația unui fișier de placă nou
Sfat: Dacă fișierul dumneavoastră de placă include parametrii necesari (de exemplu, dacă editați
un fișier de probă sau un fișier de placă existent), puteți omite această secțiune. Continuați cu
Atribuirea de parametri opționali fișierului placă de la pagina 133.

Noile fișiere de placă necesită următorii parametri:

n Dimensiune placă

n Tip de placă

n Mod de scanare

n Un fluorofor (colorant)

n Un tip de probă

Selectarea dimensiunii și tipului plăcii

Important: Trebuie să selectați o dimensiune de placă în timpul configurației plăcii. Nu puteți
modifica dimensiunea plăcii în timpul sau după o rulare.

Software-ul aplică dimensiunea și tipul plăcii tuturor godeurilor în timpul rulării. Asigurați-vă că
dimensiunea de placă selectată este aceeași cu cea a plăcii pe care o veți utiliza în rulare.

Sistemele CFX Opus 96 Dx și CFX Opus 384 Dx ale Bio-Rad sunt calibrate din fabrică pentru multe
combinații de vopsea fluorescentă și plăci. Calibrarea este specifică instrumentului, colorantului și
tipului de placă. Asigurați-vă că fluoroforul pe care intenționați să îl utilizați este calibrat pentru tipul de
placă selectat.

Sfat: Pentru a calibra o combinație nouă de colorant și tip de placă pe un instrument, selectați
Tools > Calibration Wizard (Instrumente > Expert calibrare). Pentru informații despre calibrarea
coloranților și a tipurilor de plăci, consultați Calibrarea de noi coloranți de la pagina 76.

Selectarea modului de scanare

Sistemele CFX Opus 96 Dx și sistemele CFX Opus 384 Dx excită și detectează fluoroforii în șase și
respectiv cinci canale. Ambele sisteme folosesc moduri multiple de scanare a datelor obținute, pentru
a colecta date privind fluorescența din timpul unei rulări.

CFX Maestro Dx SE oferă trei moduri de scanare:

n Toate canalele

o Scanează canalele de la 1 la 5 pe sistemele CFX Opus 96 Dx

o Scanează canalele de la 1 la 4 pe sistemele CFX Opus 384 Dx
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n SYBR®/FAM

o Scanează doar canalul 1

o Oferă o scanare rapidă

n FRET

o Scanează doar canalul FRET

o Oferă o scanare rapidă

Selectarea fluoroforilor

Important: Înainte de a iniția o rulare, Sistemul CFX Opus Dx verifică dacă fluoroforii pe care i-ați
specificat în placă sunt calibrați pe instrumentul respectiv. Nu puteți rula o placă dacă include
fluorofori care nu au fost calibrați pe instrumentul respectiv.

Trebuie să încărcați cel puțin un fluorofor în structura plăcii înainte de rulare. Puteți adăuga câți
fluorofori sunt necesari în acest moment, însă placa trebuie să conțină cel puțin un fluorofor.
Fluoroforii selectați apar ca opțiuni pentru țintele din Target Names (Denumiri ținte).

Puteți folosi caseta de dialog Select Fluorophores (Selectare fluorofori) pentru a încărca fluorofori (sau
coloranți placă) în comenzile de încărcare a godeurilor din Plate Editor (Editor placă). Fluoroforii care
apar în caseta de dialog Select Fluorophores (Selectare fluorofori) depind de modul de scanare
selectat:

n Toate canalele

Apar toți fluoroforii disponibili.

Sfat: Puteți adăuga oricâți fluorofori trebuie, însă puteți încărca doar un fluorofor per canal în
fiecare godeu.

n SYBR®/FAM

Vor apărea doar fluoroforii din canalul 1.

n FRET

Va apărea doar fluoroforul din canalul 6.

Sfat: Fluoroforul din canalul 6 FRET apare doar când modul de scanare selectat este FRET.
Nu este disponibil pentru modul de scanare All Channels (Toate canalele).

Notă: Nu puteți adăuga sau îndepărta fluorofori direct din caseta de dialog Select Fluorophore
(Selectare fluorofor). Trebuie să calibrați noii fluorofori pe un instrument utilizând Calibration
Wizard (Expert calibrare). După calibrare, noul fluorofor este adăugat automat pe această listă.
Pentru mai multe informații, consultați Calibrarea de noi coloranți de la pagina 76.
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Selectarea tipurilor de probe

Important: Trebuie să selectați cel puțin un tip de probă pe care să îl atribuiți godeurilor plăcii
înainte de rulare.

CFX Maestro Dx SE oferă cinci tipuri de probă:

n Unknown (Necunoscută)

n Eroare

n NTC (control fără țintă de amplificare)

n Positive Control (Control pozitiv)

n Negative Control (Control negativ)

n NRT (fără transcriptază inversă)

Atribuiți tipurile de probe godeurilor plăcii.

Configurația unei plăci noi

Pentru a configura o placă nouă

1. Deschideți o placă nouă în fereastra Plate Editor (Editor placă).

2. Pentru a seta dimensiunea plăcii, selectați Settings > Plate Size (Setări > Dimensiune placă) și
selectați dimensiunea corespunzătoare a plăcii din meniul vertical.

3. Pentru a seta tipul plăcii, selectați Settings > Plate Type (Setări > Tip de placă) și selectați fie BR
White (Alb), fie BR Clear (Transparent) din meniul vertical.

4. Opțional, din meniul Settings (Setări), puteți schimba convenția numerică și unitățile de afișare:

n Pentru a schimba convenția numerică, selectați Settings > Number Convention (Setări >
Convenție numerică) și selectați Scientific Notation (Notație științifică).

Sfat: Scientific Notation (Notație științifică) este selectată implicit. În acest caz, selectarea
Scientific Notation (Notație științifică) anulează selecția implicită și setează convenția
numerică la forma standard.

n Pentru a schimba unitățile de afișare, selectați Settings > Units (Setări > Unități) și selectați o
nouă valoare pentru unitate.

5. Pentru a configura modul de scanare, selectați modul de scanare corespunzător din lista verticală
Scan Mode (Mod de scanare) de pe bara de instrumente a ferestrei Plate Editor (Editor placă).
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6. Selectați fluoroforii necesari pentru placă:

a. În panoul din dreapta, faceți clic pe Select Fluorophores (Selectare fluorofori).

Va apărea caseta de dialog Select Fluorophores (Selectare fluorofori). Veți vedea fluoroforii
disponibili pentru tipul modului de scanare selectat de dumneavoastră la Pasul 5, de
exemplu:

b. Pentru a selecta un fluorofor, faceți clic pe caseta sa de selectare Selected (Selectat).

Sfat: Pentru a elimina un fluorofor din listă, debifați-i caseta de selectare Selected
(Selectat).

c. Pentru a modifica culoarea cu care este afișat un fluorofor, faceți clic pe caseta Color
(Culoare) a acestuia.

Notă: Culoarea pe care o selectați prezintă fluoroforul atât în fereastra Plate Editor
(Editor placă), cât și în graficele Data Analysis (Analiză date).

d. În caseta de dialog Color (Culoare), selectați culoarea dorită sau faceți clic pe Define Custom
Colors (Definire culori personalizate) și creați o nouă culoare care să prezinte fluoroforul.

e. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog Select
Fluorophores (Selectare fluorofori).
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7. Trebuie să selectați cel puțin un godeu în care să încărcați un tip de probă. Implicit este selectat
godeul A1.

În panoul plăcii, urmați una dintre procedurile următoare:

n Pentru a încărca mai multe godeuri adiacente, faceți clic pe un godeu și trageți-l către godeul
țintă.

n Pentru a încărca mai multe godeuri ne-adiacente, apăsați tasta Control și faceți clic pe
fiecare godeu.

n Pentru a încărca o întreagă coloană cu același tip de probă, faceți clic pe numărul coloanei.

n Pentru a încărca un întreg rând, faceți clic pe numărul rândului.

n Pentru a încărca întreaga placă, faceți clic pe colțul din stânga sus al plăcii.

De exemplu:
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8. Atribuiți un tip de probă godeului sau godeurilor selectate din meniul vertical Sample Type (Tip
probă).

9. Atribuiți cel puțin un fluorofor tuturor godeurilor care conțin un tip de probă. Puteți atribui mai mult
decât un fluorofor unui godeu sau unui grup de godeuri.

Notă: Puteți atribui doar un singur fluorofor per canal. Nu puteți atribui mai mult de un
fluorofor din același canal aceluiași godeu.

Sfat: Puteți asocia o țintă cu fluoroforul sau puteți atribui doar fluoroforul godeului de această
dată și asocia o țintă fluoroforului după ce ați rulat experimentul.

n Pentru a atribui doar un fluorofor godeurilor selectate, în secțiunea Target Names (Denumiri
ținte) din panoul din dreapta bifați caseta de selectare Load (Încărcare) pentru respectivul
fluorofor.

n Pentru a asocia o țintă unui fluorofor, în secțiunea Target Names (Denumiri ținte) selectați o
denumire de țintă din lista verticală pentru respectivul fluorofor. Software-ul selectează
automat caseta de selectare Load (Încărcare) aferentă.

10. Pentru godeurile care conțin un tip de probă Standard, trebuie să încărcați o concentrație. Fiecare
godeu poate avea o valoare diferită a concentrației. Implicit, CFX Maestro Dx SE încarcă o
concentrație de 1,00E+06 tuturor godeurilor cu un tip de probă Standard. Puteți modifica valoarea
dacă este necesar.

a. În panoul plăcii, selectați un godeu sau un grup de godeuri Standard.

b. În secțiunea Concentration (Concentrație), faceți clic pe Load (Încărcare) pentru a încărca
valoarea în godeul sau godeurile selectate.

c. (Opțional) Pentru a încărca altă concentrație, tastați noua valoare în caseta de text
Concentration (Concentrație) și apăsați Enter.

d. Realizați acest pas pentru toate godeurile cu tipul de probă Standard.
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Sfat: Pentru a încărca aceeași concentrație pentru toate godeurile Standard, asigurați-
vă că <All> (Toate) apare în lista verticală de sub valoarea Concentration (Concentrație).
Pentru a încărca aceeași valoare de concentrație pentru toate godeurile cu un anumit
fluorofor, faceți clic pe lista verticală și selectați fluoroforul.

11. Faceți clic pe OK pentru a salva noua placă.
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Atribuirea de parametri opționali fișierului placă
Fișierul plăcii conține informații despre conținutul fiecărui godeu încărcate cu probă pentru o rulare.
După rulare, CFX Maestro Dx SE asociază conținutul godeurilor cu datele de fluorescență colectate în
timpul protocolului și aplică analiza corespunzătoare în fereastra Data Analysis (Analiză date).

În CFX Maestro Dx SE, puteți atribui parametri fiecărui godeu din placă înainte, în timpul sau chiar
după rularea experimentelor. Puteți atribui parametrii unui fișier de placă existent sau unui nou fișier
de placă. Acești parametri includ:

n Target names (Denumiri ținte) – ținta sau țintele de interes (gene sau secvențe) din fiecare
godeu încărcat.

n Sample Names (Denumiri probe) – identificatorul sau condiția care corespunde probei din
fiecare godeu încărcat, de exemplu șoarece1, șoarece2 sau șoarece3.

n Biological groups (Grupuri biologice) – identificatorul sau condiția care corespunde unui grup
de godeuri, de exemplu 0 h, 1 h sau 2 h.

Sfat: Denumiri ținte, denumiri probe și grupuri biologice trebuie să fie identice între godeuri,
pentru a putea compara datele din fila Gene Expression (Expresie genică) din fereastra Data
Analysis (Analiză date). Fiecare denumire trebuie să utilizeze același tip de caractere
(majuscule sau minuscule), punctuație și spații. De exemplu, „Actin” nu este același lucru cu
„actin”, „2Hr” nu este același cu „2 hr”, iar „Mouse 1” nu este același cu „mouse1”. Pentru a
asigura coerența numirii, introduceți numele în secțiunea Libraries (Biblioteci) din User >
User Preferences > Plate (Utilizator> Preferințe utilizator> Placă), disponibilă în fereastra
Home (Pagină de pornire).

n Technical replicates (Replicate tehnice) – fiecare godeu care este utilizat pentru a analiza
aceeași combinație probă și țintă, adică replicatele reacțiilor qPCR.

n Dilution series (Serie de diluție) – cantitatea pentru modificarea concentrației tipului de probă
Standard în cadrul unui grup de replicate, pentru a crea datele curbei standard de analizat.

Atribuirea unei ținte godeurilor
Sfat: Puteți atribui același nume de țintă unui singur godeu sau mai multor godeuri. Puteți atribui,
de asemenea, mai multe ținte aceluiași godeu.

Important: Făcând clic pe OK după ce ați atribuit o țintă, se salvează modificările și se
dezactivează Undo (Anulare) de pe bara de instrumente Plate Editor (Editor placă). Procedați cu
atenție când faceți clic pe OK.
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Pentru a atribui o țintă unui godeu sau unui grup de godeuri

1. În Plate Editor (Editor placă), asigurați-vă că godeului sau grupului de godeuri i s-a atribuit un tip
de probă.

Consultați Selectarea tipurilor de probe de la pagina 128 pentru informații despre atribuirea
tipurilor de probe la godeuri.

2. În panoul plăcii, selectați godeul sau grupul de godeuri:

n Pentru a selecta un singur godeu, faceți clic pe godeu.

n Pentru a selecta mai multe godeuri adiacente, faceți clic pe un godeu și trageți-l către godeul
țintă.

n Pentru a selecta mai multe godeuri ne-adiacente, apăsați tasta Ctrl și faceți clic pe fiecare
godeu.

n Pentru a selecta o întreagă coloană cu același tip de probă, faceți clic pe numărul coloanei.

n Pentru a selecta un întreg rând, faceți clic pe numărul rândului.

3. În panoul din dreapta, selectați un nume din lista verticală Target Name (Denumire țintă) pentru
fiecare fluorofor selectat.

4. Repetați Pasul 3 pentru fiecare godeu sau grup de godeuri căruia trebuie să îi atribuiți o țintă.

Sfat: Puteți atribui aceeași denumire sau o denumire diferită de țintă pentru fiecare fluorofor
selectat.

5. Faceți clic pe OK pentru a accepta modificările și a salva placa.

Notă: Dacă ați schimbat din greșeală placa, faceți clic pe Undo (Anulare) de pe bara de
instrumente Plate Editor (Editor placă) înainte de a face clic pe OK pentru a accepta
modificările.

Pentru a șterge o denumire de țintă

u Pentru a elimina o denumire de țintă din godeu sau din grupul de godeuri selectat, debifați-i
caseta de selectare Load (Încărcare).
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Important: Eliminarea unei denumiri de țintă dintr-un godeu îi elimină și fluoroforii asociați.
Procedați cu atenție când eliminați o denumire de țintă dintr-un godeu.

Pentru a adăuga o denumire de țintă în listă

u Pentru a adăuga o denumire de țintă în lista verticală, urmați una dintre procedurile următoare:

n Tastați un nume din lista verticală Target Names (Denumiri ținte) și apăsați Enter.

Sfat: Numele țintelor pe care le-ați adăugat pe o listă apar în toate celelalte liste de ținte.

n Faceți clic pe simbolul + verde din dreapta listei verticale, tastați un nume pentru țintă și
apăsați Enter.

n Faceți clic pe User Preferences (Preferințe utilizator) de pe bara de instrumente și adăugați
numele în biblioteca Target Names (Denumiri ținte) din fila Plate (Placă).

Important: Denumirile țintelor pe care le adăugați pe lista verticală sunt disponibile doar
pentru placa curentă și doar dacă atribuiți denumirea unui godeu și salvați structura plăcii.
Dacă nu atribuiți numele unui godeu și nu salvați configurația plăcii, numele nu este salvat și
nu este disponibil pentru utilizarea ulterioară. Pentru a adăuga permanent o denumire de
țintă, adăugați-o și în biblioteca Target Names (Denumiri ținte) utilizând caseta de dialog
User Preferences (Preferințe utilizator). Numele pe care le adăugați în bibliotecă sunt
disponibile după ce deschideți din nou Plate Editor (Editor placă). Consultați Setarea
parametrilor de placă impliciți de la pagina 86 pentru mai multe informații.

Pentru a șterge o denumire de țintă din listă

1. Faceți clic pe User Preferences (Preferințe utilizator) de pe bara de instrumente.

Va apărea caseta de dialog User Preferences (Preferințe utilizator), afișând fila Plate (Placă).

2. În biblioteca Target Names (Denumiri ținte) din fila Plate (Placă), selectați denumirea pe care
doriți să o ștergeți și apăsați tasta Delete (Ștergere).

3. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog User Preferences
(Preferințe utilizator).

Important: Nu puteți șterge denumirile de ținte pe care le-ați salvat împreună cu un fișier
placă. Numele personalizate pe care le adăugați pe lista verticală Target Names (Denumiri
ținte) și nu le folosiți și salvați împreună cu placa sunt eliminate automat din listă. Numele pe
care le ștergeți din biblioteca Target Names (Denumiri ținte) sunt eliminate automat din
software și nu mai sunt disponibile utilizatorilor. Procedați cu atenție când ștergeți denumiri
de ținte.
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Atribuirea unei denumiri de probă godeurilor
Notă: Pentru a atribui o denumire probă, trebuie să atribuiți godeurilor selectate cel puțin un
fluorofor. Dacă godeurilor selectate nu li se atribuie un fluorofor, lista verticală Sample Names
(Denumiri probe) este dezactivată. Consultați Atribuirea unei ținte godeurilor de la pagina 133
pentru informații despre atribuirea fluoroforilor.

Sfat: Puteți atribui o singură denumire probă fiecărui godeu sau fiecărui grup de godeuri.

Pentru a atribui o denumire probă unui godeu sau unui grup de godeuri

1. În Plate Editor (Editor placă), asigurați-vă că godeului sau grupului de godeuri i s-a atribuit un
fluorofor.

2. În panoul plăcii, selectați godeul sau grupul de godeuri.

3. În panoul din dreapta, selectați un nume din lista verticală Sample Names (Denumiri probe).

Software-ul selectează automat caseta de selectare Load (Încărcare) aferentă.

4. Repetați Pasul 3 pentru fiecare godeu sau grup de godeuri căruia trebuie să îi atribuiți o
denumire probă.

5. Faceți clic pe OK pentru a accepta modificările și a salva placa.

Notă: Dacă ați schimbat din greșeală placa, faceți clic pe Undo (Anulare) de pe bara de
instrumente Plate Editor (Editor placă) înainte de a face clic pe OK pentru a accepta
modificările.

Pentru a șterge o denumire probă

u Pentru a elimina o denumire probă din godeul sau grupul de godeuri selectate, debifați-i caseta
de selectare Load (Încărcare).

Pentru a adăuga o denumire probă în listă

u Pentru a adăuga o denumire probă în lista verticală, urmați una dintre procedurile următoare:

n Tastați un nume din lista verticală Sample Names (Denumiri probe) și apăsați Enter.

n Faceți clic pe simbolul + verde din dreapta listei verticale și tastați un nume pentru probă.
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n Faceți clic pe User Preferences (Preferințe utilizator) de pe bara de instrumente și adăugați
numele în biblioteca Sample Names (Denumiri probe) din fila Plate (Placă).

Important: Denumirile probelor pe care le adăugați pe lista verticală sunt disponibile doar
pentru placa curentă și doar dacă atribuiți denumirea unui godeu și salvați configurația plăcii.
Dacă nu atribuiți numele unui godeu și nu salvați configurația plăcii, numele nu este salvat și
nu este disponibil pentru utilizarea ulterioară. Pentru a adăuga permanent o denumire probă,
adăugați-o și în biblioteca Sample Names (Denumiri probe) utilizând caseta de dialog User
Preferences (Preferințe utilizator). Numele pe care le adăugați în bibliotecă sunt disponibile
după ce deschideți din nou Plate Editor (Editor placă). Consultați Setarea parametrilor de
placă impliciți de la pagina 86 pentru mai multe informații.

Pentru a șterge o denumire probă din listă

1. Faceți clic pe User Preferences (Preferințe utilizator) de pe bara de instrumente.

Va apărea caseta de dialog User Preferences (Preferințe utilizator), afișând fila Plate (Placă).

2. În biblioteca Sample Names (Denumiri probe) din fila Plate (Placă), selectați denumirea pe care
doriți să o ștergeți și apăsați tasta Delete (Ștergere).

3. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog User Preferences
(Preferințe utilizator).

Important: Nu puteți șterge denumirile de probe pe care le-ați salvat împreună cu un fișier
placă. Numele personalizate pe care le adăugați pe lista verticală Sample Names (Denumiri
probe) și nu le folosiți și salvați împreună cu placa sunt eliminate automat din lista verticală.
Numele pe care le ștergeți din biblioteca Sample Names (Denumiri probe) sunt eliminate
automat din software și nu mai sunt disponibile utilizatorilor. Procedați cu atenție când
ștergeți denumiri de probe.

Atribuirea de Biological Groups (Grupuri biologice) la Wells
(Godeuri)
Notă: Pentru a atribui un grup biologic, trebuie să atribuiți godeurilor selectate cel puțin un
fluorofor. Atribuirea unui fluorofor activează lista verticală Biological Groups (Grupuri biologice).
Consultați Atribuirea unei ținte godeurilor de la pagina 133 pentru informații despre atribuirea
fluoroforilor.

Sfat: Puteți atribui un grup biologic fiecărui godeu sau fiecărui grup de godeuri.
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Pentru a atribui un grup biologic unui godeu sau unui grup de godeuri

1. În Plate Editor (Editor placă), asigurați-vă că godeului sau grupului de godeuri i s-a atribuit un
fluorofor.

2. În panoul plăcii, selectați godeul sau grupul de godeuri.

3. În panoul din dreapta, faceți o selecție din lista verticală Biological Group (Grup biologic).

CFX Maestro Dx SE selectează automat caseta de selectare Load (Încărcare).

4. Repetați Pasul 3 pentru fiecare godeu sau grup de godeuri căruia trebuie să îi atribuiți un grup
biologic.

5. Faceți clic pe OK pentru a accepta modificările și a salva placa.

Notă: Dacă ați schimbat din greșeală placa, faceți clic pe Undo (Anulare) de pe bara de
instrumente Plate Editor (Editor placă) înainte de a face clic pe OK pentru a accepta
modificările.

Pentru a elimina un grup biologic

u Pentru a elimina un grup biologic din godeul sau grupul de godeuri selectat, debifați-i caseta de
selectare Load (Încărcare).

Pentru a adăuga un grup biologic la listă

u Pentru a adăuga un grup biologic la lista verticală, efectuați una dintre următoarele acțiuni:

n Tastați un nume în caseta listei verticale Biological Group (Grup biologic) și apăsați Enter.

n Faceți clic pe simbolul + verde din dreapta listei verticale și tastați un nume pentru grupul
biologic.

n Faceți clic pe User Preferences (Preferințe utilizator) de pe bara de instrumente și adăugați
numele în biblioteca Biological Names (Nume biologice) din fila Plate (Placă).

Important: Denumirile grupurilor biologice pe care le adăugați pe lista verticală sunt
disponibile doar pentru placa curentă și doar dacă atribuiți denumirea unui godeu și salvați
configurația plăcii. Dacă nu atribuiți numele unui godeu și nu salvați configurația plăcii,
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numele nu este salvat și nu este disponibil pentru utilizarea ulterioară. Pentru a adăuga
permanent un nume de grup biologic, adăugați-l și în biblioteca Biological Group Names
(Nume grupuri biologice) utilizând caseta de dialog User Preferences (Preferințe utilizator).
Numele pe care le adăugați în bibliotecă sunt disponibile după ce deschideți din nou Plate
Editor (Editor placă). Consultați Setarea parametrilor de placă impliciți de la pagina 86 pentru
mai multe informații.

Pentru a șterge un nume de grup biologic din listă

1. Faceți clic pe User Preferences (Preferințe utilizator) de pe bara de instrumente.

Va apărea caseta de dialog User Preferences (Preferințe utilizator), afișând fila Plate (Placă).

2. În biblioteca Biological Group Names (Nume grupuri biologice) din fila Plate (Placă), selectați
numele pe care doriți să-l ștergeți și apăsați tasta Delete (Ștergere).

3. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog User Preferences
(Preferințe utilizator).

Important: Nu puteți șterge numele grupurilor biologice pe care le-ați salvat împreună cu un
fișier placă. Numele personalizate pe care le adăugați pe lista verticală Biological Group
Names (Nume grupuri biologice) și nu le folosiți și salvați împreună cu placa sunt eliminate
automat din listă. Numele pe care le ștergeți din biblioteca Biological Group Names (Nume
grupuri biologice) sunt eliminate automat din software și nu mai sunt disponibile utilizatorilor.
Procedați cu atenție când ștergeți nume biologice.

Pentru a vizualiza toate grupurile biologice de pe placă

u Faceți clic pe Show Biological Groups (Afișare grupuri biologice) pentru a vedea toate grupurile
biologice de pe placă.

Fiecare grup este identificat printr-o culoare specifică, iar butonul Show Biological Groups
(Afișare grupuri biologice) se schimbă în Hide Biological Groups (Ascundere grupuri biologice).

Faceți clic pe Hide Biological Groups (Ascundere grupuri biologice) pentru a elimina culoarea din
godeuri. Alternativ, puteți face clic pe orice godeu din placă pentru a ascunde grupurile biologice.

Ghid de utilizare | 139



Capitolul 8 Pregătirea plăcilor

Atribuirea de numere de replicate tehnice godeurilor
Important: Pentru a atribui numere de replicate tehnice, godeurile selectate trebuie să aibă
conținut identic. Adică godeurile selectate trebuie să aibă același tip de probă și același fluorofor.
Dacă se poate, trebuie, de asemenea, să le fie atribuite aceleași denumiri de țintă și de probă și
același grup biologic. Dacă nu sunt aceleași, CFX Maestro Dx SE nu activează această opțiune.

Pentru a atribui numere de replicate tehnice unui grup de godeuri

1. În Plate Editor (Editor placă), asigurați-vă că conținutul grupului de godeuri este identic.

2. În panoul plăcii, selectați grupul de godeuri țintă.

3. Pentru a atribui aceleași număr de replicat tuturor godeurilor selectate, în secțiunea Replicate #
(Nr. replicat) din panoul din dreapta tastați numărul replicatului în casetă și selectați Load
(Încărcare).

4. (Opțional) Pentru a aplica o serie de replicate unui set de godeuri selectate:

a. Faceți clic pe Replicate tehnice. Secțiunea Replicate # (Nr. replicat) se modifică, afișând
următoarele opțiuni:

n Replicate size (Dimensiunea replicatului) – un număr care reprezintă numărul de
godeuri din fiecare grup de replicat

n Starting replicate # (Nr. replicat inițial) – primul număr din seria de replicate pentru
grupul selectat de replicate

Notă: Implicit, CFX Maestro Dx SE afișează numărul inițial al replicatului cu o cifră mai
mare decât atribuit în placă. De exemplu, dacă ultimul număr de replicat tehnic din placă
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este cinci, următorul număr inițial este șase. Puteți schimba numărul inițial cu orice
număr care nu a fost încă atribuit.

n Direcția de încărcare (orizontală sau verticală)

b. Faceți clic pe Apply (Aplicare) pentru a aplica parametrii seriei și a reveni la afișajul
Replicate # (Nr. replicat).

5. Faceți clic pe OK pentru a accepta modificările și a salva placa.

Notă: Dacă ați schimbat din greșeală placa, faceți clic pe Undo (Anulare) de pe bara de
instrumente Plate Editor (Editor placă) înainte de a face clic pe OK pentru a accepta
modificările.

Pentru a elimina un godeu dintr-o serie de replicate

u Selectați godeul sau grupul de godeuri pe care doriți să le eliminați și debifați caseta de selectare
Replicate # Load (Încărcare nr. replicat).

Alternativ, puteți face clic pe Clear Replicate # (Ștergere nr. replicat) pentru a șterge numărul
replicatului dintr-un godeu sau dintr-un grup de godeuri selectate.

Pentru a vedea toate replicatele tehnice de pe placă

u Faceți clic pe Show Technical Replicates (Afișare replicate tehnice) pentru a vedea toate
replicatele tehnice de pe placă.

Fiecare grup este identificat printr-o culoare specifică, iar butonul Show Technical Replicates
(Afișare replicate tehnice) se schimbă în Hide Technical Replicates (Ascundere replicate
tehnice).

Faceți clic pe Hide Technical Replicates (Ascundere replicate tehnice) pentru a elimina culoarea
din godeuri. Alternativ, puteți face clic pe orice godeu din placă pentru a ascunde replicatele
tehnice.

Atribuirea unei serii de diluție probelor de tip standard
După cum a fost menționat anterior, tuturor godeurilor cu probe de tip Standard trebuie să li se
atribuie o valoare de concentrație. Puteți atribui o serie de diluție mai multor godeuri cu probe de tip
Standard.

Notă: Pentru a atribui o serie de diluție unui grup de godeuri, godeurile trebuie să fie incluse într-
o serie de replicate tehnice. Consultați Atribuirea de numere de replicate tehnice godeurilor de la
pagina 140 pentru informații despre adăugarea godeurilor la o serie de replici.
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Pentru a atribui o serie de diluție unui grup de godeuri cu probe de tip Standard

1. În Plate Editor (Editor placă), asigurați-vă că sunt îndeplinite următoarele cerințe:

n Tipul de probă pentru grupul de godeuri este Standard.

n Tuturor godeurilor din grup li s-a atribuit cel puțin un fluorofor și toate conțin aceiași fluorofori.

n Toate godeurile din grup sunt incluse în aceeași serie de replicate tehnice.

Notă: CFX Maestro Dx SE permite opțiunea Dilution Series (Serie de diluție) doar dacă
toate godeurile selectate îndeplinesc aceste criterii.

2. În panoul pentru placă, selectați grupul de godeuri țintă.

3. În secțiunea Concentration (Concentrație) din panoul din dreapta, faceți clic pe Dilution Series
(Serie de diluție). Secțiunea Concentration (Concentrație) se modifică, afișând următoarele
opțiuni:

n Starting concentration (Concentrația inițială) – valoarea concentrației de la care pornește
seria

n Replicates from and to (Replicate de la și până la) – replicatele din serie cărora li se va
aplica factorul de diluție

n Dilution factor (Factor de diluție) – cantitatea pentru modificarea concentrației din fiecare
grup de replicate

4. Configurați valorile pentru opțiuni sau acceptați valorile implicite.

5. Implicit, seria de diluție scade cu factorul de diluție. Selectați Increasing (Crescător) pentru a
crește seria de diluție.

6. (Opțional) Implicit, factorul de diluție se aplică tuturor fluoroforilor din seria de replicate. Dacă
seria dumneavoastră conține mai mult de un fluorofor și doriți să aplicați diluția unui singur
fluorofor, selectați-l din lista verticală.
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7. Faceți clic pe Apply (Aplicare) pentru a aplica seria de diluție grupului de godeuri și pentru a
reveni la vizualizarea Concentration (Concentrație).

8. Faceți clic pe OK pentru a accepta modificările și a salva placa.

Copierea conținutului unui godeu într-un alt godeu
Puteți copia conținutul unui godeu și-l puteți lipi într-un singur godeu sau în mai multe godeuri. Cu
toate acestea, puteți copia conținutul unui singur godeu. Nu puteți selecta mai multe godeuri pentru ca
apoi să le copiați conținutul.

Pentru a copia conținutul unui godeu într-un alt godeu

1. În panoul plăcii, selectați godeul pe care doriți să îl copiați.

2. Faceți clic dreapta pe godeu și selectați Copy Well (Copiere godeu).

3. Selectați godeul sau godeurile în care doriți să lipiți conținutul:

n Pentru a selecta un singur godeu, faceți clic pe godeu.

n Pentru a selecta mai multe godeuri adiacente, faceți clic pe un godeu și trageți-l către godeul
țintă.

n Pentru a selecta mai multe godeuri ne-adiacente, apăsați tasta Ctrl și faceți clic pe fiecare
godeu.

4. După ce ați selectat godeurile țintă, faceți clic dreapta și selectați Paste Well (Lipire godeu).

CFX Maestro Dx SE lipește conținutul primului godeu în godeurile selectate.

Adăugarea unei note la un godeu
Puteți adăuga o notă descriptivă la un godeu. Puteți vizualiza notele godeurilor în fila Quantification
(Cuantificare) din fereastra Data Analysis (Analiză date).

Pentru a adăuga o notă la un godeu

1. În panoul plăcii, selectați godeu sau godeurile la care intenționați să adăugați o notă.

2. În secțiunea View (Vizualizare) din panoul de jos, selectați Well Note (Notă godeu).

Zona Well Note (Notă godeu) apare în panoul din dreapta.

3. Scrieți conținutul notei în caseta de text și apăsați Enter.
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Textul apare în partea de jos a godeurilor selectate.

Sfat: Dacă ați creat o notă de godeu anterior, o puteți selecta din lista verticală și o puteți
aplica godeurilor selectate.

Golirea godeurilor de tot conținutul
Puteți debifa un godeu individual, un grup de godeuri sau întreaga placă de tot conținutul. Golirea
godeurilor nu elimină datele de fluorescență colectate în timpul citirii plăcii.

Important: Golirea unui godeu elimină permanent conținutul din godeu. Dacă faceți clic pe OK și
salvați placa după golirea unui godeu, nu puteți anula acțiunea de debifare. Procedați cu atenție
când debifați godeurile.

Pentru a debifa godeurile de toate setările

1. În Plate Editor (Editor placă), selectați godeul sau grupul de godeuri în panoul plăcii:

n Pentru a selecta un singur godeu, faceți clic pe godeu.

n Pentru a selecta mai multe godeuri adiacente, faceți clic pe un godeu și trageți-l către godeul
țintă.

n Pentru a selecta mai multe godeuri ne-adiacente, apăsați tasta Ctrl și faceți clic pe fiecare
godeu.

n Pentru a selecta o întreagă coloană cu același tip de probă, faceți clic pe numărul coloanei.

n Pentru a selecta un întreg rând, faceți clic pe numărul rândului.

2. În panoul din dreapta, faceți clic pe Clear Wells (Debifare godeuri).

CFX Maestro Dx SE debifează godeurile selectate de toate setările.

3. Urmați una dintre procedurile următoare:

n Dacă ați debifat godeurile din greșeală, faceți clic pe Undo (Anulare) de pe bara de
instrumente Plate Editor (Editor placă) înainte de a face clic pe OK pentru a accepta
modificările.

Important: Dacă faceți clic pe OK înainte de a face clic pe Undo (Anulare), modificările
vor fi salvate și butonul Undo (Anulare) va dispărea de pe bara de instrumente Plate
Editor (Editor placă).

n Faceți clic pe OK pentru a accepta modificările și a salva placa.
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Schimbarea setărilor experimentelor
Utilizați caseta de dialog Experiment Settings (Setări experimente) pentru a vizualiza sau a modifica
lista de ținte, probe sau grupuri biologice sau pentru a seta grupul de probe pentru analiza expresiei
genice să analizeze dacă ați atribuit grupuri biologice godeurilor din cadrul plăcii.

În caseta de dialog Experiment Settings (Setări experimente), fila Targets (Ținte) afișează o listă a
denumirilor țintelor pentru fiecare reacție PCR, de exemplu gena țintă sau secvențele de gene de
interes.

Fila Samples (Probe) și Biological Group (Grupuri biologice) afișează o listă de denumiri de probe și
grupuri biologice care indică sursa țintei, de exemplu o probă recoltată la 1 oră (1 Hr) sau de la un
anumit individ (mouse1 (șoarece1)).

Pentru a schimba setările plăcii utilizând caseta de dialog Experiment Settings (Setări
experimente)

1. Pentru a deschide caseta de dialog Experiment Settings (Setări experimente), urmați una dintre
procedurile următoare:

n În panoul din dreapta al Plate Editor (Editor placă), faceți clic pe Experiment Settings (Setări
experimente).

n În fila Gene Expression (Expresie genică) din fereastra Data Analysis (Analiză date), faceți
clic pe Experiment Settings (Setări experimente).

Apare caseta de dialog Experiment Settings (Setări experimente), care afișează conținutul filei
Targets (Ținte).
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2. Pentru a adăuga o nouă denumire de țintă, probă sau grup biologic, în tipul de filă corespunzător
introduceți o denumire în caseta de text New (Nou) și faceți clic pe Add (Adăugare).

3. Pentru a elimina una sau mai multe denumiri de țintă, probă sau grup biologic din listă, în fila
corespunzătoare bifați caseta de selectare a elementului din coloana Select to Remove
(Selectare pentru eliminare) și faceți clic pe Remove checked item(s) (Eliminare elemente
bifate).

4. CFX Maestro Dx SE exclude tipul de probă NTC (control fără ținta de amplificare) din analiza
expresiei genice.

Pentru a include tipurile de probe NTC, debifați caseta de selectare corespunzătoare din
secțiunea Exclude the following sample types (Excludeți următoarele tipuri de probe). Puteți
alege să excludeți următoarele tipuri de probe selectând caseta de selectare corespunzătoare:

n NRT (fără transcriptază inversă)

n Negative Control (Control negativ)

n Positive Control (Control pozitiv)

n Eroare

5. În fila Targets (Ținte):

a. Pentru a selecta o țintă ca referință pentru analiza datelor expresiei genice, selectați-o în
coloana Reference (Referință).

b. Pentru a ascunde setările de analiză care vor fi aplicate în fila Gene Expression (Expresie
genică) din fereastra Analysis Settings (Setări analiză), debifați Show Analysis Settings
(Afișare setări analiză).

Software-ul ascunde următoarele coloane:

n Color (Culoare)

n Show Chart (Afișare grafic)

n Auto Efficiency (Eficiență automată)

n Efficiency (%) (Eficiență (%))

c. Pentru a schimba culoarea țintei așa cum este reprezentată în graficul Gene Expression
(Expresie genică), faceți clic pe celula corespunzătoare din coloana Color (Culoare),
selectați o culoare nouă în caseta de dialog Color (Culoare) și faceți clic pe OK.

d. Pentru a afișa ținta cu culoarea selectată în graficul Gene Expression (Expresie genică),
bifați-i caseta de selectare în coloana Show Chart (Afișare grafic).
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e. Implicit, CFX Maestro Dx SE calculează automat eficiența relativă a țintei, dacă datele
acesteia includ o curbă standard.

Pentru a utiliza o valoare de eficiență determinată anterior, introduceți valoarea în celula
corespunzătoare din coloana Efficiency (%) (Eficiență (%)) și apăsați tasta Enter.
CFX Maestro Dx SE deselectează căsuța de selecție Auto Efficiency (Eficiență automată).

6. În fila Samples (Probe) și Biological Groups (Grupuri biologice):

a. Pentru a selecta o probă sau un grup biologic drept probă de control pentru analiza datelor
expresiei genice, selectați caseta sa de selectare în coloana Control.

b. Pentru a atribui condiția de control unei probe sau unui grup biologic pentru o rulare, faceți
clic pe caseta sa de selectare în coloana Control.

c. Dacă nu este deja selectată, faceți clic pe Show Analysis Settings (Afișare setări analiză)
pentru a vizualiza sau a schimba parametrii de analiză care vor fi aplicați în fila Gene
Expression (Expresie genică). Software-ul ascunde coloanele Color (Culoare) și Show Chart
(Afișare grafic).

7. Faceți clic pe OK pentru a salva parametrii în caseta de dialog Experiment Settings (Setări
experimente) și a reveni la fereastra Plate Editor (Editor placă).
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Crearea de grupuri de godeuri
Grupurile de godeuri împart o placă individuală în subseturi de godeuri care pot fi analizate
independent în fereastra Data Analysis (Analiză date). După configurarea grupurilor de godeuri,
selectați unul în fereastra Data Analysis (Analiză date) pentru a analiza datele pentru fiecare grup în
mod independent. De exemplu, configurați grupuri de godeuri pentru a analiza mai multe rulări de
experimente pe o singură placă sau pentru a analiza fiecare grup de godeuri cu o curbă standard
diferită.

Notă: Grupul de godeuri implicit este All Wells (Toate godeurile).

Pentru a crea grupuri de godeuri

1. Pentru a deschide Well Groups Manager (Manager grupuri de godeuri), urmați una dintre
procedurile următoare:

n Pe bara de instrumente Plate Editor (Editor placă), faceți clic pe Well Groups (Grupuri
godeuri).

n În fereastra Data Analysis (Analiză date), faceți clic pe Manage Well Groups (Gestionare
grupuri godeuri).

Apare caseta de dialog Well Groups Manager (Manager grupuri de godeuri).
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2. Faceți clic pe Add (Adăugare) pentru a crea un grup nou. Meniul vertical afișează denumirea
grupului ca Group 1 (Grupul 1) pentru primul grup.

3. Selectați godeurile pentru grupul de godeuri din vizualizarea plăcii, făcând clic și deplasând
cursorul peste grupul de godeuri. Godeurile selectate apar cu albastru în Manager.

4. (Opțional) Pentru a schimba denumirea grupului, selectați-o din meniul vertical și introduceți o
denumire nouă.

5. (Opțional) Pentru a șterge un grup de godeuri, selectați denumirea sa din lista verticală și faceți
clic pe Delete (Ștergere).

6. Faceți clic pe OK pentru a finaliza și a închide fereastra sau faceți clic pe Cancel (Anulare) pentru
a închide fereastra fără a efectua modificări.

Elementele de meniu afișate prin clic dreapta pentru caseta de dialog Well
Groups Manager (Manager grupuri de godeuri)

Tabelul 8 listează elementele disponibile în caseta de dialog Well Groups Manager (Manager grupuri
de godeuri) atunci când faceți clic dreapta pe orice godeu.

Element Funcție

Copy (Copiere) Copiază conținutul godeului, care poate fi apoi lipit la alt
godeu sau alte godeuri.

Copy as Image (Copiere ca
imagine)

Copiază vizualizarea selector de godeu sub formă de
imagine.

Print (Imprimare) Imprimă vizualizarea selector de godeu.

Print Selection (Imprimare
selecție)

Imprimă doar celulele selectate.

Export to Excel (Exportare în
Excel)

Exportă datele într-o foaie de calcul Excel.

Export to Csv (Exportare în
CSV)

Exportă datele într-un document cu valori separate prin
virgulă.

Export to Xml (Exportare în
Xml)

Exportă datele drept document .xml.

Export to Html (Exportare în
Html)

Exportă datele drept document .html.

Tabelul 8. Faceți clic dreapta pe elementele de meniu din caseta de dialog Plate Editor
Well Groups Manager (Manager grupuri de godeuri pentru editorul de plăci)
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Modificarea stilurilor urmelor
În timpul configurației plăcii și în cursul rulării, puteți modifica culoarea și stilul urmelor de amplificare.
Apoi puteți vedea cu ușurință urmele în fereastra de stare în timp real, pe măsură ce datele sunt
colectate.

Pentru a modifica stilurile urmelor

1. Faceți clic pe Trace Styles (Stiluri Urme) în bara de instrumente Plate Editor (Editor placă).

Va apărea caseta de dialog Trace Styles (Stiluri Urme) pentru placa deschisă, de exemplu:

2. Pentru a afișa stilurile urmelor în funcție de un anumit fluorofor, selectați-l din lista verticală
Fluorophores (Fluorofori).

3. Pentru a schimba afișarea urmei:

a. Selectați tipul urmei din lista verticală Wells (Godeuri).

b. Faceți clic pe culoarea acesteia în coloana Color (Culoare).

c. În caseta de dialog Color (Culoare) care apare, selectați o altă culoare pentru urmă și faceți
clic pe OK.

CFX CFX Maestro Dx SE afișează schimbarea culorii pentru tipul de godeu din grilă.

d. (Opțional) Selectați un simbol pentru urmă din lista verticală Symbols (Simboluri).

4. Pentru a schimba rapid setul de culori, faceți clic pe opțiunea corespunzătoare din secțiunea
Color Quick Set (Set de culori rapid).
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5. Pentru a vedea etichetele godeului în grilă, selectați tipul etichetei în secțiunea Well Labels
(Etichete godeuri).

6. Faceți clic pe OK pentru a salva modificările sau pe Cancel (Anulare) pentru a anula modificările.
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Vizualizarea plăcii în format foaie de calcul
Instrumentul Spreadsheet View/Importer (Vizualizator/Importator foaie de calcul) afișează conținutul
unei plăci în format foaie de calcul. Puteți utiliza instrumentul Spreadsheet View/Importer
(Vizualizare/Importator foaie de calcul) pentru a exporta conținutul godeului în format delimitat cu
tabulatoare într-o aplicație precum Microsoft Excel. Puteți, de asemenea, importa conținut dintr-o
aplicație delimitată cu tabulatoare.

Pentru a utiliza instrumentul Spreadsheet View/Importer (Vizualizare/Importator foaie de
calcul)

1. În bara de instrumente Plate Editor (Editor placă), faceți clic pe Spreadsheet View/Importer
(Vizualizator/Importator foaie de calcul) pentru a deschide caseta de dialog Plate Spreadsheet
View (Vizualizare placă în foaie de calcul).

2. Caseta de dialog Spreadsheet View (Vizualizare în foaie de calcul) afișează conținutul plăcii
pentru un singur fluorofor. Pentru a vizualiza conținutul plăcii pentru alt fluorofor, selectați-l din
lista verticală Fluors List (Listă fluorofori).

3. Faceți clic pe Export Template (Exportare matriță) pentru a exporta o matriță al foii de calcul a
plăcii într-un format de fișier Excel (format .csv). Puteți edita această matriță pentru a importa
informațiile despre conținutul godeului.

4. (Opțional) Faceți clic pe Import (Importare) pentru a importa conținutul godeului dintr-un fișier cu
delimitare prin virgule.

5. Pentru a sorta foaia de calcul în funcție de datele dintr-o anumită coloană, faceți clic pe triunghiul
de lângă denumirea coloanei.
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Sfat: Puteți edita conținutul oricărei celule dintr-o coloană care are un asterisc (*) lângă
denumirea coloanei (de exemplu, *Target Name (Denumire țintă)).

Notă: Selectați unitățile pentru datele curbei standard din coloana Quantity (Cantitate)
deschizând Plate Editor (Editor placă) și selectând Settings > Units (Setări > Unități) din bara de
meniu. După ce rularea plăcii este finalizată, datele din aceste standarde apar în graficul
Standard Curve (Curbă standard) din fila Quantification (Cuantificare) din fereastra Data Analysis
(Analiză date) cu unitățile pe care le-ați selectat.

Elemente de meniu afișate prin clic dreapta pentru instrumentul Plate
Spreadsheet View/Importer (Vizualizator/Importator foaie de calcul placă)

Tabelul 9 prezintă elementele de meniu disponibile în instrumentul Spreadsheet View/Importer
(Vizualizator/Importator foaie de calcul) atunci când faceți clic dreapta pe orice godeu din instrument.

Element Funcție

Copy (Copiere) Copiază toată foaia de calcul.

Copy as Image
(Copiere ca imagine)

Copiază foaia de calcul ca fișier imagine.

Print (Imprimare) Imprimă foaia de calcul.

Print Selection
(Imprimare selecție)

Imprimă doar celulele selectate.

Export to Excel
(Exportare în Excel)

Exportă fișierul într-o foaie de calcul Excel.

Export to Csv
(Exportare în CSV)

Exportă fișierul ca fișier .csv.

Export to Xml
(Exportare în Xml)

Exportă fișierul ca fișier .xml.

Export to Html
(Exportare în Html)

Exportă fișierul ca fișier .html.

Find (Găsire) Caută text specific.

Sort (Sortare) Sortează foaia de calcul selectând până la trei coloane de date în
fereastra Sort (Sortare).

Tabelul 9. Elemente de meniu afișate prin clic dreapta în instrumentul Plate
Spreadsheet View/Importer (Vizualizator/Importator foaie de calcul placă)
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Crearea unei structuri de placă folosind Plate Setup Wizard
(Expert configurație placă)

Puteți utiliza Setup Wizard (Expert configurație) pentru a introduce informațiile privind structura plăcii
care sunt necesare pentru analiza expresiei genice normalizate, inclusiv:

n Denumiri ținte

n Denumiri probe

n Poziția țintelor și probei pe placă

n Genă/gene de referință

n Probă de control

Puteți folosi Setup Wizard (Expert configurație) înainte, în timpul sau după finalizarea unei rulări.

Utilizarea Setup Wizard (Expert configurație) al plăcii
Această secțiune explică modul de creare a unei structuri de placă cu ajutorul Setup Wizard (Expert
configurație). Pentru a vizualiza conținutul fiecărui godeu din placă mai ușor, faceți clic pe Zoom plate
(Mărire placă) din partea de sus a Setup Wizard (Expert configurație).

Important: Revenirea la fila Auto layout (Structură automată) când vă aflați în orice altă filă din
Setup Wizard (Expert configurație) resetează structura plăcii. Procedați cu atenție când selectați
această filă.

Sfat: Puteți reseta structura selectând Tools > Clear Plate (Instrumente > Ștergere placă) în Setup
Wizard (Expert configurație).

Pentru a utiliza Setup Wizard (Expert configurație) al plăcii

1. Deschideți Plate Editor (Editor placă)

2. Pentru a deschide Setup Wizard (Expert configurație), efectuați una dintre următoarele acțiuni:

n Alegeți Editing Tools > Setup Wizard (Instrumente de editare > Expert configurație).

n Faceți clic pe Setup Wizard (Expert configurație) în bara de instrumente Plate Editor (Editor
placă).

Setup Wizard (Expert configurație) va apărea în fila Auto layout (Structură automată).
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3. În fila Auto layout (Structură automată), urmați procedura următoare:

a. Faceți clic pe un godeu din grilă și trageți peste și în jos pentru a specifica zona de pe placă
în care doriți să încărcați proba.

b. Introduceți numărul de ținte și probe de încărcat.

Sfat: Numărul de ținte și probe trebuie să fie egal cu numărul de celule selectate. Dacă
numerele introduse nu se potrivesc în zona selectată, modificați numerele sau zona de
selectare a plăcii. Orientarea elementelor de pe placă și gruparea acestora pot fi
specificate.

c. (Opțional) Modificați orientarea plăcii. De exemplu, puteți configura țintele în coloane și
probele în rânduri sau puteți grupa după probe.

d. Faceți clic pe Next (Următorul) pentru a accesa fila Target Names (Denumiri ținte).

Notă: Dacă structura plăcii nu are un model obișnuit, folosiți fila Target Names (Denumiri
ținte) pentru a vă poziționa manual țintele sau fila Sample Names (Denumiri probe) pentru a
vă poziționa manual probele pe placă. Faceți clic și trageți pentru a selecta mai multe
godeuri.

4. În fila Target Names (Denumiri țintă), definiți numele țintei pentru grupurile de ținte:

a. Urmați una dintre procedurile următoare:

n Pentru a redenumi țintele după grup, setați Select by (Selectare după) cu valoarea
Target (Țintă).
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n Pentru a redenumi țintele după godeu, setați Select by (Selectare după) cu valoarea
Well (Godeu).

b. Selectați un grup de ținte sau godeuri din grilă și tastați un nume în lista verticală Target
name (Denumire țintă).

Sfat: Apăsați Tab pentru a selecta următorul grup sau următorul godeu din dreapta sau
Enter pentru a selecta următorul grup sau următorul godeu de dedesubt. Alternativ, în
filele Target name (Denumire țintă) și Sample name (Denumire probă), apăsați tasta
Control și faceți clic pe un godeu pentru a selecta mai multe godeuri care nu sunt
adiacente.

c. Faceți clic pe Next (Următorul) pentru a accesa fila Sample Names (Denumiri probe).

5. În fila Sample Names (Denumiri probe), definiți numele probelor pentru grupurile de probe.

6. Faceți clic pe Next (Următorul) pentru a accesa fila Reference targets (Ținte de referință).

7. În fila Reference targets (Ținte de referință), selectați una sau mai multe ținte pe care să le folosiți
drept referințe pentru expresia genică normalizată și faceți clic pe Next (Următorul) pentru a
accesa fila Control sample (Probă de control).

8. În fila Control sample (Probă de control), selectați o probă de utilizat ca și control în calculele
expresiei genice relative.

9. Faceți clic pe OK pentru a salva structura plăcii și a reveni la fila Plate Editor (Editor placă), în
care puteți defini alți parametri de placă. Consultați Atribuirea de parametri opționali fișierului
placă de la pagina 133 pentru mai multe informații.

Alternativ, faceți clic pe Previous (Anterior) pentru a reveni la o filă anterioară și a efectua orice
modificări.

Notă: Revenirea la fila Auto layout (Structură automată) resetează automat placa. Procedați
cu atenție când faceți clic pe Previous (Anterior).
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Acest capitol vă explică cum să rulați experimente de testare personalizate (definite de utilizator) sau
teste PrimePCR folosind Software-ul CFX Maestro Dx SE.

Un fișier de date de rulare conține informațiile despre protocol și placă pentru rularea respectivă.
Fișierul conține și datele obținute în urma analizelor realizate de CFX Maestro Dx SE după finalizarea
rulării.

CFX Maestro Dx SE facilitează configurarea și rularea experimentelor definite de utilizator sau
PrimePCR. Fereastra Run Setup (Configurare rulare) vă ghidează prin pașii comuni de configurare a
unui experiment, ducându-vă la caseta de dialog Start Run (Începere rulare), din care puteți iniția
rularea.

Ghid de utilizare | 157



Capitolul 9 Rularea de experimente

Fereastra Run Setup (Configurare rulare)
Fereastra Run Setup (Configurare rulare) oferă acces rapid la fișierele și setările necesare pentru
configurarea și desfășurarea unui experiment. Când optați să rulați un experiment definit de utilizator,
fereastra Run Setup (Configurare rulare) se deschide, afișând fila Protocol. Când optați să rulați un
experiment PrimePCR, fereastra Run Setup (Configurare rulare) se deschide, afișând fila Start Run
(Începere rulare).

Sfat: Consultați Efectuarea de experimente PrimePCR de la pagina 175 pentru informații despre
PrimePCR; consultați Fila Start Run (Începere rulare) de la pagina 166 pentru informații despre
fila Start Run (Începere rulare).
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1. Filele vă ghidează prin configurarea și rularea unui experiment:

n Fila Protocol – selectați un protocol existent pentru rulare sau editare sau pentru a
crea un protocol nou în Protocol Editor (Editor Protocol).

n Fila Plate (Placă) – selectați o placă existentă pentru rulare sau editare sau pentru a
crea o placă nouă în Plate Editor (Editor placă).

n Fila Start Run (Începere rulare) – vizualizați setările experimentului, selectați unul
sau mai multe blocuri de instrumente și începeți rularea.

2. Fereastra principală afișează opțiunile pentru fiecare filă pe măsură ce le aplicați.

3. Butoanele de navigare vă duc la fila Start Run (Începere rulare).

LEGENDĂ

Accesarea ferestrei Run Setup (Configurare rulare)
Pentru a accesa fereastra Run Setup (Configurare rulare)

u Urmați una dintre procedurile următoare:

n În fila Run Setup (Configurare rulare) din Startup Wizard (Expert pornire), faceți clic fie pe
User-defined (Definită de utilizator), fie pe PrimePCR.

n În fereastra Home (Pagină de pornire), faceți clic fie pe User-defined Run Setup (Configurare
rulare definită de utilizator), fie pe PrimePCR Run Setup (Configurare rulare PrimePCR) de
pe bara de instrumente.

n În fereastra Home (Pagină de pornire), selectați fie Run > User-defined Run (Rulare > Rulare
definită de utilizator), fie Run (Rulare) > PrimePCR Run (Rulare PrimePCR).
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Fila Protocol
Fila Protocol afișează o previzualizare a fișierului de protocol pe care intenționați să-l rulați. Un fișier
de protocol conține instrucțiunile pentru pașii de temperatură ai instrumentului, precum și opțiunile
instrumentului care controlează viteza de creștere, volumul probei și temperatura capacului.

Implicit, software-ul afișează protocolul definit în secțiunea File Selection for Run Setup (Selectare
fișier pentru configurarea rulării) din fila Files (Fișiere) în caseta de dialog User > User Preferences
(Utilizator > Preferințe utilizator). Puteți modifica protocolul implicit în caseta de dialog User
Preferences (Preferințe utilizator). Consultați Schimbarea setărilor implicite ale fișierelor de la pagina
83 pentru mai multe informații.

În fila Protocol, puteți:

n Crea un nou protocol de rulat

n Selecta un protocol existent pentru a-l rula sau edita

Pentru mai multe informații despre crearea și modificarea protocoalelor, consultați Capitolul 7,
Crearea de protocoale.
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Pentru a crea un nou protocol

1. În fila Protocol, faceți clic pe Create New (Creare nou).

Va apărea fereastra Protocol Editor (Editor Protocol).

2. Utilizați Protocol Editor (Editor Protocol) pentru a crea un nou protocol.

3. Faceți clic pe OK pentru a salva protocolul și a reveni la fila Protocol din Run Setup (Configurare
rulare).

4. Vizualizați detaliile protocolului și urmați una dintre procedurile următoare:

n Dacă detaliile sunt corecte, faceți clic pe Next (Următorul) pentru a accesa fila Plate (Placă).

n Dacă detaliile sunt incorecte, faceți clic pe Edit Selected (Editare selectat) pentru a reveni la
fereastra Protocol Editor (Editor Protocol). Revizuiți protocolul, salvați modificările, apoi faceți
clic pe Next (Următorul) din fila Protocol pentru a accesa fila Plate (Placă).

Pentru a selecta un protocol existent

1. În fila Protocol, urmați una dintre procedurile următoare:

n Faceți clic pe Select Existing (Selectare existent) pentru a naviga la un protocol existent.

n Faceți clic pe Express Load (Încărcare expresă) și selectați un protocol din lista verticală a
protocoalelor.

Sfat: Puteți adăuga sau elimina protocoale din lista verticală Express Load (Încărcare
expresă). Consultați Adăugarea și ștergerea protocoalelor cu încărcare expresă care
urmează pentru mai multe informații.

2. Vizualizați detaliile protocolului și urmați una dintre procedurile următoare:

n Dacă detaliile sunt corecte, faceți clic pe Next (Următorul) pentru a accesa fila Plate (Placă).

n Dacă detaliile sunt incorecte, faceți clic pe Edit Selected (Editare selectat) pentru a deschide
fereastra Protocol Editor (Editor Protocol). Revizuiți protocolul, salvați modificările, apoi faceți
clic pe Next (Următorul) din fila Protocol pentru a accesa fila Plate (Placă).

Adăugarea și ștergerea protocoalelor cu încărcare expresă

Puteți modifica conținutul listei verticale Express Load (Încărcare expresă) care apare în Protocol
Editor (Editor Protocol). Protocoalele din această listă sunt salvate în următorul folder:

c:\Users\Public\Public Documents\Bio-Rad\CFX_MDx\Users\[user_name]\ExpressLoad\
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Pentru a modifica lista de protocoale Express Load (Încărcare expresă)

1. Navigați la și deschideți folderul ExpressLoad (Încărcare expresă).

2. Verificați fișierele de protocol (.pcrl) din folder.

3. Urmați una dintre procedurile următoare:

n Ștergeți protocoalele din folder pentru a le îndepărta din lista verticală.

n Copiați protocoalele în folder pentru a le adăuga în lista verticală.
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Fila Plate (Placă)
Notă: Dacă protocolul selectat în fila Protocol nu include un pas de citire placă pentru analiza
PCR în timp real, fila Plate (Placă) este ascunsă. Pentru a vizualiza fila Plate (Placă), adăugați cel
puțin o citire de placă la protocol.

Fila Plate (Placă) afișează o previzualizare a fișierului de placă pe care doriți să îl încărcați. Într-o
rulare PCR în timp real, fișierul cu plăci conține o descriere a conținutului fiecărui godeu, inclusiv
fluoroforii săi, modul de scanare și tipul de placă. CFX Maestro Dx SE folosește aceste descrieri
pentru colectarea și analiza datelor.

Implicit, software-ul afișează placa definită în secțiunea File Selection for Run Setup (Selectare fișier
pentru configurarea rulării) din fila Files (Fișiere) din caseta de dialog User > User Preferences
(Utilizator > Preferințe utilizator). Puteți modifica placa implicită în caseta de dialog User Preferences
(Preferințe utilizator). Consultați Schimbarea setărilor implicite ale fișierelor de la pagina 83 pentru
mai multe informații.

În fila Plate (Placă), puteți:

n Creați o placă nouă pentru încărcare.

n Selectați o placă existentă pentru încărcare sau editare.
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Pentru mai multe informații despre crearea și modificarea plăcilor, consultați Capitolul 8, Pregătirea
plăcilor.

Pentru a crea o placă nouă

1. Pe fila Plate (Placă), faceți clic pe Create New (Creare nou).

Apare Plate Editor (Editor placă).

2. Utilizați Plate Editor (Editor placă) pentru a crea o placă nouă.

3. Faceți clic pe OK pentru a salva placa și a reveni la fila Plate (Placă) din Run Setup (Configurare
rulare).

4. Vizualizați detaliile plăcii și urmați una dintre procedurile următoare:

n Dacă detaliile sunt corecte, faceți clic pe Next (Următorul) pentru a accesa fila Start Run
(Începere rulare).

n Dacă detaliile sunt incorecte, faceți clic pe Edit Selected (Editare selectate) pentru a reveni la
fereastra Plate Editor (Editor placă). Revizuiți fișierul de placă, salvați modificările, apoi faceți
clic pe Next (Următorul) pentru a accesa fila Plate (Placă) pentru a continua la fila Start Run
(Începere rulare).

Pentru a selecta un fișier de placă existent

1. În fila Plate (Placă), urmați una dintre procedurile următoare:

n Faceți clic pe Select Existing (Selectare existent) pentru a naviga la un fișier de placă
existent.

n Faceți clic pe Express Load (Încărcare expresă) și selectați un fișier de placă din lista
verticală.

Sfat: Puteți adăuga sau elimina plăci din lista verticală Express Load (Încărcare
expresă). Consultați Adăugarea și ștergerea fișierelor placă cu încărcare expresă care
urmează pentru mai multe informații.

2. Vizualizați detaliile plăcii și urmați una dintre procedurile următoare:

n Dacă detaliile sunt corecte, faceți clic pe Next (Următorul) pentru a accesa fila Start Run
(Începere rulare).

n Dacă detaliile sunt incorecte, faceți clic pe Edit Selected (Editare selectat) pentru a deschide
fereastra Plate Editor (Editor placă). Revizuiți fișierul de placă, salvați modificările, apoi faceți
clic pe Next (Următorul) pentru a accesa fila Start Run (Începere rulare).
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Adăugarea și ștergerea fișierelor placă cu încărcare expresă

Puteți modifica conținutul listei verticale Express Load (Încărcare expresă) care apare în Plate Editor
(Editor placă). Plăcile care apar în această listă sunt salvate în următorul folder:

c:\Users\Public\Documents\Bio-Rad\CFX_MDx\Users\[user_name]\ExpressLoad\

Pentru a modifica lista Express Load (Încărcare expresă) pentru fișierele de placă

1. Navigați la și deschideți folderul ExpressLoad (Încărcare expresă).

2. Verificați fișierele de placă (.pltd) din folder.

3. Urmați una dintre procedurile următoare:

n Ștergeți fișierele de placă din folder pentru a le îndepărta din lista verticală.

n Copiați fișierele de placă din folder pentru a le adăuga în lista verticală.
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Fila Start Run (Începere rulare)
Fila Start Run (Începere rulare) afișează informații despre experimentul care urmează a fi rulat.
Aceasta afișează, de asemenea, blocul sau blocurile instrumentului conectat pe care puteți rula
experimentul.

Utilizând fila Start Run (Începere rulare), puteți face următoarele lucruri:

n Vizualiza informații detaliate despre rulare, inclusiv fișierul de protocol selectat, fișierul placă și
modul de scanare.

n Adăuga observații despre rulare.

n Vizualiza detalii despre toate instrumentele conectate, inclusiv starea lor de rulare (în funcțiune
sau inactiv), volumul probei în µl, temperatura capacului, modul de emulare și nr. de identificare
sau codul de bare, dacă sunt disponibile.

Notă: Puteți modifica coloanele care apar în tabelul Start Run on Selected Blocks (Începere
rulare pe blocurile selectate). Pentru informații suplimentare, consultați Modificarea detaliilor
din tabelul Selected Blocks (Blocuri selectate) de la pagina 167.

n Selectați blocul sau blocurile pe care doriți să realizați rularea.

n Deschideți sau închideți de la distanță capacul fiecărui instrument selectat.
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n Porniți rularea.

Modificarea detaliilor din tabelul Selected Blocks (Blocuri selectate)

Puteți modifica coloanele care apar în tabelul Start Run on Selected Block(s) (Începere rulare pe
blocurile selectate). Puteți, de asemenea, modifica valorile implicite pentru volumul probei și
temperatura capacului în tabel. Schimbările setărilor sunt aplicate asupra rulării de efectuat.

Pentru a adăuga coloane în tabelul Start Run on Selected Blocks (Începere rulare pe
blocurile selectate)

u Faceți clic dreapta pe tabel și selectați o opțiune în meniul care apare.

Pentru a elimina coloane din tabelul Start Run on Selected Blocks (Începere rulare pe
blocurile selectate)

u Faceți clic dreapta pe tabel și ștergeți opțiunea din meniul care apare.

Pentru a edita valorile pentru volumul probei sau temperatura capacului pentru un bloc

u Selectați celula pentru volumul probei sau temperatura capacului pentru blocul țintă și introduceți
o valoare nouă în celulă.

Pentru a adăuga un ID de rulare sau un cod de bare pentru un bloc

u Selectați celula ID/Bar Code (ID/Cod de bare) pentru blocul țintă și introduceți un ID sau scanați
blocul cu un cititor de cod de bare.

Rularea unui experiment
Important: Înainte de a rula un experiment, asigurați-vă că software-ul anti-virus al computerului
dumneavoastră nu va iniția o scanare în timpul rulării. Consultați Instalarea pentru Software-ul
CFX Maestro Dx SE de la pagina 31 și administratorul de sistem pentru mai multe informații.

Pentru a rula un experiment

1. În fila Start Run (Începere rulare), verificați detaliile despre placă și protocol în secțiunea Run
Information (Informații rulare).

2. (Opțional) Adăugați observații despre rulare sau experiment în caseta de text Notes (Observații).

3. Bifați caseta de selectare a blocului sau blocurilor pe care doriți să realizați rularea.

Sfat: Pentru a rula experimentul pe toate blocurile, selectați Select All Blocks (Selectare toate
blocurile) de sub tabelul Selected Blocks (Blocuri selectate).

4. (Opțional) Faceți clic pe Flash Block Indicator (Indicator luminos intermitent bloc) pentru a face să
lumineze indicatorul LED de pe blocurile selectate ale instrumentului.
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5. Introduceți plăcile experimentului în bloc:

a. Faceți clic pe Open Lid (Deschidere capac). Se va deschide capacul motorizat al fiecărui
bloc selectat.

b. Introduceți o placă de experiment în fiecare bloc selectat.

c. Faceți clic pe Close Lid (Închidere capac).

Sfat: Pe Sistemul CFX Opus Dx, atingeți Deschidere capac sau Închidere capac pe ecranul
de pornire.

6. Faceți clic pe Open Lid (Deschidere capac) și Close Lid (Închidere capac) pentru a deschide și
închide capacul motorizat al fiecărui bloc selectat pentru instrument.

7. Vizualizați detaliile rulării și urmați una dintre procedurile următoare:

n Dacă detaliile sunt corecte, faceți clic pe Start Run (Începere rulare).

n Dacă detaliile sunt incorecte:

o Corectați detaliile în tabelul Selected Blocks (Blocuri selectate) și faceți clic pe Start Run
(Începere rulare).

o Reveniți la fila corectă și efectuați modificările adecvate, salvați modificările, apoi faceți
clic pe Next (Următorul) pentru a reveni la fila Start Run (Începere rulare) și a iniția
rularea.

Pentru a iniția o nouă rulare dintr-o rulare anterioară

u Urmați una dintre procedurile următoare:

n Selectați File > Repeat a Run (Fișier > Repetare rulare) din bara meniului principal al
software-ului; navigați la și faceți dublu clic pe fișierul de date al rulării pe care doriți să o
repetați.

n Selectați fila Repeat Run (Repetare rulare) din Startup Wizard (Expert pornire) și faceți dublu
clic pe fișierul de date al rulării pe care doriți să o repetați.

Opțional, în fila Repeat Run (Repetare rulare) puteți face clic pe Browse (Navigare) și naviga
la și face dublu clic pe fișierul de date al rulării pe care doriți să o repetați.
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Caseta de dialog Run Details (Detalii rulare)
Când faceți clic pe Start Run (Începere rulare), CFX Maestro Dx SE vă indică să salvați fișierul de date
(.pcrd), începe rularea și deschide caseta de dialog Run Details (Detalii rulare). Caseta de dialog Run
Details (Detalii rulare) cuprinde trei file de stare:

n Run Status (Stare rulare) – utilizată pentru a vizualiza starea actuală a protocolului, a deschide
sau închide capacul, a pune pe pauză o rulare, a adăuga repetări, a omite pași sau a opri
rularea.

n Real-time Status (Stare în timp real) – utilizată pentru a vizualiza datele fluorescenței PCR în
timp real, pe măsură ce sunt colectate.

n Time Status (Stare timp) – utilizată pentru a vizualiza pe întregul ecran cronometrul pentru
numărătoarea inversă pentru protocol.

Aceste file sunt explicate în detaliu în următoarele secțiuni.

Fila Run Status (Stare rulare)
Fila Run Status (Stare rulare) afișează starea actuală a unei rulări în curs de desfășurare. În această
vizualizare puteți, de asemenea, să controlați capacul și să schimbați rularea în curs de desfășurare.
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1. Panoul Run Status (Stare rulare) – afișează progresul actual al protocolului.

2. Soluții de control pentru Run Status (Stare rulare) – vă permit să operați instrumentul
sau să întrerupeți protocolul actual.

3. Panoul Run Information (Informații rulare) – afișează detaliile rulării.

LEGENDĂ

Comenzi Run Status (Stare rulare)

Utilizați comenzile din fila Run Status (Stare rulare) fie pentru a opera instrumentul din software, fie
pentru a modifica o rulare în curs.

Notă: Schimbările aduse protocolului în timpul rulării, precum adăugarea de repetări, nu modifică
fișierul de protocol asociat rulării. Aceste acțiuni sunt înregistrate în Run Log (Jurnal rulare).

– deschide capacul motorizat al instrumentelor selectate.

Important: Deschiderea capacului în timpul unei rulări pune rularea pe pauză în timpul
pasului curent și ar putea modifica datele.

– închide capacul motorizat al instrumentelor selectate.

– adaugă mai multe repetări la pasul curent GOTO (SaltLa) din protocol. Această opțiune este
disponibilă doar când rulează un pas GOTO (SaltLa).

Notă: Puteți adăuga repetări suplimentare în timpul unui ciclu GoTo (SaltLa) când protocolul
este în desfășurare. In orice caz,CFX Maestro Dx SE recunoaște cea mai recentă modificare
a numărului de repetări. De exemplu, dacă adăugați 10 repetări suplimentare în timpul unui
ciclu GoTo (SaltLa), software-ul va schimba numărul total la n + 10. Dacă apoi adăugați încă
cinci (5) repetări în același ciclu, CFX Maestro va schimba numărul total de repetări la n + 5.
Prima modificare (10 repetări) este ignorată. Pentru a vă asigura că software-ul efectuează
numărul țintă de repetări, introduceți numărul total (în acest caz, 15 repetări).

– omite pasul curent din protocol.

Notă: Dacă inițiați un salt în timpul unui pas GOTO (SaltLa), sistemul trece la următorul ciclu
în bucla GOTO (SaltLa). Dacă, în momentul saltului, era în desfășurare ultimul ciclu al pasului
GOTO (SaltLa), sistemul trece la pasul următor.
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– aprinde intermitent LED-ul de pe instrumentul selectat, pentru a identifica blocurile selectate.

– pune pauză protocolului.

Notă: Această acțiune este înregistrată în Run Log (Jurnal rulare).

– reia un protocol care a fost pus pe pauză.

– oprește rularea înainte ca protocolul să fie finalizat.

Notă: Oprirea unei rulări înainte ca protocolul să fie finalizat vă poate modifica datele.

Fila Real-time Status (Stare în timp real)
Fila Real-time Status (Stare în timp real) afișează datele PCR în timp real colectate în fiecare ciclu în
timpul rulării, după primele două citiri ale plăcii.
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1. Panoul urme de amplificare – afișează datele de amplificare în timp real din timpul
rulării.

2. Identificator grup de godeuri – dacă la configurația plăcii au fost identificate grupuri de
godeuri, utilizatorii pot selecta un anumit grup de godeuri pentru a-i vizualiza urmele,
godeurile și informațiile tabelare.

Identificator număr de pas – dacă protocolul colectează date la mai mult de un pas (de
exemplu, în timpul amplificării și curbei de topire), utilizatorii pot selecta un anumit
pas și vizualiza urmele colectate la pasul respectiv.

3. Panoul selectorului de godeuri – afișează godeurile active, inactive și goale din placă.

4. Panoul tabelului de configurație a plăcii – afișează configurația plăcii în format tabelar.

5. Panoul cu detalii despre rulare – afișează starea rulării în timp real, inclusiv:

n Pasul curent

n Repetarea curentă

n Temperatura curentă

n Timpul rămas

n Temperatura probei

n Temperatura capacului

6. Plate Setup (Configurație placă) – deschide caseta de dialog Plate Setup
(Configurație placă), în care utilizatorii pot modifica configurația curentă a plăcii în
timpul unei rulări.

LEGENDĂ

În fila Real-time Status (Stare în timp real) puteți:

n Afișa sau ascunde urmele în timp real, selectându-le în panoul selectorului de godeuri sau în
tabelul de configurație a plăcii

n Vizualiza o singură urmă sau grupuri de urme selectându-le din meniul vertical al grupurilor de
godeuri

n Edita placa sau înlocui fișierul placă

n Aplica un fișier PrimePCR la rulare

Afișarea sau ascunderea urmelor în timp real

Implicit, toate godeurile umplute sunt active și apar în tabelul de configurație a plăcii. Godeurile active
apar cu albastru în panoul selectorului de godeuri. Godeurile ascunse apar cu gri deschis, iar
godeurile nefolosite apar cu gri închis în panoul selectorului de godeuri.
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Puteți ascunde urme din godeurile active în timpul rulării. CFX Maestro Dx SE continuă să colecteze
date pentru toate godeurile; când ascundeți godeurile, datele lor nu apar în tabelul de configurare a
plăcilor.

Pentru a ascunde urmele în timp real

u În panoul selectorului de godeuri, faceți clic pe godeurile active (albastre) pe care doriți să le
ascundeți.

Pentru a afișa urmele în timp real

u În panoul selectorului de godeuri, faceți clic pe godeurile ascunse (gri deschis) pe care doriți să
le afișați.

Pentru mai multe informații despre selectorul de sonde, consultați Selectorul de godeuri de la pagina
195.

Editarea configurației plăcii

Pentru a edita configurația plăcii

u Faceți clic pe Plate Setup (Configurație placă) și apoi selectați View/Edit Plate (Vizualizare
editare/placă).

Apare fereastra Plate Editor (Editor placă) în care puteți edita placa în timp ce rularea este în curs.
Pentru mai multe informații despre editarea plăcilor, consultați Capitolul 8, Pregătirea plăcilor.

Notă: De asemenea, puteți edita stilurile de urme din fereastra Plate Editor (Editor placă).
Modificările apar în graficul urmelor de amplificare din fila Real-time Status (Stare în timp
real).

Înlocuirea unui fișier placă

Sfat: Înlocuirea unui fișier placă este utilă în special dacă inițiați o rulare cu un fișier Quick Plate
(Placă rapidă) din folderul ExpressLoad (Încărcare expresă) .

Pentru a înlocui un fișier placă

u Faceți clic pe Plate Setup (Configurație placă), apoi selectați una dintre următoarele opțiuni:

n Replace Plate file (Înlocuire fișier placă) – selectați noul fișier placă din lista din fereastra de
navigare

n Apply PrimePCR file (Aplicare fișier PrimePCR) – căutați un fișier de rulare din care se va
obține structura plăcii, utilizând Smart search (Căutare inteligentă) sau făcând clic pe Browse
(Răsfoire) pentru a găsi un fișier pe care l-ați descărcat de pe site-ul web Bio-Rad și care nu
se află în folderul PrimePCR
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Notă: CFX Maestro Dx SE verifică modul de scanare și dimensiunea plăcii pentru fișierul
placă. Acestea trebuie să corespundă cu cele din setările rulării cu care a început rularea.

Fila Time Status (Stare timp)
Fila Time Status (Stare timp) afișează timpul rămas pentru finalizarea rulării actuale.
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Efectuarea de experimente PrimePCR
Experimentele PrimePCR utilizează teste specifice pentru cale biologică sau afecțiune pe care Bio-
Rad le-a validat și le-a optimizat în laborator umed și care sunt disponibile în următoarele formate:

n Panouri cu placă preconfigurată – plăci care conțin teste care sunt specifice pentru o cale
biologică sau afecțiune; acestea includ soluții de control PrimePCR și gene de referință

n Plăci cu o configurație personalizată – plăci care pot fi configurate într-o structură definită de
utilizator, cu opțiunea de a selecta teste pentru ținte de interes, soluții de control și referințe.

n Teste individuale – eprubete care conțin seturi de primeri individual pentru utilizare în reacții în
timp real

Pentru a reduce timpul de rulare general, puteți elimina pasul de topire din protocol. Bio-Rad vă
recomandă insistent să nu faceți nicio altă modificare a unui protocol de rularePrimePCR. Protocolul
implicit este cel care a fost utilizat pentru validarea testului. Orice deviere de la aceasta poate afecta
rezultatele. Schimbările privind protocolul sunt notate în fila Run Information (Informații rulare) pentru
fișierul de date rezultat și în orice rapoarte create.

Pentru a iniția o rulare PrimePCR

u Pentru a iniția o rulare PrimePCR, efectuați oricare dintre următoarele:

n În Startup Wizard (Expert pornire), selectați PrimePCR pe fila Run Setup (Configurare rulare)
și apoi selectați chimia corespunzătoare (SYBER® sau Probe - sondă).

n Selectați o rulare PrimePCR din lista Recent Runs (Rulări recente) de pe fila Repeat Run
(Repetare rulare) în Startup Wizard (Expert pornire).

n Selectați File > New > PrimePCR Run File (Fișier > Nou > Fișier Rulare PrimePCR) în
fereastra Home (Pagină de pornire).

n Trageți și eliberați un fișier de rulare PrimePCR în fereastra Home (Pagină de pornire).

După ce ați selectat o rulare PrimePCR, în fereastra Run Setup (Configurare rulare) se deschide pe
fila Start Run (Începere rulare) cu structura implicită de placă PrimePCR încărcată în funcție de
instrumentul selectat.

Pentru a elimina pasul de topire din protocol

u Pe fila Protocol, ștergeți caseta adiacentă de lângă opțiunea Include Melt Step (Includere pas
topire).
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Pentru a importa informații țintă pentru plăci PrimePCR într-o structură de placă

1. Urmați una dintre procedurile următoare:

n În fila Real-time Status (Stare în timp real), în caseta de dialog Run Details (Detalii rulare),
selectați Plate Setup > Apply PrimePCR File (Configurare placă > Aplicare fișier PrimePCR).

n În fereastra Data Analysis (Analiză date), selectați Plate Setup > Apply PrimePCR File
(Configurație placă > Aplicare fișier PrimePCR).

2. În caseta de dialog pentru fișierul de rulare PrimePCR, faceți clic pe Browse (Răsfoire) pentru a
naviga la fișierul PrimePCR corespunzător (.csv).

3. Selectați fișierul PrimePCR țintă și faceți clic pe Open (Deschidere).

Sistemul CFX Opus Dx importă informațiile țintă în structura dvs. de placă.
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Transferarea datelor independente pentru analiză
Important: Când transferați fișiere de date din Sistemul CFX Opus Dx pe CFX Maestro Dx SE,
toate fișierele salvate pe sistem sunt transferate. Asigurați-vă că aveți suficient spațiu pe disc
pentru ca datele să se transfere în siguranță.

Când rularea este finalizată, CFX Maestro Dx SE analizează datele de fluorescență. Dacă rularea
este efectuată în modul independent și salvată pe Sistemul CFX Opus Dx, datele trebuie transferate
către computerul CFX Maestro Dx SE pentru analiză.

Sistemul CFX Opus Dx poate stoca până la 100 de rulări PCR în timp real. După ce rularea se
finalizează, puteți transfera fișiere de date independente către computerul cu CFX Maestro Dx SE prin
e-mail, unitate USB sau prin software-ul însuși.

Această secțiune explică modul de a transfera fișiere de date independente către computerul
CFX Maestro Dx SE.

Transferarea datelor prin e-mail
Pentru a trimite prin e-mail un fișier de date la sfârșitul unei rulări

1. Configurați notificări prin e-mail pentru instrument.

Consultați Configurarea notificării prin e-mail de la pagina 80 sau Manualul de utilizare Sistemul
PCR în timp real CFX Opus Dx.

2. Atunci când configurați notificări prin e-mail, asigurați-vă că opțiunea Attach Data File (Atașare
fișier de date) este selectată.

Datele rulării sunt trimise prin e-mail ca fișier .pcrd.

Transferul datelor de peSistemul PCR în timp real CFX Opus Dx
s
Cu ajutorul funcției File Browser (Browser fișiere) de peSistemul CFX Opus Dx , puteți transfera fișiere
de date pe o unitate USB atașată sau într-un folder de rețea partajat. De asemenea, puteți
transferaCFX Maestro Dx SE fișiere de protocol de pe o unitate USB sau unitate partajată într-un
folder dinSistemul CFX Opus Dx sistemul de browser de fișiere și le puteți rula pe instrumentul CFX
Opus.

Sfat: În această secțiune este explicat modul de transfer al datelor. Pentru informații despre
configurarea conexiunii Ethernet consultați Ghidul instrumentului Sistemul PCR în timp real CFX
Opus Dx Manualul de instrucțiuni disponibil din meniul Help (Ajutor) al CFX Maestro Dx SE.
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1. Pe ecranul de pornire CFX Opus Dx, atingeți Files (Fișiere) pentru a vizualiza ecranul File
Browser (Browser fișiere).

2. Pe ecranul File Browser (Browser fișiere), navigați la fișierul pe care doriți să îl copiați, apoi
atingeți fișierul pentru a vizualiza panoul de detalii al fișierului.

3. În panoul cu detalii despre fișier, atingeți Options (Opțiuni), apoi atingeți Copy (Copiere).
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Apare caseta de dialog Select Location (Selectare locație).

4. În caseta de dialog Select Location (Selectare locație), efectuați una dintre următoarele acțiuni:

n Navigați la un folder existent.

n Navigați la locație pentru a crea un folder în care să salvați fișierul, apoi atingeți Create
Folder (Creare folder)

( ) pentru a crea un folder nou în locația respectivă.

5. Atingeți Select (Selectare) pentru a copia fișierul în locația selectată sau Cancel (Anulare) pentru
a reveni la ecranul File Browser (Browser fișiere).

Notă: Dacă există un fișier cu același nume în locația selectată, apare un dialog. Atingeți Yes
(Da) pentru a suprascrie fișierul existent sau No (Nu) pentru a reveni la ecranul File Browser
(Browser fișiere).

Sistemul CFX Opus afișează un mesaj de confirmare atunci când fișierul este copiat cu succes.

Transferarea datelor folosind o unitate USB
Dacă introduceți o unitate USB în portul USB de pe instrument, fișierul de date este salvat automat în
directorul rădăcină al unității USB atunci când rularea este finalizată. De asemenea, puteți găsi fișiere
de date salvate anterior și le puteți salva pe o unitate USB atașată.

Pentru a transfera fișiere de date pe o unitate USB introdusă în Sistemul CFX Opus Dx

u În caseta de dialog Select Location (Selectare locație), atingeți USB și navigați la folderul țintă în
care să copiați fișierul sau Cancel (Anulați) pentru a reveni la ecranul File Browser (Browser
fișiere).

Notă: Dacă există un fișier cu același nume în locația selectată, apare un dialog. Atingeți Yes
(Da) pentru a suprascrie fișierul existent sau No (Nu) pentru a reveni la ecranul File Browser
(Browser fișiere).

Sistemul CFX Opus Dx afișează un mesaj de confirmare atunci când fișierul este copiat cu succes.
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Transferul de date printr-o unitate de rețea partajată folosind
Sistemul PCR în timp real CFX Opus Dx
Sfat: Puteți transfera date către și de pe o unitate de rețea partajată numai prin Sistemul CFX
Opus Dx.

Sistemul CFX Opus Dx vă permit să vă conectați la o unitate de rețea partajată utilizând Ethernet . Cu
o conexiune reușită, puteți transfera fișiere de date către și dintr-un folder de pe unitatea de rețea
partajată.

Pentru a transfera date către și de pe o unitate de rețea partajată

u În caseta de dialog Select Location (Selectare locație), atingeți Network (Rețea) și navigați la
folderul țintă în care să copiați fișierul sau Cancel (Anulați) pentru a reveni la ecranul File Browser
(Browser fișiere).

Notă: Dacă există un fișier cu același nume în locația selectată, apare un dialog. Atingeți Yes
(Da) pentru a suprascrie fișierul existent sau No (Nu) pentru a reveni la ecranul File Browser
(Browser fișiere).

Sistemul CFX Opus Dx afișează un mesaj de confirmare atunci când fișierul este copiat cu succes.
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Crearea unui fișier de date
Pentru a analiza datele transferate de la instrument la computerul CFX Maestro Dx SE, fișierul de date
comprimate (fișierul .zpcr) trebuie convertit într-un fișier de date (fișierul .pcrd). CFX Maestro Dx SE
convertește fișierul .zpcr într-un fișier .pcrd și apoi selectează un fișier placă care are același mod de
scanare și dimensiunea plăcii și îl aplică fișierului .pcrd.

Pentru a crea un fișier de date dintr-un fișier de date de sine stătător

1. În CFX Maestro Dx SE, urmați una dintre procedurile următoare:

n Localizați fișierul .zpcr țintă și trageți-l în fereastra Home (Pagină de pornire) a CFX Maestro
Dx SE.

n Selectați File > Open > Stand-alone Run (Fișier > Deschidere > Rulare de sine stătătoare) și
navigați la și selectați fișierul țintă.

CFX Maestro Dx SE afișează caseta de dialog Save as (Salvare ca).

2. Navigați la folderul în care intenționați să salvați fișierul .pcrd și faceți clic pe Save (Salvare).

După ce ați salvat fișierul .pcrd, CFX Maestro Dx SE deschide fereastra Data Analysis (Analiză
date) și afișează datele rezultate.
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Capitolul 10 Prezentare generală a ferestrei Data
Analysis (Analiză date)

Software-ul CFX Maestro Dx SE procesează automat date PCR în timp real la finalul fiecărei rulări și
deschide fereastra Data Analysis (Analiză date) pentru a afișa aceste date (fișierul .pcrd).

CFX Maestro Dx SEoferă mai multe metode de a deschide și vizualiza fișierele de date. Puteți să

n Trageți un fișier de date (extensie .pcrd) în fereastra Home (Pagină de pornire) și să-l eliberați

n Selectați File > Open > Data File (Fișier > Deschidere > Fișier de date) din fereastra Home
(Pagină de pornire) și să navigați la fișierul .pcrd țintă

n Selectați File > Recent Data Files (Fișier > Fișiere de date recente) din fereastra Home (Pagină
de pornire) pentru a selecta dintr-o listă cu cele mai recente zece fișiere de date deschise

n Alegeți fila Analyze (Analizare) din Startup Wizard (Expert pornire) și fie să selectați din Recent
Files (Fișiere recente), fie să faceți clic pe Browse (Navigare) pentru a localiza fișierul de date

Fereastra Data Analysis (Analiză date)
Fereastra Data Analysis (Analiză date) afișează mai multe file, fiecare filă afișând datele analizate
pentru o anumită metodă de analiză sau informații specifice rulării. Filele apar doar dacă datele
colectate în timpul rulării sunt disponibile pentru tipul respectiv de analiză.

Sfat: Pentru a alege filele care vor fi afișate, selectați-le din meniul vertical View (Vizualizare) din
fereastra Data Analysis (Analiză date). Pentru a reveni la aspectul original al filei, selectați
Settings > Restore Default Window Layout (Setări > Restabilire Aspect fereastră implicit).
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Bara de instrumente de analiză a datelor
Bara de instrumente din fereastra Data Analysis (Analiză date) oferă acces rapid la funcții importante
de analiză a datelor.

Tabelul 10 prezintă funcțiile butoanelor de pe bara de instrumente.

Buton Denumire Funcție

Plate Setup
(Configurație
placă)

View/Edit plate (Vizualizare/Editare placă) —
deschide Plate Editor (Editor placă) pentru a
vizualiza și edita conținutul godeurilor.

Replace Plate (Înlocuire placă) — selectează un
fișier placă pentru a înlocui configurația plăcii.

Apply PrimePCR file (Fișier pentru aplicarea
PrimePCR) — selectează un fișier de rulare care va
înlocui structura plăcii pentru o rulare PrimePCR.

Manage Well
Groups
(Gestionare
grupuri de godeuri)

Deschide fereastra Well Groups Manager (Manager
grupuri de godeuri) pentru a crea, edita și șterge
grupuri de godeuri.

Grup de godeuri Selectează numele unui grup de godeuri existent din
meniul vertical. Selecția implicită este All Wells
(Toate godeurile). Acest buton apare doar când sunt
create grupuri de godeuri.

Analysis Mode
(Mod Analiză)

Analizează datele fie în modul Fluorophore
(Fluorofor), fie în modul Target (Țintă).

Help (Ajutor) Deschide utilitarul Help (Ajutor) al software-ului prin
intermediul căruia care puteți găsi ajutor online și o
copie digitală a acestui manual în format Acrobat
PDF.

Tabelul 10. Bara de instrumente din fereastra Data Analysis (Analiză date)
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Bara de meniu de analiză a datelor
Tabelul 11 listează elementele barei de meniu din fereastra Data Analysis (Analiză date).

Element de
meniu Comandă Funcție

File (Fișier) Save (Salvare) Salvează fișierul.

Save As (Salvare ca) Salvează fișierul cu o denumire nouă.

File Passwords (Parole fișier) Permite utilizatorilor să seteze o parolă pentru
salvarea, respectiv deschiderea fișierelor.

Sign (Semnătură) Permite utilizatorilor să semneze fișierul de
date.

Repeat Run (Repetare rulare) Extrage fișierul de protocol și pentru placă din
rularea curentă, pentru a-l rula din nou.

Close (Închidere) Închide fereastra Data Analysis (Analiză date).

View
(Vizualizare)

Run Log (Jurnal rulare) Deschide o fereastră Run Log (Jurnal rulare)
pentru a vizualiza jurnalul rulării fișierului de
date curent.

Traseul auditului Deschide traseul de audit pentru fișier.

Quantification, Melt Curve, Gene
Expression, End Point, Custom
Data View, QC, Run Information
(Cuantificare, Curbă de topire,
Expresie genică, Momentul final,
Vizualizare personalizată a
datelor, CC, Informații rulare)

Afișează datele analizate din filele selectate în
fereastra Data Analysis (Analiză date).
Trebuie selectată cel puțin o filă.

Tabelul 11. Elementele barei de meniu din fereastra Data Analysis (Analiză date)
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Element de
meniu Comandă Funcție

Setări Cq Determination Mode (Mod
determinare Cq)

Vă permite să selectați modul Regression
(Regresie) sau Single Threshold (Prag unic)
pentru a determina cum se calculează valorile
Cq pentru fiecare urmă.

Tabelul 11. Elementele barei de meniu din fereastra Data Analysis (Analiză date), continuare
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Element de
meniu Comandă Funcție

Baseline Setting (Setarea Nivel
inițial)

Vă permite să selectați metoda de scădere a
nivelului inițial pentru grupurile selectate de
godeuri.

Analysis Mode (Mod Analiză) Vă permite să analizați datele în funcție de
Fluorophore (Fluorofor) sau Target (Țintă).

Cycles to Analyze (Cicluri de
analizat)

Vă permite să selectați ciclurile de analizat.

Baseline Thresholds (Praguri nivel
inițial)

Deschide fereastra Baseline Thresholds
(Praguri nivel inițial) pentru a ajusta nivelul
inițial sau pragul.

Trace Styles (Stiluri Urme) Deschide fereastra Trace Styles (Stiluri
Urme).

Plate Setup (Configurație placă) Deschide Plate Editor (Editor placă) pentru a
vizualiza și edita placa; a înlocui placa curentă
cu una dintr-un fișier pentru placă definit de
utilizator sau un fișier de rulare PrimePCR.

Include All Excluded Wells
(Includeți toate godeurile excluse)

Include toate godeurile excluse în analiză.

Mouse Highlighting (Evidențiere cu
mouse-ul)

Activează sau dezactivează evidențierea
simultană a datelor cu indicatorul mouse-ului.

Sfat: Dacă Mouse Highlighting
(Evidențiere cu mouse-ul) este
dezactivată, apăsați tasta Control pentru a
activa temporar evidențierea.

Restore Default Window Layout
(Restabilire Aspect fereastră
implicit)

Restabilește aranjarea ferestrei la setările
implicite.

Tabelul 11. Elementele barei de meniu din fereastra Data Analysis (Analiză date), continuare
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Element de
meniu Comandă Funcție

Export
(Exportare)

Exportă toate fișele de date Vă permite să selectați dacă doriți să exportați
toate vizualizările foilor de calcul din fiecare
filă într-un fișier .csv, .txt. Excel sau .xml.

Export RDML File (Exportă un
fișier RDML)

Vă permite să selectați versiunea 1.1 sau 1.0 a
RDML, în care să exportați fișierul.

Custom Export (Export
personalizat)

Deschide fereastra Custom Export (Export
personalizat) în care pot fi specificate
câmpurile de exportat și formatul fișierului.

Export to LIMS Folder (Exportare
în folderul LIMS)

Deschide o fereastră pentru a salva datele într-
un format predeterminat în folderul LIMS.

Seegene Export (Exportare
Seegene)

Deschide o fereastră pentru a identifica locul
de salvare a datelor din toate foile de calcul în
fișiere Excel structurate special pentru a fi
utilizate de Seegene, Inc.

Sfat: De asemenea, puteți porni automat
programul Seegene Viewer după export.
Pentru mai multe informații, consultați
Comenzile meniului Tools
(Instrumente) de la pagina 63.

Tools
(Instrumente)

Reports (Rapoarte) Deschide Raportul pentru acest fișier de date.

Well Group Reports (Rapoarte
pentru grupuri de godeuri)

Deschide fereastra Well Group Report
(Rapoarte pentru grupuri de godeuri) pentru a
genera rapoarte pentru grupurile de godeuri
specificate.

Import Fluorophore Calibration
(Importare calibrare fluorofor)

Selectați un fișier de calibrare de aplicat
fișierului de date curent.

qbase+ Lansează qbase+ v2.5 direct din fișierul .pcrd
curent, dacă este instalat.

Generate LIMS PLRN file
(Generare fișier LIMS PLRN)

Salvează fișierul de date ca fișier .plrn
formatat LIMS.

Tabelul 11. Elementele barei de meniu din fereastra Data Analysis (Analiză date), continuare
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Detalii filă
Fiecare filă din fereastra Data Analysis (Analiză date) afișează datele în grafice și foi de calcul pentru
o anumită metodă de analiză și include un selector de godeu pentru selectarea datelor pe care doriți
să le afișați. Când se deschide, Data Analysis (Analiză date) afișează implicit fila Quantification
(Cuantificare). Puteți utiliza datele din graficul Amplification (Amplificare) din fila Quantification
(Cuantificare) pentru a determina setările adecvate de analiză pentru rulare.

Notă: Software-ul asociază datele din panourile fiecărei file Data Analysis (Analiză date). De
exemplu, evidențierea unui godeu prin plasarea indicatorului mouse-ului pe godeu în
vizualizarea selector de godeuri evidențiază datele din toate celelalte panouri.

Selectorul Step Number (Număr pas)
Sistemele CFX Opus 96 Dx și CFX Opus 384 Dx pot obține date de fluorescență în mai mulți pași de
protocol; software-ul menține datele obținute la fiecare pas în mod independent. CFX Maestro Dx SE
afișează selectorul Step Number (Număr pas) sub graficul Standard Curve (Curbă standard) din fila
Quantification (Cuantificare). Atunci când un protocol conține cel puțin un pas de colectare a datelor,
CFX Maestro Dx SE afișează datele din primul pas de colectare.

Dacă protocolul conține mai mult de un pas de colectare, puteți selecta un alt pas din lista verticală.
De exemplu:
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Atunci când selectați un pas, software-ul aplică acea selecție tuturor datelor afișate în fereastra Data
Analysis (Analiză date).

Vizualizarea grupurilor de godeuri în Data Analysis (Analiză
date)
Godeurile din placă pot fi grupate în subseturi pentru analiză independentă utilizând grupuri de
godeuri. Când creați grupuri de godeuri, denumirea grupului apare în fereastra Data Analysis
(Analiză date), în lista verticală Well Groups (Grupuri de godeuri) de pe bara de instrumente.

Dacă ați creat grupuri de godeuri, software-ul afișează grupul implicit de godeuri All Wells (Toate
godeurile) atunci când deschideți fereastra Data Analysis (Analiză date), afișând datele din toate
godeurile cu conținut în grafice și foi de calcul. Doar godeurile din grupul de godeuri respectiv
încărcate cu conținut apar în selectorul de godeuri și doar datele pentru godeurile respective sunt
incluse în calculele analizei datelor.

Sfat: Pentru a crea, edita și șterge grupuri de godeuri, faceți clic pe Manage Well Groups
(Gestionare grupuri de godeuri) de pe bara de instrumente.

Notă: Dacă nu ați creat grupuri de godeuri, lista verticală Well Groups (Grupuri de godeuri) nu va
apărea în bara de instrumente.

Modificarea conținutului godeurilor după o rulare
În timpul analizei datelor, modificarea modului în care sunt afișate datele prin modificarea conținutului
godeurilor în Plate Editor (Editor placă) nu modifică niciodată datele de fluorescență colectate din
fiecare godeu în timpul rulării. După ce modulul colectează datele de fluorescență, acele date nu pot fi
șterse, dar puteți să le eliminați din vizualizare și din analiză.

Pentru modificarea conținutului godeurilor după o rulare

u În fereastra Data Analysis (Analiză date), faceți clic pe Plate Setup (Configurație placă) și selectați
una dintre următoarele opțiuni:

n Edit/View Plate (Editare/Vizualizare placă) – deschide Plate Editor (Editor placă), unde
puteți face modificări manuale la configurație.

n Replace Plate File (Înlocuire fișier placă) – deschide browser-ul Select Plate (Selectare
placă), în care puteți naviga la un fișier placă salvat anterior cu care să înlocuiți structura
curentă a plăcii.

n Apply PrimePCR file (Aplicare fișier PrimePCR) – deschide caseta de dialog Select
PrimePCR file (Selectare fișier PrimePCR), în care puteți naviga la un fișier de rulare
PrimePCR, pe care îl puteți aplica structurii plăcii.
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Sfat: Puteți adăuga sau edita informații despre conținutul godeului înainte de o rulare, în timpul
sau după o rulare sau după finalizarea unei rulări PCR. Trebuie să atribuiți modul de scanare și
dimensiunea plăcii înainte de rulare. Acești parametri nu pot fi modificați după rulare.
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Data Analysis Settings (Setări Analiză date)
Datele graficului Amplification (Amplificare) din fila Quantification (Cuantificare) indică unitatea de
fluorescență relativă (RFU) pentru fiecare godeu din fiecare ciclu. Fiecare urmă din grafic reprezintă
datele de la un singur fluorofor dintr-un godeu. Aceste date sunt utilizate pentru determinarea valorilor
Cq pentru fiecare godeu și fiecare fluorofor. Software-ul folosește unul dintre cele două moduri pentru
a determina valorile Cq:

n Regression (Regresie) – aplică un model de regresie neliniar, cu mai multe variabile, urmelor
individuale ale godeului, iar apoi utilizează modelul respectiv pentru a calcula o valoare Cq
optimă.

n Single Threshold (Prag unic) – folosește o singură valoare de prag pentru a calcula valoarea Cq
în funcție de punctul de depășire a pragului urmelor de fluorescență individuale.

Selectați Settings> Cq Determination Mode (Setări > Mod determinare Cq) pentru a alege modul de
determinare a Cq .

Ajustarea pragului
În modul Single Threshold (Prag unic), puteți ajusta pragul pentru un fluorofor făcând clic pe linia de
prag din graficul Amplification (Amplificare) și deplasând indicatorul mouse-ului pe verticală.
Alternativ, puteți specifica un prag exact pentru fluoroforul existent.

Setarea Nivel inițial
Software-ul setează automat nivelul inițial individual pentru fiecare godeu. Setarea Nivel inițial
determină metoda de scădere a nivelului inițial pentru toate urmele de fluorescență. Software-ul oferă
trei opțiuni de scădere a nivelului inițial:

n No Baseline Subtraction (Fără scădere a nivelului inițial) – afișează datele sub formă de urme
de fluorescență relativă. Anumite analize nu sunt posibile în acest mod de analiză, prin urmare
software-ul nu afișează filele Gene Expression (Expresie genică), End Point (Momentul final) și
Allelic Discrimination (Discriminare alelică).

n Baseline Subtracted (Nivelul inițial scăzut) – afișează datele sub formă de urme din care s-a
scăzut nivelul inițial pentru fiecare fluorofor dintr-un godeu. Software-ul trebuie să scadă nivelul
inițial din date pentru a determina ciclurile de cuantificare, construi curbele standard și determina
concentrația probelor necunoscute. Pentru a genera o urmă din care s-a scăzut nivelul inițial,
software-ul integrează cea mai bună linie dreaptă prin fluorescența înregistrată a fiecărui godeu
în timpul ciclurilor inițiale, apoi scade datele cele mai potrivite din datele de fond din care s-a
scăzut nivelul inițial la fiecare ciclu.
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n Baseline Subtracted Curve Fit (Potrivirea curbei din care s-a scăzut nivelul inițial) – afișează
datele drept urme din care s-a scăzut nivelul inițial, iar software-ul ajustează curba din care s-a
scăzut nivelul inițial folosind un filtru de medie centrat. Acest proces este realizat în așa fel încât
fiecare Cq să rămână invariabilă.

Pe lângă aceste opțiuni, puteți selecta și Apply Fluorescent Drift Correction (Aplicare corecție deviație
fluorescență). Pentru godeurile care au valori de deviație RFU anormale în timpul primelor câteva cicluri
ale unei rulări, software-ul derivă un nivel inițial estimat din godeurile adiacente pentru care s-a generat
cu succes un nivel inițial orizontal.

Pentru a schimba setarea scăderii nivelului inițial:

u Selectați Settings > Baseline Setting (Setări > Setarea nivelului de referință).

Analysis Mode (Mod Analiză)
Datele pot fi grupate și analizate fie după fluorofor, fie după denumirea țintei. Atunci când sunt grupate
după fluorofor, urmele de date sunt afișate în funcție de fluorofor, așa cum este indicat de configurația
plăcii pentru rularea respectivă. Datele individuale ale fluoroforului apar în graficul curbei de amplificare
și în graficul curbei standard (dacă este disponibil) atunci când sunt bifate casetele de selectare a
fluoroforului localizate sub graficul de amplificare.

Atunci când sunt grupate după țintă, urmele de date sunt afișate în funcție de denumirea țintei, așa
cum a fost introdusă în configurația plăcii pentru rularea respectivă.

Pentru a alege un mod de analiză a datelor

u Urmați una dintre procedurile următoare:

n Selectați Settings > Analysis Mode (Setări > Mod Analiză).
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n Alegeți un mod din meniul vertical Analysis Mode (Mod Analiză) de pe bara de instrumente.

Cycles to Analyze (Cicluri de analizat)
Puteți restricționa numărul de cicluri de analizat. Puteți, de asemenea, analiza date dintr-un anumit set
de cicluri. Numărul maxim de cicluri pe care le puteți analiza este 50.

Notă: Eliminarea ciclurilor de la începutul unei rulări poate avea un impact semnificativ asupra
valorii inițiale.

Pentru a restricționa analiza datelor la un anumit interval de cicluri

1. Selectați Settings > Cycles to Analyze (Setări > Cicluri de analizat).

Va apărea caseta de dialog Cycles to Analyze (Cicluri de analizat).

2. Introduceți valorile ciclului inițial și final și faceți clic pe OK.

Faceți clic pe Restore Defaults (Restaurare valori implicite) din caseta de dialog Cycles to Analyze
(Cicluri de analizat) pentru a reveni la ciclurile utilizate original pentru analiză.
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Selectorul de godeuri
Folosiți Selectorul de godeuri pentru a afișa sau ascunde datele godeurilor în graficele sau foile de
calcul din fereastra Data Analysis (Analiză date). Doar godeurile încărcate cu probă pot fi selectate în
selectorul de godeuri. Software-ul colorează godeurile din Well Selector (Selectorul de godeuri):

n Albastru – indică godeurile selectate. Datele din godeurile selectate apar în fereastra Data
Analysis (Analiză date).

n Gri deschis – indică godeurile neselectate. Datele din godeurile neselectate nu apar în fereastra
Data Analysis (Analiză date).

n Gri închis – indică godeurile goale.

Pentru a afișa sau ascunde datele godeurilor

u În selectorul de godeuri, urmați oricare dintre procedurile următoare:

n Pentru a ascunde un godeu, faceți clic pe godeul respectiv. Pentru a afișa godeul respectiv,
faceți clic din nou pe el.

n Pentru a ascunde mai multe godeuri, trageți cu mouse-ul peste godeurile pe care doriți să le
selectați. Pentru a afișa godeurile respective, trageți din nou cu mouse-ul peste godeuri.

n Faceți clic pe colțul din stânga sus al plăcii pentru a ascunde toate godeurile. Faceți clic din
nou pe colțul din stânga sus pentru a afișa toate godeurile.

n Faceți clic pe începutul unei coloane sau al unui rând pentru a ascunde godeurile respective.
Faceți clic din nou pe coloană sau pe rând pentru a afișa godeurile.
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Elementele de meniu afișate prin clic dreapta în Well Selector
(Selector godeuri)
Tabelul 12 listează opțiunile afișate prin clic dreapta disponibile în vizualizarea selector de godeu.

Element Funcție

Well XX (Godeu XX) Afișează numai acest godeu, elimină acest godeu din vizualizare,
setează culoarea pentru acest godeu sau exclude acest godeu din
analiză.

Selected Wells (Godeuri
selectate) (faceți clic dreapta și
trageți)

Afișează numai aceste godeuri, elimină aceste godeuri din vizualizare,
setează culoarea pentru aceste godeuri sau exclude aceste godeuri
din analiză.

Copy (Copiere) Copiază conținutul godeului pe clipboard, inclusiv Sample Type (Tip
probă) și Replicate # (Nr. replicat) opțional.

Copy as Image (Copiere ca
imagine)

Copiază vizualizarea selector de godeu sub formă de imagine.

Print (Imprimare) Imprimă vizualizarea selector de godeu.

Print Selection (Imprimare
selecție)

Imprimă selecția curentă.

Export to Excel (Exportare în
Excel)

Exportă datele într-o foaie de calcul Excel.

Export to Csv (Exportare în
CSV)

Exportă datele ca document .csv.

Export to Xml (Exportare în
Xml)

Exportă datele drept document .xml.

Well Labels (Etichete godeuri) Schimbă etichetele godeurilor în Sample Type (Tip probă), Target
Name (Denumire țintă) sau Sample Name (Denumire probă).

Tabelul 12. Elementele de meniu afișate prin clic dreapta în vederea de selecție a godeurilor
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Excluderea temporară a godeurilor din analiză
Pentru a exclude temporar godeuri din analiza datelor

1. Faceți clic dreapta pe godeu în selectorul de godeuri, pe o urmă de fluorescență sau pe un punct
reprezentat grafic pe curba standard. Pentru a exclude godeurile multiple, faceți clic dreapta și
trageți pentru a evidenția mai multe godeurile, urme sau puncte.

2. Din meniul afișat prin clic dreapta, alegeți opțiunea corespunzătoare:

n Well > Exclude Well (Godeu > Excludere godeu)

n Selected Wells > Exclude from Analysis (Godeuri selectate > Excludere din analiză)

n Selected Traces > Exclude these wells from Analysis (Urme selectate > Excludere aceste
godeuri din analiză)

Alternativ, pentru a elimina permanent godeuri din analiză, ștergeți conținutul godeului în Plate
Editor (Editor placă), făcând clic pe butonul Clear Wells (Ștergere godeuri).

Important: Trebuie să reintroduceți orice conținut de godeu care este debifat.

Pentru a include un godeu exclus

u Faceți clic dreapta pe godeul corespunzător în selectorul de godeuri și selectați Well > Include
Well in Analysis (Godeu > Includere godeu în analiză).
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Grafice
Fiecare grafic din fereastra Data Analysis (Analiză date) afișează datele într-o reprezentare grafică
diferită și include opțiuni pentru ajustarea și exportarea datelor sau a imaginilor din grafice.

Instrumente grafic
Tabelul 13 listează opțiunile afișate prin clic dreapta disponibile în majoritatea graficelor.

Element Funcție

Copy (Copiere) Copiază graficul pe clipboard.

Save Image As... (Salvați
imaginea ca...)

Salvează graficul ca fișier imagine. Configurați rezoluția și
dimensiunile imaginii, apoi selectați tipul fișierului (PNG, GIF, JPG,
TIF sau BMP).

Page Setup... (Configurare
pagină...)

Selectează configurarea paginii pentru imprimare.

Print... (Imprimare...) Imprimă graficul.

Set Scale to Default (Setare
scară la implicit)

Afișează toate datele în graficul cu bare. Barele de defilare apar dacă
există prea multe puncte de date/probe de afișat în cadrul graficului.

Setări grafic Deschide caseta de dialog Chart Settings (Setări grafic), în care puteți
modifica opțiunile de afișare ale graficului, inclusiv:

Tabelul 13. Elementele de meniu afișate prin clic dreapta comune majorității graficelor

De asemenea, instrumente pentru grafic apar în fiecare grafic în fereastra Data Analysis (Analiză
date). Toate graficele afișează următoarele instrumente:

Copy to Clipboard (Copiere pe clipboard) – copiază conținutul graficului pe clipboard.

Chart Settings (Setări grafic) – deschide caseta de dialog Chart Settings (Setări grafic), în care puteți
modifica opțiunile de afișare ale graficului.

Export (Exportare) – deschide caseta de dialog Export Options (Opțiuni de exportare), din care puteți
modifica rezoluția și dimensiunea graficului și îl puteți salva într-o locație specificată, sub forma unuia
dintre următoarele tipuri de fișier:

n .bmp

n .jpg

n .png
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Instrumente din graficul cu bare

Pe lângă instrumentele din grafic, graficele cu bare afișează următoarele instrumente:

Sort (Sortare) – sortează țintele și probele în ordine alfabetică sau în ordine alfabetică inversă.

Color Settings (Setări culoare) – deschide caseta de dialog Color Settings (Setări culoare), în care
puteți schimba culoarea țintelor și probelor.

Pentru mai multe informații despre aceste instrumente, consultați Schimbarea și adnotarea vizualizării
graficului de la pagina 258.

Instrumente din graficul Amplification (Amplificare)

Pe lângă cele enumerate mai sus, graficele de amplificare afișează următoarele instrumente:

Trace Styles (Stiluri Urme) – deschide caseta de dialog Trace Styles (Stiluri Urme), în care puteți
modifica aspectul urmelor în graficul de amplificare.

Baseline Threshold (Prag de referință) – deschide caseta de dialog Baseline Threshold (Prag de
referință), în care puteți modifica valoarea de referință implicită pentru godeurile selectate sau puteți
schimba pragul pentru fiecare curbă de fluorescență din graficul de amplificare.

Copierea datelor din grafic pe clipboard

Puteți copia conținutul din vizualizarea graficului și lipi acest conținut în orice aplicație care acceptă
fișiere imagine bitmap.

Pentru a copia date din grafic pe clipboard

1. Din instrumentele pentru grafic, selectați pictograma Copy to Clipboard (Copiere în clipboard).

2. Deschideți o aplicație care acceptă imagini bitmap, de exemplu Microsoft Word.

3. Faceți clic dreapta și selectați Paste (Lipire) pentru a lipi imaginea bitmap din clipboard în
aplicație.

Modificarea setărilor de afișare a graficului

Utilizați caseta de dialog Chart Settings (Setări grafic) pentru a modifica titlurile, caracterele și
dimensiunile, scara axei și poziționarea legendei pentru graficul afișat. Modificările efectuate sunt
aplicate numai graficului afișat și sunt salvate împreună cu graficul.

Pentru a modifica setările de afișare a graficului

1. Din instrumentele graficului, faceți clic pe Chart Settings (Setări grafic).

Apare caseta de dialog Chart Settings (Setări grafic).
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2. Selectați fila Chart And Axes (Grafic și axe) pentru:

n A introduce un titlu pentru grafic.

n A introduce un titlu nou pentru axa x și a schimba unghiul etichetelor.

n A introduce un titlu nou pentru axa y.

3. Selectați fila Fonts (Caractere) pentru a modifica caracterul și dimensiunea caracterului utilizate
în grafic.

Sfat: Implicit, dimensiunea caracterului este scalată automat odată cu modificarea
dimensiunii graficului. Selectați Change Font Size (Modificare dimensiune caracter) pentru a
seta o dimensiune de caracter statică pentru fiecare tip de etichetă.

4. Selectați fila Axes Scale (Scară axe) pentru:

n A debifa opțiunile de scalare automată a axelor x și y și a specifica valorile de scalare
minime și maxime.

n A alege afișarea de linii de grilă sau de gradații pe grafic.

5. Selectați fila Legend (Legendă) pentru:

n A alege să ascundeți legenda graficului.

n A modifica poziția implicită a legendei graficului.

Notă: Când legenda este poziționată în stânga sau dreapta graficului, afișează numai primii
zece fluorofori din grafic.
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6. Faceți clic pe Apply (Aplicare) în orice moment pentru a vizualiza modificările setărilor graficului
fără a salva modificările.

7. Faceți clic pe OK pentru a salva modificările și a reveni la grafic.

Exportarea graficului

Folosiți această casetă de dialog pentru a modifica lățimea, înălțimea și rezoluția graficului, ca să-l
exportați în unul dintre următoarele formate de fișier:

n .bmp

n .jpg

n .png

Puteți apoi utiliza graficul exporta pentru a vă afișa rezultatele în sesiuni de prezentare, prezentări
Microsoft PowerPoint și publicații de specialitate.

Notă: Atunci când modificați setările, luați în considerare următoarele:

n Limitele maxime și minime de lățime și înălțime

o La 72 dpi: 0,1-83 in

o La 96 dpi: 0,1–62 in

o LA 150 dpi: 0,1–40 in

o La 300 dpi: 0,1–20 in

o La 600 dpi: 0,1-10 in

o La toate rezoluțiile: 2-6.000 pixeli

n Raportul de aspect se bazează pe lățime.

Pentru a exporta graficul

1. Din instrumentele graficului, faceți clic pe Export (Exportare).

Va apărea caseta de dialog Export Preview (Previzualizare export).
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2. Modificați setările pentru afișare după cum este necesar.

3. Faceți clic pe Export (Exportare).

4. În caseta de dialog Export (Exportare), urmați procedura următoare:

a. (Opțional) Navigați la folderul în care doriți să salvați fișierul grafic.

b. Tastați o denumire pentru fișier și alegeți un tip de fișier din lista verticală.

5. Faceți clic pe Save (Salvare) pentru a salva fișierul grafic.

Modificarea setărilor de prag pentru nivelul inițial

În modul Single Threshold (Prag unic), puteți ajusta pragul pentru un fluorofor făcând clic pe linia de
prag din graficul Amplification (Amplificare) și deplasând indicatorul mouse-ului pe verticală.
Alternativ, puteți specifica un prag exact pentru fluoroforul existent.

Sfat: Puteți specifica un interval de cicluri pentru a determina nivelul inițial pentru toate fișierele
de date din fila Data Analysis (Analiză date) din User > User Preferences (Utilizator > Preferințe
utilizator).

Pentru a ajusta ciclul inițial pentru început și sfârșit pentru fiecare godeu

1. În fila Quantification (Cuantificare), în graficul Amplification (Amplificare) selectați un singur
fluorofor.

2. Din instrumentele pentru grafic, selectați Baseline Threshold (Pragul nivel inițial).
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Va fi afișată caseta de dialog Baseline Threshold (Prag nivel inițial).

3. În secțiunea Baseline Cycles (Cicluri nivel inițial), urmați una dintre procedurile următoare:

n Pentru a selecta un godeu, faceți clic pe numărul de rând al acesteia.

n Pentru a selecta mai multe godeuri adiacente, faceți clic pe numărul de rând al primului
godeu și deplasați cursorul în jos de-a lungul coloanei până la ultimul godeu.

n Pentru a selecta mai multe godeuri neadiacente, apăsați tasta Ctrl și faceți clic pe numărul de
rând al fiecărui godeu țintă.

n Pentru a selecta toate godeurile, faceți clic în colțul din stânga sus al tabelului.

4. Ajustați ciclul inițial pentru început și ciclul inițial pentru sfârșit pentru toate godeurile selectate
sau modificați numărul ciclurilor de început și de sfârșit în partea de jos a foii de calcul.

Sfat: Pentru a readuce setările la ultimele valori salvate, faceți clic pe Reset All User Defined
Values (Resetare toate valorile definite de utilizator).

5. Faceți clic pe OK pentru a salva modificările și a reveni la grafic.

Pentru a specifica un interval de cicluri pentru toate fișierele de date

u Din fereastra Home (Pagină de pornire) sau fereastra Plate Editor (Editor placă), selectați User
(Utilizator) > User Preferences (Preferințe utilizator) și alegeți fila Data Analysis (Analiză date).
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Sortarea datelor țintei, probei și grupului biologic

Notă: Această opțiune este disponibilă numai în graficele de expresie genică.

Implicit, listele Targets (Ținte), Samples (probe), și Biological Groups (Grupuri biologice) apar în
ordine alfabetică. Utilizați caseta de dialog Sort (Sortare) pentru a sorta afișajul în ordine alfabetică
inversă sau pentru a muta manual un termen în altă poziție din listă.

Pentru a sorta datele pentru țintă, probă și grupul biologic

1. Din instrumentele graficului, faceți clic pe Sort (Sortare).

Va apărea caseta de dialog Gene Expression Chart Sorting (Sortare grafic expresie genică).

2. În caseta de dialog, faceți clic pe Z-A pentru a sorta lista în ordine alfabetică inversă.

3. Pentru a muta manual un termen, selectați-l și faceți clic pe butonul corespunzător dintre grafice:

n Faceți clic pe săgeata În sus sau În jos pentru a muta termenul selectat cu o poziție.

n Faceți clic pe săgeata bară În sus sau În jos pentru a muta termenul selectat în partea de sus
sau de jos a listei.

4. Faceți clic pe OK pentru a salva modificările și a reveni la fila Gene Expression (Expresie genică).
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Modificarea setărilor de culoare pentru țintă și probă

Notă: Această opțiune este disponibilă numai în graficele de expresie genică.

Utilizați caseta de dialog Color Settings (Setări culoare) dacă doriți să modificați culoarea unei ținte
sau a unei probe sau dacă doriți să eliminați elementul respectiv din grafic.

Pentru a modifica setările de culoare

1. Din instrumentele graficului, selectați Color Settings (Setări culoare).

Apare caseta de dialog Color Settings (Setări culoare).

2. Dacă doriți să modificați culoarea afișajului pentru o țintă sau o probă, faceți clic pe culoarea sa în
coloana Color (Culoare).

3. În caseta de dialog Color (Culoare) care apare, selectați o culoare nouă și faceți clic pe OK.

4. Pentru a elimina un element din graficul de expresie genică, debifați caseta de selectare aferentă
din coloana Show Chart (Afișare grafic).

Sfat: Pentru a elimina toate elementele din graficul de expresie genică, debifați caseta de
selectare Show Chart (Afișare grafic) în capul de tabel.

5. (Opțional) Implicit, culoarea graficului cu bare este afișată cu gradient. Pentru a afișa culoarea în
formă compactă, selectați opțiunea Use Solid Colors (Utilizare culori compacte).

6. Faceți clic pe OK pentru a salva modificările și a reveni la fila Gene Expression (Expresie genică).
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Mărirea unei zone a graficului
Pentru a mări o zonă a graficului

u Faceți clic și deplasați mouse-ul deasupra graficului, apoi faceți clic pe Zoom (Mărire). Software-
ul redimensionează graficul și îl centrează asupra zonei selectate.

Notă: Pentru graficul cu bare, nu este necesar să faceți clic pe comanda pop-up Zoom
(Mărire).

Pentru a reseta graficul la vizualizarea completă

u Faceți clic dreapta în grafic și selectați Set Scale to Default (Setare scară la implicit).

Copierea graficelor într-un fișier Microsoft
Puteți copia grafice de date în documente Microsoft Word, Excel sau PowerPoint. Rezoluția imaginii
corespunde cu cea a ecranului din care a fost obținută aceasta.

Pentru a copia grafice într-un fișier Microsoft

1. În fereastra Data Analysis (Analiză date), faceți clic pe Copy To Clipboard (Copiere în clipboard)
în colțul din dreapta sus al panoului graficului.

2. Deschideți un fișier Microsoft gol și lipiți conținutul din clipboard.

Elementele de meniu comune afișate prin clic dreapta pentru
grafice
Tabelul 14 listează elementele de meniu afișate prin clic dreapta disponibile în grafice. Câteva dintre
elementele disponibile sunt prezente în toate graficele, iar aceste elemente pot fi utilizate pentru a
schimba modul de afișare sau pentru a exporta cu ușurință datele dintr-un grafic.

Element Funcție

Copy (Copiere) Copiază graficul pe clipboard.

Save Image As
(Salvați imaginea
ca)

Salvează imaginea la o dimensiune, rezoluție și tip de fișier, specificate, inclusiv
PNG (implicit), JPG și BMP.

Tabelul 14. Elementele de meniu afișate prin clic dreapta pentru grafice
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Element Funcție

Page Setup
(Configurare
pagină)

Afișează opțiunile de configurare a tipăririi.

Print (Imprimare) Imprimă graficul.

Set Scale to Default
(Setare scară la
implicit)

Restaurează vizualizarea implicită a graficului după ce acesta a fost mărit.

Chart Options
(Opțiuni grafic)

Deschide fereastra Chart Options (Opțiuni grafic) pentru a modifica graficul,
incluzând schimbarea titlului, selectarea limitelor pentru axele x și y, afișarea
liniilor grilei și a gradațiilor minore de pe axe.

Notă: Elementele de meniu care se aplică graficelor specifice sunt descrise în Capitolul 11,
Detalii despre fereastra Data Analysis (Analiză date).
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Foi de calcul
Foile de calcul afișate în Data Analysis (Analiză date) includ opțiuni pentru sortarea și transferarea
datelor. Sortați coloanele folosind una dintre aceste metode:

n Faceți clic pe și trageți o coloană într-o nouă locație din tabelul selectat.

n Faceți clic pe antetul coloanei pentru a sorta datele în ordine ascendentă sau descendentă.

Pentru a sorta până la trei coloane de date din fereastra Sort (Sortare)

1. Faceți clic dreapta în foaia de calcul și selectați Sort (Sortare).

2. În caseta de dialog Sort (Sortare), selectați titlul primei coloane pe care doriți să o sortați. Sortați
datele în ordine ascendentă sau descendentă.

3. Selectați a doua sau a treia coloană pe care doriți să o sortați și alegeți Ascending (Ascendent)
sau Descending (Descendent).

4. Faceți clic pe OK pentru a sorta datele sau clic pe Cancel (Anulare) pentru a opri sortarea.

Sfat: Evidențiați datele din graficele asociate și selectorul de godeuri ținând indicatorul mouse-
ului pe o celulă. Faceți clic într-o celulă pentru a copia și lipi conținutul acesteia în alt program
software.

Elementele de meniu comune afișate prin clic dreapta pentru
foile de calcul
Tabelul 15 listează elementele de meniu afișate prin clic dreapta disponibile în orice vizualizare a foii
de calcul.

Element Funcție

Copy (Copiere) Copiază conținutul godeurilor selectate pe clipboard, apoi lipește
conținutul într-o foaie de calcul precum un document Excel.

Copy as Image (Copiere ca
imagine)

Copiază vizualizarea foii de calcul sub formă de fișier imagine și o
lipește într-un fișier care acceptă un fișier imagine, precum fișierele
text, imagine sau foaie de calcul.

Print (Imprimare) Imprimă vizualizarea curentă.

Tabelul 15. Elementele de meniu afișate prin clic dreapta pentru foile de calcul
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Element Funcție

Print Selection (Imprimare
selecție)

Imprimă selecția curentă.

Export to Excel (Exportare în
Excel)

Exportă datele într-o foaie de calcul Excel.

Export to Text (Exportare în
Text)

Exportă datele într-un editor de text.

Export to Csv (Exportare în
CSV)

Exportă datele într-un fișier .csv.

Export to Xml (Exportare în Xml) Exportă datele într-un fișier xml.

Export to Html (Exportare în
Html)

Exportă datele într-un fișier Html.

Find (Găsire) Caută text.

Sort (Sortare) Sortează datele din până la trei coloane.

Select Columns (Selectare
coloane)

Selectează coloanele care vor fi afișate în foaia de calcul.

Tabelul 15. Elementele de meniu afișate prin clic dreapta pentru foile de calcul, continuare
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Export (Exportare)
CFX Maestro Dx SE oferă mai multe opțiuni de exportare din meniul vertical Export (Exportare):

n Exportă toate fișele de date

n Export RDML Files (Exportă fișierele RDML)

n Custom Export (Export personalizat)

n Export to LIMS Folder (Exportare în folderul LIMS)

n Seegene Export (Exportare Seegene)

Exportarea tuturor fișelor de date
Puteți exporta toate vizualizările foilor de calcul din fiecare filă a CFX Maestro Dx SE în fișiere
individuale.

Pentru a exporta toate fișele de date

u Selectați Export > Export All Data Sheets (Exportare > Exportă toate fișele de date) și apoi
selectați tipul de fișier dorit:

n CSV (*.csv)

n Text (*.txt)

n Registru de lucru Excel (* .xlsx)

Analizele exportate sunt salvate în mai multe registre de lucru Excel cu o foaie de lucru cu
date de analiză pentru fiecare fișier. În cazul în care o analiză include mai mulți fluorofori,
datele de la fiecare fluorofor sunt exportate într-o foaie separată de lucru.

n Registru de lucru Excel - combinat (* .xlsx)

Analizele exportate sunt salvate într-un singur registru de lucru Excel care include mai multe
foi de lucru, câte una pentru fiecare set de date de analiză.

n Excel 97 - 2003 (*.xls)

n XML (*.xml)

Exportarea fișierelor RDML
RDML este un standard structurat și universal de date pentru realizarea de schimburi de date PCR
cantitativ (qPCR). Standardul de date este un fișier text în format Extensible Markup Language (.xml).
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Consultați site-ul web al Consorțiului Internațional RDML (www.rdml.org) pentru informații
suplimentare despre formatul de schimb de date RDML.

Notă: Salvați fișierul RDML ca versiune 1.1 dacă utilizați versiunea 2.3 sau o versiune ulterioară
a software-ului qbase+.

Pentru a exporta un fișier RDML

1. Selectați Export (Exportare) > Export RDML Files (Exportare fișiere RDML) și selectați RDML v1.1
sau RDML v1.0 din lista care apare.

Va apărea caseta de dialog Save As (Salvare ca).

2. În caseta de dialog Save As (Salvare ca), specificați un nume de fișier și locul în care doriți să
salvați fișierul RDML.

3. Faceți clic pe OK pentru a salva fișierul exportat.
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Crearea unui fișier de exportare particularizată
Pentru a crea un fișier de exportare particularizată

1. Selectați Export > Custom Export (Exportare > Exportare particularizată). Apare caseta de dialog
Custom Export (Exportare particularizată).

2. Selectați formatul de exportare din lista verticală care apare.

3. Bifați casetele de selectare pentru elementele de exportat.

4. (Opțional) Faceți clic pe Customize Column Names (Personalizare nume coloană) pentru a
modifica numele coloanei.

5. Faceți clic pe Export (Exportare). Va apărea caseta de dialog Save As (Salvare ca).
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6. În caseta de dialog Save As (Salvare ca), specificați un nume de fișier și locul în care doriți să
salvați fișierul exportat.

7. Faceți clic pe OK pentru a salva fișierul exportat.
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Exportarea într-un folder LIMS
Puteți exporta datele într-un format de fișier compatibil cu LIMS. Pentru mai multe informații despre
crearea, gestionarea și utilizarea fișierelor LIMS, consultați Anexa C, Integrare LIMS.

Pentru a exporta datele în format LIMS

1. Selectați Export > Export to LIMS Folder (Exportare > Exportare în folder-ul LIMS).

Va apărea caseta de dialog Save As (Salvare ca).

2. În caseta de dialog Save As (Salvare ca), specificați un nume de fișier și locul în care doriți să
salvați fișierul exportat.

3. Faceți clic pe OK pentru a salva fișierul exportat.

Exportarea de date în format Seegene
Puteți exporta datele din toate vizualizările foilor de calcul în fișiere Excel structurate special pentru a
fi utilizate de Seegene, Inc.

Sfat: De asemenea, puteți porni automat programul Seegene Viewer în momentul finalizării
exportului. Pentru mai multe informații, consultați Comenzile meniului Tools (Instrumente) de la
pagina 63.

Pentru a exporta date într-un format specific Seegene

1. Selectați Export > Seegene Export (Exportare > Exportare Seegene).

Se afișează caseta de dialog Browse For Folder (Răsfoire după folder).

2. În caseta de dialog Browse For Folder (Răsfoire după folder), specificați localizarea folderului în
care doriți să salvați fișierele în format Seegene Excel (.xlsx) exportate.

Analizele sunt exportate în mai multe fișiere Excel Workbook cu o singură filă de date de analiză
pentru fiecare fișier.

3. Faceți clic pe OK pentru a salva fișierele exportate.
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(Analiză date)

Fereastra de analiză a datelor din Software-ul CFX Maestro Dx SE cuprinde mai multe file în de
vizualizare a datelor. Acest capitol explică detaliat aceste file.

Sfat: Puteți alege filele pe care doriți să le vizualizați în fereastra Data Analysis (Analiză date)
utilizând meniul View (Vizualizare). Aspectul personalizat al ferestrei este salvat împreună cu
fișierul de date.
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Fila Quantification (Cuantificare)
Utilizați datele din fila Quantification (Cuantificare) pentru a seta condițiile pentru analiza datelor,
inclusiv setările de nivel inițial pentru godeuri individuale și setările de prag. Fila Quantification
(Cuantificare) afișează date în aceste patru vizualizări:

n Graficul Amplification (Amplificare) – afișează unitățile de fluorescență relativă (RFU) pentru
fiecare godeu la fiecare ciclu. Fiecare urmă din grafic reprezintă datele de la un singur fluorofor
dintr-un godeu.

n Standard curve (Curbă standard) – apare numai dacă rularea include godeuri desemnate ca tip
de probă standard (Std). Curba standard afișează ciclul de prag reprezentat pe baza logaritmului
cantității inițiale. Legenda afișează Reaction Efficiency (Eficiența reacțiilor) (E) pentru fiecare
fluorofor din godeuri cu un tip de probă Standard.

n Well selector (Selector godeuri) – selectează godeurile cu datele de fluorescență pe care doriți să
le afișați.

n Spreadsheet (Foaie de calcul) – afișează o foaie de calcul a datelor colectate în godeurile
selectate.

Opțiuni fluorofori
Pentru a afișa datele pentru fluorofori în fila Quantification (Cuantificare) a graficelor și foilor de calcul,
selectați fluoroforul (fluoroforii) țintă de sub graficul Amplification (Amplificare). Pentru a ascunde
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datele pentru fluorofori din fereastra Data Analysis (Analiză date), debifați caseta de selectare
aferentă.

Caseta de dialog Trace Styles (Stiluri Urme)
Folosind caseta de dialog Trace Styles (Stiluri Urme), puteți ajusta aspectul urmelor în graficele pentru
amplificare și curbă de topire din filele Quantification (Cuantificare) și Melt Curve (Curbă de topire).
Apoi puteți previzualiza schimbările în selectorul de godeuri care apare în caseta de dialog Trace
Styles (Stiluri Urme).

Pentru a ajusta stilurile de urme

1. Selectați un singur fluorofor din graficul Amplification (Amplificare).

2. Pentru a deschide caseta de dialog Trace Styles (Stiluri Urme), efectuați una dintre următoarele:

n Faceți clic pe Trace Styles (Stiluri Urme) în graficul Amplification (Amplificare).

n Selectați Settings > Trace Styles (Setări > Stiluri Urme) din bara de meniu Data Analysis
(Analiză date).

n Faceți clic dreapta pe o urmă și selectați Trace Styles (Stiluri Urme).

Apare dialogul Trace Styles (Stiluri Urme).

Ghid de utilizare | 217



Capitolul 11 Detalii despre fereastra Data Analysis (Analiză date)

3. În caseta de dialog Trace Styles (Stiluri Urme), selectați un set specific de godeuri în selectorul de
godeuri din panoul de jos. Alternativ, selectați godeurile care conțin un tip de probă în meniul
vertical din coloana Wells (Godeuri).

4. Urmați oricare dintre procedurile următoare:

n Pentru a alege o culoare pentru godeurile selectate, faceți clic pe caseta din coloana Color
(Culoare).

n Pentru a aloca un simbol godeurilor selectate, selectați un simbol din lista verticală Symbol
(Simbol).

n Pentru a colora rapid godeurile prin eticheta butonului, faceți clic pe setul rapid
corespunzător:

o Random by Well (Aleatoriu după godeuri)

o Random by Replicate (Aleatoriu după replicate)

o Use Fluor Colors (Utilizare culori fluorofor)

o Use Target Colors (Utilizare culori pentru țintă)

o Use Sample Colors (Utilizare culori pentru probă)

n Pentru a aloca etichete de godeu, selectați Sample Type (Tip de probă), Target Name
(Denumire țintă), Sample Name (Denumire probă) sau Symbol (Simbol).

Opțiunea Log Scale (Scară logaritmică)
Selectați Log Scale (Scară logaritmică) de sub graficul Amplification (Amplificare) pentru a vizualiza
urmele de fluorescență într-o scară semi-logaritmică:
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Sfat: Pentru a mări orice zonă a graficului, trageți de-a lungul zonei țintă. Pentru a reveni la o
vizualizare completă, faceți clic dreapta în grafic și selectați Set Scale to Default (Setare scară la
implicit).

Standard Curve Chart (Grafic Curbă standard)
Software-ul creează un grafic Standard Curve (Curbă standard) în fila Quantification (Cuantificare)
dacă datele includ tipuri de probă definite ca Std pentru cel puțin un fluorofor din rulare.

Graficul Standard Curve (Curbă standard) afișează următoarele informații:

n Denumirea fiecărei curbe (fluoroforul sau ținta).

n Culoarea fiecărui fluorofor sau fiecărei ținte.

n Eficiența reacțiilor (E). Utilizați această statistică pentru a optimiza o reacție multiplă și pentru a
egaliza datele unei curbe standard.

Notă: Eficiența reacțiilor descrie cât de mult este produsă ținta dumneavoastră cu fiecare
ciclu din protocol. O eficiență de 100% indică faptul că vă dublați ținta cu fiecare ciclu.

n Coeficientul de determinare, R2 (scris sub forma R^2). Folosiți această statistică pentru a
determina cât de corect descrie linia datele (adecvarea potrivirii).

n Slope (Pantă)

n Punct de intersecție Y
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Opțiunile meniului graficului Amplification (Amplificare)
În plus față de opțiunile obișnuite de meniu afișate prin clic dreapta pentru grafice (consultați
Elementele de meniu comune afișate prin clic dreapta pentru grafice de la pagina 206 ), Tabelul 16
prezintă opțiunile de meniu disponibile numai în diagrama Amplification (Amplificare).

Opțiune de meniu Funcție

Well XX, Fluor Target
(Godeu XX, Țintă fluorofor)

Afișează numai acest godeu, elimină acest godeu din vizualizare,
setează culoarea pentru această urmă sau exclude acest godeu din
analiză.

Selected Traces (Urme
selectate)

Afișează numai aceste godeuri, elimină aceste godeuri din vizualizare,
setează culoarea pentru aceste urme sau exclude aceste godeuri din
analiză.

Show Threshold Values
(Afișare valori prag)

Afișează valoarea pragului pentru fiecare curbă de amplificare din grafic.

Trace Styles (Stiluri Urme) Deschide fereastra Trace Styles (Stiluri Urme) pentru a schimba stilurile
urmelor care apar pe filele Quantification (Cuantificare) și Melt Curve
(Curbă de topire).

Baseline Thresholds
(Praguri nivel inițial)

Deschide fereastra Baseline Thresholds (Praguri de nivel de referință)
pentru a schimba nivelul de referință sau pragurile fiecărui fluorofor
(schimbările apar în graficul Amplification (Amplificare) din fila
Quantification (Cuantificare)).

Tabelul 16. Elementele de meniu afișate prin clic dreapta și clic stânga în graficul de
amplificare

Foaia de calcul din fila Quantification (Cuantificare)
Tabelul 17 definește datele afișate în foaia de calcul din fila Quantification (Cuantificare).

Informație Descriere

Well (Godeu) Poziția godeului în placă

Fluor (Fluorofor) Fluorofor detectat

Target (Țintă) Denumirea țintei încărcate în godeurile Plate Editor (Editor placă)

Tabelul 17. Conținutul foii de calcul din fila Quantification (Cuantificare)
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Informație Descriere

Content (Conținut) O combinație între Tipul de probă (obligatoriu) și Numărul replicatului
(opțional) încărcate în Plate Editor (Editor placă)

Sample (Probă) Denumirea probei încărcate în godeurile Plate Editor (Editor placă)

Cq Ciclul de cuantificare pentru fiecare urmă

Modificarea datelor aferente țintei, conținutului sau probei

Puteți modifica datele din coloanele Țintă, Conținut și Probă editând fișierul plăcii cu Editor placă
chiar și după rularea experimentului.

Pentru a modifica datele din coloanele Conținut, Țintă și Probă

u Faceți clic pe Plate Setup (Configurare placă) și selectați View/Edit Plate (Vizualizare/editare
placă) pentru a deschide Plate Editor (Editor placă).
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Fila Quantification Data (Date de cuantificare)
Fila Quantification Data (Date de cuantificare) afișează datele de cuantificare colectate în fiecare
godeu. CFX Maestro Dx SE afișează datele în patru vizualizări diferite ale foilor de calcul:

n Results (Rezultate) – afișează o foaie de calcul a datelor. Aceasta este vizualizarea implicită.

n Standard Curve Results (Rezultate Curbă standard) – afișează o foaie de calcul cu datele curbei
standard.

n Plate (Placă) – afișează datele din fiecare godeu sub formă de hartă a plăcii.

n RFU – afișează cantitățile RFU din fiecare godeu pentru fiecare ciclu.

Selectați fiecare foaie de calcul din lista verticală care apare sub fila Quantification Data (Date de
cuantificare).

Foaia de calcul Results (Rezultate)
Foaia de calcul Results (Rezultate) afișează date pentru fiecare godeu din placă.

Notă: Toate calculele Std. Dev (deviație standard) se aplică grupelor de replicate alocate în
godeurile din fereastra Plate Editor (Editor placă). Calculele stabilesc media pentru valoarea Cq
pentru fiecare godeu din grupul de replicate.

Tabelul 18 definește datele care apar în foaia de calcul Results (Rezultate).
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Informație Descriere

Well (Godeu) Poziția godeului în placă

Fluor (Fluorofor) Fluorofor detectat

Target (Țintă) Nume țintă amplificare (genă)

Content (Conținut) Tipul de probă și Numărul replicatului

Sample (Probă) Descrierea probei

Biological Set Name (Denumire
set biologic)

Denumirea setului biologic

Cq Ciclul de cuantificare

Cq Medie Media ciclului de cuantificare pentru grupul de replicate

Cq Std. Dev Deviația standard a ciclului de cuantificare pentru grupul de replicate

Starting Quantity (SQ)
(Cantitate inițială (SQ))

Estimare a cantității inițiale a țintei

Log Starting Quantity (Log.
cantitate inițială)

Logaritmul cantității inițiale

SQ Mean (Medie SQ) Media cantității inițiale

SQ Std. Dev Deviație standard a cantității inițiale între replicate

Tabelul 18. Conținutul foii de calcul Results (Rezultate)
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Foaia de calcul Standard Curve Results (Rezultate Curbă
standard)
Foaia de calcul Standard Curve Results (Rezultate Curbă standard) afișează parametrii curbei
standard calculați.

Tabelul 19 definește datele care apar în foaia de calcul Standard Curve Results (Rezultate Curbă
standard).

Informație Descriere

Fluor (or Target) (Fluorofor sau
Țintă)

Fluorofor (sau Țintă) detectat(ă)

Efficiency % (% Eficiență) Eficiența reacțiilor

Slope (Pantă) Panta curbei standard

Y-intercept (Punct de intersecție
Y)

Punctul în care curba se intersectează cu axa y

R^2 Coeficientul de determinare

Tabelul 19. Conținutul foii de calcul Rezultate Curbă standard
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Foaia de calcul Plate (Placă)
Foaia de calcul Plate (Placă) afișează o hartă a plăcii datelor pentru câte un fluorofor pe rând.

Pentru a vedea datele pentru un anumit fluorofor

u Faceți clic pe fila sa din partea de jos a foii de calcul.
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Foaia de calcul RFU
Foaia de calcul RFU afișează citirile de unități de fluorescență relativă (RFU) pentru fiecare godeu
obținute la fiecare ciclu al rulării. Numărul de godeuri apare în partea de sus a fiecărei coloane și
numărul de cicluri apare la stânga fiecărui rând.
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Fila Melt Curve (Curbă de topire)

Fila Melt Curve (Curbă de topire)
Pentru coloranții de fixare a DNA (ADN) și sondele de hibridizare neclivabile, fluorescența este cea
mai puternică atunci când cele două catene de DNA (ADN) se atașează. Prin urmare, pe măsură ce
temperatura crește apropiindu-se de temperatura de topire (Tm), fluorescența scade cu o viteză
constantă (pantă constantă). La Tm se înregistrează o reducere dramatică a fluorescenței, cu o
schimbare notabilă a pantei. Viteza acestei schimbări este determinată prin trasarea primei regresii
negative a fluorescenței versus temperatura (-d(RFU)/dT). Cea mai mare viteză de modificare a
fluorescenței determină valori de vârf vizibile și reprezintă Tm (Temperatura de topire) a complexelor
DNA (ADN) cu două catene.

CFX Maestro Dx SE trasează datele RFU colectate în timpul unei curbe de topire ca o funcție a
temperaturii. Pentru a analiza datele valorilor de vârf de topire, software-ul atribuie o temperatură
inițială și finală fiecărui vârf, deplasând bara de prag. Valoarea minimă a zonei de vârf este
specificată de poziția barei pragului de topire. Un vârf valid trebuie să aibă o înălțime minimă relativ la
distanța dintre bara de prag și înălțimea celui mai înalt vârf.

Fila Melt Curve (Curbă de topire) afișează Tm (temperatura de topire) a produselor PCR amplificate în
patru vizualizări:

n Melt Curve (Curbă de topire) – afișează datele în timp real pentru fiecare fluorofor sub formă de
RFUs per temperatura pentru fiecare godeu.

n Melt Peak (Vârf de topire) – afișează regresia negativă a datelor RFU per temperatură pentru
fiecare godeu.

n Well selector (Selector godeuri) – afișează godeurile pentru a arăta sau ascunde datele.

n Peak spreadsheet (Foaie de calcul vârf) – afișează datele colectate din godeul selectat.

Notă: Această foaie de calcul afișează până la două vârfuri pentru fiecare urmă. Pentru a
vedea mai multe vârfuri, faceți clic pe fila Melt Curve (Curbă de topire).
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Tabelul 20 definește datele care apar în foaia de calcul Melt Curve (Curbă de topire).

Informație Descriere

Well (Godeu) Poziția godeului în placă

Fluor (Fluorofor) Fluorofor detectat

Content
(Conținut)

O combinație între Tipul de probă și Numărul replicatului

Sample (Probă) Denumirea probei încărcate în Plate Editor (Editor placă)

Melt Temp
(Temperatura de
topire)

Temperatura vârfului de topire pentru fiecare godeu

Notă: Doar cele mai mari două valori de vârf apar în această foaie de calcul.

Tabelul 20. Conținutul foii de calcul Melt Curve (Curbă de topire)
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Ajustarea datelor Melt Curve (Curbă de topire)
Pentru a ajusta datele Melt Curve (Curbă de topire)

u Urmați oricare dintre procedurile următoare:

n Faceți clic pe și trageți barele de prag din graficul Melt Peak (Vârf de topire) pentru a include
sau exclude valorile de vârf în analiza datelor.

n Selectați Positive (Pozitive) în meniul vertical Peaks (Valori de vârf) pentru a afișa datele din
foaia de calcul pentru valorile de vârf de deasupra linei Melt Threshold (Prag de topire) sau
selectați Negative (Negative) pentru a vizualiza datele din foaia de calcul pentru valorile de
vârf de sub linia pragului de topire.

n Deschideți fereastra Trace Styles (Stiluri Urme) pentru a schimba culoarea urmelor din
graficele Melt Curve (Curbă de topire) și Melt Peak (Vârf de topire).

n Selectați un număr în selectorul Step Number (Număr pas) pentru a vizualiza datele din Melt
Curve (Curbă de topire) la un alt pas din protocol. Lista afișează mai mult de un pas dacă
protocolul include citiri ale plăcii în mai mult de un pas al curbei de topire.

n Selectați godeuri din selectorul de godeuri, pentru a vă axa pe subseturi de date.

n Selectați un grup de godeuri pentru a vizualiza și analiza un subset al godeurilor din placă.
Selectați fiecare grup de godeuri după nume în meniul vertical Well Group (Grup godeuri) de
pe bara de instrumente.
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Fila Melt Curve Data (Date curbă de topire)
Fila Melt Curve Data (Date curbă de topire) afișează datele din fila Melt Curve (Curbă de topire) în mai
multe foi de calcul care includ toate vârfurile de topire pentru fiecare urmă. CFX Maestro Dx SE oferă
patru opțiuni de foaie de calcul în care să vizualizați datele curbei de topire:

n Melt Peaks (Vârfuri de topire) – afișează toate datele, inclusiv toate vârfurile de topire, pentru
fiecare urmă. Aceasta este vizualizarea implicită.

n Plate (Placă) – afișează o vizualizare a datelor și conținutului fiecărui godeu din placă.

n RFU – afișează cantitățile RFU la fiecare temperatură pentru fiecare godeu.

n -d(RFU)/dT – afișează rata negativă de schimbare din RFU pe măsură ce se schimbă
temperatura (T). Acesta este un grafic de regresie inițial pentru fiecare godeu din placă.

Selectați fiecare foaie de calcul din lista verticală care apare sub fila Melt Curve Data (Date curbă de
topire).

Foaia de calcul Melt Peaks (Vârfuri de topire)
Foaia de calcul Melt Peaks (Vârfuri de topire) afișează toate datele curbei de topire.

Tabelul 21 de la pagina 231 definește datele care apar în foaia de calcul Melt Peaks (Vârfuri de
topire).
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Informație Descriere

Well (Godeu) Poziția godeului în placă

Fluor (Fluorofor) Fluorofor detectat

Content (Conținut) Tipul de probă listat în fereastra Plate Editor (Editor placă)

Target (Țintă) Ținta amplificării (genă)

Sample (Probă) Denumirea probei listată în fereastra Plate Editor (Editor placă)

Melt Temperature (Temperatura
de topire)

Temperatura de topire a fiecărui produs, listată ca valoare de vârf
(cea mai mare) per rând în foaia de calcul

Peak Height (Înălțime de vârf) Înălțimea vârfului

Begin Temperature (Temperatura
inițială)

Temperatura la începutul vârfului

End Temperature (Temperatura
finală)

Temperatura la finalul vârfului

Tabelul 21. Conținutul foii de calcul Melt Peaks (Vârfuri de topire)

Foaia de calcul Plate (Placă)
Foaia de calcul Plate (Placă) afișează datele privind curba de topire într-un format placă.

Notă: Pentru a ajusta vârful apelat de software, ajustați linia pragului din graficul Melt Peak (Vârf
de topire) în fila Melt Curve (Curbă de topire).

Tabelul 22 de la pagina 232 definește datele care apar în foaia de calcul Plate (Placă).
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Informație Descriere

Content
(Conținut)

O combinație între Sample Type (Tipul de probă) (obligatoriu) și Replicate # (Numărul
replicatului) (opțional)

Sample
(Probă)

Descrierea probei

Peak 1 (Vârful
1)

Primul vârf de topire (cel mai mare)

Peak 2 (Vârful
2)

Al doilea vârf de topire (mai mic)

Tabelul 22. Conținutul foii de calcul Plate (Placă)

Foaia de calcul RFU
Foaia de calcul RFU afișează fluorescența pentru fiecare godeu în fiecare ciclu achiziționat în timpul
curbei de topire.

Tabelul 23 definește datele afișate în foaia de calcul RFU.

Informație Descriere

Well number (Număr godeu) (A1, A2, A3,
A4, A5)

Poziția godeului în placă pentru godeurile
încărcate

Temperature (Temperatura) Temperatura de topire a țintei amplificate,
reprezentată ca un godeu per rând și mai multe
godeuri pentru mai multe produse din același
godeu

Tabelul 23. Conținutul foii de calcul RFU
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Foaia de calcul -d(RFU)/dT
Foaia de calcul -d(RFU)/dT afișează raportul negativ de schimbare din RFU pe măsură ce
temperatura (T) se modifică.

Tabelul 24 definește datele care apar în foaia de calcul -d(RFU)/dT.

Informație Descriere

Well number (Număr godeu) (A1, A2, A3,
A4, A5)

Poziția godeului în placă pentru godeurile încărcate

Temperature -d(RFU)/dT (Temperatura -d
(RFU)/dT)

Raportul negativ de schimbare din RFU pe măsură ce
temperatura (T) se modifică

Tabelul 24. Conținutul foii de calcul -d(RFU)/dT
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Fila End Point (Momentul final)
Deschideți fila End Point (Momentul final) pentru a analiza unitățile finale de fluorescență relativă
(RFU) pentru godeurile cu probe. Software-ul compară nivelurile RFU pentru godeurile cu probe
necunoscute cu nivelurile RFU pentru godeurile cu controale negative și determină dacă proba
necunoscută este pozitivă sau negativă. Probele pozitive au o valoare RFU mai mare decât media
valorii RFU a controalelor negative plus valoarea limită.

Pentru a analiza datele din momentul final, placa trebuie să conțină controale negative, altfel
software-ul nu poate efectua analiza.

n Rulați un protocol Quantification (Cuantificare) – configurați un protocol standard. După
finalizarea rulării, deschideți fereastra Data Analysis (Analiză date), ajustați setările analizei
datelor în fila Quantification (Cuantificare), apoi faceți clic pe fila End Point (Momentul final)
pentru a alege un ciclu final.

n Rulați un protocol End Point Only (Doar momentul final) – încărcați protocolul End Point Only
(Doar momentul final) în fila Plate (Placă) a ferestrei Run Setup (Configurare rulare), selectați sau
creați o placă și inițiați rularea.

Fila End Point (Momentul final) afișează media valorilor RFU, pentru a determina dacă ținta a fost
amplificată de ultimul ciclu (final). Folosiți aceste date pentru a stabili dacă o anumită secvență țintă
este prezentă (pozitivă) într-o probă. Țintele pozitive au valori RFU mai mari decât nivelul de prag
definit de dumneavoastră.

234 | Software-ulCFXMaestro DxSE



Fila End Point (Momentul final)

Sfat: Pentru a crea un protocol pentru momentul final, deschideți fila Protocol (fereastra Run
Setup (Configurare rulare)) și selectați Run > End Point Only Run (Rulare > Rulare doar
momentul final).

După finalizarea rulării, fișierul de date se deschide la fila , care fila End Point (Momentul final)
cuprinde următoarele secțiuni:

n Settings (Setări) – ajustează setările analizei datelor.

n Results (Rezultate) – afișează rezultatele imediat după ce ați ajustat setările.

n Well selector (Selector godeuri) – selectează godeurile cu datele finale pe care doriți să le afișați.

n RFU spreadsheet (Foaie de calcul RFU) – afișează datele RFU finale colectate din godeurile
selectate.

Date rezultate
Secțiunea Results (Rezultate) afișează următoarele date:

n Lowest RFU value (Cea mai mică valoare RFU) – cea mai mică valoare RFU din cadrul datelor

n Highest RFU value (Cea mai mare valoare RFU) – cea mai mare valoare RFU din cadrul datelor

n Negative Control Average (Medie control negativ) – valoarea RFU medie pentru godeurile care
conțin controale negative

n Cut Off Value (Valoare limită) – calculată prin adunarea toleranței (RFU sau Percentage (Procent)
al intervalului indicat în Setări) și a mediei controalelor negative. Eșantioanele cu valori RFU mai
mari decât valoarea limită vor fi denumite „pozitive”. Pentru a regla valoarea de limită, modificați
RFU sau Procentajul intervalului

Valoarea limită este calculată utilizând următoarea formulă:

Valoare limită = medie control negativ + toleranță

Selectați o toleranță printr-una dintre următoarele metode:

n RFU (implicit) – selectați această metodă pentru a utiliza o valoare RFU absolută pentru
toleranță. Valoarea minimă a toleranței RFU este 2. Valoarea maximă este valoarea absolută a
celei mai mari valori RFU minus valoarea absolută a celei mai mici valori RFU. Valoarea implicită
a toleranței RFU este 10 % din intervalul RFU total.

n Percent of Range (Procent interval) – selectați această metodă pentru a utiliza un procent al
intervalului RFU pentru toleranță. Procentul minim al intervalului este 1 %. Procentul maxim al
intervalului este 99 %. Procentul implicit al intervalului este 10 %.
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Ajustarea analizei datelor din momentul final
Pentru a ajusta datele din fila End Point (Moment final)

u Urmați oricare dintre procedurile următoare:

n Alegeți un fluorofor din lista verticală.

n Alegeți o valoare End Cycle to Average (Ciclu final la medie) pentru a configura numărul de
cicluri cu care să calculați valoarea medie finală RFU.

n Selectați RFUs (Valori RFU) pentru a vizualiza datele în unități de fluorescență relativă.

n Selectați Percentage of Range (Procentaj interval) pentru a vizualiza datele sub formă de
procentaj al intervalului RFU.

n Selectați godeuri din selectorul de godeuri, pentru a vă axa pe subseturi de date.

n Selectați un grup de godeuri pentru a vizualiza și analiza un subset al godeurilor din placă.
Selectați fiecare grup de godeuri după nume în meniul vertical Well Group (Grup godeuri) de
pe bara de instrumente.

Foaia de calcul RFU pentru analiza momentului final
Tabelul 25 definește datele care apar în foaia de calcul RFU din fila End Point (Momentul final).

Informație Descriere

Well (Godeu) Poziția godeului în placă

Fluor (Fluorofor) Fluorofor detectat

Content (Conținut) Combinație între tipul de probă și numărul replicatului

End RFU (RFU final) RFU pentru ciclul de la momentul final

Call (Apel) Pozitiv sau negativ, unde probele pozitive au o valoare RFU mai mare decât
RFU medie a controalelor negative plus valoarea limită

Sample (Probă) Denumirea probei încărcate în Plate Editor (Editor placă)

Tabelul 25. Conținutul foii de calcul RFU End Point (RFU la momentul final)

236 | Software-ulCFXMaestro DxSE



Fila AllelicDiscrimination (Discriminare alelică)

Fila Allelic Discrimination (Discriminare alelică)
Fila Allelic Discrimination (Discriminare alelică) atribuie genotipuri godeurilor cu probe necunoscute.
Utilizați aceste date pentru a identifica probe cu diferite genotipuri, inclusiv Alela 1, Alela 2,
Heterozigot, Niciun apel (nicio amplificare) sau Nedeterminat.

Notă: Datele pentru discriminarea alelică trebuie să provină din rulări multiplex cu cel puțin doi
fluorofori. Fiecare fluorofor identifică o alelă în toate probele.

Analiza discriminării alelice necesită următorul conținut minim al godeurilor:

n Doi fluorofori în fiecare godeu

n Probe NTC (control fără țintă de amplificare) pentru analiza de date optimizată

CFX Maestro Dx SE oferă patru opțiuni în care puteți vizualiza datele privind discriminarea alelică:

n Graficul Allelic Discrimination (Discriminare alelică) – afișează datele într-un grafic al RFU pentru
Alela 1/Alela 2. Fiecare punct din grafic reprezintă datele din ambii fluorofori dintr-un godeu.
Puteți comuta între coordonate carteziene și polare, bifând și debifând caseta de selectare Polar
Coordinates (Coordonate polare). Coordonatele carteziene reprezintă RFU pentru Alela 1 de pe
axa x și RFU pentru Alela 2 de pe axa y. Coordonatele polare reprezintă unghiul de pe axa x și
distanța dintre origine și RFU de pe axa y (media tuturor NTC).
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n Well spreadsheet (Foaie de calcul godeu) – afișează datele de discriminare alelică colectate în
fiecare godeu al plăcii.

n Well selector (Selector godeuri) – selectează godeurile cu datele alelice pe care doriți să le
afișați.

n Selected Fluorophores panel (Panoul Fluorofori selectați) – schimbă etichetele axei x și y în
graficul Discriminare alelică, ciclul de analizat și afișarea sau ascunderea hărții apelurilor.

Ajustarea datelor pentru discriminare alelică
Software-ul atribuie automat un genotip godeurilor cu probe necunoscute, pe baza pozițiilor probelor
martor NTC și a unghiului și distanței punctelor de date necunoscute din probele martor NTC.

Pentru a ajusta datele de discriminare alelică

u Urmați oricare dintre procedurile următoare:

n Pentru a afișa coordonatele polare, bifați caseta de selectare din graficul Allelic
Discrimination (Discriminare alelică).

n Pentru a vizualiza un alt fluorofor, alegeți-l din lista verticală de pe panoul Selected
Fluorophores (Fluorofori selectați).

n Pentru a schimba un apel, glisați peste punctul (punctele) de date din graficul Allelic
Discrimination (Discriminare alelică) și alegeți o opțiune din lista Selected Wells (godeuri
selectate):

o Allele 1 (Alela 1)

o Allele 2 (Alela 2)

o Heterozygote (Heterozigot)

o Undetermined (Nedeterminat)

o No Call (Niciun apel)

o Auto Call (Apel automat)

Sfat: Selectați Auto Call (Apel automat) pentru a reveni la apelul implicit.
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Opțiunile de meniu pentru grafice
În plus față de opțiunile comune de meniu afișate prin clic dreapta pentru grafice (consultați
Elementele de meniu comune afișate prin clic dreapta pentru grafice de la pagina 206 ), Tabelul 26
prezintă opțiunile de meniu disponibile în graficul Allelic Discrimination (Discriminare alelică).

Opțiune de meniu Funcție

Zoom (Mărire) Focalizează vizualizarea graficului asupra zonei selectate (făcând
clic și trăgând cursorul în grafic).

Sfat: Pentru a anula mărirea și a afișa toate punctele de date,
faceți clic dreapta și selectați Set Scale to Default (Setare
scară la implicit).

Well (Godeu) Pentru godeul selectat, opțiunile sunt: afișează doar acest godeu,
elimină acest godeu din vizualizare, setează culoarea pentru
această urmă sau exclude acest godeu din analiză.

Selected Wells (Godeurile
selectate)

Pentru godeurile selectate (făcând clic și trăgând cursorul în grafic),
opțiunile sunt: afișează doar aceste godeuri, elimină aceste godeuri
din vizualizare, setează culoarea pentru aceste urme sau exclude
aceste godeuri din analiză.

Tabelul 26. Opțiunile de meniu dreapta și stânga pentru graficul Allelic Discrimination
(Discriminare alelică)

Foaia de calcul Allelic Discrimination (Discriminare alelică)
Tabelul 27 definește datele care apar în foaia de calcul Allelic Discrimination (Discriminare alelică).

Informație Descriere

Well (Godeu) Poziția godeului în placă

Sample (Probă) Descrierea denumirii probei

Call (Apel) Identitatea alelei, incluzând opțiunile automate Alelă 1, Alelă 2,
Heterozigot, Niciun apel sau Nedeterminat

Type (Tip) Auto (Automat) sau Manual, descrie modul în care a fost efectuat
apelul. Automat indică faptul că software-ul a selectat apelul. Manual
indică faptul că utilizatorul a ales apelul.

Tabelul 27. Conținutul foii de calcul Allelic Discrimination (Discriminare alelică)
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Informație Descriere

RFU1 RFU pentru Alelă 1

RFU2 RFU pentru Alelă 2

Tabelul 27. Conținutul foii de calcul Allelic Discrimination (Discriminare alelică), continuare
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Fila Custom Data View (Vizualizare de date personalizată)
Fila Custom Data View (Vizualizare de date personalizată) afișează simultan mai multe panouri într-
un format care poate fi personalizat.

Lista verticală Load a Preset View (Încărcare vizualizare prestabilită) oferă o selecție a matrițelor de
format de afișare. Vizualizarea implicită afișată depinde de fișierul analizat. De exemplu, dacă sunt
prezente date Melt Curve (Curbă de topire), va apărea vizualizarea implicită Amp+Melt.
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Crearea unei vizualizări de date personalizată
Pentru a crea o vizualizare de date personalizată

u Urmați oricare dintre procedurile următoare:

n Selectați o vizualizare prestabilită alternativă din lista verticală.

n Selectați altă vizualizare grafic din lista verticală aflată în partea de sus a fiecărui panou
individual.

n Modificați numărul de rânduri și coloane din filă.

n Modificați dimensiunile panourilor individuale. Trageți de barele de la marginea fiecărui
panou.

Faceți clic pe Save as Preset (Salvare ca prestabilit) pentru a salva vizualizarea personalizată ca
matriță prestabilită. Faceți clic pe Manage Presets (Gestionare prestabilite) pentru a șterge, redenumi
sau restabili vizualizări prestabilite existente.
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Fila QC (CC)
Utilizați fila QC (CC) pentru a evalua rapid calitatea datelor de rulare pe baza regulilor definite în fila
QC (CC) din tabelul cu reguli .

CFX Maestro Dx SE oferă patru opțiuni în care puteți vizualiza datele QC (CC):

n Graficul Amplification (Amplificare) – afișează RFU pentru fiecare godeu la fiecare ciclu.
Fiecare urmă din grafic reprezintă datele de la un singur fluorofor dintr-un godeu.

n Tabelul de reguli QC (CC) – afișează regulile QC (CC) disponibile și setările care definesc
fiecare regulă. Regulile QC (CC) aplicate sunt indicate printr-o bifă.

n Well selector (Selector godeuri) – selectează godeurile cu datele de fluorescență pe care doriți
să le afișați.

n QC rule summary pane (Panou rezumat pentru regula CC) – afișează regula QC (CC) selectată
și evidențiază godeurile care nu îndeplinesc regula.
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Schimbarea criteriilor QC (CC)
Pentru a schimba criteriile QC (CC)

u Bifați sau debifați caseta de selectare Use (Utilizare) pentru regulă, pentru a o include sau
exclude din QC (CC).

Excluderea godeurilor care nu îndeplinesc QC (CC)
CFX Maestro Dx SE afișează godeurile care nu îndeplinesc criteriile QC (CC) în coloana Rezultate
din tabelul de reguli QC (CC) și în panoul rezumativ.

Pentru a exclude godeurile care nu îndeplinesc criteriile QC (CC)

u Selectați Exclude Wells (Excludere godeuri) pentru fiecare godeu pe care doriți să îl excludeți.
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Fila Run Information (Informații rulare)
Fila Run Information (Informații rulare) afișează informații despre protocol și alte informații despre
fiecare rulare. Folosiți această filă pentru a:

n Vizualiza protocolul.

n Introduce și edita observații despre rulare.

n Introduce sau edita ID (Nr. de identificare) sau codul de bare al rulării.

n Vizualiza evenimentele potențial produse în timpul rulării. Folosiți aceste mesaje pentru
depanarea unei rulări.

Sfat: Faceți clic dreapta pe Protocol pentru a-l copia, exporta sau imprima. Faceți clic dreapta pe
panourile Notes (Observații), ID/Bar Code (Nr. de identificare/cod de bare) sau Other (Altele)
pentru a anula, tăia, copia, lipi, șterge sau selecta textul.
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Rapoarte de analiză a datelor
Caseta de dialog Report (Raport) afișează informații despre fișierul de date curent în fereastra Data
Analysis (Analiză date). Pentru a deschide un raport, selectați Tools > Reports (Instrumente >
Rapoarte) sau faceți clic pe Reports (Rapoarte) de pe bara de instrumente.

Caseta de dialog Report (Raport) conține următoarele secțiuni:

n Meniu și bară de instrumente – oferă opțiuni de formatare, salvare și imprimare a raportului sau
matriței.

n Listă de opțiuni (partea stângă sus a casetei de dialog) – oferă opțiuni de afișare a raportului.

n Panou de opțiuni (partea stângă jos a casetei de dialog) – afișează casete text în care puteți
introduce informații despre o opțiune selectată.

n Panou de previzualizare (partea dreaptă a casetei de dialog) – afișează o previzualizare a
raportului curent.
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Categorii de rapoarte de analiză a datelor
Tabelul 28 afișează toate opțiunile disponibile pentru un raport de analiză a datelor, în funcție de tipul
de date din fereastra Data Analysis (Analiză date).

Categorie Opțiune Descriere

Header (Antet)

Titlu, subtitlu și logo pentru raport

Report Information (Informații
raport)

Data rulării, nume utilizator, denumirea
fișierului de date, calea fișierului de date
și grupul de godeuri selectat

Audit Information (Informații
audit)

Informații suplimentare necesare pentru
audit, inclusiv semnături

Notes (Observații) Observații despre raportul de date

Run Setup (Configurare rulare)

Run Information (Informații
rulare)

Data rulării, nume utilizator, denumirea
fișierului de date, calea fișierului de date
și grupul de godeuri selectat

Protocol Vizualizare în format text a pașilor și
opțiunilor protocolului

Plate Display (Afișare placă) Vizualizare a plăcii, cu informații despre
fiecare godeu din placă

Quantification (Cuantificare)

Analysis Settings (Setări
analiză)

Numărul pașilor de colectare a datelor,
modul de analiză și metoda de scădere a
nivelului inițial

Graficul Amplification
(Amplificare)

Graficul de amplificare pentru rulările
care includ date de cuantificare

Standard Curve Chart (Grafic
Curbă standard)

Grafic curbă standard

Tabelul 28. Categorii de rapoarte de analiză a datelor în lista de opțiuni
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Categorie Opțiune Descriere

Data (Date) Foaie de calcul care listează datele din
fiecare godeu

Gene Expression – Bar Chart (Expresie genică – Grafic cu bare)

Analysis Settings (Setări
analiză)

Modul de analiză, datele graficului,
opțiunea de scalare și erori grafic

Chart (Grafic) Copie a graficului cu bare

Target Names (Denumiri ținte) Grafic cu denumirile țintelor

Sample Names (Denumiri probe) Grafic cu denumirile probelor

Data (Date) Foaie de calcul care listează datele din
fiecare godeu

Target Stability (Stabilitatea
țintei)

Grafic cu valorile de stabilitate a țintelor

Diagramă boxplot Diagramă boxplot

Dot Plot Chart (Grafic de puncte) Grafic de puncte

Expresia genelor - clustergrama și corelograma

Analysis Settings (Setări
analiză)

Setări pentru fiecare tip de grafic

Chart (Grafic) Copie a graficului

Data (Date) Foaie de calcul care listează datele din
fiecare țintă

Gene Expression (Expresie genică) – ANOVA Data (Date ANOVA)

ANOVA Settings (Setări
ANOVA)

Pragul valorii P utilizat în analiză

ANOVA Results (Rezultate
ANOVA)

Tabelul cu rezultatele analizelor ANOVA
și HSD Tukey post-hoc

Melt Curve (Curbă de topire)

Tabelul 28. Categorii de rapoarte de analiză a datelor în lista de opțiuni, continuare
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Categorie Opțiune Descriere

Analysis Settings (Setări
analiză)

Număr pași de topire și setare bară prag

Grafic Melt Curve (Curbă de
topire)

Graficul curbei de topire

Graficul Melt peak (Vârf de
topire)

Graficul Melt peak (Vârf de topire)

Data (Date) Foaie de calcul care listează datele din
fiecare godeu

Allelic Discrimination (Discriminare alelică)

Analysis Settings (Setări
analiză)

Fluorofori, ciclu și harta apelurilor de
vizualizare

Allelic Discrimination Chart
(Grafic discriminare alelică)

Copie a graficului de discriminare alelică

Data (Date) Foaie de calcul care listează datele din
fiecare godeu

End Point (Momentul final)

Analysis Settings (Setări
analiză)

Fluorofor, cicluri finale la medie, mod,
cea mai mică valoare RFU, cea mai mare
valoare RFU și valoarea limită

Data (Date) Foaie de calcul care listează datele din
fiecare godeu

QC Parameters
(Parametri CC)

Data (Date) Foaie de calcul cu parametrii pentru
fiecare regulă CC

Tabelul 28. Categorii de rapoarte de analiză a datelor în lista de opțiuni, continuare
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Crearea unui raport de analiză a datelor
Puteți salva structura raportului drept matriță, pe care o puteți utiliza din nou pentru rapoarte similare.

Pentru a crea un raport de analiză a datelor

1. Efectuați ajustările finale la conținutul godeurilor, godeurile selectate, grafice și foile de calcul în
fereastra Data Analysis (Analiză date) înainte de a crea raportul.

2. Selectați Tools > Reports (Instrumente > Rapoarte) din bara de meniu Data Analysis (Analiză
date) pentru a deschide caseta de dialog Report (Raport).

3. Alegeți opțiunile pe care doriți să le includeți în raport. Raportul se deschide cu opțiunile implicite
selectate. Bifați sau debifați casetele de selectare pentru a schimba categorii întregi sau opțiuni
individuale dintr-o categorie.

Tabelul 28 de la pagina 247 prezintă opțiunile disponibile pentru afișare.

Notă: Datele care apar în raport depind de selecțiile curente din cadrul filelor ferestrei Data
Analysis (Analiză date). De exemplu, o rulare de cuantificare poate să nu conțină o curbă
standard și prin urmare datele respective nu apar în fereastra Data Analysis (Analiză date)
sau în raportul de date.

4. Schimbați ordinea categoriilor și elementelor dintr-un raport. Trageți opțiunile în poziția aferentă.
Elementele pot fi reordonate doar în cadrul categoriilor cărora le aparțin.

5. (Opțional) În panoul Report Options (Opțiuni raport), introduceți informațiile relevante pentru
opțiunea selectată:

n Alegeți un subset de informații de afișat în raport.

n Alegeți setările specifice pentru opțiunea selectată.

n Modificați textul de afișat pentru opțiunea selectată.

6. Faceți clic pe Update Report (Actualizare raport) pentru a actualiza Report Preview
(Previzualizare raport) cu orice modificări efectuate.

7. Imprimați sau salvați raportul:

a. Faceți clic pe butonul Print Report (Imprimare raport) de pe bara de instrumente pentru a
imprima raportul curent.

b. Selectați File (Fișier)> Save (Salvare) pentru a salva raportul în formatul de fișier PDF (fișier
Adobe Acrobat Reader) , MHT (document Microsoft) sau MHTML (document Microsoft).

c. Selectați o locație în care să salvați fișierul.
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d. Selectați File > Save As (Fișier > Salvare ca) pentru a salva raportul cu o nouă denumire sau
într-un nou loc.

8. (Opțional) Creați o matriță de raport cu informațiile pe care le doriți. Pentru a salva setările
raportului curent într-o matriță, selectați Template > Save (Matriță > Salvare) sau Save As
(Salvare ca). Apoi încărcați matrița raportului data viitoare când doriți să creați un raport nou.
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Crearea rapoartelor pentru grupuri de godeuri
Pentru a crea un raport pentru un grup de godeuri

1. Selectați Tools > Well Group Reports (Instrumente > Rapoarte grupuri de godeuri) din fereastra
Data Analysis (Analiză date).

2. Din caseta de dialog Well Groups Reports (Rapoarte grupuri de godeuri), selectați grupurile de
godeuri, pașii de amplificare și pașii de topire de inclus în raport.

3. Introduceți calea sau navigați la folderul de destinație în care doriți să salvați raportul.

4. (Opțional) Selectați Choose a Report Template (Alegeți o matriță de raport) și navigați la folderul
fișierului matriță.

5. (Opțional) Selectați Open Destination Folder (Deschidere folder destinație) pentru a deschide
folderul și vizualiza rapoartele după ce sunt generate.

6. Faceți clic pe Create Reports (Creare rapoarte).
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Cu ajutorul unor probe control calificate mai stringent în reacțiile dumneavoastră, puteți utiliza
Software-ul CFX Maestro Dx SE pentru a efectua o rulare de expresie genică pentru a normaliza
diferențele relative dintr-o concentrație țintă printre probe. În mod tipic, nivelurile de expresie pentru
una sau mai multe gene de referință sunt utilizate pentru a normaliza nivelurile de expresie ale unei
gene de interes. Genele de referință iau în considerare diferențele de încărcare sau alte variații
reprezentate în fiecare probă și nivelurile lor de expresie trebuie să nu fie afectate în sistemul biologic
studiat.

Selectați fila Gene Expression (Expresie genică) în fereastra Data Analysis (Analiză date) pentru a
evalua diferențele relative între reacțiile PCR din două sau mai multe godeuri. De exemplu, puteți
evalua numerele relative de genomuri virale sau numerele relative de secvențe transfectate dintr-o
reacție PCR. Cea mai comună aplicație pentru studiul de expresie genică este comparația între
concentrația cDNA (ADNc) în mai mult de o reacție, pentru a estima nivelurile de stare de echilibru al
RNA (ARN) mesager.

Software-ul calculează nivelul de expresie relativă al unei ținte cu unul dintre aceste scenarii:

n Nivelul de expresie relativă pentru o secvență țintă (Ținta 1) relativ la o altă țintă (Ținta 2); de
exemplu cantitatea unei gene relativ la o altă genă sub același tratament al probei.

n Nivelul expresiei relative al unei secvențe țintă într-o probă comparativ cu aceeași țintă sub
tratament diferit al probei; de exemplu, cantitatea relativă a unei gene în raport cu ea însăși în
condiții temporale, geografice sau de dezvoltare diferite.

Configurația plăcii pentru analiza expresiei genice
Pentru a realiza analiza expresiei genice, conținutul godeurilor trebuie să includă următoarele:

n Două sau mai multe ținte – cele două ținte care reprezintă diferite gene amplificate sau secvențe
din probele dumneavoastră.

n Una sau mai multe ținte de referință – cel puțin o țintă trebuie să fie țintă de referință pentru
expresia normalizată. Atribuiți toate țintele de referință în fereastra Experiment Settings (Setări
experimente), pentru a analiza datele în modul Normalized Expression (Expresie normalizată)
(ΔΔCq). Rulările care nu conțin o referință trebuie analizate utilizând modul Relative Expression
(Expresie relativă) (ΔCq).
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n Probe comune – reacțiile dumneavoastră trebuie să includă probe comune (minimum două
necesare) pentru a vă vizualiza datele reprezentate grafic în fila Gene Expression (Expresie
genică). Aceste probe ar trebui să reprezinte diferite tratamente sau condiții pentru fiecare dintre
secvențele dumneavoastră țintă. Atribuiți o probă de control (opțională) în fereastra Experiment
Settings (Setări experimente). Dacă nu este selectată nicio probă de control, software-ul folosește
cea mai mică valoare Cq drept valoare de control.

Cerințele pentru setarea Gene Expression (Expresie genică) din Plate Editor (Editor placă) depind de
tipul conținutului reacției: PCR singleplex, cu un fluorofor în reacții, sau PCR multiplex, cu mai mulți
fluorofori în reacții.

Configurația ghidată a plăcii
Dacă configurația plăcii unui fișier de date nu conține informațiile necesare pentru analiză și este
selectată fila Gene Expression (Expresie genică), spațiul ocupat în mod normal de graficul cu bare va
conține instrucțiuni pentru introducerea acestor informații. Pentru expresia genică normalizată,
parcurgeți următorii pași:

1. Definiți denumirile Target (Țintă) și Sample (Probă) urmând oricare dintre procedurile următoare:

n Plate Setup (Configurație placă) – deschide fereastra Plate Editor (Editor placă).

n Replace Plate File (Înlocuire fișier placă) – deschide browser-ul Select Plate (Selectare
placă), în care puteți naviga la un fișier placă salvat anterior cu care să înlocuiți structura
curentă a plăcii.

n Replace PrimePCR File (Înlocuire fișier PrimePCR) – deschide caseta de dialog Select
PrimePCR File (Selectare fișier PrimePCR), în care puteți naviga la un fișier de rulare
PrimePCR pe care să-l aplicați la structura plăcii.

2. Selectați una sau mai multe ținte de referință și o probă de control utilizând caseta de dialog
Experiment Settings (Setări experimente).

Dacă structura plăcii conține deja informații despre țintă și probă, doar al doilea pas este necesar
și este evidențiat cu portocaliu. Acest pas trebuie parcurs înainte de realizarea analizei expresiei
genice normalizate.

Notă: Datele pentru corelogramă, și clustergramă și sunt afișate doar dacă toate cerințele
pentru expresia genică normalizată listate în Plate Setup (Configurație placă) pentru Gene
Expression Analysis (Analiza expresiei genice) sunt îndeplinite.
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Graficele de expresie genică
CFX Maestro Dx SE afișează datele expresiei genice în mai multe vizualizări. Tabelul 29 listează
opțiunile graficelor disponibile în software.

Buton Denumire Funcție

Reprezentare grafică Afișează datele expresiei genice normalizate
folosind una dintre următoarele vizualizări:

n Grafic cu bare (implicită)

n Diagramă boxplot

n Grafic de puncte

Clustergramă Afișează datele expresiei normalizate într-o
ierarhie bazată pe gradul de similaritate a
expresiei pentru diferite ținte și probe.

Corelogramă Afișează expresia normalizată a țintelor pentru
un control versus o probă experimentală.

ANOVA Afișează rezultatele unei ANOVA
unidirecționale pentru datele expresiei genice
utilizând următoarele pachete R pentru a
efectua ANOVA și a determina rezultatele
Tukey:

n Complement de regresie aplicată (car)

n Media celor mai mici pătrate (lsmeans)

Instrumentul de selectare a genei
de referință

(Disponibil în fila Study Analysis (Analiză
studiu) din fereastra Gene Study (Studiu genic))
Identifică genele de referință testate și le
clasifică drept Ideal (Ideale), Acceptable
(Acceptabile) sau Unstable (Instabile), în
funcție de stabilitatea lor.

Analiza controalelor PrimePCR (Disponibilă în fila Study Analysis (Analiză
studiu) din fereastra Gene Study (Studiu genic))
Afișează rezultatele probelor testate.

Tabelul 29. Opțiunile graficelor de expresie genică
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Reprezentare grafică

Expresia relativă a țintelor este prezentată în aceste două vizualizări:

n Graficul Expresie genică – afișează datele PCR în timp real, sub una dintre următoarele forme:

o ΔΔCq – expresie normalizată relativă, calculată folosind probe de control și ținte de referință.

o ΔCq – cantitatea relativă a genei țintă dintr-o probă în raport cu o probă de control.

Puteți vizualiza datele din graficul de expresie genică în una dintre cele trei vizualizări. Pentru
mai multe informații, consultați Schimbarea și adnotarea vizualizării graficului de la pagina 258.

n Foaie de calcul – afișează o foaie de calcul a datelor expresiei genice.

Sfat: Faceți clic dreapta pe orice grafic sau foaie de calcul pentru a accesa opțiunile.
Selectați View/Edit Plate (Vizualizare/Editare placă) din meniul vertical Plate Setup
(Configurație placă) pentru a deschide Plate Editor (Editor placă) și a modifica conținutul
godeului din placă.

Sfat: Selectați Sort (Sortare) din meniul clic dreapta pentru a rearanja ordinea denumirilor
Target (Țintă) și Sample (Probă) din grafic.
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Expresie genică normalizată

Pentru a normaliza datele, utilizați nivelul expresiei măsurat pentru una sau mai multe gene de
referință ca factor de normalizare. Genele de referință sunt ținte care nu sunt regulate în sistemul
biologic studiat, de exemplu actină,GAPDH sau tubulină.

Pentru a configura analiza expresiei genice normalizate (ΔΔCq)

1. Deschideți un fișier de date (extensia .pcrd).

2. Revizuiți datele din fila Quantification (Cuantificare) din fereastra Data Analysis (Analiză date).
Ajustați datele, de exemplu schimbând pragul și modul de analiză.

3. Alegeți fila Gene Expression (Expresie genică).

4. În fila Gene Expression (Expresie genică), faceți clic pe Experiment Settings (Setări experimente).

5. În caseta de dialog Experiment Settings (Setări experimente), urmați procedura următoare:

a. Alegeți fila Samples (Probe) și selectați un control. La atribuirea unui control, CFX Maestro Dx SE
normalizează cantitățile relative pentru toate genele la cantitatea de control, care este setată la 1.

b. Alegeți fila Target (Țintă) și selectați genele de referință. Analiza expresiei genice necesită o
referință între țintele din probele dumneavoastră

6. Selectați Normalized Expression (Expresie normalizată) (ΔΔCq) dacă această opțiune nu este
deja selectată și apoi vizualizați nivelurile de expresie în fila Gene Expression (Expresie genică).

Notă: De asemenea, puteți utiliza Setup Wizard (Expert configurație) pentru a configura
structura plăcii pentru analiza expresiei genice normalizate.

Cantitate relativă

Prin definiție, datele de cantitate relativă (ΔCq) nu sunt normalizate. Această metodă este utilizată
pentru a cuantifica probele care nu includ gene de referință (ținte). În mod obișnuit, cercetătorii se
bazează pe una dintre următoarele considerente când setează rularea:

n Fiecare probă conține aceeași cantitate de RNA (ARN) sau cDNA (ADNc) în fiecare godeu.

n Orice variație a cantității de probă biologică încărcată va fi normalizată după rulare printr-o metodă
de analiză a datelor, în afara software-ului. De exemplu, un cercetător poate alege să împartă
valoarea cantității relative la factorul de normalizare, dacă se poate la masa de acid nucleic
încărcată pentru fiecare probă, sau la numărul de celule din care a fost izolat acidul nucleic.

Pentru a rula o analiză a cantității relative (ΔCq)

u In fila Gene Expression (Expresie genică), selectați Relative Quantity (ΔCq) (Cantitate relativă)
(ΔCq) din lista verticală Mode (Mod) din panoul din dreapta.
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Sfat: Pentru a compara rezultatele cu datele din alte rulări ale expresiei genice, deschideți
un nou studiu genic sau adăugați un fișier de date la un studiu genic existent.

Schimbarea și adnotarea vizualizării graficului
Utilizând comenzile de meniu de pe bara de instrumente pentru grafice și instrumentele graficului
pentru analiza datelor, puteți modifica modul de vizualizare a graficului, adnota fiecare grafic și
modifica afișarea graficului. Bara de instrumente a graficelor este afișată între grafic și foaia de calcul
cu analiza datelor, în partea de jos a ecranului.

Instrumente bară de instrumente grafic

Sfat: Consultați Grafice de la pagina 198 pentru informații despre instrumentele graficului care
apar în partea dreaptă a graficelor de analiză a datelor.

Bara de instrumente de sub grafice oferă acces rapid la instrumentele de adnotare.

Tabelul 30 afișează funcțiile butoanelor de pe bara de instrumente a graficelor.

Buton Denumire Funcție

Grafic cu bare Afișează expresia relativă a țintelor.

Diagramă boxplot Afișează datele sub formă de intervale de cuartile (a se
vedea Calculele aferente diagramei boxplot de la pagina
297 pentru detalii de calcul).

Notă: Disponibil numai dacă Analyze Using (Analiză cu)
este setată la Biological Groups Only (Numai grupuri
biologice).

Grafic de puncte Afișează punctele de date ale probei individuale pentru
fiecare țintă.
Note: Disponibil numai dacă Analyze Using (Analiză cu)
este setată la Biological Groups Only (Numai grupuri
biologice).

Adăugare săgeată Desenează o săgeată pe graficul activ.

Tabelul 30. Bară de instrumente grafic
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Buton Denumire Funcție

Adăugare cerc Desenează un cerc pe graficul activ

Adăugare text Inserează o casetă text în graficul activ, în care puteți
adăuga text pentru a identifica elementele de interes din
grafic.

Anulare Elimină sau aduce la starea anterioară ultima adnotare
efectuată în graficul activ.

Refacere Aduce la starea anterioară ultima acțiune de Anulare
efectuată pe graficul activ.

Ștergere toate Elimină toate adnotările de pe graficul activ.

Tabelul 30. Bară de instrumente grafic, continuare
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Sortarea datelor țintei, probei și grupului biologic

Notă: Această opțiune este disponibilă numai în graficele de expresie genică.

Implicit, listele Targets (Ținte), Samples (probe), și Biological Groups (Grupuri biologice) apar în
ordine alfabetică. Utilizați caseta de dialog Sort (Sortare) pentru a sorta afișajul în ordine alfabetică
inversă sau pentru a muta manual un termen în altă poziție din listă.

Pentru a sorta datele pentru țintă, probă și grupul biologic

1. Din instrumentele graficului, faceți clic pe Sort (Sortare).

Va apărea caseta de dialog Gene Expression Chart Sorting (Sortare grafic expresie genică).

2. În caseta de dialog, faceți clic pe Z-A pentru a sorta lista în ordine alfabetică inversă.

3. Pentru a muta manual un termen, selectați-l și faceți clic pe butonul corespunzător dintre grafice:

n Faceți clic pe săgeata În sus sau În jos pentru a muta termenul selectat cu o poziție.

n Faceți clic pe săgeata bară În sus sau În jos pentru a muta termenul selectat în partea de sus
sau de jos a listei.

4. Faceți clic pe OK pentru a salva modificările și a reveni la fila Gene Expression (Expresie genică).
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Modificarea setărilor de culoare pentru țintă, probă și grup biologic

Utilizați caseta de dialog Color Settings (Setări culoare) dacă doriți să modificați culoarea unei ținte,
probe sau grup biologic sau să eliminați elementul respectiv din grafic.

Pentru a modifica setările de culoare ale țintei

1. În panoul din dreapta al casetei de dialog Gene Expression (Expresie genică), asigurați-vă că
Sample (Probă) apare în lista verticală a axei x.

2. În Chart Tools (Instrumente grafic), selectați Color Settings (Setări culoare).

Apare caseta de dialog Color Settings (Setări culoare).

3. Ca să modificați culoarea afișajului pentru o țintă, faceți clic pe culoarea acesteia în coloana
Color (Culoare).

4. În caseta de dialog Color (Culoare) care apare, selectați o culoare nouă și faceți clic pe OK.

5. Pentru a elimina o țintă din graficul de expresie genică, debifați caseta de selectare aferentă din
coloana Show Chart (Afișare grafic).

Sfat: Pentru a elimina toate țintele, debifați Show Chart (Afișare grafic) în capul de tabel.

6. (Opțional) Implicit, barele sunt afișate în culori compacte. Pentru a afișa barele cu gradient de
culoare, debifați Use Solid Colors (Utilizare culori compacte).

7. Faceți clic pe OK pentru a salva modificările și a reveni la fila Gene Expression (Expresie genică).

Pentru a modifica setările de culoare ale probei sau grupului biologic

1. În panoul din dreapta al casetei de dialog Gene Expression (Expresie genică), asigurați-vă că
Target (Țintă) apare în lista verticală a axei x.

2. Efectuați pașii din Pentru a modifica setările de culoare ale țintei de la pagina 261.

Schimbarea vizualizării graficului

Pentru a schimba vizualizarea curentă a graficului

u Selectați comanda de meniu de pe bara de instrumente pentru vizualizarea țintei.

Notă: Fila Gene Expression (Expresie genică) se deschide întotdeauna afișând datele în
vizualizarea implicită a graficului cu bare.
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Excluderea punctelor de date extreme

În graficul de puncte, puteți vizualiza și exclude cu ușurință extremele din analiză.

Pentru a exclude punctele de date extreme

u În graficul de puncte, faceți clic dreapta pe extremele țintei și selectați Exclude Well from Analysis
(Excludere godeu din analiză).

Punctul de date este eliminat din graficul de puncte și godeul devine gri în Well Selector (Selector
godeuri) din fila Quantification (Cuantificare).

Pentru a include un punct de date extreme exclus

u În fila Quantification (Cuantificare), faceți clic dreapta pe godeu în Well Selector (Selector
godeuri) și selectați Well (Godeu) > Include in Analysis (Includere în analiză).

Vizualizarea detaliilor punctului de date

Pentru a vizualiza detaliile punctului de date

u În diagrama boxplot sau în graficul de puncte, opriți cursorul pe un singur punct de date.

Va apărea un sfat pe ecran, indicând denumirea probei și expresia acesteia (cantitatea relativă sau
expresia normalizată, în funcție de modul selectat).

Adnotarea graficelor

Puteți adăuga săgeți, cercuri și text la fiecare vizualizare a graficului cu bare, pentru o comunicare
clară a datelor. Adnotările sunt salvate împreună cu graficul cu bare și apar în fișierul exportat și
tipărit. Cu toate acestea, adnotările efectuate la o vizualizare a graficului nu sunt adăugate la celelalte
vizualizări ale graficului.

Pentru a desena o săgeată sau un cerc pe grafic

1. Pe bara de instrumente a graficului cu bare, faceți clic pe instrumentul specific.

2. Faceți clic în graficul cu bare și deplasați cursorul peste grafic, după caz.
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Pentru a adăuga text la grafic

1. Pe bara de instrumente a graficului cu bare, faceți clic pe Add Text (Adăugare text).

2. Faceți clic în graficul cu bare. Va apărea o casetă text în locul respectiv.

3. Adăugați text în caseta de text.

4. Faceți clic oriunde pe grafic pentru a ieși din caseta de text.

Sfat: Apăsați Enter pentru a adăuga mai multe rânduri în caseta de text.

Pentru a muta o adnotare

1. Mișcați cursorul peste adnotare. Pictograma se transformă într-un deget arătător și chenarul
adnotării este evidențiat.

2. Faceți clic pe adnotare și deplasați-o într-o altă poziție.

3. Eliberați adnotarea pentru a o fixa pe poziție.

Pentru a anula o adnotare

u Faceți clic pe Undo (Anulare).

Va fi eliminată adnotarea adăugată cel mai recent.

Sfat: Puteți anula pe rând cele mai recente zece adnotări.

Pentru a reface o adnotare

u Faceți clic pe Redo (Refacere).

Adnotarea eliminată cel mai recent este restaurată.

Sfat: Puteți reface pe rând cele mai recente zece adnotări.

Pentru a șterge o adnotare

u Faceți clic dreapta pe adnotare și selectați Delete (Ștergere).

Ajustarea datelor de expresie genică
După ce ați selectat modul de analiză – expresie normalizată (∆∆Cq) sau cantitate relativă (∆Cq),
ajustați datele pe care le vedeți în fila Gene Expression (Expresie genică) modificând opțiunile de
setare din partea dreaptă a graficului.

Sfat: Setați opțiunile implicite de date Gene Expression (Expresie genică) în caseta de dialog User
Preferences (Preferințe utilizator) (consultați Setarea parametrilor impliciți pentru fișierul de date de
expresie genică de la pagina 90 ).
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Datele graficului

Setați valoarea axei y la scara liniară pentru a activa opțiunile datelor graficului. Opțiunile datelor
graficului vă permit să prezentați datele din grafic folosind una dintre următoarele opțiuni:

n Relativ la control – reprezentarea grafică a datelor cu axa scalată de la 0 la 1. Dacă atribuiți o
valoare de control în rularea dumneavoastră, selectați această opțiune pentru a vizualiza rapid
reglarea pozitivă și negativă a țintei.

n Relativ la zero – reprezentarea grafică a datelor cu originea la zero.

Analyze Using (Analiză cu)

Utilizați meniul vertical pentru a selecta modul de analiză și reprezentare grafică a datelor. Opțiunile
disponibile sunt:

n Samples Only (Numai probe) – datele sunt analizate și reprezentate grafic pentru fiecare probă.

n Biological Groups Only (Numai grupuri biologice) – datele sunt analizate și reprezentate grafic
pentru grupurile biologice. Expresia afișată pentru grupul biologic este media geometrică a
probelor din acel grup.

n Sample Biological Group (Probă Grup biologic) – datele sunt analizate și reprezentate grafic
pentru fiecare probă, cu grupul biologic adăugat după denumirea probei. Valorile P afișate sunt
calculate pe baza grupului biologic.

n Biological Group Sample (Grup biologic Probă) – datele sunt analizate și reprezentate grafic
pentru fiecare probă, cu grupul biologic precedând denumirea probei. Valorile P afișate sunt
calculate pe baza grupului biologic.

Control

Utilizați meniul vertical Control pentru a selecta o probă care va fi utilizat(ă) la normalizarea cantității
relative:

Adnotarea valorilor P și a pragului valorii P

Când selectați Annotate P-Values (Adnotare valori P), software-ul afișează un asterisc (*) pe graficul
cu bare deasupra unei ținte, dacă valoarea sa P este sub pragul selectat. Software-ul calculează
automat valoarea P comparând nivelul expresiei probei cu nivelul expresiei probei de control
selectate, utilizând un test t standard. Intervalul pragului valorii P este de 0,000-1,000.

Opțiuni axa x

Opțiunea axei x vă permite să selectați datele axei x ale graficului Gene Expression (Expresie
genică):
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n Target (Țintă) – reprezintă grafic denumirile țintelor pe axa x.

n Sample (Probă) – reprezintă grafic denumirile probelor pe axa x.

Opțiuni axa y

Opțiunea axei y vă permite să afișați graficul Gene Expression (Expresie genică) pe una dintre
următoarele trei scări:

n Linear (Liniară) – selectați această opțiune pentru a afișa o scară liniară.

Sfat: Setarea axei y la Linear (Liniară) activează lista verticală Graph Data (Date grafic), din
care puteți alege să reprezentați grafic datele relativ la control sau relativ la zero.

n Log 2 – selectați această opțiune pentru a evalua probele la nivelul unui interval dinamic mare.

n Log 10 – selectați această opțiune pentru a evalua probele la nivelul unui interval dinamic foarte
mare.

Opțiuni de scalare

Selectați Normalized Gene Expression (Expresie genică normalizată) (ΔΔCq) și setați Controlla None
(Niciuna) pentru a activa opțiunile de scalare în graficul Gene Expression (Expresie genică). Selectați
una dintre aceste opțiuni de scalare pentru a calcula și prezenta datele în maniera cea mai adecvată
pentru designul rulării dumneavoastră:

n Unscaled (Nescalat) – prezintă expresia genică normalizată nescalată.

n Highest (Cel mai ridicat) – scalează expresia genică normalizată pentru fiecare țintă, împărțind
nivelul expresiei fiecărei probe la cel mai ridicat nivel de expresie pentru toate probele.

Această opțiune de scalare folosește formula „scalat la cel mai ridicat nivel”.

n Lowest (Cel mai scăzut) – scalează expresia genică normalizată pentru fiecare țintă, împărțind
nivelul expresiei fiecărei probe la cel mai scăzut nivel de expresie pentru toate probele.

Această opțiune de scalare folosește formula „scalat la cel mai scăzut nivel”.

n Average (Mediu) – scalează expresia genică normalizată pentru fiecare țintă, împărțind nivelul
expresiei fiecărei probe la media geometrică a nivelurilor de expresie pentru toate probele.

Această opțiune de scalare folosește formula „scalat la nivel mediu”.

Selectați o opțiune pentru calcularea tipului de eroare (barele de eroare) din graficul Gene
Expression (Expresie genică).
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Multiplicator bare de eroare din grafic

Selectați un multiplicator pentru barele de eroare din graficul Gene Expression (Expresie genică).
Selectați unul dintre aceste numere întregi:
+/- 1 (implicit), 2 sau 3. Tipul multiplicatorului se schimbă atunci când selectați bara de eroare:

n SEMs pentru eroarea standard a mediei

n Std Devs pentru deviațiile standard

Setări experimente
Sfat: Această casetă de dialog este disponibilă și în Plate Editor (Editor placă). Pentru mai multe
informații, consultați Schimbarea setărilor experimentelor de la pagina 145.

În caseta de dialog Experiment Settings (Setări experimente), puteți vizualiza sau modifica lista de
ținte, probe sau grupuri biologice, selecta genele de referință, selecta controalele sau seta grupul
Gene Expression Analysis (Analiză expresie genică) de analizat, dacă grupurile biologice au fost
adăugate la godeuri.

Pentru a deschide caseta de dialog Experiment Settings (Setări experimente)

u În fila Graphing (Reprezentare grafică), faceți clic pe Experiment Settings (Setări experimente) în
partea de jos a panoului din dreapta.

Apare caseta de dialog Experiment Settings (Setări experimente), care afișează fila Targets
(Ținte).

Pentru a ajusta setările pentru Targets (Ținte)

u În fila Targets (Ținte), urmați oricare dintre procedurile următoare:

n Pentru a selecta o țintă ca referință pentru analiza datelor expresiei genice, selectați
denumirea sa în coloana Reference (Referință).

n Pentru a schimba culoarea țintei, faceți clic pe celula corespunzătoare din coloana Color
(Culoare) și modificați culoarea în caseta de dialog Color (Culoare) care apare.

Schimbarea culorii apare în graficele Gene Expression (Expresie genică).

n Pentru a utiliza o valoare de eficiență determinată anterior, debifați caseta de selectare
aferentă țintei din coloana Auto Efficiency (Eficiență automată) și introduceți un număr pentru
procentul de eficiență al unei ținte.

Software-ul calculează eficiența relativă a unei ținte folosind Auto Efficiency (Eficiență
automată), dacă datele pentru o țintă includ o curbă standard.
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Pentru a ajusta setările pentru Sample (Probă) sau

u În fila Samples (Probe) și , urmați oricare dintre procedurile următoare:

n Pentru a selecta o probă drept control pentru analiza datelor expresiei genice, selectați
denumirea sa în coloana Control.

n Pentru a schimba culoarea probei, faceți clic pe celula corespunzătoare din coloana Color
(Culoare) și schimbați culoarea în caseta de dialog Color (Culoare) care apare.

Schimbarea culorii apare în graficele Gene Expression (Expresie genică).

n Pentru a afișa proba în graficele Gene Expression (Expresie genică), selectați-o în coloana
Show Chart (Afișare grafic).

n Pentru a elimina proba din graficele Gene Expression (Expresie genică), debifați-o în
coloana Show Chart (Afișare grafic).

Sfat: Datele probei rămân în tabelul Results (Rezultate).

Pentru a exclude un tip de probă din calculele analizei

u Bifați caseta de selectare aferentă din partea de jos a casetei de dialog Experiment Settings
(Setări experimente).

Notă: Aceasta exclude controalele și/sau standardele din analiza expresiei genice.

Opțiunile de meniu afișate prin clic dreapta
Faceți clic dreapta pe graficul expresiei genice pentru a selecta elementele afișate în Tabelul 31.

Element Funcție

Copy (Copiere) Copiază graficul pe clipboard.

Save Image As (Salvați
imaginea ca)

Salvează graficul ca fișier imagine. Configurați rezoluția și
dimensiunile imaginii, apoi selectați tipul fișierului (PNG, JPG, sau
BMP).

Page Setup (Configurare
pagină)

Selectează configurarea paginii pentru imprimare.

Print (Imprimare) Imprimă graficul.

Tabelul 31. Elementele de meniu afișate prin clic dreapta pentru expresia genică
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Element Funcție

Set Scale to Default (Setare
scară la implicit)

Show All (Afișare toate) afișează toate datele din graficul cu bare.
Scroll Bar (Bară de defilare) afișează o bară de defilare dacă există
prea multe probe de afișat în cadrul graficului, menținând o lățime
minimă a barei.

Deschide fereastra , pentru a ajusta graficul.

Sort (Sortare) Sortează ordinea probelor sau țintelor care apar pe axa x a graficului.

Use Corrected Std Devs
(Utilizare deviații standard
corectate)

Calculează barele de eroare utilizând formula deviației standard
corectate.

Use Solid Bar Colors (Utilizare
culori compacte bare)

Afișează barele compacte din grafic.

X–Axis Labels (Etichete axă x) Afișează etichetele axei x pe orizontală sau în unghi.

Tabelul 31. Elementele de meniu afișate prin clic dreapta pentru expresia genică, continuare

Foaia de calcul Data (Date)
Tabelul 32 definește datele afișate în tabelul de date Gene Expression (Expresie genică).

Notă: Valorile din tabel sunt calculate pe baza tipului de grafic și a preferințelor selectate în
panoul din dreapta.

Informație Descriere

Țintă Denumirea țintei (genă amplificată) selectată în fereastra Experiment
Settings (Setări experimente).

Probă Denumirea probei selectată în fereastra Experiment Settings (Setări
experimente).

Denumirea controlului selectat în fereastra Experiment Settings
(Setări experimente).

Relative Quantity (Cantitate
relativă) sau
Expression (Expresie)

Cantitate relativă (ΔCq) sau Expresie genică normalizată (ΔΔCq), în
funcție de modul selectat.

Tabelul 32. Descrierea informațiilor din foaia de calcul din fila
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Informație Descriere

SEM (sau SD) pentru cantitate
relativă sau expresie

Eroarea standard a mediei (SEM) sau deviația standard (SD) a
cantității relative sau a expresiei normalizate, în funcție de opțiunea
selectată.

SEM (sau SD) corectată pentru
cantitate relativă sau expresie

Calculul valorii corectate pentru SEM sau SD a cantității relative sau a
expresiei normalizate, în funcție de opțiunea selectată.

Medie Cq Media ciclului de cuantificare.

SEM (sau SD) Cq SEM sau SD a ciclului de cuantificare, în funcție de opțiunea
selectată.
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Opțiunea Show Details (Afișare detalii)
Tabelul 33 definește datele afișate când este selectată opțiunea Show Details (Afișare detalii) din
meniul clic dreapta al foii de calcul a graficului cu bare.

Informație Descriere

Set de date Date privind fluorescența de la un fluorofor din fișierul de date

Cantitate relativă Cantitatea relativă calculată a probelor

SD cantitate relativă Deviația standard a calculării cantității relative

SD cantitate relativă corectată Deviația standard calculată a cantității relative corectate

SEM cantitate relativă Eroarea standard a mediei calculării cantității relative

SEM cantitate relativă corectată Eroarea standard a mediei calculării cantității relative corectate

Cantitate relativă(lg) Log2 al cantității relative utilizate pentru analiza statistică

SD RQ(lg) Deviația standard a cantității relative (log2)

SEM expresie(lg) Eroarea standard a mediei expresiei (log2)

Expresie nescalată Expresia nescalată calculată

SD expresie nescalată Deviația standard calculată a expresiei nescalate

SD expresie nescalată corectată Deviația standard calculată a expresiei nescalate corectate

SEM expresie nescalată Eroarea standard a mediei calculată a expresiei nescalate

SEM expresie nescalată
corectată

Eroare standard a mediei calculată a expresiei nescalate corectate

Expresie nescalată(lg) Log2 al expresiei nescalate

SD expresie nescalată(lg) Deviația standard a expresiei nescalate (log2)

SEM expresie nescalată(lg) Eroarea standard a mediei expresiei nescalate (log2)

Expresie Expresie genică normalizată

SD expresie corectată Deviația standard calculată a expresiei corectate

Tabelul 33. Informațiile din foaia de calcul a graficului cu bare cu opțiunea Show Details (Afișare
detalii) selectată
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Informație Descriere

SEM expresie Eroarea standard a mediei expresiei

SEM expresie corectată Eroare standard a mediei calculată a expresiei corectate

Expresie(lg) Log2 al expresiei (expresia normalizată) utilizate pentru analiza
statistică

SD expresie(lg) Deviația standard a expresiei (log2)

SEM expresie(lg) Eroarea standard a mediei expresiei (log2)

Medie Cq Media ciclului de cuantificare

SD Cq Deviație standard a ciclului de cuantificare

SEM Cq Eroarea standard a mediei ciclului de cuantificare

Tabelul 33. Informațiile din foaia de calcul a graficului cu bare cu opțiunea Show Details (Afișare
detalii) selectată, continuare
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Clustergramă
Clustergrama afișează datele într-o ierarhie bazată pe gradul de similaritate a expresiei pentru
diferitele ținte și probe.

Notă: Trebuie să alegeți o țintă de referință pentru a afișa oricare dintre reprezentările grafice de
date, în afară de expresia relativă pentru graficele cu bare.

Imaginea clustergramei descrie expresia relativă a unei probe sau ținte, după cum urmează:

n Reglare pozitivă (roșu) – expresie mai mare

n Reglare negativă (verde sau albastru) – expresie mai mică

n Nicio reglare (negru)

n Nicio valoare calculată (negru cu un X alb)

Cu cât nuanța culorii este mai deschisă, cu atât mai mare este diferența expresiei relative. Dacă nu se
poate calcula nicio valoare Cq normalizată, pătratul va fi negru cu un X alb.

Pe marginile exterioare ale graficului de date se găsește o dendrogramă, care indică ierarhia de
clustering. Țintele sau probele care au tipare de expresie similare vor avea ramuri adiacente, iar cele
cu tipare nesimilare vor fi mai depărtate.

Setări
Puteți seta următoarele opțiuni:

n Cluster By (Grupare după) – alegeți dintre Targets (Ținte), Samples (Probe), Both (Ambele) sau
None (Niciuna).

n Size (Dimensiune) – ajustează dimensiunea imaginii și modifică gradul de mărire a graficului
pentru.

n Split Out Replicates (Împărțire replicate) – afișează valorile replicatelor individuale.

Sfat: Puteți schimba schema de culoare pentru de la setarea implicită Red/Green (Roșu/Verde) la
Red/Blue (Roșu/Albastru) selectând această opțiune din meniul clic dreapta dintre aceste grafice.

Opțiunile de meniu afișate prin clic dreapta
Opțiunile de meniu afișate prin clic dreapta pentru clustergramă sunt aceleași cu cele pentru graficul
cu bare. Consultați Tabelul 31 de la pagina 267 pentru opțiunile disponibile. De asemenea, selectați
Color Scheme (Schemă de culori) pentru a modifica expresia de reglare negativă de la setarea
implicită Red/Green (Roșu/Verde) la Red/Blue (Roșu/Albastru) pe grafic.
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Foaia de calcul Data (Date)
Foaia de calcul afișează valorile pentru țintă, probă și expresia normalizată.
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Corelogramă
Corelograma afișează expresia normalizată a țintelor pentru un control versus o probă experimentală. Liniile
din grafic indică pragul factorului de modificare. Punctele de date dintre linii indică faptul că diferența de
expresie pentru ținta (gena) respectivă este neglijabilă între probe. Punctele de date din afara liniilor
depășesc pragul de variație și ar putea fi de interes.

Imaginea din grafic afișează următoarele modificări în expresia țintă pe baza pragului factorului de
modificare

n Reglare pozitivă (cerc roșu) – expresie relativ mai mare

n Reglare negativă (cerc verde sau albastru) – expresie relativ mai mică

n Nicio schimbare (cerc negru)

Faceți clic pe și trageți oricare linie de prag pentru a ajusta valoarea de prag a factorului de
modificare.

Setări
Puteți seta următoarele opțiuni:

n Probă de control

n Probă experimentală

n Fold Change Threshold (Pragul factorului de modificare) Pe măsură ce măriți sau micșorați
valoarea factorului de modificare, liniile de prag din grafic se mută și ele în mod corespunzător.

Opțiunile de meniu afișate prin clic dreapta
Opțiunile de meniu afișate prin clic dreapta pentru corelogramă sunt aceleași cu cele pentru graficul
cu bare. Consultați Tabelul 31 de la pagina 267 pentru opțiunile disponibile. În plus, selectați Symbol
(Simbol) pentru a schimba simbolul utilizat pe grafic din cercul implicit în unul dintre următoarele:

n Triunghi

n Cruce

n Pătrat

n Romb
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Foaia de calcul Data (Date)
Foaia de calcul afișează valorile pentru țintă și expresia normalizată pentru proba de control și proba
experimentală. Indică, de asemenea, dacă țintele sunt reglate pozitiv sau negativ în comparație cu
reglarea țintă.
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Foaia de calcul Results (Rezultate)
Foaia de calcul Rezultate rezumă datele din toate diagramele. Tabelul 34 definește datele afișate în
foaia de calcul Results (Rezultate).

Informație Descriere

Target (Țintă) Denumirea țintei (genă amplificată)

Sample (Probă) Denumire probă

Medie Cq Media ciclului de cuantificare

Mean Efficiency Corrected Cq
(media Cq corectată eficient)

Media ciclului de cuantificare după ajustarea pentru eficiența reacțiilor

Expresie normalizată Expresia țintei normalizată în funcție de o țintă de referință (ΔΔCq)

Relative Normalized Expression
(Expresie normalizată relativă)

Expresie normalizată relativă la o probă de control; denumită și Fold
Change (Factor de modificare)

Regulation (Reglare) Modificare a expresiei relativă la o probă de control

Compared to Regulation
Threshold (Comparativ cu
pragul de reglare)

Reglare pozitivă sau negativă a unei probe experimentale bazată pe
setarea pragului

Tabelul 34. Informațiile din fila Rezultate

Notă: Datele pentru replicate se găsesc numai în foile de calcul ale filelor de analiză a datelor în
care s-a selectat Split Out Replicates (Replicate individuale) (respectiv Clustergram
(Clustergramă)). Poate exista o discrepanță între datele de expresie din foile de calcul de analiză
a expresiei genice dacă selectați „none” (niciuna) drept probă de control pe graficul cu bare.
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Studiu genic
Creați un studiu genic pentru a compara datele de expresie genică de la unul sau mai multe
experimente PCR în timp real folosind un element de calibrare între rulări pentru normalizare între
experimente. Creați un studiu genic adăugând date din unul sau mai multe fișiere de date (extensia
.pcrd) la studiul genic. Software-ul le grupează într-un fișier unic (extensie .mgxd).

Notă: Numărul maxim de probe pe care le puteți analiza într-un studiu genic este limitat de
mărimea memoriei RAM a computerului și de memoria virtuală.

Inter-run Calibration (Calibrare între rulări)
Inter-run calibration (Calibrare între rulări) este încercată automat în fiecare studiu genic pentru fiecare
țintă pentru a normaliza variațiile între rulări între țintele testate în rulări PCR în timp real separate (cu
alte cuvinte, fișiere .pcrd diferite generate din plăci diferite).

Pentru ca software-ul să recunoască o probă drept element de calibrare între rulări, aceasta trebuie
să aibă același nume de țintă, nume de probă și, dacă este utilizat, același nume de set biologic pe
fiecare placă comparată.

Notă: Cel puțin o probă element de calibrare între rulări trebuie să fie prezentă în studiul genic
pentru a avea loc calibrarea între rulări. Țintele fără probe element de calibrare între rulări
adecvate vor fi procesate fără corecție în studiul genic (nerecomandat).

Elementele de calibrare între rulări pot fi aplicate în două moduri:

n Per țintă – diferiți primeri PCR pot avea eficiențe diferite. În mod implicit, elementul de calibrare
între rulări este aplicat tuturor godeurilor unei plăci care au aceeași denumire a țintei de
amplificare, de exemplu Cq generată cu același test.

n Întregul studiu – un element de calibrare între rulări este selectat de utilizator și aplicat întregului
studiu genic.
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Caseta de dialog Gene Study (Studiu genic)

Caseta de dialog Gene Study (Studiu genic) include două file:

n Fila Study Setup (Configurare studiu) – gestionează rulările din studiul genic.

Important: Adăugarea sau eliminarea fișierelor de date într-un studiu genic nu modifică
datele din fișierul original.

n Fila Study Analysis (Analiză studiu) – afișează datele de expresie genică pentru rulările
combinate.

Fila Study Setup (Configurare studiu)
Tabelul 35 definește datele care apar în fila Study Setup (Configurare studiu).

Titlu coloană Descriere

File Name (Nume fișier) Denumirea fișierului de date pentru rulare (extensie .pcrd)

File Folder (Folder fișiere) Director care stochează fișierul de date pentru fiecare rulare din
studiul genic

Date Created (Data creării) Data la care au fost colectate datele rulării

Tabelul 35. Fila Study Setup (Configurare studiu) din caseta de dialog Gene Study (Studiu
genic)
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Titlu coloană Descriere

Well Group Name (Nume
grup godeuri)

Numele grupului de godeuri care a fost selectat atunci când fișierul a
fost adăugat la studiul genic

Sfat: Pentru a analiza un grup de godeuri din studiul genic,
trebuie să selectați acel grup de godeuri din fereastra Data
Analysis (Analiză date) înainte de a importa fișierul de date în
studiul genic.

Step (Pas) Pas de protocol care include citirea de placă pentru colectarea datelor
PCR în timp real

Run Type (Tip rulare) Rulare definită de utilizator sau rulare PrimePCR

Protocol Edited (Protocol
editat)

Dacă este selectat, indică faptul că protocolul utilizat pentru o rulare
PrimePCR a fost editat

View Plate (Vizualizare
placă)

Deschide o hartă de placă a plăcii cu datele din fiecare rulare inclusă
în studiul genic

Tabelul 35. Fila Study Setup (Configurare studiu) din caseta de dialog Gene Study (Studiu
genic), continuare

Pregătirea unui studiu genic
Pentru a pregăti un studiu genic

1. Înainte de a importa datele într-un studiu genic, efectuați următoarele în fereastra Data Analysis
(Analiză date:

n Verificați că probele cu același conținut au același nume. Într-un studiu genic, software-ul
presupune că godeurile cu același nume pentru Target (Țintă) sau Sample (Probă) conțin
aceleași probe.

n Ajustați nivelul inițial și pragul (Cq) în fila Quantification (Cuantificare) pentru a optimiza
datele din fiecare rulare.

n Selectați grupul de godeuri pe care doriți să îl includeți în studiul genic.

Pentru a afișa date de la un grup de godeuri în studiul genic, grupul respectiv trebuie să fie
selectat înainte de a importa fișierul de date.

Fila Study Setup (Configurare studiu) afișează o listă a tuturor rulărilor din studiul genic.

2. În caseta de dialog Gene Study (Studiu genic) selectați fila Study Setup (Configurare studiu).

3. Faceți clic pe Add Data Files (Adăugare fișiere de date) pentru a selecta un fișier din fereastra
browser-ului.
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Sfat: Pentru a adăuga rapid rulări la un studiu genic, trageți fișierele de date (extensia .pcrd)
în caseta de dialog Study Setup (Configurare studiu).

4. CFX Maestro Dx SE efectuează automat analiza studiului genic pe măsură ce adăugați fișiere de
date. Selectați fila Study Analysis (Analiză studiu) pentru a vizualiza rezultatele.

Pentru a elimina rulări din studiul genic

u Selectați unul sau mai multe fișiere din listă și faceți clic pe Remove (Eliminare).

Pentru a adăuga observații despre studiul genic

u Introduceți observații despre fișiere și analiză în caseta de dialog Notes (Observații).

Fila Study Analysis (Analiză studiu)
Fila Study Analysis (Analiză studiu) afișează datele de la toate rulările din studiul genic. Opțiunile de
analiză pentru datele de expresie genică sunt aceleași cu cele pentru un fișier de date unic, cu
următoarele excepții:

n Pentru graficele cu bare, valorile de calibrare între rulări (dacă sunt calculate) apar atunci când
faceți clic pe Inter-run Calibration (Calibrare între rulări).

Notă: Numai următoarele tipuri de probe pot fi utilizate drept element de calibrare între rulări:

o Unknown (Necunoscută)

o Eroare

o Positive Control (Control pozitiv)

Tipurile de probe Negative Control (Control negativ), no template control (control fără ținta de
amplificare) (NTC) și no reverse transcriptase control (control fără transcriptază inversă) (NRT) nu
pot fi utilizate drept element de calibrare între rulări.

n Instrumentul Reference Gene Selection (Selectare a genei de referință) identifică genele de
referință testate și le clasifică drept Ideal (Ideală), Acceptable (Acceptabilă) sau Unstable
(Instabilă), pe baza stabilității acestora:

o Genele de referință ideale sunt stabile și reprezintă variații minime între probele testate.

o Genele de referință acceptabile nu sunt stabile în mod ideal și reprezintă o variație moderată
între probele testate. Utilizați aceste gene de referință în analiză dacă nu sunt prezente gene
de referință ideale.

o Genele de referință instabile reprezintă o variație excesivă între probele testate. Se
recomandă ca aceste gene să fie excluse din analize.
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n Instrumentul PrimePCR Analysis Control (Controlul analizei PrimePCR) afișează rezultatele
probelor testate într-un tabel:

o Fila Summary (Rezumat) afișează un rezumat al tuturor probelor testate. Probele care au
trecut toate testele de control apar în culoarea verde. Probele care nu au trecut unul sau mai
multe dintre testele de control apar în culoarea galbenă.

o Fila PCR afișează rezultatele testului pozitiv de control PCR. Acest test detectează inhibarea
sau probleme experimentale care afectează expresia genică.

o Fila RT afișează rezultatele testului de control cu transcriere inversă. Acest test evaluează
calitativ performanța RT și identifică probele la care performanța RT este probabil să
compromită expresia genică.

o Fila gDNA (ADNg) afișează rezultatele testului de control pentru contaminare ADN. Acest test
determină dacă ADN-ul genomic (gDNA) este prezent într-o probă la un nivel care ar putea
afecta rezultatele qPCR.

o Fila RQ afișează rezultatele testelor de calitate pentru ARN (RQ1 și RQ2). Aceste teste
evaluează calitativ dacă integritatea ARN ar putea afecta în mod negativ expresia genică.

Categoriile raportului de studiu genic
Folosiți caseta de dialog Gene Study Report (Raport studiu genic) pentru a aranja datele studiului
genic într-un raport. Tabelul 36 listează toate opțiuni disponibile pentru un raport de studiu genic.

Categorie Opțiune Descriere

Header (Antet)

Titlu, subtitlu și logo pentru raport

Report Information
(Informații raport)

Data, numele utilizatorului, denumirea fișierului
de date, calea fișierului de date și grupul de
godeuri selectat

Gene Study File List (Lista
fișierelor studiului genic)

Lista tuturor fișierelor de date din studiul genic

Notes (Observații) Observații despre raportul de date

Study Analysis (Analiză studiu): Grafic cu bare

Analysis Settings (Setări
analiză)

Lista parametrilor de analiză selectați

Tabelul 36. Categoriile unui raport de studiu genic
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Categorie Opțiune Descriere

Chart (Grafic) Graficul cu bare al expresiei genice care
afișează datele

Target Names (Denumiri
ținte)

Lista țintelor din studiul genic

Sample Names (Denumiri
probe)

Lista probelor din studiul genic

Data (Date) Foaie de calcul care afișează datele

Target Stability
(Stabilitatea țintei)

Date privind stabilitatea țintei

Inter-run Calibration
(Calibrare între rulări)

Date de calibrare între rulări

Diagramă boxplot Diagrama boxplot a expresiei genice

Dot-Plot Chart (Grafic de
puncte)

Graficul de puncte al expresiei genice

Study Analysis (Analiză studiu): clustergramă și corelogramă

Analysis Settings (Setări
analiză)

Setări pentru fiecare tip de grafic

Chart (Grafic) Graficul expresiei genice care afișează datele

Data (Date) Foaie de calcul care listează datele din fiecare
țintă

Study Analysis (Analiză studiu): Date
ANOVA

ANOVA Settings (Setări
ANOVA)

Pragul valorii P utilizat în analiză

ANOVA Results (Rezultate
ANOVA)

Tabelul cu rezultatele analizelor ANOVA și HSD
Tukey post-hoc

Tabelul 36. Categoriile unui raport de studiu genic, continuare
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Categorie Opțiune Descriere

Shapiro-Wilk Normality
Test (Test de normalitate
Shapiro-Wilk)

Grup biologic, număr, valoarea P și orice erori
care survin pentru fiecare țintă din analiză

ANOVA Errors (Erori
ANOVA)

Erori identificate în timpul calculelor ANOVA

Tabelul 36. Categoriile unui raport de studiu genic, continuare
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Crearea unui raport de studiu genic
Pentru a crea un raport de studiu genic

1. Ajustați datele raportului de studiu genic și graficele după caz înainte de a crea un raport.

2. Selectați Tools > Reports (Instrumente > Rapoarte) din meniul Gene Study (Studiu genic) pentru
a deschide caseta de dialog Report (Raport).

3. Alegeți opțiunile pe care doriți să le includeți în raport. Raportul se deschide cu opțiunile implicite
selectate. Bifați sau debifați casetele de selectare pentru a schimba categorii întregi sau opțiuni
individuale dintr-o categorie.

Categoriile raportului de studiu genic de la pagina 281 listează opțiunile disponibile de afișat.

4. Schimbați ordinea categoriilor și elementelor dintr-un raport. Trageți opțiunile în poziția necesară.
Elementele pot fi reordonate doar în cadrul categoriilor cărora le aparțin.

5. Faceți clic pe Update Report (Actualizare raport) pentru a actualiza Report Preview
(Previzualizare raport) cu orice modificări efectuate.

6. Imprimați sau salvați raportul. Faceți clic pe butonul Print Report (Imprimare raport) de pe bara de
instrumente pentru a imprima raportul curent. Selectați File > Save (Fișier > Salvare) pentru a
salva raportul în format PDF (fișier Adobe Acrobat Reader), și selectați o locație în care să salvați
fișierul. Selectați File > Save As (Fișier > Salvare ca) pentru a salva raportul cu o nouă denumire
sau într-un nou loc.

7. (Opțional) Creați o matriță de raport cu informațiile pe care le doriți. Pentru a salva setările
raportului curent într-o matriță, selectați Template > Save (Matriță > Salvare) sau Save As
(Salvare ca). Apoi încărcați matrița raportului data viitoare când doriți să creați un raport nou.
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Software-ul CFX Maestro Dx SE software calculează automat formulele și afișează rezultatele în filele
Data Analysis (Analiză date). Această anexă explică în detaliu cum calculează CFX Maestro Dx SE
formulele.

Eficiența reacțiilor
Dovezile sugerează că utilizarea unei modalități exacte de măsură a eficiențelor pentru fiecare primer
și set de sonde va determina rezultate mai exacte la analiza datelor de expresie genică. Valoarea
implicită a eficienței utilizată în calculele de expresie genică este 100 %. Pentru a evalua eficiența
reacțiilor, generați o curbă standard utilizând diluții în serie ale unei probe reprezentative la nivelul
unui interval dinamic relevant și apoi înregistrați eficiența pentru analiza ulterioară a expresiei genice.
Dacă rularea dumneavoastră include o curbă standard, atunci software-ul va calcula automat
eficiența și o va afișa sub Standard Curve (Curbă standard) în fila Quantification (Cuantificare), când
Auto Efficiency (Eficiență automată) este bifată în fila Targets (Ținte) din fereastra Experiment Settings
(Setări experimente).

Eficiența (E) din formulele de eficiență se referă la „eficiențele” descrise de Pfaffl (2001) și
Vandesompele et al. (2002). În aceste publicații, o eficiență de 2 (dublarea perfectă cu fiecare ciclu)
este echivalentă cu o eficiență de 100 % în acest software. Aveți posibilitatea să convertiți calculele
dumneavoastră de eficiență în cele utilizate de software, utilizând următoarele relații matematice:

n E = (% eficiență * 0,01) + 1

n % eficiență = (E – 1) * 100

Cantitate relativă
Formula pentru cantitatea relativă (ΔCq) pentru orice probă (GOI) este:

Notă: Această formulă este utilizată la calcularea cantității relative atunci când nu s-a definit o
probă de control sau un grup biologic.

Unde:
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n E = Eficiența primerului și a setului de sonde. Această eficiență se calculează cu formula
(% Eficiență * 0,01) + 1, unde 100% eficiență = 2

n C q (min) = Cq medie pentru proba cu cea mai mic[ medie Cq pentru GOI

n C q (probă) = Cq medie pentru probă

n GOI = Genă de interes (o țintă)

Cantitatea relativă când este selectat un control
Atunci când se atribuie o probă de control sau un grup biologic, cantitatea relativă (RQ) pentru orice
probă care include o genă de interes (GOI) este calculată după următoarea formulă:

Unde:

n E = Eficiența primerului și a setului de sonde. Această eficiență se calculează cu formula
(% Eficiență * 0,01) + 1, unde 100% eficiență = 2

n Cq (control) = Cq medie pentru proba de control sau Cq medie pentru grupul biologic

n Cq (probă) = Cqmedie pentru orice probe cu GOI

n GOI = Genă de interes (o țintă)

Deviația standard a cantității relative
Important: Acest calcul se aplică doar dacă parametrul Analyze Using (Analiză cu) este
configurat cu valoarea Samples Only (Numai probe), Sample Biological Group (Probă Grup
biologic) sau Biological Group Sample (Grup biologic Probă).

Formula pentru deviația standard a cantității relative este

Unde:

n SD Relative Quantity = Deviația standard a cantității relative

n SD CqGOI sample = Deviația standard a Cq pentru probă (GOI)

n Relative Quantity = Cantitatea relativă a probei

n E = Eficiența primerului și a setului de sonde. Această eficiență se calculează cu formula
(% Eficiență * 0,01) + 1, unde 100% eficiență = 2
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Cq corectată eficient (CqE)

n GOI = Genă de interes (o țintă)

Cq corectată eficient (CqE)
Formula pentru Cq corectată eficient este

Unde:

n E = Eficiență

Cq media corectată eficient (MCqE)
Formula pentru Cq media corectată eficient este

Unde:

n CqE = Cq corectată eficient

n n = Numărul de replicate

Ghid de utilizare | 287



Anexa ACalcule Analiză date

Expresie normalizată
Expresia normalizată (ΔΔCq) este cantitatea relativă a țintei (genei) normalizată la cantitățile țintelor
de referință (gene sau secvențe) din sistemul dumneavoastră biologic. Pentru a selecta țintele de
referință, deschideți fereastra Experiment Settings (Setări experimente) și faceți clic pe coloana de
referință pentru fiecare țintă care servește drept genă de referință.

Formula pentru expresia normalizată, care folosește metoda de calcul a Cantității relative (RQ)
calculate, este

Unde:

n RQ = Cantitatea relativă a unei probe

n Ref = Ținta de referință dintr-o rulare, care include una sau mai multe ținte de referință în fiecare
probă

n GOI = Genă de interes (o țintă)

Cu condiția ca țintele de referință să nu își modifice nivelul de expresie din sistemul dvs. biologic,
calcularea expresiei normalizate va lua în considerare diferențele de încărcare sau variațiile
numărului de celule care sunt reprezentate în fiecare dintre probele dvs.
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Expresia normalizată când este selectat un control

Expresia și cantitatea relativă pentru grupurile biologice
Dacă parametrul Analyze Using (Analiză cu) este configurat cu valoarea Biological Groups Only
(Numai grupuri biologice), software-ul afișează expresia medie (expresia normalizată sau cantitatea
relativă, în funcție de modul selectat) a probelor din grupul biologic. Având în vedere că expresia este
de obicei distribuită printr-o distribuție normală logaritmică, media expresiei este obținută folosind
media geometrică:

Unde:

n Exp1, Exp2, Expn = cantitatea relativă sau expresia normalizată a probelor din grupul biologic

n n = Numărul de probe din grupul biologic

Expresia normalizată când este selectat un control
Când selectați o probă de control din fereastra Experiment Settings (Setări experimente), software-ul
setează nivelul de expresie al probei de control la 1. În această situație, software-ul normalizează
cantitățile relative ale tuturor expresiilor țintelor (genelor) la cantitatea de control (o valoare de 1).
Această expresie normalizată este echivalentă cu analiza expresiei normalizate nescalate atunci
când este selectat un control.

Notă: Aceasta este cunoscută și sub denumirea de expresie normalizată relativă (RNE) și factor
de modificare.
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Deviația standard pentru expresia normalizată
Rescalarea valorii expresiei normalizate este realizată împărțind deviația standard a expresiei
normalizate la valoarea expresiei normalizate pentru cele mai ridicate sau cele mai scăzute niveluri
individuale de expresie, în funcție de opțiunea de scalare aleasă. Formula pentru deviația standard
(SD) a factorului de normalizare este

Unde:

n RQ = Cantitatea relativă a unei probe

n SD = Deviația standard

n NF = Factor de normalizare

n Ref = Țintă de referință

n n = Numărul de ținte de referință

Când se atribuie o probă de control, nu este nevoie să aplicați această funcție de rescalare pentru
deviația standard, după cum se arată în formula de mai jos:

Unde:

n NE = Expresia normalizată

n RQ = Cantitatea relativă a unei probe

n SD = Deviația standard

n GOI = Genă de interes (o țintă)
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Expresia normalizată scalată la celmai ridicat nivel de expresie

Expresia normalizată scalată la cel mai ridicat nivel de
expresie

Când rularea nu include controale, scalați expresia normalizată (NE) pentru fiecare țintă (genă)
împărțind nivelul expresiei fiecărei probe la cel mai ridicat nivel de expresie pentru toate probele.
Software-ul stabilește cel mai ridicat nivel de expresie la o valoare de 1 și rescalează toate niveluri de
expresie ale probelor. Formula celei mai ridicate scalări este

Unde:

n GOI = Gena de interes (țintă)

Expresia normalizată scalată la cel mai redus nivel de
expresie

Când rularea nu include controale, scalați expresia normalizată (NE) pentru fiecare țintă (genă)
împărțind nivelul expresiei fiecărei probe la cel mai redus nivel de expresie pentru toate probele.
Software-ul stabilește cel mai redus nivel de expresie la o valoare de 1 și rescalează toate nivelurile
de expresie ale probelor. Formula celei mai reduse scalări este

Unde:

n GOI = Gena de interes (țintă)

Expresia normalizată scalată la nivelul expresiei medie
Când rularea nu include controale, scalați expresia normalizată (NE) pentru fiecare țintă (genă),
împărțind nivelul expresiei fiecărei probe la media geometrică a expresiei pentru toate probele.
Software-ul stabilește nivelul mediu de expresie la o valoare de 1 și rescalează toate nivelurile de
expresie ale probelor. Formula scalării medii este

Unde:

n GOI = Gena de interes (țintă)
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n GM = Media geometrică a expresiei normalizate pentru toate probele
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Deviația standard pentru expresia normalizată scalată

Deviația standard pentru expresia normalizată scalată
Rescalarea valorii expresiei normalizate (NE) este realizată împărțind deviația standard (SD) a
expresiei normalizate la valoarea expresiei normalizate pentru cele mai ridicate (MAX) sau cele mai
scăzute (MIN) niveluri de expresie, în funcție de opțiunea de scalare aleasă.

Notă: Când se atribuie o probă de control, nu este nevoie să aplicați această funcție de rescalare
pentru deviația standard.

Calculul pentru această formulă este

Unde:

n NE = Expresia normalizată

n SD = Deviația standard

n GOI = Gena de interes (țintă)

n MAX = Cel mai ridicat nivel de expresie

n MIN = Cel mai scăzut nivel de expresie
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Bare de eroare pentru deviația standard (lg) și eroarea
standard a mediei (lg)

Pe lângă utilizarea intervalelor de încredere, barele de eroare pot fi afișate pentru grupuri biologice în
funcție de deviația standard sau de eroarea standard a mediei log2 a expresiei. Barele de eroare sunt
calculate după cum urmează:

RQ bară de eroare inferioară = 2RQ(lg)-SD RQ(lg) sau 2RQ(lg)-SEM RQ(lg)

RQ bară de eroare superioară = 2RQ(lg)+SD RQ(lg) sau 2RQ(lg)+SEM RQ(lg)

Unde:

n RQ(lg) = log2 al cantității relative pentru grupul biologic

n SD RQ(lg) = deviația standard a cantității relative (log2)

n SEM RQ(lg) = eroarea standard a mediei cantității relative (log2)

Exp. bară de eroare inferioară = 2Exp.(lg)-SD Exp.(lg) sau 2Exp.(lg)-SEM Exp.(lg)

Exp. bară de eroare superioară = 2Exp.(lg)+SD Exp.(lg) sau 2Exp.(lg)+SEM Exp.(lg)

Unde:

n Exp.(lg) = log2 al expresiei (expresiei normalizate) pentru grupul biologic

n SD RQ(lg) = deviația standard a expresiei (log2)

n SEM RQ(lg) = eroarea standard a mediei expresiei (log2)

294 | Software-ulCFXMaestro DxSE



Fold Change (Factorul demodificare)

Fold Change (Factorul de modificare)
Factorul de modificare este o modalitate de a măsura creșterea sau micșorarea expresiei unei ținte
pentru o probă experimentală față de o probă de control sau un grup biologic și se determină astfel:

Dacă Expresie (experimentală) > Expresie (control):

Dacă Expresie (experimentală) < Expresie (control):

Notă: Pentru Graphing (reprezentarea grafică), Expression (Expresia) se bazează fie pe
cantitatea relativă fie pe expresia normalizată, în funcție de modul selectat (consultați
Reprezentare grafică de la pagina 256). Cu toate acestea, pentru corelogramă și clustergramă
factorul de modificare este calculat întotdeauna pe baza expresiei normalizate.
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Formule valori corectate
Important: Aceste calcule se aplică doar dacă parametrul Analyze Using (Analiză cu) este
configurat cu valoarea Samples Only (Numai probe), Sample Biological Group (Probă Grup
biologic) sau Biological Group Sample (Grup biologic Probă).

O diferență între valorile corectate și valorile necorectate este observată doar dacă este creată o
curbă standard ca parte a rulării PCR în timp real. Software-ul folosește trei ecuații pentru a determina
propagarea erorilor:

n Eroare standard

n Eroare standard pentru expresie normalizată

n Eroare standard pentru gena de interes normalizată (țintă)

Formula pentru eroarea standard este

Unde:

n n = Numărul de ținte de referință (gene)

n SD = Deviația standard

Eroarea standard pentru factorul de normalizare din formula expresiei normalizate este

Unde:

n n = Numărul de ținte de referință

n SE = Eroare standard

n NF = Factor de normalizare

n RQ = Cantitate relativă

Formula erorii standard pentru gena de interes (GOI) normalizată este

Unde:

n SE = Eroare standard
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Calcularea intervalului de încredere pentru analiza grupului biologic

n GOI = Genă de interes (o țintă)

n NF = Factor de normalizare

n n = Numărul de ținte de referință

Calcularea intervalului de încredere pentru analiza grupului
biologic

Când realizați analize ale grupurilor biologice – parametrul Analyze Using (Analiză cu) este
configurat cu valoarea Biological Groups Only (Numai grupuri biologice) – intervalele de încredere
sunt calculate pentru cantitatea relativă și expresia normalizată relativă.

Intervalele de încredere sunt calculate pe scară logaritmică în funcție de distribuția t, utilizând
următoarea formulă:

Unde:

n = expresia medie a nivelurilor de expresie pe scara logaritmică a probelor din grupul biologic

n SD = deviația standard a nivelurilor de expresie pe scara logaritmică a probelor din grupul
biologic

n n = numărul de probe din grupul biologic

n t = obținut din distribuția t pe baza gradelor de libertate și nivelului alfa

Notă: Nivelul alfa poate fi setat folosind câmpul de prag pentru valoarea P din fila Graphing
(Reprezentare grafică).

După ce s-au calculat intervalele de încredere, acestea sunt convertite în scara liniară și prezentate în
tabelul cu datele expresiei genice și graficul cu bare din fila Graphing (Reprezentare grafică).

Calculele aferente diagramei boxplot
Diagrama boxplot afișează distribuția valorilor expresiei dintr-un grup biologic, reprezentând datele
sub formă de cuartile. Prima și a 3-a cuartilă sunt reprezentate de limita inferioară și, respectiv,
superioară, a casetei. Mediana este afișată ca o linie continuă de-a lungul casetei. Liniile reprezintă
valorile non-aberante minime și maxime din setul de date. Valorile aberante sunt cele care depășesc
prima și a 3-a cuartilă cu o valoare egală cu 1,5 ori intervalul inter-cuartile.
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Notă: Dacă grupul biologic conține o singură probă, aceasta este afișată ca un cerc individual,
indicând un singur punct de date.

Următoarea diagramă boxplot demonstrează modul de reprezentare al acestor date.

1. Extremă. Valoarea acestei extreme este > Q3 + (1,5 x [Q3 - Q1]).

Notă: Plasați cursorul peste cerc pentru a vizualiza un sfat care afișează denumirea probei și
cantitatea relativă sau informații despre expresia normalizată, în funcție de modul selectat.

2. Demarcare valori non-aberante maxime

3. Cuartila superioară/a 3-a (Q3). 75% din valorile expresiei sunt mai mici decât Q3.

4. Mediana, sau valoarea cea mai de mijloc, a valorilor expresiei ordonate după rang

5. Cuartila inferioară/primă (Q1). 25% din valorile expresiei sunt mai mici decât Q1.

6. Demarcare valori non-aberante minime

7. Extremă. Valoarea acestei extreme este < Q1 - (1,5 x [Q3 - Q1]).

LEGENDĂ
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Anexa B Trasee de audit
Software-ul CFX Maestro Dx SE creează trasee de audit pentru fișiere de date și studii genetice
(fișierele .prcd și respectiv .mgxd). Orice modificări sau acțiuni efectuate asupra datelor securizate și a
fișierelor de studiu genetic sunt memorate în traseul de audit al fișierului atunci când fișierul este
salvat.CFX Maestro Dx SE creează un traseu separat de audit pentru fiecare fișier.

Puteți alege File (Fișier)> Save (Salvare ca) și să salvați date sigure semnate sau nesemnate și fișiere
de studiu genetic într-un alt folder sau cu alt nume. Noul fișier moștenește traseul de audit al fișierului
original. Traseul de audit pentru noul fișier include, de asemenea, activitatea Save As (Salvare ca).
Modificările sau acțiunile efectuate asupra noului fișier sunt memorate în propriul său traseu de audit.
Fișierul original își păstrează traseul de audit, în care este memorată activitatea suplimentară.

Evenimente verificabile de la pagina 301 listează evenimentele verificabile pe care software-ul le
memorează.

Vizualizarea traseelor de audit
Vizualizarea traseelor de audit

Fiecare traseu de audit afișează următoarele informații:

n Audit header detail (Detalii antet audit)

o File version (Versiune fișier) - versiunea salvată a fișierului

o Date (Data) - data evenimentului verificabil curent

o User (Utilizator) - domeniul Windows și numele de utilizator al utilizatorului conectat

o Comment (Comentariu) - ultimul comentariu salvat

o Signature (Semnătură) - semnătura electronică a ultimei persoane care a semnat dosarul

o Signature reason (Motivul semnăturii) - motivul semnăturii

o Application (Aplicație) - CFX Maestro Dx SE

o Application version (Versiunea aplicației) - versiunea curentă a CFX Maestro Dx SE

o Full user (Utilizator complet) - numele complet al utilizatorului conectat

o Machine (Mașină) - computerul pe care este instalat CFX Maestro Dx SE
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n Audit change detail (Detaliile modificării auditului)

o Object (Obiect) - elementul care a fost schimbat (elementul auditat)

o Old value (Valoare veche) - valoarea anterioară

o New value (Valoare nouă) - noua valoare

o Description (Descriere) - descrierea modificării

Pentru a vizualiza traseul de audit

u În fișierul de date sau studiu genic deschis, selectați View (Vizualizare)> Audit Trail (traseul
auditului). Este afișat traseul auditului fișierului.

În mod implicit, datele sunt sortate după dată și oră și toate evenimentele apar în vizualizarea
extinsă. Puteți filtra vizualizarea după numele de utilizator și obiect și puteți restrânge
vizualizarea extinsă pentru a sorta cu ușurință după orice câmp de antet. De asemenea, puteți
vizualiza traseul de audit ca un raport html.

Pentru a sorta după numele de utilizator

u Selectați utilizatorul dorit din lista verticală User Name (Nume utilizator).

Pentru a sorta după obiect

u Selectați ținta din lista verticală Object (Obiect).

Pentru a ascunde descrierea completă a evenimentelor

u Faceți clic pe Collapse All (Restrângeți totul).
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Evenimente verificabile

Pentru a sorta datele în tabelul cu detalii de modificare

u Faceți clic pe simbolul diamantului din antetul coloanei de date pentru a efectua o sortare
crescătoare (de la A la Z, de la cel mai mic la cel mai mare sau de la cel mai vechi la cel mai
recent).

Pentru a imprima traseul de audit

1. Faceți clic pe HTML Report (Raport HTML) pentru a afișa traseul de audit într-un browser web.

2. În fereastra browserului, efectuați una dintre următoarele acțiuni:

n Selectați File (Fișier)> Print (Imprimare).

n Faceți clic dreapta pe raport și selectați Print (Imprimare).

Evenimente verificabile
CFX Maestro Dx SE reține următoarele evenimente verificabile în fișiere de date și de studii a genelor.

Evenimente verificabile în timpul funcționării

n Ora de pornire

n Modificări ale plăcilor procesate

n Modificări ale protocolului de procesare

n Ora de finalizare

Evenimente verificabile la crearea unui fișier de date

n Fișier de date creat

n Citiri interpolate de plăci adăugate de sistem

Evenimente verificabile la salvarea unui fișier de date

n General

o Nume

o Signing (Semnare)

o Plate Setup (Configurație placă)

o Display Wells (Afișare godeuri)

o Analyzed fluorophores (Fluorofori analizați)

o Plate edits (Modificări ale plăcii)
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o Analysis mode (Mod Analiză)

o PCR Active Well Group (Grup de godeuri active PCR)

n Fila Quantification (Cuantificare)

o Active step (Pas activ)

o Settings (Setări) - C q Determination mode (Mod determinare)

o Settings — Baseline Setting Setări — Setarea nivelului de referință)

o Drift correction applied (Corecția derivației aplicată)

o Settings — Cycles to Analyze (Setări — Cicluri de analizat)

o Settings — Analysis Mode (Setări — Mod Analiză)

o Settings — Baseline Threshold (Setări — Pragul nivelului de referință)

n Fila Melt Curve (Curbă de topire)

o Active step (Pas activ)

o Peak type displayed (Tipul de vârf afișat)

o Peak analysis threshold (Pragul de analiză de vârf)

n Fila End Point (Momentul final)

o Active fluorophore/target (Fluorofor activ/țintă)

o End cycles to average (Cicluri finalizate până la medie)

o Tolerance calculation method (Metoda de calcul a toleranței)

o Percentage of range (Procentul intervalului)

n Fila Allelic Discrimination (Discriminare alelică)

o X- and Y-axis fluorophore (Fluorofor pe axa X și Y)

o Select cycle number (Selectați numărul ciclului)

o View call map (Vizualizați harta apelurilor)

n Fila Gene Expression (Expresie genică) - All plots (Toate punctele)

o Experiment Settings (Setări experiment) - Target reference (Referință țintă)

o Experiment Settings (Setări experiment) - Sample control (Controlul probei)

o Experiment Settings (Setări experiment) - Auto efficiency (Eficiență automată)
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o Experiment Settings (Setări experiment) - Efficiency (Eficiență)

n Fila Gene Expression (Expresie genică) - Graphing (Prezentare grafică)

o Analysis mode (Mod Analiză)

o Graph data (Datele graficului)

o X-axis (Axa X)

o Y-axis (Axa Y)

o Scaling option (Opțiune de scalare)

o Error bar (Bară de erori)

o Error bar multiplier (Multiplicator bară de erori)

o P-value threshold (Prag valoare P)

n Fila Expresie genică - Clustergram (Grafic grupat)

o Cluster By (Grupare după)

o Split out replicates (Împărțire replicate)

n Fila Gene Expression (Expresie genică) - Scatter Plot (Corelogramă)

o Control biological group (Grup biologic de control)

o Experimental biological group (Grup biologic experimental)

o Fold change threshold (Pragul factorului de modificare)

n Fila Gene Expression (Expresie genică) - ANOVA

o P-value threshold (Prag valoare P)

n Plate Setup (Configurație placă) - View/Edit Plate (Vizualizare/Editare placă)

o Settings (Setări) - PlateType (Tip placă)

o Settings (Setări) - Units (Unități)

o Editing Tools (Instrumente de editare) - Flip Plate (Placă de răsturnare)

o Well groups (Grupuri de godeuri)

o Plate fluorophores (Fluorofori din plăci)

n Plate Setup (Configurația plăcii) - Replace Plate and Apply PrimePCR File (Înlocuiți placa și
aplicați fișierul PrimePCR)

o Plate Setup Import (Importarea configurației plăcilor)
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Audit Changes for Gene Study Files (Modificări de audit pentru fișierele de
studiu genic)

General

n Nume

n Fila Study Setup (Configurare studiu)

o Add/Remove data files (Adăugați/eliminați fișiere de date)

n Fila Study Analysis (Analiză studiu)
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Anexa C Integrare LIMS
Puteți configura Software-ul CFX Maestro Dx SE pentru utilizarea cu un sistem de management al
informațiilor din laborator (LIMS). Pentru integrarea LIMS, CFX Maestro Dx SE necesită informații
pentru configurația plăcii generate de platforma LIMS (un fișier LIMS, *.plrn), un fișier de protocol creat
folosind CFX Maestro Dx SE (*.prcl), o locație definită pentru exportarea datelor și un format de
exportare definit.

După finalizarea rulării, CFX Maestro Dx SE generează un fișier de date (.pcrd) și îl salvează într-o
locație de folder de export de date definită. CFX Maestro Dx SE poate crea, de asemenea, un fișier de
date compatibil LIMS în format .csv și îl poate salva în aceeași locație.

Crearea de fișiere de date compatibile cu LIMS
Această anexă explică modul în care puteți configura CFX Maestro Dx SE pentru a crea, salva și
exporta fișiere de date compatibile cu LIMS.

Configurarea folderului LIMS și a opțiunilor de exportare a
datelor
Implicit, CFX Maestro Dx SE salvează protocoalele LIMS, fișierele LIMS și fișierele de exportare a
datelor în acest folder:
C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

Puteți configura CFX Maestro Dx SE să salveze fișiere într-un alt folder și puteți schimba opțiunile de
exportare pentru date LIMS.

Pentru a configura un folder LIMS și opțiunile de exportare a datelor

1. Din fereastra Home (Pagină de pornire), selectați Tools > Options (Instrumente > Opțiuni).

2. În caseta de dialog Options (Opțiuni), selectați Data Export Settings (Setări exportare date).
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3. (Opțional) Selectați Automatically Export LIMS data at end of run (Exportare automată date LIMS
la sfârșitul rulării).

Software-ul va exporta automat date LIMS după fiecare rulare și le va salva în locația specificată.

4. Pentru a schimba opțiunile de exportare implicite pentru date LIMS, faceți clic pe LIMS Data
Export Settings (Setări exportare date LIMS).

Important: Numai datele LIMS exportate ca fișier .csv pot fi importate înapoi în CFX Maestro
Dx SE.

5. În caseta de dialog LIMS Data Export Format Settings (Setări format exportare date LIMS),
selectați opțiunile de exportare necesare și faceți clic pe OK.

6. În caseta de dialog Options (Opțiuni), navigați la și selectați un folder implicit în care doriți să
salvați fișierele de date LIMS. Puteți selecta un loc diferit pentru fiecare tip de fișier:

n Protocol

n Fișier LIMS

n Data export (Exportare date)

7. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog Options (Opțiuni).
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Crearea de fișiere de date compatibile cu LIMS

Crearea unui protocol LIMS
Pentru a iniția o rulare LIMS, creați un fișier protocol (*.prcl) CFX Maestro Dx SE și salvați-l în folderul
de protocol LIMS desemnat.

Consultați Capitolul 7, Crearea de protocoale pentru mai multe informații.

Crearea unui fișier LIMS
Un fișier LIMS (*.plrn) conține detaliile configurației plăcii și denumirea fișierului de protocol. Acest
fișier este generat de LIMS-ul dvs. intern. CFX Maestro Dx SE folosește fișierul LIMS pentru a crea un
fișier placă care să fie utilizat cu un fișier al unui protocol.

CFX Maestro Dx SE oferă două fișiere matriță de import a plăcii, pe care le puteți edita pentru a crea
fișiere placă LIMS personalizate.

Sfat: Această sarcină trebuie realizată de un specialist LIMS.

Pentru a crea un fișier LIMS

1. În fereastra Home (Pagină de pornire), selectați View > Show > LIMS File Folder (Vizualizare >
Afișare > Folder fișier LIMS).

2. Deschideți folderul LIMS Templates (Matrițe LIMS) și selectați un fișier .csv pe care să-l importați
în unitatea LIMS internă.

3. Cu ajutorul LIMS, editați fișierul matriță completând câmpurile obligatorii listate în Tabelul 37.

4. Urmați una dintre procedurile următoare:

n Pentru a salva modificările pentru o utilizare viitoare, salvați fișierul ca fișier .csv.

n Pentru a salva modificările și a utiliza fișierul imediat, salvați fișierul cu extensia .plrn.

n Salvați matrița cu extensia .plrn în folderul cu fișiere LIMS.

Important: CFX Maestro Dx SE poate deschide doar fișierul .plrn. Trebuie să salvați fișierul
.csv ca .plrn pentru a putea să inițiați rularea LIMS.
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Coloană Rox (Rând)
Description
(Descriere) Content (Conținut)

Purpose
(Scop)

A 1 Plate header (Antet
placă)

Nu editați Predefinit

A,B,C 2 Field/Data/Instruction
(Câmp/Date/Instrucțiuni)

Nu editați Predefinit

B 3 Version (Versiunea) Nu editați Predefinit

B 4 Dimensiune placă Nu editați Predefinit

B 5 Tip de placă Introduceți „BR White” (BR
Alb), „BR Clear” (BR
Transparent) sau alt tip de
plăci calibrate

Obligatoriu

B 6 Mod de scanare Introduceți „SYBR/FAM Only:”
(Doar SYBR/FAM), „All
Channels” (Toate canalele)
sau „FRET”

Obligatoriu

B 7 Unități Introduceți una dintre
următoarele „copy number”
(număr copie), „fold dilution”
(factor diluție), „micromoles”
(micromoli), „nanomoles”
(nanomoli), „picomoles”
(picomoli), „femtomoles”
(femtomoli), „attomoles”
(atomoli), „milligrams”
(miligrame), „micrograms”
(micrograme), „nanograms”
(nanograme), „picograms”
(picograme), „femtograms”
(femtograme), „attograms”
(atograme) sau „percent”
(procent)

Obligatoriu

Tabelul 37. Definirea conținutului unui fișier LIMS .csv
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Coloană Rox (Rând)
Description
(Descriere) Content (Conținut)

Purpose
(Scop)

B 8 ID rulare Introduceți o scurtă descriere
sau un cod de bare care să
identifice această rulare
(maximum 30 de caractere,
virgulele nu sunt permise)

Opțional

B 9 Note rulare Introduceți descrierea rulării Opțional

B 10 Protocol rulare Introduceți numele fișierului de
protocol exact cum apare în
listă.

Obligatoriu

A 11 Fișier de date Introduceți numele fișierului de
date

Opțional

A 12-15 Urmează a fi
determinat/Gol

Nu editați Predefinit

A 16 Date placă Nu editați Predefinit

A 17-113 Poziția godeului Nu editați Predefinit

B-G Ch1 Dye, Ch2 Dye, Ch3
Dye, Ch4 Dye, Ch5 Dye,
FRET (Colorant canal1,
Colorant canal2,
Colorant canal3,
Colorant canal4,
Colorant canal5, FRET)

Introduceți un nume de
colorant calibrat (de exemplu,
„FAM”) pentru fiecare canal
utilizat

Obligatoriu

H Tipul de probă Introduceți unul dintre
următoarele tipuri de probe:
„Unknown” (Necunoscută),
„Standard”, „Positive Control”
(Control pozitiv), „Negative
Control” (Control negativ),
„NTC” sau „NRT”

Obligatoriu

I Denumire probă Introduceți denumirea probei Opțional

Tabelul 37. Definirea conținutului unui fișier LIMS .csv, continuare
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Coloană Rox (Rând)
Description
(Descriere) Content (Conținut)

Purpose
(Scop)

J-O CH1 Target, CH2
Target, CH3 Target,
CH4 Target, CH5
Target, FRET Target
(Țintă C1, Țintă C2,
Țintă C3, Țintă C4, Țintă
C5, Țintă FRET)

Introduceți denumirea țintei
pentru fiecare canal utilizat

Opțional

P Numele colecției Introduceți denumirea setului
biologic

Opțional

Q Replicat Introduceți un întreg pozitiv
pentru fiecare set de replicate.
Valoarea nu poate fi zero.

Opțional

R-W CH1 Quantity, CH2
Quantity, CH3 Quantity,
CH4 Quantity, CH5
Quantity, FRET
Quantity (Cantitate C1,
Cantitate C2, Cantitate
C3, Cantitate C4,
Cantitate C5, Cantitate
FRET)

Introduceți cantitatea valorilor
pentru oricare standard.
Introduceți concentrația sub
formă de număr zecimal.

Obligatoriu
pentru toate
standardele

Tabelul 37. Definirea conținutului unui fișier LIMS .csv, continuare
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Coloană Rox (Rând)
Description
(Descriere) Content (Conținut)

Purpose
(Scop)

X Notă godeu Introduceți o notă pentru godeu
(maximum 20 de caractere)

Notă: Deși CFX Maestro
Dx SE are o limită de 20
de caractere atunci când
introduceți note în Well
Note prin intermediul
software-ului, câmpul
Well Note poate conține
până la 500 de caractere
dacă este inclus într-un
fișier .plrn importat. Cu
toate acestea,
CFX Maestro Dx SE va
afișa doar primele 20 de
caractere. Fișierul .pcrd
exportat va conține toate
caracterele în câmpul
Well Note, nu se pierd
date.

Opțional

Y-AD Ch1 Well Color, Ch2
Well Color, Ch3 Well
Color, Ch4 Well Color,
Ch5 Well Color, FRET
Well Color (Culoare
godeu C1, Culoare
godeu C2, Culoare
godeu C3, Culoare
godeu C4, Culoare
godeu C5, Culoare
godeu FRET)

Introduceți orice culoare de stil
de urmă definită de utilizator în
format zecimal întreg pe 32 biți
(argb)

Opțional

Tabelul 37. Definirea conținutului unui fișier LIMS .csv, continuare
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Inițierea unei rulări LIMS
Pentru a iniția o rulare LIMS

1. Urmați una dintre procedurile următoare pentru a deschide un fișier LIMS .plrn:

n În fereastra Home (Pagină de pornire), selectați View > Show > LIMS File Folder (Vizualizare
> Afișare > Folder fișier LIMS) și deschideți fișierul .plrn țintă.

n În fereastra Home (Pagină de pornire), selectați File > Open > LIMS File (Fișier > Deschidere
> Fișier LIMS) și deschideți fișierul .plrn țintă.

Fișierul se deschide în fila Start Run (Începere rulare) din expertul Run Setup (Configurare
rulare). Fila Start Run (Începere rulare) afișează informații despre experimentul care urmează a fi
rulat. Aceasta afișează, de asemenea, blocul sau blocurile instrumentului conectat pe care puteți
rula experimentul.

2. În fila Start Run (Începere rulare), selectați un instrument și faceți clic pe Start Run (Începere
rulare).

Exportarea datelor către un sistem LIMS
La finalizarea rulării, CFX Maestro Dx SE generează un fișier de date (.pcrd) și îl salvează în locul
definit al folderului de exportare a datelor.
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Pentru a exporta fișierul de date către un sistem LIMS

u Deschideți fișierul .pcrd și selectați Export > Export to LIMS Folder (Export > Exportare către folder
LIMS).

Sfat: Dacă selectați Automatically Export Data after Run (Exportare automată date după rulare) în
LIMS Options (Opțiuni LIMS), CFX Maestro Dx SE creează un fișier compatibil cu LIMS în format
.csv și îl salvează în același folder.
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Anexa D Depanarea pentru Software-ul
CFX Maestro Dx SE

Această anexă oferă sugestii pentru depanarea problemelor pe care le-ați putea întâlni în timp ce se
actualizează sau rulează Software-ul CFX Maestro Dx SE .

Listă de permisiuni pentru Software-ul CFX Maestro Dx SE
Fișiere și foldere

Pentru a vă proteja împotriva virușilor și a programelor malware, este posibil ca departamentul
dumneavoastră IT să fi implementat măsuri de securitate software foarte stricte. Aceste măsuri ar
putea afecta timpul de actualizare sau de execuție a CFX Maestro Dx SE .

Pentru a îmbunătăți performanța CFX Maestro Dx SE, Bio-Rad recomandă departamentului IT să
introducă în lista de permisiuni din setările Firewall ale software-ul antivirus instalat pe computerul
CFX Maestro Dx SE următoarele fișiere și foldere:

Foldere

n C:\Program Files (x86)\Bio-Rad\CFX_MDx

n C:\ProgramData\Bio-Rad\CFX_MDx

n C:\Users\Public\Documents\Bio-Rad\CFX_MDx

Fișiere

n Toate fișierele .exe aflate în folderul C:\Program Files (x86)\Bio-Rad\CFX _MDx

n R.exe și Rscript.exe (aflate în folderul C:\Program Files (x86)\Bio-Rad\CFX _MDx\R\
R-3.3.1\bin)
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Jurnalul aplicației
Înainte de a începe o nouă rulare, sistemul CFX Opus 96 Dx sau CFX Opus 384 Dx inițiază un test de
auto-diagnosticare pentru a verifica dacă rulează în conformitate cu specificațiile. Software-ul
înregistrează rezultatele acestui test în fișierul Run Log (Jurnalul rulării) și Application Log (Jurnalul
aplicației). Dacă observați o problemă la unul sau mai multe experimente, deschideți jurnalele rulării
și aplicației pentru a descoperi când a început problema.

CFX Maestro Dx SE înregistrează informații despre starea unui instrument în timpul unei rulări în
Application Log (Jurnalul aplicației). Folosiți aceste jurnale pentru a monitoriza evenimentele produse
în cazul instrumentelor și software-ului și pentru a le depana.

Pentru a deschide Application Log (Jurnalul aplicației)

u Din fereastra Home (Pagină de pornire), selectați View > Application Log (Vizualizare > Jurnalul
aplicației).
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Depanare
De obicei, problemele de comunicare ale software-ului și instrumentului pot fi rezolvate prin
repornirea computerului dumneavoastră și a sistemului. Asigurați-vă că ați salvat lucrul în desfășurare
înainte de repornire.

Notă: Verificați dacă computerul dumneavoastră are suficient RAM și spațiu liber pe disc.
Memoria RAM minimă este de 4 GB, iar spațiul minim pe disc este de 128 GB.

Power Failure
In a power failure, the instrument and computer will shut down. If the power failure is short, the
instrument will resume running a protocol but the Application Log will note the power failure.
Depending on the computer settings and the length of time the power is off, the instrument and
software attempt to continue running depending on the protocol step:

n If the protocol is in a step with no plate read, the protocol continues running as soon as the
instrument regains power.

n If the protocol is in a step with a plate read, the instrument waits for the software to restart and
resume communication to collect the data. In this situation, the protocol continues only if the
software is not shut down by the computer. When the computer and software start up again, the
protocol continues.

Transferarea fișierelor în computerul CFX Maestro Dx SE
Puteți transfera date și fișiere jurnal situate pe instrument pe hard disk-ul unui computer CFX Maestro
Dx SE atașat.

Sfat: Toate fișierele din folderul cu date în timp real din baza instrumentului sunt preluate în
computer.

Notă: Din instrumentele CFX Opus Dx, puteți transfera numai fișiere jurnal. Toate fișierele jurnal
de pe instrument sunt transferate pe computer.

Pentru a prelua fișiere din instrument

1. În panoul Detected Instruments (Instrumente detectate) din fereastra Home (Pagină de pornire),
faceți clic dreapta pe instrumentul țintă și selectați Retrieve Log Files.

2. Alegeți locația folderului în care să salvați fișierele preluate.

3. Faceți clic pe OK.
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Instalarea manuală pentru Software-ul CFX Maestro Dx SE
Pentru a instala manual CFX Maestro Dx SE

1. Dacă este necesar, deconectați orice instrumente conectate de la computer.

Localizați și deconectați cablul USB al instrumentului de la computerul CFX Maestro Dx SE.
Capătul introdus în instrument poate să rămână în poziție.

2. Autentificați-vă pe computerul CFX Maestro Dx SE cu drepturi de administrator.

3. Introduceți unitatea USB cu CFX Maestro Dx SE în portul USB al computerului.

4. În Windows Explorer, navigați la și deschideți unitatea USB cu CFX Maestro Dx SE.

5. Deschideți folderul CFX și faceți dublu clic pe CFXMaestro Dx Setup.exe pentru a instala
CFX Maestro Dx SE.

6. Urmați instrucțiunile de pe ecran pentru a instala software-ul.

La finalizare, ecranul de pornire pentru Software-ul CFX Maestro Dx SE Bio-Rad apare pe
ecranul computerului, iar pictograma cu Software-ul CFX Maestro Dx SE Bio-Rad apare pe
desktop.

7. Îndepărtați în siguranță unitatea USB cu software-ul și inițializați CFX Maestro Dx SE.

Reinstalarea driverelor
Pentru a reinstala driverele instrumentului

u Din fereastra Home (Pagină de pornire), selectați Tools > Reinstall Instrument Drivers
(Instrumente > Reinstalare drivere instrument).

Notă: Dacă aveți probleme cu comunicarea dintre software și sistemul în timp real după ce ați
reinstalat driverele și ați verificat conexiunea USB, contactați serviciul de asistență tehnică Bio-
Rad.

318 | Software-ulCFXMaestro DxSE



Anexa E Bio-Rad Free and Open-Source Notices
for PCR Products

This document includes licensing information relating to free, open- source, and public- source
software and data (together, the “MATERIALS”) included with or used to develop Bio-Rad products
and services. The terms of the applicable free, open-source, and public-source licenses (each an
“OPEN LICENSE”) govern Bio-Rad’s distribution and your use of the MATERIALS. Bio-Rad and the
third-party authors, licensors, and distributors of the MATERIALS disclaim all warranties and liability
arising from all use and distribution of the MATERIALS. To the extent the OSS is provided under an
agreement with Bio-Rad that differs from the applicable OSS LICENSE, those terms are offered by
Bio-Rad alone.

Bio- Rad has reproduced below copyright and other licensing notices appearing within the
MATERIALS. While Bio- Rad seeks to provide complete and accurate copyright and licensing
information for all MATERIALS, Bio-Rad does not represent or warrant that the following information is
complete, correct, or error-free. MATERIALS recipients are encouraged to (a) investigate the identified
MATERIALS to confirm the accuracy of the licensing information provided and (b) notify Bio-Rad of
any inaccuracies or errors found in this document so that Bio-Rad may update this document
accordingly.

Certain OPEN LICENSES (such as the Affero General Public Licenses, Common Development and
Distribution Licenses, Common Public License, Creative Commons Share-Alike License, Eclipse
Public License, Mozilla Public Licenses, GNU General Public Licenses, GNU Library/Lesser General
Public Licenses, and Open Data Commons Open Database License) require that the source materials
be made available to recipients or other requestors under the terms of the same OPEN LICENSE.

The corresponding open source software is available for download from the links in the section that
follows.
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Software Notices

ZedGraph
Project homepage/download site:

https://sourceforge.net/projects/zedgraph/

Bio-Rad source code site:

https://github.com/bio-rad-lsg-open-source/ZedGraph-5.0.1

External source code site:

https://github.com/ZedGraph/ZedGraph

Project licensing notices:

/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

/sources/ZedGraph/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

Standard Open License Text

LGPL-2.1
GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 59 Temple
Place, Suite 330, Boston, MA 02111-1307 USA Everyone is permitted to
copy and distribute verbatim copies of this license document, but
changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.]
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Standard Open License Text

Preamble

The licenses for most software are designed to take away your freedom
to share and change it. By contrast, the GNU General Public Licenses
are intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some
specially designated software packages--typically libraries--of the
Free Software Foundation and other authors who decide to use it. You
can use it too, but we suggest you first think carefully about
whether this license or the ordinary General Public License is the
better strategy to use in any particular case, based on the
explanations below.

When we speak of free software, we are referring to freedom of use,
not price. Our General Public Licenses are designed to make sure that
you have the freedom to distribute copies of free software (and
charge for this service if you wish); that you receive source code or
can get it if you want it; that you can change the software and use
pieces of it in new free programs; and that you are informed that you
can do these things.

To protect your rights, we need to make restrictions that forbid
distributors to deny you these rights or to ask you to surrender
these rights. These restrictions translate to certain
responsibilities for you if you distribute copies of the library or
if you modify it.

For example, if you distribute copies of the library, whether gratis
or for a fee, you must give the recipients all the rights that we
gave you. You must make sure that they, too, receive or can get the
source code. If you link other code with the library, you must
provide complete object files to the recipients, so that they can
relink them with the library after making changes to the library and
recompiling it. And you must show them these terms so they know their
rights.

We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there
is no warranty for the free library. Also, if the library is modified
by someone else and passed on, the recipients should know that what
they have is not the original version, so that the original author's
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reputation will not be affected by problems that might be introduced
by others.

Finally, software patents pose a constant threat to the existence of
any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be
consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the
ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and
is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those
libraries into non-free programs.

When a program is linked with a library, whether statically or using
a shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General
Public License permits more lax criteria for linking other code with
the library.

We call this license the "Lesser" General Public License because it
does Less to protect the user's freedom than the ordinary General
Public License. It also provides other free software developers Less
of an advantage over competing non-free programs. These disadvantages
are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain
special circumstances.

For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it
becomes a de-facto standard. To achieve this, non-free programs must
be allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this
case, there is little to gain by limiting the free library to free
software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free
programs enables a greater number of people to use a large body of
free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU
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operating system, as well as its variant, the GNU/Linux operating
system.

Although the Lesser General Public License is Less protective of the
users' freedom, it does ensure that the user of a program that is
linked with the Library has the freedom and the wherewithal to run
that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a
"work based on the library" and a "work that uses the library". The
former contains code derived from the library, whereas the latter
must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms
of this Lesser General Public License (also called "this License").
Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work
which has been distributed under these terms. A "work based on the
Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or
translated straightforwardly into another language. (Hereinafter,
translation is included without limitation in the term
"modification".)

"Source code" for a work means the preferred form of the work for
making modifications to it. For a library, complete source code means
all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control
compilation and installation of the library.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output
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from such a program is covered only if its contents constitute a work
based on the Library (independent of the use of the Library in a tool
for writing it). Whether that is true depends on what the Library
does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's
complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the
Library. You may charge a fee for the physical act of transferring a
copy, and you may at your option offer warranty protection in
exchange for a fee.

2. You may modify your copy or copies of the Library or any portion
of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge
to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a
table of data to be supplied by an application program that uses the
facility, other than as an argument passed when the facility is
invoked, then you must make a good faith effort to ensure that, in
the event an application does not supply such function or table, the
facility still operates, and performs whatever part of its purpose
remains meaningful. (For example, a function in a library to compute
square roots has a purpose that is entirely well-defined independent
of the application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function must be
optional: if the application does not supply it, the squareroot
function must still compute square roots.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
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distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Library.

In addition, mere aggregation of another work not based on the
Library with the Library (or with a work based on the Library) on a
volume of a storage or distribution medium does not bring the other
work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do
this, you must alter all the notices that refer to this License, so
that they refer to the ordinary GNU General Public License, version
2, instead of to this License. (If a newer version than version 2 of
the ordinary GNU General Public License has appeared, then you can
specify that version instead if you wish.) Do not make any other
change in these notices. Once this change is made in a given copy, it
is irreversible for that copy, so the ordinary GNU General Public
License applies to all subsequent copies and derivative works made
from that copy. This option is useful when you wish to copy part of
the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or
derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany
it with the complete corresponding machine- readable source code,
which must be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange. If
distribution of object code is made by offering access to copy from a
designated place, then offering equivalent access to copy the source
code from the same place satisfies the requirement to distribute the
source code, even though third parties are not compelled to copy the
source along with the object code.

5. A program that contains no derivative of any portion of the
Library, but is designed to work with the Library by being compiled
or linked with it, is called a "work that uses the Library". Such a
work, in isolation, is not a derivative work of the Library, and
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therefore falls outside the scope of this License. However, linking a
"work that uses the Library" with the Library creates an executable
that is a derivative of the Library (because it contains portions of
the Library), rather than a "work that uses the library". The
executable is therefore covered by this License. Section 6 states
terms for distribution of such executables. When a "work that uses
the Library" uses material from a header file that is part of the
Library, the object code for the work may be a derivative work of the
Library even though the source code is not. Whether this is true is
especially significant if the work can be linked without the Library,
or if the work is itself a library. The threshold for this to be true
is not precisely defined by law. If such an object file uses only
numerical parameters, data structure layouts and accessors, and small
macros and small inline functions (ten lines or less in length), then
the use of the object file is unrestricted, regardless of whether it
is legally a derivative work. (Executables containing this object
code plus portions of the Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may
distribute the object code for the work under the terms of Section 6.
Any executables containing that work also fall under Section 6,
whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or
link a "work that uses the Library" with the Library to produce a
work containing portions of the Library, and distribute that work
under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse
engineering for debugging such modifications. You must give prominent
notice with each copy of the work that the Library is used in it and
that the Library and its use are covered by this License. You must
supply a copy of this License. If the work during execution displays
copyright notices, you must include the copyright notice for the
Library among them, as well as a reference directing the user to the
copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-
readable source code for the Library including whatever changes were
used in the work (which must be distributed under Sections 1 and 2
above); and, if the work is an executable linked with the Library,
with the complete machine-readable "work that uses the Library", as
object code and/or source code, so that the user can modify the
Library and then relink to produce a modified executable containing
the modified Library. (It is understood that the user who changes the
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contents of definitions files in the Library will not necessarily be
able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (1) uses at run time a copy
of the library already present on the user's computer system, rather
than copying library functions into the executable, and (2) will
operate properly with a modified version of the library, if the user
installs one, as long as the modified version is interface-compatible
with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three
years, to give the same user the materials specified in Subsection
6a, above, for a charge no more than the cost of performing this
distribution.

d) If distribution of the work is made by offering access to copy
from a designated place, offer equivalent access to copy the above
specified materials from the same place.

e) Verify that the user has already received a copy of these
materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the
Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
the executable.

It may happen that this requirement contradicts the license
restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot
use both them and the Library together in an executable that you
distribute.

7. You may place library facilities that are a work based on the
Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a
combined library, provided that the separate distribution of the work
based on the Library and of the other library facilities is otherwise
permitted, and provided that you do these two things:

Ghid de utilizare | 327



Anexa EBio-Rad Free andOpen-Source Notices for PCR Products

a) Accompany the combined library with a copy of the same work based
on the Library, uncombined with any other library facilities. This
must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that
part of it is a work based on the Library, and explaining where to
find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the
Library except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense, link with, or distribute the
Library is void, and will automatically terminate your rights under
this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated
so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are

prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the
Library subject to these terms and conditions. You may not impose any
further restrictions on the recipients' exercise of the rights
granted herein. You are not responsible for enforcing compliance by
third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do
not excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under
this License and any other pertinent obligations, then as a
consequence you may not distribute the Library at all. For example,
if a patent license would not permit royalty-free redistribution of
the Library by all those who receive copies directly or indirectly
through you, then the only way you could satisfy both it and this
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License would be to refrain entirely from distribution of the
Library.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended
to apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a
licensee cannot impose that choice. This section is intended to make
thoroughly clear what is believed to be a consequence of the rest of
this License.

12. If the distribution and/or use of the Library is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time. Such
new versions will be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library
specifies a version number of this License which applies to it and
"any later version", you have the option of following the terms and
conditions either of that version or of any later version published
by the Free Software Foundation. If the Library does not specify a
license version number, you may choose any version ever published by
the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free
programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is
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copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free
status of all derivatives of our free software and of promoting the
sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER MATERIALS), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest
possible use to the public, we recommend making it free software that
everyone can redistribute and change. You can do so by permitting
redistribution under these terms (or, alternatively, under the terms
of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It
is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should
have at least the "copyright" line and a pointer to where the full
notice is found.
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<one line to give the library's name and a brief idea of what it
does.>

Copyright (C) <year> <name of author>

This library is free software; you can redistribute it and/or modify
it under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is
distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public
License for more details.

You should have received a copy of the GNU Lesser General Public
License along with this library; if not, write to the Free Software
Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307
USA

Also add information on how to contact you by electronic and paper
mail. You should also get your employer (if you work as a programmer)
or your school, if any, to sign a "copyright disclaimer" for the
library, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the
library `Frob' (a library for tweaking knobs) written by James Random
Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

That's all there is to it!
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Minpack Copyright Notice (1999) University of Chicago. Toate drepturile rezervate.

Redistribuirea și utilizarea în forma sursă și binară, cu sau fără modificare, sunt permise cu
îndeplinirea următoarelor condiții:

1. Redistribuirile codului sursă trebuie să păstreze notificarea privind drepturile de utilizator de mai
sus, această listă de condiții și următoarea exonerare de răspundere.

2. Redistribuirile în formă binară trebuie să reproducă notificarea privind drepturile de autor de mai
sus, această listă de condiții și următoarea exonerare de răspundere în documentația și/sau
celelalte materiale furnizate împreună cu distribuirea.

3. Documentația pentru utilizatorul final inclusă cu redistribuirea, dacă există, trebuie să includă
următoarea recunoaștere:

„Acest produs include software dezvoltat de Universitatea din Chicago, ca Operator al Laboratorului
Național Argonne.”
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